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Reports for WinForms  Overview 
Reports for WinForms provides all the tools you need to meet your reporting, printing, 

previewing, and exporting needs. Add Microsoft-Access style database reporting. Create 

complex hierarchical documents with automatic word index, TOC generation, data binding, and 

more. Export, print, or preview your reports and documents. 

Reporting 

Generate Microsoft Access-style reports for your Visual Studio applications quickly and easily 

with Reports for WinForms. 

 The C1Report component, which generates data-based banded reports. Render reports 

directly to a printer or preview control, or export to various portable formats (including 

XLS, PDF, HTML, text, and images). The component exposes a rich object model for 

creating, customizing, loading, and saving report definitions. See Working with 

C1Report for more information. 

 The C1RdlReport component, a component that represents an RDL (Report Definition 

Language) report defined using the 2008 version of the RDL specification. The 

C1RdlReport component is similar to the C1Report component with the addition of RDL 

support. See Working with C1RdlReport for more information. 

 The C1ReportDesigner designer, a stand-alone application used to create report 

definitions without writing code. The designer allows you to quickly create and edit 

report definitions, or to import existing Microsoft Access and Crystal report definitions. 

The designer mimics the Microsoft Access interface, so, if you currently use Microsoft 

Access, you will quickly adapt to using C1ReportDesigner. See Working with 

C1ReportDesigner for more information. 

 The C1ReportDesigner control (not to be confused with the stand-alone designer) 

which displays reports in design mode, and allows users to drag, copy, and resize report 

fields and sections. The control also provides an unlimited undo/redo stack and a 

selection mechanism designed for use with the PropertyGrid control that ships with 

Visual Studio. You can use the C1ReportDesigner control to incorporate some report 

design features into your applications, or you can write your own full-fledged report 

designer application. 

 The C1ReportsScheduler application, a stand-alone application used to schedule 

report creation to run in the background. Using the C1ReportsScheduler application, 

you can choose what reports to export or print, formats to export the report to, and the 

schedule and frequency for creating reports. See Working with C1ReportsScheduler for 

more information. 

Printing and Previewing 

No matter how simple or complex your printing requirements, Reports for WinForms can help 

you add printing and previewing capabilities to your project quickly and easily. 

 The C1PrintDocument component provides a rich object model which allows you to 

create arbitrarily complex documents in code. The object model specifically targets 

paginated documents, providing a rich set of features facilitating automatic and 

intelligent pagination of complex structured documents. Documents can be completely 

C1.C1Report.4~C1.C1Report.C1Report.html
C1.C1Report.4~C1.C1Rdl.Rdl2008.C1RdlReport.html
C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner.html
C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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created in code, or bound to a database via a powerful and flexible data binding model. 

C1PrintDocument can also import and generate report definitions. See Working with 

C1PrintDocument for more information. 

 The C1MultiDocument component is designed to allow creating, persisting, and 

exporting large documents that cannot be handled by a single C1PrintDocument object 

due to memory limitations. C1MultiDocument supports links between contained 

documents, common TOC, common page numeration, and total page count. 

 The Reports for WinForms visual preview components provide a powerful, flexible and 

easy to use set of tools that let you quickly add document viewing capabilities to your 

application. The integrated components (the C1PrintPreviewControl control and the 

C1PrintPreviewDialog dialog box) make adding a professional-looking preview to your 

applications a snap, while the set of specialized controls (C1PreviewPane, 

C1PreviewThumbnailView, C1PreviewOutlineView, C1PreviewTextSearchPanel) allow you 

to fine-tune your preview as much as you need. 

 Report Preview control for WinForms is a new ribbon based preview control that is 

released as beta version for 2015 v2 release. It provides the multiple document or 

report viewing functionality from different sources in a single viewer. It has a Ribbon 

based UI designed as per latest trends with easy to use ribbon elements, groups, 

sidebars, etc., that eliminates implementation complexities. For more information, 

see Report Preview Control Overview. 

See Also 
Help with WinForms Edition 

Upgrading from VSReport 8.0 

Reports and Preview .NET Versions 

Converting a Preview for WinForms Project to Reports for WinForms 

Help with WinForms Edition 
Reports for WinForms Overview > Help with WinForms Edition 

Getting Started 

For information on installing ComponentOne Studio WinForms Edition, licensing, technical 

support, namespaces and creating a project with the control, please visit Getting Started with 

WinForms Edition. 

Upgrading from VSReport 8.0 
Reports for WinForms Overview > Upgrading from VSReport 8.0 

Show All  

Hide All  

VSReport 8.0 users will have no trouble using C1Report. Although C1Report was completely 

rewritten in C# to take advantage of the latest .NET technologies, the object model is virtually 

C1.C1Report.4~C1.C1Preview.C1MultiDocument.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewDialog.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewPane.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewThumbnailView.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewOutlineView.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewTextSearchPanel.html
http://helpcentral.componentone.com/nethelp/c1studiowinforms/
http://helpcentral.componentone.com/nethelp/c1studiowinforms/
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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identical to the one in VSReport 8.0. C1Report uses the same report definition files, and 

implements all the features you are used to, including subreports, export options including 

HTML/DHTML/PDF export, and much more. 

C1Report also includes the same powerful Report Designer that ships with VSView Reporting 

Edition, so creating and customizing your reports is as easy as ever. 

The main difference between VSReport and C1Report is how reports are rendered into preview 

controls: VSReport uses the VSPrinter control to provide report previewing. For example, the 

following line of code would render the report in vsreport1 into the vsprinter1 control: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

VSReport1.Render(vsprinter1) 

To write code in C# 

C# Copy Code  

 

vsreport1.Render(vsprinter1); 

C1Report exposes a PrintDocument object instead. This object can be used to print the report, 

or it can be attached to a preview control such as the C1PrintPreview or the Microsoft 

PrintPreviewControl. For example, the following line of code would render the report in 

C1Report1 into the C1PrintPreview1 control: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

C1PrintPreview1.Document = c1r 

To write code in C# 

C# Copy Code  

 

c1printPreview1.Document = c1r; 
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C1Report event names are also different from VSReport. The events were renamed because 

VSReport has script-handler properties with the same name as the events. In .NET, events and 

properties must have different names. 

Aside from these differences, the controls have virtually identical object models. Both 

implement the RenderToFile method, which renders reports to HTML, PDF and other types of 

file, and both expose collections of Groups, Sections, and Fields. 

Reports and Preview .NET Versions 
Reports for WinForms Overview > Reports and Preview .NET Versions 

The Reports for WinForms product has evolved through several versions. The current version 

(#6 in the table below) is a combination of the .NET 2.0 Preview for .NET and Reports for .NET 

products. The following table describes the available .NET versions of reporting and previewing 

products. Note that the list has been numbered to differentiate between versions (this product, 

Reports for WinForms, is #6 below): 

# Name .NET 

Framewor

k 

Assemblies Controls 

1 Preview 

for .NET 

.NET 1.x C1.C1PrintDocument.dll 

C1.Win.C1PrintPreview.dll 

C1PrintDocument 

C1PrintPreview 

2 Reports 

for .NET 

.NET 1.x C1 C1.Win.C1Report.dll C1Report 

3 Preview 

Classic 

for .NET 

.NET 2.0 C1.C1PrintDocument.Classic.2.dll 

C1.Win.C1PrintPreview.Classic.2.dll 

C1PrintDocument 

C1PrintPreview 

4 Reports 

for .NET 

.NET 2.0 C1.Win.C1Report.2.dll C1Report 

5 Preview 

for .NET 

.NET 2.0 C1.C1Preview.2.dll 

C1.Win.C1Preview.2.dll 

C1PrintDocument 

C1PreviewPane 

C1PrintPreviewControl 

C1PrintPreviewDialog 

C1PreviewThumbnailView 

C1PreviewOutlineView 

C1PreviewTextSearchPane

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~RenderToFile.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Groups.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Sections.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Fields.html
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# Name .NET 

Framewor

k 

Assemblies Controls 

l 

6 Reports 

for 

WinForm

s 

.NET 2.0 C1.C1Report.2.dll C1.Win.C1Report.2.dll 

C1.Win.C1ReportDesigner.2.dll 

C1Report 

C1PrintDocument 

C1PreviewPane 

C1PrintPreviewControl 

C1PrintPreviewDialog 

C1PreviewThumbnailView 

C1PreviewOutlineView 

C1PreviewTextSearchPane

l C1ReportDesigner 

7 Reports 

for WPF 

.NET 3.0 C1.WPF.C1Report.dll 

C1.WPF.C1Report.Design.dll 

C1.WPF.C1Report.VisualStudio.Design.dl

l 

C1DocumentViewer 

Version Compatibility 

While the products above provide reporting and previewing functionality and may include 

similar components, they are not all backwards compatible. Some considerations for upgrading 

versions are discussed below: 

 Preview Classic for .NET (.NET 2.0, #3 in the above table) 

This is the "classic" version of ComponentOne's preview controls. While the assembly 

names are different from #1, these are 100% backwards compatible, so upgrading from 

the .NET 1.x product (#1 above) does not require any changes except for changing the 

references in your project and licenses.licx files. Preview Classic for .NET is no longer 

actively developed and is in maintenance mode. 

 Reports for .NET (.NET 2.0, #4 above) 

This is the old .NET 2.0 version of ComponentOne's reporting controls. These reports 

can be shown by all versions of preview controls (#1, #3 or #5 above), by assigning the 

C1Report.Document property to the Document property of a preview control. 

 Preview for .NET (.NET 2.0, #5 above) 

This is the newer previewing product (new compared to the classic version). This 

product has different code and object model from the previous versions (#1or #3 

above). Automatic conversion from #1 or #3 to this product is not supported; in 

particular the Convert2Report.exe utility can not convert those older projects. 

Converting from #1 or #3 to this preview requires rewriting user code, always. The 

scope of changes differs and may be trivial, but code must be updated by hand. 
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 Reports for WinForms (.NET 2.0, #6 above) 

The current .NET 2.0 combined reporting and previewing product. This includes both 

the "new" preview (#5 above) and reports (#4 above). Unlike in previous versions, to 

preview a C1Report, it itself (rather than its Document property) should be assigned to 

the Document property of the preview control. This build is backwards code 

compatible with #4 and #5, but assembly references and namespaces must be updated. 

The changes are always trivial and can be made manually or by using the 

Convert2Report.exe utility which can be downloaded from ComponentOne 

HelpCentral. 

 Reports for WPF (.NET 3.0, #7 above) 

2.0 (#5) and Reports for .NET 2.0 (#4). This product can be used in .NET 3.0 and 3.5 

applications. 

Converting a Preview for WinForms 

Project to Reports for WinForms 
Reports for WinForms Overview > Converting a Preview for WinForms Project to Reports for WinForms 

In the 2008 v3 release of the ComponentOne Studio Enterprise, the Preview for WinForms and 

Reports for WinForms products were merged into one product: Reports for WinForms. The 

new Reports for WinForms contains the C1Report component as well as all components and 

controls that were previously provided by the C1Preview assemblies, but, because the 

assemblies now have different names, projects that used Preview for WinForms must have 

references changed to the new assemblies. 

You may want to use this utility if: 

 You have existing C# or VB projects that use C1PrintDocument or any of the 

previewing WinForms controls previously provided by the C1.Win.C1Preview.2 

assembly (C1PrintPreviewControl, C1PrintPreviewPane, and so on). OR 

 You have an existing C# or VB project that used the old C1Report control (build 2.5 or 

earlier) provided by a single C1.Win.C1Report.2 assembly. 

Specifically, this utility performs the following: 

 In C# or VB projects, references are changed from C1.C1Preview.2 and 

C1.Win.C1Preview.2 to the C1.C1Report.2 and C1.Win.C1Report.2 assemblies. 

 In licenses.licx files, references for C1PrintDocument and preview controls are updated 

to reference the corresponding report assemblies. 

 Also in licenses.licx files, references for C1Report residing in the C1.Win.C1Report.2 

assembly are updated to point to the C1.C1Report.2 assembly where it now resides. 

 In C# or VB source code files, all mentions of the C1.Win.C1Report namespace are 

replaced with C1.C1Report. 

The Convert2Report utility can convert multiple projects and/or individual files. You can 

download the Convert2Report.exe utility from ComponentOne HelpCentral. Using this utility, 

select and convert your files. 

http://helpcentral.componentone.com/CS/forums/storage/14/213893/Convert2Report.zip
http://helpcentral.componentone.com/CS/forums/storage/14/213893/Convert2Report.zip
http://helpcentral.componentone.com/CS/forums/storage/14/213893/Convert2Report.zip
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To convert a project, complete the following steps: 

1. Download and open the Convert2Report.exe file, located on ComponentOne 

HelpCentral. The application window will look like the following: 

 
2. Keep the Auto-select licenses.licx and Auto-select code files check boxes to auto 

select all included files when a project file is selected for upgrade. 

3. Click either the Select projects/files to convert or Select folders to convert button. 

The Open or Browse For Folder dialog box will open. 

4. In the Open or Browse For Folder dialog box, locate either the files or folder you wish 

to convert and select OK. 

If you need to select additional folders or files, you can click the Select projects/files 

to convert or Select folders to convert button again to choose more files. If you need 

to clear your selection and choose files again, press the Clear button. 

Your dialog box will look similar to the following: 

http://helpcentral.componentone.com/CS/forums/storage/14/213893/Convert2Report.zip
http://helpcentral.componentone.com/CS/forums/storage/14/213893/Convert2Report.zip
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5. Confirm the files you are converting in the left pane. You can check or uncheck files to 

change what will be converted. 

6. Click Convert to convert your Preview for WinForms project to using Reports for 

WinForms. 

Files that have been successfully converted will display a green check mark in the left 

pane. 

 
The bottom pane will list the code and licensing files that have been converted as well 

as the saved locations for the original and converted files. By default the original file will 
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be saved in the same directory as FileName.original and the converted file will be 

saved as the original file name (overwriting that file). 

7. Close the utility after successfully converting all files. 

Key Features 
Build customized reviews and reports using Reports for WinForms and take advantage of the 

many features of the C1Report and C1PrintDocument components, and many visual 

previewing controls, including: 

C1Report Features 

The C1Report control's features include the following: 

 Report Designer Application 

Quickly create, edit, preview, load, and save report definition files without writing a 

single line of code. The familiar Microsoft Access-like user interface of the 

C1ReportDesigner application yields fast adaptation. 

 C1Report Wizard 

You don't have to be an expert to create reports using the C1Report Wizard. 

Effortlessly create a new report from start to finish in five easy steps. Select the data 

source, report fields, and layout of your report with the C1Report Wizard guiding you 

through each step. 

 Banded Report Model 

Reports uses a banded report model based on groups, sections, and fields. The banded 

report model allows for a highly-organized report layout. 

 30+ Built-in Report Templates 

The enhanced report designer application now includes 34 report templates. Simply 

select a report theme in the C1Report Wizard and you get a professionally styled 

report. No coding required - your colorful report is just a click away! 

 Microsoft Access and Crystal Reports Compatibility 

Reports supports features found in Microsoft Access and Crystal Reports. With the click 

of a button, import Access report files (MDB) and Crystal report files (RPT) using the 

C1ReportDesigner. 

 Flexible Data Binding 

Specify a connection string and an SQL statement in your report definition and Reports 

will load the data automatically for you. Optionally, use XML files, custom collections, 

and other data sources. 

 Parameters for Adding/Limiting Data 

Reports may contain parameterized queries, allowing users to customize the report by 

adding/limiting the data that should be included in the report before it is rendered. 

Specify a value for a report field, filter data, control sorting and grouping, and more. 

Display only necessary data using report parameters. 

 Combine Several Reports Into One 

Reports may contain nested reports to arbitrary levels (subreports). You can use the 

main report to show detailed information and use subreports to show summary data at 

the beginning of each group. 

 VBScript Expression 

Reports may include embedded VBScript event handlers, making them self-contained. 

Format fields according to value, update a page count, hide a section without data, and 
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more when the report is rendered. Use VBScript expressions to retrieve, calculate, 

display, group, filter, sort, parameterize, and format the contents of a report, including 

extensions for aggregate expressions (sum, max, average, and more). 

 VBScript Editor 

Write global scripts in VBScript Editor and take full advantage of syntax check and 

IntelliSense that make the scripting experience intuitive. Use split window mode of 

VBScript Editor to write two scripts for two different fields simultaneously in the report. 

 Chart Field 

Embed charts into your reports to graphically display numerical data. The Report's 

Chart field is implemented using the C1Chart control and can display multiple series of 

data. The supported chart types include Bar, Area, Scatter, Pie, Line, Column, Radar, 

Polar, Step, and Histogram. 

 Aggregated Charting 

Create charts that automatically aggregate data values (ValueY) that have the same 

category (ValueX) using an aggregate function of your choice. The chart field's 

Aggregate property tells the chart how to aggregate values that have the same 

category into a single point in the chart. It can be set to perform any of the common 

aggregation functions on the data: sum, average, count, maximum, minimum, standard 

deviation, and variance. 

 Barcode Field 

The barcode field in C1Report offers 38 barcodes to choose from. The properties 

available for rendering the barcodes can be used to obtain customized barcodes. The 

FNC1 characters are also supported in some barcodes. 

 Export Formats 

Render your reports directly to a printer or preview control or export your reports to 

various portable formats: Excel (XLS, XLSX), PDF, HTML, Rich Text and Compressed 

Metafiles. 

 Automated Reports 

Automate reports using the C1ReportsScheduler, a stand-alone application used to 

schedule report creation to run in the background. Using the C1ReportsScheduler 

application, you can choose what reports to export or print, formats to export the 

report to, and the schedule and frequency for creating reports. 

C1PrintDocument Features 

The C1PrintDocument component's features include the following: 

 Powerful Document Oriented Object Model 

The C1PrintDocument component provides a flexible hierarchical document object 

model with powerful automatic layout, formatting, and pagination control features so 

there's no need to manually calculate the layout, insert page breaks, and so on. 

 Rich Formatting Options 

Control the look of your document with support for paragraphs of text with multiple 

fonts, text and background colors, text positioning (subscript, superscript), inline 

images, various text alignment (including justified text), and more. 

 Powerful Table Layouts 

Use the C1PrintDocument tables to layout elements in your documents. Apply styles 

to tables, modify row and column headers, and more. Tables support an Excel-like 

object model, with a logically infinite number of columns and rows. Simply accessing a 

table element instantiates it, so you never have to worry about specifying the correct 

table size. 

C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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 Flexible Sizing and Positioning of Elements 

Document element size and position can be specified as absolute values, relative to 

other elements sizes and positions, or as simple expressions combining absolute and 

relative values. For example, specify the width of an element as a percentage of the 

parent element or of the current page width. 

 Automatically Generate TOC and Word Index 

C1PrintDocument supports automated generation of Table of Contents (TOC) and 

alphabetical word index. Depending on your output format, links in both the TOC and 

index are clickable and take the user to the referenced page. 

 Add Hyperlinks 

Make documents interactive by adding hyperlinks, link targets, and more. Any 

document element can be a hyperlink, or a hyperlink jump target. 

 Data Binding Support 

Documents can be completely created in code, or bound to a database via a powerful 

and flexible data binding model. 

 Import Report Definitions 

Combine C1PrintDocument with the powerful C1Report component, which exposes a 

rich object model for creating, customizing, loading, and saving report definitions. You 

can quickly import and generate report definitions with the C1PrintDocument 

component. 

 SQL Server Reporting Services 

Report Definition Language (RDL) is the reporting scheme commonly used in SQL 

Server Reporting Services. C1PrintDocument allows you to import an SSRS definition 

file (.rdl). The result is a data bound document representation of the imported report. 

 Export Formats 

Multiple export format options make saving and sharing documents easy. Export your 

documents to Adobe Portable Document Format (PDF), Excel (XLS and XLSX), Word 

(RTF and DOCX), HTML, and several image formats. 

 Create Adobe Acroforms 

Documents can include interactive forms (to be filled out by the end user). Add text 

boxes, list boxes, drop-down lists, check, radio and push buttons to C1PrintDocument. 

These controls become interactive when viewed inside C1PrintPreviewControl (see 

Print Preview). You can also export these documents to Adobe Acroforms. 

 Control Exported PDF Display 

You can control how an exported PDF file is displayed in Adobe Acrobat. For example, 

set the how pages are viewed (for instance, one page at a time or two pages in 

columns) and the visibility of various elements (that is, if thumbnail images or a 

document outline view is visible). 

 C1DX File Format for Smaller File Sizes 

A new OPC-based file format for C1PrintDocument objects, C1D OpenXML (C1DX) 

complies with Microsoft Open Packaging Conventions and is similar to the Microsoft 

Office 2007 OpenXML format. Due to built-in compression, resulting files are smaller in 

size. The current Preview for WinForms C1D format is also fully supported for 

backwards compatibility. 

 Multiple Page Layouts 

Several page layouts accommodating different paper sizes, page settings, number of 

columns, page headers, and so on can be predefined and selected at run time by 

setting a single property. 

 Combine Multiple Large Documents 

Use C1MultiDocument to combine multiple C1PrintDocuments which will be 

rendered as a whole continuous document with shared page numbering, a common 

TOC, word index, page count and inter-document hyperlinks. This allows you to create 



 

 22 

and export very large documents that cannot be handled by a single 

C1PrintDocument object due to memory limitations. 

 Hierarchical Styles 

Hierarchical styles control the look of all document elements, with intelligent support 

for ambient and non-ambient style attributes. Specify individual font attributes (such as 

boldness or font size), table grid lines, and more. 

 GDI+ Text Rendering 

By setting one property you can render text using the GDI+ text API - with GDI+ text 

rendering text looks similar to text in Microsoft Office 2007 and matches the default 

text layout in XPS. 

 Embed True Type Fonts 

Embed fonts to guarantee text is rendered correctly on any system - even if the fonts 

used are not installed on the system used to preview or print the document. 

 Dictionary Support 

Store resources (such as images used throughout the document) in the document 

dictionary to save space and time. 

Print Preview Features 

The Reports for WinForms visual previewing controls' features include the following: 

 Full-Featured Preview Controls 

Integrated C1PrintPreviewControl and C1PrintPreviewDialog controls provide a 

ready-to-use full-featured UI with thumbnail and outline views, text search, and 

predefined toolbars right out of the box. 

 Preview Reports 

Easily integrate Reports with Reports for WinForms to add previewing, formatting, 

printing and exporting functionality to your reports. Just set the Document property on 

the C1PrintPreviewControl or C1PreviewPane to your reporting control and you are 

finished. 

 Preview SSRS Reports 

A new component called the C1SsrsDocumentSource allows you to preview SSRS 

reports in the C1PrintPreviewControl. 

 PrintDocument Compatibility 

In addition to the Reporting controls, Reports supports the standard .NET 

PrintDocument component, and can even export to a number of external formats 

(such as PDF). So you can easily upgrade your applications with minimal effort. 

 Thumbnail Views 

Reports includes built-in thumbnail views of all pages within any rendered document. 

The thumbnail view allows quick navigation to any page. Thumbnails are generated on 

the fly as pages are created so you instantly get thumbnails even if all pages have not 

finished rendering. Use the separate C1PreviewThumbnailView control and attach it 

to a C1PreviewPane, or just use the all-inclusive C1PrintPreviewControl to display 

automatic thumbnail views. 

 Interactive Document Reflow 

End-users can interactively change the document (for example change page margins or 

orientation) at run time and the document will automatically reflow to accommodate 

the changes. 

 Text Search 

Perform text searching at run-time without any additional coding. The 

C1PrintPreviewControl includes a built-in text search panel. Search results include 

page numbers and link to found locations. 
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 Several Built-in Toolbar Sets 

Choose from several preset toolbar image collections, or choose your own. The 

C1PrintPreviewControl includes themes to match Adobe, XP, Classic Windows, and 

the Mac operating system. 

 Zooming Tools 

Reports supports many different zooming options that you would find in Microsoft 

Word. Predefined views include: actual size, page width, text width and whole page. You 

can also use percentages to define a specific zoom value. The C1PrintPreviewControl 

also has a zoom-in and zoom-out tool which allows the user to specify where on the 

page to zoom in or out. 

 C1PrintDocument Feature Support 

All preview controls fully support the C1PrintDocument component's features such as 

hyperlinks and outlines. 

 Code-free Development 

Reports includes extensive design-time support, including ComponentOne 

SmartDesignertechnology with floating toolbars, allowing you to easily customize your 

preview window without writing code. 

 Flexible Modular Design 

Use the separate, specialized controls (preview pane, thumbnail and outline views, text 

search panel) to customize your document view. Combine Reports controls with other 

Studio for WinForms controls such as Ribbon for WinForms to create a custom 

preview window that fits any UI. 

 Localization 

Create localized versions of all end-user visible strings for different cultures at design 

time and switch between languages at run time. 

     

C1ReportDesigner Features 

The C1ReportDesigner application's features include the following: 

 Easily Accessible 

While the C1ReportDesigner is a stand-alone application, you can easily launch and 

navigate to it from within Visual Studio. Just select Edit Report on the C1Report 

component's smart tag and it will open up the C1ReportDesigner application. 

 Create New Reports 

Use the C1Report Wizard to quickly and easily create a new report. To create a report, 

simply:  

1. Select the data source for the new report 

2. Select the fields you want to include in the report 

3. Set the layout, style and title for the new report 

 Import Existing Reports 

The ability to take your existing reports and turn them into Reports is one of the most 

powerful features of the C1ReportDesigner. Import your existing report definitions 

from Microsoft Access files (.mdb and .adp) or Crystal Reports (.rpt). 

 Design and Modify Reports 

The Access-style WYSIWYG design surface makes designing reports easy and intuitive. 

Drag and drop report fields from the toolbar onto the report's design surface. Banded 

regions mark each area of the report such as header, body and footer. Set all field 

related properties directly in the application itself. You can even write custom VBScript 

code from the Properties window. 
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 Export Reports 

Directly export a report to any of the supported file formats: HTML, PDF, RTF, XLS, XLSX, 

TIF, TXT or ZIP. 

 Save and Distribute Report Definitions 

Once you have created or imported a report you can save it out to an XML-based 

report definition file. Package the definition files with the C1Report component in your 

published applications to distribute the reports to your end-users. To distribute or 

customize the C1ReportDesigner application itself, you must use the Reports for .NET 

Designer Edition. 

C1ReportsScheduler Features 

The C1ReportsScheduler application's features include the following: 

 Generate and Export Reports 

The C1ReportsScheduler is a stand-alone scheduling application that is included with 

Reports for WinForms. It is designed to generate and export Reports in the 

background on set schedules. 

 Run in Background or Control Schedules 

The C1ReportsScheduler application consists of two interacting parts: a front-end and a 

Windows service. The Windows service runs in the background, executing specified 

tasks according to their schedules. The front-end can be used to view or edit the task 

list, start or stop schedules, and control the service. While the front-end is used to 

install and setup the service, it is not needed for the service to run. 

 Export to Various Formats 

Reports can be exported to many formats including: PDF, Rich Text, Open XML Word, 

Excel, HTML, Metafile, images and more. 

 Schedule Reporting Output in 4 Easy Steps 

To schedule reporting, you would simply need to complete the following:  

1. Select any number of C1Report definition files (.xml) from your machine. 

2. Choose any number of actions such as export or print for each report in the 

Task Actions pane. 

3. Set a one-time or recurring schedule for each report. 

4. Press Start to initiate the background service. Your reports will be generated in 

the specified outputs at the scheduled times. 

 Full Source Included 

You can ship the pre-built application and service to your end-users "as-is," or modify 

the UI and functionality to fit your needs. We provide complete source code for the 

C1ReportsScheduler as a sample. 

 C1ReportsScheduler Windows Service 

The C1ReportsScheduler Windows service is provided so reports can be generated at 

any scheduled time because the front-end application will not always be running. The 

service can be easily installed and uninstalled on your machine through the front-end 

application. When the C1ReportsScheduler is run for the first time, a dialog pops up 

asking whether you would like to install the service. The service does not need to be 

installed if the front-end application is to remain running. 

C1MultiDocument Features 

The C1MultiDocument component's features include the following: 
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 Handle Large Documents 

C1MultiDocument can handle large documents that would be otherwise impossible to 

create/export/print due to memory limitations. 

 Combine Multiple Documents 

Use of compression and temporary disk storage allows C1MultiDocument to combine 

several C1PrintDocument objects into a large multi-document that would cause an out 

of memory condition if all pages belonged to a single C1PrintDocument. 

C1RdlReport Features 

The C1RdlReport component's features include the following: 

 Exposes Full RDL Object Model 

The C1RdlReport component exposes the full RDL object model following the latest 

RDL 2008 specification. This allows you to modify existing reports or even create new 

RDL reports completely in code. This is not possible through Microsoft Reporting 

Services alone. 

 Generate RDL Reports from any Data Source 

You are not constrained to using SQL Server data as your data source. C1RdlReport 

can generate RDL reports using any data source, such as an Access database. 

 No External Dependencies 

C1RdlReport provides a self-contained RDL reporting solution without external 

dependencies such as the need for a Microsoft Reporting Services server. 

 Seamless Integration with C1Reports 

C1RdlReport provides seamless integration with the entire Reports suite. Use 

C1RdlReport with C1PrintPreviewControl to provide previewing, formatting, printing 

and exporting functionality for your reports. 

 Support for RDL Objects and Properties 

C1RdlReport supports most of the common Microsoft reporting features such as 

subreports, parameters, hyperlinks, charts, shapes, images, text boxes and more. 

C1RdlReport Features 

The C1ReportDesigner control's features include the following: 

 Closely Integrate the Designer Into Your Application 

Writing your own customized report designer allows you to integrate the designer 

tightly into your application, rather than running a separate application. You can 

customize the data sources available to the end-user, or the types of fields that can be 

added to the report. For example, you may want to use custom data source objects 

defined by your application. 

 Supply Custom Stock Report Definitions to End-users 

With your own customized report designer you can provide a menu of stock report 

definitions that make sense in the scope of your application. It allows end-users to 

customize some aspects of each stock report, similar to the printing options in 

Microsoft Outlook. 

 Royalty-free Run-time Distribution 

Developers can now enjoy royalty-free run-time distribution of the C1ReportDesigner 

application for flexible application deployment to an unlimited number of clients. 

Developers can easily create, customize, and deploy powerful and integrated reporting 

http://msdn.microsoft.com/en-us/library/dd297486(SQL.100).aspx
C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner.html
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solutions including end-user report designers, and distribute them without royalty-fee 

restrictions. 

 Full Source Code for the C1ReportDesigner Application 

The designer edition ships with full source code for the C1ReportDesigner application 

included in Reports for .WinForms Designer Edition. Full source code allows 

developers to customize the designer application or even integrate it within their own 

applications. 

 Easy-to-use C1ReportDesigner Component 

The C1ReportDesigner component displays reports in design mode, and allows users 

to drag, copy, and resize report fields and sections. The component also provides an 

unlimited undo/redo stack and a selection mechanism designed for use with the 

PropertyGrid control that ships with Microsoft Visual Studio. 

Reports for WinForms Components 

and Controls 
Please note that though the functionality is similar to the old version of the product, the object 

model of both the C1PrintDocument component and the print preview control have been 

significantly changed, so the new components are not binary- or code-compatible with the old 

components. 

Reports for WinForms consists of the following assemblies: 

C1.C1Report.2.dll 

C1.C1Report.2.dll provides the C1PrintDocument and C1Report components and other public 

classes providing non-Windows Forms specific services, such as export and more. Components 

in this assembly include: 

 C1Report 

The C1Report component generates data-based banded reports. Render reports 

directly to a printer or preview control, or export to various portable formats (including 

XLS, PDF, HTML, text, and images). The component exposes a rich object model for 

creating, customizing, loading, and saving report definitions. 

 C1PrintDocument 

The C1PrintDocument component allows you to create complex documents that can be 

printed, previewed, persisted in a disc file, or exported to a number of external formats 

including PDF (Portable Document Format) and RTF (Rich Text File). 

 C1MultiDocument 

The C1MultiDocument component is designed to allow creating, persisting and 

exporting large documents that cannot be handled by a single C1PrintDocument object 

due to memory limitations. 

 C1RdlReport 

C1RdlReport allows you to generate RDL reports that can consume any data source 

(such as .mdb files) not only SQL server data as Microsoft Reporting Services. The 

C1RdlReport component supports RDL files based on the RDL 2008 specifications. 

C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
C1.C1Report.4~C1.C1Report.C1Report.html
C1.C1Report.4~C1.C1Report.C1Report.html
C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
C1.C1Report.4~C1.C1Preview.C1MultiDocument.html
C1.C1Report.4~C1.C1Rdl.Rdl2008.C1RdlReport.html
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This assembly does not reference other ComponentOne DLL files. Most of the classes in this 

assembly are in the C1.C1Preview, C1.C1Report, and C1.C1Rdl.Rdl2008 namespaces. 

C1.Win.C1Report.2.dll 

C1.Win.C1Report.2.dll provides Windows Forms controls that can work with C1PrintDocument 

and other types of documents, including: 

 C1PreviewPane 

The preview pane. This control shows the pages of the document being previewed, 

allows panning, zooming and other preview operations. In the forms designer, standard 

toolbars and status bar can be created on the current form via context menu items. 

 C1PrintPreviewControl 

The integrated print preview control. Contains the preview pane, toolbars with the 

standard preview related operations, navigation panel with thumbnails and outline 

pages, and the collapsible text search panel. 

 C1PrintPreviewDialog 

A dialog box form with the nested print preview control. 

 C1PreviewThumbnailView 

Panel that can be attached to a preview pane (via the PreviewPane property) to show 

the navigation page thumbnails. 

 C1PreviewOutlineView 

Panel that can be attached to a preview pane (via the PreviewPane property) to show 

the document outline. 

 C1PreviewTextSearchPanel 

Panel that can be attached to a preview pane (via the PreviewPane property) to perform 

text search in the document. 

This assembly references C1.C1PrintDocument. Most of the classes in this assembly are in the 

C1.Win.C1Preview namespace. 

Included Applications 

In addition to the reporting components and controls included, Reports for WinForms 

includes two stand-alone applications, C1ReportDesigner and C1ReportsScheduler: 

 C1ReportDesigner 

The C1ReportDesigner application is a tool used for creating and editing C1Report 

report definition files. The Designer allows you to create, edit, load, and save files (XML) 

that can be read by the C1Report component. 

 C1ReportsScheduler 

C1ReportsScheduler is a stand-alone application used to schedule report creation to 

run in the background. Using the C1ReportsScheduler application, you can choose 

what reports to export or print, formats to export the report to, and the schedule and 

frequency for creating reports. 

This product requires .NET version 2.0 or later. 

C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewPane.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewDialog.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewThumbnailView.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewOutlineView.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewTextSearchPanel.html
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Getting Started with Reports for 

WinForms 
The current release of Reports for WinForms includes a new component, 

C1.C1Report.C1Report. This component provides a complete compatible replacement for 

C1.Win.C1Report.C1Report found in previous releases. The only difference, from the user code 

point of view, is the namespace change (C1.C1Report instead of C1.Win.C1Report). The 

C1.C1Report namespace also provides all other familiar public C1Report classes such as Field, 

Section, and so on. Again, the only expected difference affecting the user is the namespace 

change. 

Internally, the new C1Report works differently from the old version. Whereas the old C1Report 

engine in the usual (preview/print) scenario generated metafile page images, the new C1Report 

builds a C1PrintDocument representing the report. That document is accessible via the new 

public read-only property on C1Report: C1PrintDocument C1Report.C1Document {get;}. 

The document can then be used in any of the usual ways; for example, it can be exported to 

one of the formats supported by C1PrintDocument. 

Export filters: 

Along with other public members exposed by the old version, the new C1Report provides the 

familiar WinForms C1Reports export filters, so the following code is still completely valid: 

report.Load(...); 

report.RenderToFile("MyReport.rtf",C1.C1Report.FileFormatEnum.RTF); 

It is important to note that the file produced by the code above (in our example, an RTF file) will 

differ from the file produced by exporting the C1PrintDocument exposed by the report: 

report.Load(...); 

report.C1Document.Export("MyReport.rtf"); 

Usually, the a RenderToFile would yield better results, unless the target format is a fixed layout 

format (such as PDF), in which case the results should be identical. 

Note also that the RenderToFile method does not support the new XPS format, the only way to 

generate an XPS file is to export the C1PrintDocument exposed by C1Report. 

See Also 

Generating Reports(C1Report vs. C1PrintDocument) 

Getting Started with Reporting 

Getting Started with Printing and Previewing 

C1.C1Report.4~C1.C1Report.Field.html
C1.C1Report.4~C1.C1Report.Section.html
C1.C1Report.4~C1.C1Report.C1Report~RenderToFile.html
generatingreportsc1r.html
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Getting Started with Reporting 
Getting Started with Reports for WinForms > Getting Started with Reporting 

In this section you will learn how to use the basic C1Report functionality to create simple 

reports. This section is not supposed to be a comprehensive tutorial on all features of C1Report, 

but rather provide a quick start and highlight some general approaches to using the 

component. 

See Also 

C1Report Quick Start 

C1Report Quick Start 
Getting Started with Reports for WinForms > Getting Started with Reporting > C1Report Quick Start 

Although you can use C1Report in many different scenarios, on the desktop and on the Web, 

the main sequence of steps is always the same: 

1. Create a report definition 

This can be done directly with the C1Report Designer or using the report designer in 

Microsoft Access and then importing it into the C1Report Designer. You can also do it 

using code, either using the object model to add groups and fields or by writing a 

custom XML file. 

2. Load the report into the C1Report component 

This can be done at design time, using the Load Report context menu, or 

programmatically using the C1Report.Load method. If you load the report at design 

time, it will be persisted (saved) with the control and you won't need to distribute the 

report definition file. 

Render the report (desktop applications) 

3. If you are writing a desktop application, you can render the report into a 

C1PrintPreview control (or a Microsoft PrintPreview control) using the 

C1Report.Document property. The preview control will display the report on the 

screen, and users will be able to preview it with full zooming, panning, and so on. 

4. Render the report (Web applications) 

If you are writing a Web application, you can render reports into HTML or PDF files 

using the RenderToFile method, and your users will be able to view them using any 

browser. 

The following steps will show you how to create a report definition, load the report into the 

C1Report component, and render the report. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~RenderToFile.html
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See Also 

Step 1 of 4: Creating a Report Definition 

Step 2 of 4: Modifying the Report 

Step 3 of 4: Loading the Report in the C1Report Component 

Step 4 of 4: Rendering the Report 

Step 1 of 4: Creating a Report Definition 
Getting Started with Reports for WinForms > Getting Started with Reporting > C1Report Quick Start > 

Step 1 of 4: Creating a Report Definition 

Show All  

Hide All  

The following topic shows how you can create a report definition using the C1ReportDesigner 

and Using code. Note that creating a report definition is not the same as rendering a report. To 

render a report, you can simply load an existing definition and call the C1Report.Render 

method. The easiest way to create a report definition is to use the C1ReportDesigner, which is 

a stand-alone application similar to the report designer in Microsoft Access. 

Creating a Report Definition Using the C1ReportDesigner: 

The C1Report Wizard walks you through the steps of creating a new report from start to finish. 

To begin, complete the following steps: 

1. To begin, create a .NET project and add the C1Report component to your Toolbox. 

2. From the Toolbox, double-click the C1Report icon to add the component to your 

project. Note that the component will appear below the form in the Component Tray. 

3. Click the C1Report component's smart tag and select Edit Report from its Tasks 

menu. 

The C1ReportDesigner opens and the C1Report Wizard is ready to guide you 

through five easy steps. 

From the C1Report Wizard, complete the five following steps to create your report: 

1. Select the data source for the new report. 

Use this page to select the DataSource.ConnectionString and 

DataSource.RecordSource that will be used to retrieve the data for the report. 

You can specify the DataSource.ConnectionString in three ways: 

o Type the string directly into the editor. 

o Use the drop-down list to select a recently used connection string (the 

Designer keeps a record of the last eight connection strings). 

o Click the ellipsis button (...) to bring up the standard connection string builder. 
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You can specify the DataSource.RecordSource string in two ways: 

o Click the Table option and select a table from the list. 

o Click the SQL option and type (or paste) an SQL statement into the editor. 

Complete Step 1: 

Complete the following steps: 

6. Click the ellipsis button to bring up the standard connection string builder. 

7. Select the Provider tab and select a data provider from the list. For this 

example, select Microsoft Jet 4.0 OLE DB Provider. 

8. Click the Next button or select the Connection tab. Now you must choose a 

data source. 

9. To select a database, click the ellipsis button. The Select Access Database 

dialog box appears. For this example, select the C1NWind.mdb located in the 

Common folder in the ComponentOne Samples directory (by default installed 

in the Documents or My Documents folder). Note that this directory reflects 

the default installation path and its path may be different if you made changes 

to the installation path. 

10. Click Open. You can test the connection and click OK. 

11. Click OK to close the Select Access Database dialog box. 

12. Once you have selected your data source, you can select a table, view, or stored 

procedure to provide the actual data. You can specify the 

DataSource.RecordSource string in two ways:  

 Click the Table option and select the Products table from the list. 

 Click the SQL option and type (or paste) an SQL statement into the 

editor.  

For example: 

select * from products  
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13. Click Next. The wizard will walk you through the remaining steps. 

 Select the fields you want to include in the report. 

This page contains a list of the fields available from the recordset you selected in Step 

1, and two lists that define the group and detail fields for the report. Group fields define 

how the data will be sorted and summarized, and detail fields define what information 

you want to appear in the report. 

You can move fields from one list to another by dragging them with your mouse 

pointer. Drag fields into the Detail list to include them in the report, or drag within the 

list to change their order. Drag fields back into the Available list to remove them from 

the report. 

Complete Step 2: 

Complete the following steps: 

0. With your mouse pointer, select the CategoryID field and drag it into the Groups list. 
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1. Press the >> button to move the remaining fields into the Detail list. 

 
2. Click Next. The wizard will walk you through the remaining steps. 

 Select the layout for the new report. 

This page offers you several options to define how the data will be organized on the 

page. When you select a layout, a thumbnail preview appears on the left to give you an 

idea of what the layout will look like on the page. There are two groups of layouts, one 

for reports that have no groups and one for reports with groups. Select the layout that 

best approximates what you want the final report to look like. 

This page also allows you to select the page orientation and whether fields should be 

adjusted to fit the page width. 

The Labels layout option is used to print Avery-style labels. If you select this option, 

you will see a page that prompts you for the type of label you want to print. 

Complete Step 3: 

Complete the following steps: 
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0. Keep the Outline layout. 

 
1. Click Next. The wizard will walk you through the remaining steps. 

 Select the style for the new report. 

This page allows you to select the fonts and colors that will be used in the new report. 

Like the previous page, it shows a preview to give you an idea of what each style looks 

like. Select the one that you like best (and remember, you can refine it and adjust the 

details later). 

Complete Step 4: 

0. Select the Verdana style. 
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1. Click Next. The wizard will walk you through the remaining steps. 

 Select a title for the new report. 

This last page allows you to select a title for the new report and to decide whether you 

would like to preview the new report right away or whether you would like to go into 

edit mode and start improving the design before previewing it. 

Complete Step 5: 

0. Enter a title for the new report, Products Report, for example.  
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1. Choose to Preview the report and click Finish. 

You will immediately see the report in the preview pane of the Designer. 

You will notice that the report will require some adjustments. In the next step, you will learn 

how to modify the report. 

Creating a Report Definition Using Code: 

The following steps show how you can create a report definition using the C1ReportDesigner 

application or using code. You can even write your own report designer or ad-hoc report 

generator. 

The following example uses code to create a simple tabular report definition based on the 

NorthWind database. The code is commented and illustrates the most important elements of 

the C1Report object model. Complete the following steps: 

1. First, add a button control, C1Report component, and C1PrintPreview control to your 

form. Set the following properties:  

Button.Name = btnEmployees 

C1Report.Name = c1r 

C1PrintPreview.Name = ppv 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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2. Initialize the control, named c1r, using the Clear method to clear its contents and set 

the control font (this is the font that will be assigned to new fields):  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub RenderEmployees()     

With c1r     

  ' clear any existing fields     

  .Clear()     

  ' set default font for all controls     

  .Font.Name = "Tahoma"     

  .Font.Size = 8     

End With 

To write code in C# 

C# Copy Code  

 

private void RenderEmployees()     

{     

  // clear any existing fields     

  c1r.Clear();     

  // set default font for all controls     

  c1r.Font.Name = "Tahoma";     

  c1r.Font.Size = 8;     

} 

3. Next, set up the DataSource object to retrieve the data that you want from the 

NorthWind database. This is done using the ConnectionString and RecordSource 

properties (similar to the Microsoft ADO DataControl): 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' initialize DataSource     

With c1r.DataSource     

  .ConnectionString = "Provider=Microsoft.Jet.OLEDB.4.0;" & _     

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Clear.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.DataSource.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.DataSource~ConnectionString.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.DataSource~RecordSource.html
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                      "Data Source=C:\...\ComponentOne 

Samples\Common\C1NWind.mdb;" & _     

                      "Persist Security Info=False"     

  .RecordSource = "Employees"     

End With 

To write code in C# 

C# Copy Code  

 

// initialize DataSource     

DataSource ds = c1r.DataSource;     

ds.ConnectionString = @"Provider=Microsoft.Jet.OLEDB.4.0;Data 

Source=C:\...\ComponentOne Samples\Common\C1NWind.mdb;";     

ds.RecordSource = "Employees"; 

4. Next, initialize the Layout object that defines how the report will be laid out on the 

page. In this case, render the report in Portrait mode and set its Width to 6.5 inches (8.5 

page width minus one inch for margins on either side): 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' initialize Layout     

With c1r.Layout    

  .Orientation = OrientationEnum.Portrait     

  .Width = 6.5 * 1440 ' 8.5 - margins, in twips     

End With 

To write code in C# 

C# Copy Code  

 

// initialize Layout     

Layout l = c1r.Layout;     

l.Orientation = OrientationEnum.Portrait;    

l.Width = 6.5 * 1440; // 8.5 - margins, in twips 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~Width.html
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5. Now comes the interesting part. Every report has five basic sections: Detail, Report 

Header, Report Footer, Page Header, and Page Footer. Use the following code to set up 

the report header by setting a couple of properties and adding a title field to it: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' variable used to create and format report fields     

Dim f As Field 

 

' create a report header     

 With c1r.Sections(SectionTypeEnum.Header)     

  .Height = 1440     

  .Visible = True     

  .BackColor = Color.FromArgb(200, 200, 200)     

  f = .Fields.Add("FldTitle", "Employees Report", 0, 0, 8000, 1440)     

  f.Font.Size = 24     

  f.Font.Bold = True     

  f.ForeColor = Color.FromArgb(0, 0, 100)     

End With 

To write code in C# 

C# Copy Code  

 

// variable used to create and format report fields     

 Field f;    

   

// create a report header     

Section s = c1r.Sections[SectionTypeEnum.Header];     

  s.Height = 1440;     

  s.Visible = true;     

  s.BackColor = Color.FromArgb(200, 200, 200);     

  f = s.Fields.Add("FldTitle", "Employees Report", 0, 0, 8000, 1440);     

  f.Font.Size = 24;     

  f.Font.Bold = true;     

  f.ForeColor = Color.FromArgb(0, 0, 100); 

The section object has a Fields collection. The collection's Add method creates a new 

field and assigns it to the Section. The parameters specify the new field's Name, Text, 

Left, Top, Width, and Height properties. By default, the field has the same font as the 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~Fields.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.FieldCollection~Add.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Name.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Text.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Left.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Top.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Width.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Height.html
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control. Since this is a title, it makes sense to change the font and make it larger. Note 

that the field should be tall enough to accommodate the font size, or nothing will 

appear in it. 

6. Next, set up the Page Footer Section. This section is more interesting because it 

contains calculated fields. Calculated fields contain VBScript expressions in their Text 

property, which are evaluated when the report is rendered. To make a field calculated, 

set its Calculated property to True. To create a page footer, add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' create a page footer     

With c1r.Sections(SectionTypeEnum.PageFooter)     

  .Height = 500     

  .Visible = True     

  f = .Fields.Add("FldFtrLeft", """Employees: Printed on "" & Now",_     

                  0, 0, 4000, 300)     

  f.Calculated = True     

  f = .Fields.Add("FldFtrRight", """Page "" & Page & "" of "" & Pages",_     

                  4000, 0, 4000, 300)     

  f.Calculated = True     

  f.Align = FieldAlignEnum.RightTop     

  f.Width = c1r.Layout.Width - f.Left     

  f = .Fields.Add("FldLine", "", 0, 0, c1r.Layout.Width, 20)     

  f.LineSlant = LineSlantEnum.NoSlant     

  f.BorderStyle = BorderStyleEnum.Solid     

  f.BorderColor = Color.FromArgb(0, 0, 100)     

End With 

To write code in C# 

C# Copy Code  

 

// create a page footer     

s = c1r.Sections[SectionTypeEnum.PageFooter];     

  s.Height = 500;     

  s.Visible = true;    

  f = s.Fields.Add("FldFtrLeft", @"""Employees: Printed on "" & Now",_     

                  0, 0, 4000, 300);     

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Calculated.html
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  f.Calculated = true;     

  f = .Fields.Add("FldFtrRight", @"""Page "" + Page + "" of "" & Pages",_     

                  4000, 0, 4000, 300);     

  f.Calculated = true;     

  f.Align = FieldAlignEnum.RightTop;     

  f.Width = c1r.Layout.Width - f.Left;     

  f = s.Fields.Add("FldLine", "", 0, 0, c1r.Layout.Width, 20);     

  f.LineSlant = LineSlantEnum.NoSlant;     

  f.BorderStyle = BorderStyleEnum.Solid;     

  f.BorderColor = Color.FromArgb(0, 0, 100); 

The Page Footer section uses expressions with variables that are not intrinsic to 

VBScript, but are defined by C1Report. Page and Pages are variables that contain the 

current page number and the total page count. The section also uses a field configured 

to look like a line. This is done using the BorderStyle and LineSlant properties. 

7. Next, set up the Page Header Section. This section gets rendered at the top of every 

page and will display the field labels. Using a Page Header section to display field labels 

is a common technique in tabular reports. The code is simple, but looks a bit messy 

because of all the field measurements. In a real application, these values would not be 

hard-wired into the program. To create a page header with field labels, add the 

following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' create a page header with field labels     

With c1r.Sections(SectionTypeEnum.PageHeader)     

  .Height = 500     

  .Visible = True     

  c1r.Font.Bold = True     

  f = .Fields.Add("LblID", "ID", 0, 50, 400, 300)     

  f.Align = FieldAlignEnum.RightTop     

  f = .Fields.Add("LblFirstName", "First", 500, 50, 900, 300)     

  f = .Fields.Add("LblLastName", "Last", 1500, 50, 900, 300)     

  f = .Fields.Add("LblTitle", "Title", 2500, 50, 2400, 300)     

  f = .Fields.Add("LblTitle", "Notes", 5000, 50, 8000, 300)     

  c1r.Font.Bold = False     

  f = .Fields.Add("FldLine", "", 0, 400, c1r.Layout.Width, 20)     

  f.LineSlant = LineSlantEnum.NoSlant     

  f.LineWidth = 50 

 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~BorderStyle.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~LineSlant.html
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  f.BorderColor = Color.FromArgb(100, 100, 100)     

End With 

To write code in C# 

C# Copy Code  

 

// create a page header with field labels   v  

s = c1r.Sections[SectionTypeEnum.PageHeader];     

  s.Height = 500;     

  s.Visible = true;     

  c1r.Font.Bold = true;     

  f = s.Fields.Add("LblID", "ID", 0, 50, 400, 300);     

  f.Align = FieldAlignEnum.RightTop;     

  f = s.Fields.Add("LblFirstName", "First", 500, 50, 900, 300);     

  f = s.Fields.Add("LblLastName", "Last", 1500, 50, 900, 300);     

  f = s.Fields.Add("LblTitle", "Title", 2500, 50, 2400, 300);     

  f = s.Fields.Add("LblTitle", "Notes", 5000, 50, 8000, 300);     

  c1r.Font.Bold = false;     

  f = s.Fields.Add("FldLine", "", 0, 400, c1r.Layout.Width, 20);     

  f.LineSlant = LineSlantEnum.NoSlant;     

  f.LineWidth = 50;     

  f.BorderColor = Color.FromArgb(100, 100, 100); 

This code illustrates a powerful technique for handling fonts. Since every field inherits 

the control font when it is created, set the control's Font. Bold property to True before 

creating the fields, and set it back to False afterwards. As a result, all controls in the 

Page Header section have a bold font. 

8. To finalize the report, add the Detail Section. This is the section that shows the actual 

data. It has one calculated field below each label in the Page Header Section. To create 

the Detail section, add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' create the Detail section     

With c1r.Sections(SectionTypeEnum.Detail)     

  .Height = 330     

  .Visible = True     

  f = .Fields.Add("FldID", "EmployeeID", 0, 0, 400, 300)     

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Font.html
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  f.Calculated = True     

  f = .Fields.Add("FldFirstName", "FirstName", 500, 0, 900, 300)     

  f.Calculated = True     

  f = .Fields.Add("FldLastName", "LastName", 1500, 0, 900, 300)     

  f.Calculated = True     

  f = .Fields.Add("FldTitle", "Title", 2500, 0, 2400, 300)     

  f.Calculated = True     

  f = .Fields.Add("FldNotes", "Notes", 5000, 0, 8000, 300)     

  f.Width = c1r.Layout.Width - f.Left     

  f.Calculated = True    

  f.CanGrow = True     

  f.Font.Size = 6     

  f.Align = FieldAlignEnum.JustTop     

  f = .Fields.Add("FldLine", "", 0, 310, c1r.Layout.Width, 20)     

  f.LineSlant = LineSlantEnum.NoSlant    

  f.BorderStyle = BorderStyleEnum.Solid     

  f.BorderColor = Color.FromArgb(100, 100, 100)     

End With 

To write code in C# 

C# Copy Code  

 

// create the Detail section     

s = c1r.Sections[SectionTypeEnum.Detail];     

  s.Height = 330;     

  s.Visible = true;     

  f = s.Fields.Add("FldID", "EmployeeID", 0, 0, 400, 300);     

  f.Calculated = true;     

  f = s.Fields.Add("FldFirstName", "FirstName", 500, 0, 900, 300);     

  f.Calculated = true;     

  f = s.Fields.Add("FldLastName", "LastName", 1500, 0, 900, 300);     

  f.Calculated = true;     

  f = s.Fields.Add("FldTitle", "Title", 2500, 0, 2400, 300);     

  f.Calculated = true;     

  f = s.Fields.Add("FldNotes", "Notes", 5000, 0, 8000, 300);     

  f.Width = c1r.Layout.Width - f.Left;     

  f.Calculated = true;     

  f.CanGrow = true;     

  f.Font.Size = 6;     

  f.Align = FieldAlignEnum.JustTop;     



 

 44 

  f = s.Fields.Add("FldLine", "", 0, 310, c1r.Layout.Width, 20);     

  f.LineSlant = LineSlantEnum.NoSlant;    

  f.BorderStyle = BorderStyleEnum.Solid;     

  f.BorderColor = Color.FromArgb(100, 100, 100); 

Note that all fields are calculated, and their Text property corresponds to the names of 

fields in the source recordsetsource. Setting the Calculated property to True ensures 

that the Text property is interpreted as a database field name, as opposed to being 

rendered literally. It is important to adopt a naming convention for report fields that 

makes them unique, different from recordset field names. If you had two fields named 

"LastName", an expression such as "Left(LastName,1)" would be ambiguous. This 

example has adopted the convention of beginning all report field names with "Fld". 

Note also that the "FldNotes" field has its CanGrow property set to True, and a smaller 

font than the others. This was done to make sure that the "Notes" field in the database, 

which contains a lot of text, will appear in the report. Rather than make the field very 

tall and waste space, setting the CanGrow property to True tells the control to expand 

the field as needed to fit its contents; it also sets the containing section's CanGrow 

property to True, so the field doesn't spill off the Section. 

9. The report definition is done. To render the report into the C1PrintPreview control, 

double-click the Employees button to add an event handler for the 

btnEmployees_Click event. The Code Editor will open with the insertion point placed 

within the event handler. Enter the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

RenderEmployees()     

' render the report into the C1PrintPreview control     

ppv.Document = c1r.Document 

To write code in C# 

C# Copy Code  

 

RenderEmployees();     

// render the report into the C1PrintPreview control     

ppv.Document = c1r.Document; 

Here's what the basic report looks like: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~CanGrow.html
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Step 2 of 4: Modifying the Report 
Getting Started with Reports for WinForms > Getting Started with Reporting > C1Report Quick Start > 

Step 2 of 4: Modifying the Report 

With the Designer in preview mode you cannot make any adjustments to the report. 

1. Click the Design button to switch to Design mode and begin making modifications. 

2. After selecting the Design button, the right pane of the main window switches from 

Preview mode to Design mode, and it shows the controls and fields that make up the 

report. 

Modify the Report: 

For this example, we will resize the Group Header section and fields as well as format a field 

value. To do this, complete the following steps: 
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1. To resize the Group Header section, select its border and with your mouse pointer drag 

to the position where you want it. 

 
2. With your mouse pointer, drag field corners to resize fields. 

 

 

Tip: If text is not fitting in the field, set the Appearance.WordWrap property for the field to 

True in the Properties window. 

3. In the Detail section under the Unit Price column, select the UnitPriceCtl field. 
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4. In the Properties window, set the Appearance.Format property for the field to 

Currency. 

 
5. Click the Preview button to switch to Preview mode and see your modifications. 

6. Click Design button to switch from Preview mode to Design mode. 

7. Click the File menu and select Save As from the menu that appears. 

    

8. In the Save Report Definition File dialog box, enter ProductsReport.xml in the File 

name box. Save the file to a location that you will remember for later use. 

9. Close the Designer and return to your Visual Studio project. 
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You have successfully created a report definition file; in the next step you will load the report in 

the C1Report component. 

Step 3 of 4: Loading the Report in the C1Report 

Component 
Getting Started with Reports for WinForms > Getting Started with Reporting > C1Report Quick Start > 

Step 3 of 4: Loading the Report in the C1Report Component 

To load a report definition from a file at design time, complete one of the following tasks: 

 Right-click the C1Report component and select the Load Report menu option.  

OR 

 Click the smart tag ( ) above the C1Report component and select Load Report from 

the C1Report Tasks menu. 

Using the Select a report dialog box to select the report you want, complete the following 

tasks: 

1. Click the ellipsis button. The Open dialog box appears. 

2. Browse to the location that you just saved your ProductsReport.xml file, select it, and 

click Open. 

3. The available report definitions are listed in the Report drop-down box. Select the 

Products Report definition to load. 

4. Click Load and OK to close the dialog box. 

 

In the next step you will render the report into a preview control. 

Step 4 of 4: Rendering the Report 
Getting Started with Reports for WinForms > Getting Started with Reporting > C1Report Quick Start > 
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Step 4 of 4: Rendering the Report 

Show All  

Hide All  

Once the report definition has been created, a data source defined, and loaded into the 

C1Report component, you can render the report to the printer, into preview controls, or to 

report files. 

To preview the report, use the use the C1Report.Document property. Assign it to the 

Document property in the C1PrintPreviewControl or to the .NET PrintPreview or 

PrintPreviewDialog controls and the preview controls will display the report and allow the user 

to browse, zoom, or print it. 

 

Note: C1Report works with the .NET preview components, but it is optimized to work with 

the included Reports for WinForms preview controls. When used with the included 

controls, you can see each report page as it is generated. With the standard controls, you 

have to wait until the entire report is ready before the first page is displayed. 

To complete this step:  

1. From the Toolbox, double-click the C1PrintPreviewControl icon to add the 

component to your project. 

2. From the Properties window, set the C1PrintPreviewControl.Dock property to Fill. 

3. Select the Windows Form with your mouse and drag to resize it. For this example, we 

resized the Form to 600x500 so it better reveals the preview panel. 

4. Double-click the form and enter the following code in the Form_Load event handler:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

' load report definition 

C1Report1.Load("C:\ProductsReport.xml", "Products Report") 

' preview the document 

C1PrintPreviewControl1.Document = C1Report1.Document 

To write code in C# 

C# Copy Code  

 

// load report definition 

c1Report1.Load(@"C:\ProductsReport.xml", "Products Report"); 
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// preview the document 

c1PrintPreviewControl1.Document = c1Report1.Document; 

You will need to change the directory above to the location the ProductsReport.xml 

file is saved. 

Note that the C1Report.Load(String, String) method has the following parameters: 

o fileName: Full name of the XML report definition file. 

o reportName: Name of the report to retrieve from the file (case-insensitive). 

5. Click the Start Debugging button to run the application. The report renders in the 

preview control: 

 

Congratulations! You just created a simple report definition, modified the report, loaded into 

the C1Report component, and rendered the report into a preview control. Read the following 

section to learn how you can further customize your report definition using VBScript 

expressions. 
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Getting Started with Printing and 

Previewing 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing 

In this section you will learn how to use the basic C1PrintDocument functionality to create 

simple documents. This section is not supposed to be a comprehensive tutorial on all features 

of C1PrintDocument, but rather provide a quick start and highlight some general approaches to 

using the component. 

See Also 

C1PrintDocument Quick Start 

Creating Tables 

Adding Text 

Creating Page Headers in C1PrintDocument 

Drawing a Horizontal Line 

Creating Page Footers 

C1PrintDocument Quick Start 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > 

C1PrintDocument Quick Start 

In this quick start guide we'll follow tradition by creating a simple "Hello World!" document. In 

the following steps, you'll add Reports for WinForms printing and previewing controls to a 

project, set up the preview, and explore some of the run-time interactions available in Reports 

for WinForms' previewing controls. 

See Also 

Step 1 of 4: Adding Previewing Controls to the Form 

Step 2 of 4: Setting Up the Form and Controls 

Step 3 of 4: Adding Code to the Project 

Step 4 of 4: Running the Program 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/drawingahorizontalli.html
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Step 1 of 4: Adding Previewing Controls to the 

Form 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > 

C1PrintDocument Quick Start > Step 1 of 4: Adding Previewing Controls to the Form 

In this step you'll add Reports for WinForms controls to the form and set the form up to 

create a simple "Hello World!" document preview. The simplest possible document is one that 

prints the sentence "Hello, World!". Complete the following steps to set up the form to create 

such a document: 

 

Note: The sample code fragments in this topic assume that the "using C1.C1Preview;" 

directive (in C# syntax; or an equivalent for other languages) has been inserted into the file, 

so that instead of fully qualified type names (such as C1.C1Preview.RenderText) we can use 

just the class name part (RenderText). 

1. Create a new .NET Windows application, and name it HelloWorld. 

2. Navigate to the Toolbox and double-click C1PrintPreviewControl to add it to your 

form.  

A print preview control called C1PrintPreviewControl1and showing a sample 

document will appear on your form. 

The C1PrintPreviewControl control is a composite control containing a preview pane, 

navigation and text search panels, and toolbars with predefined buttons. 

In addition, two additional entries will appear in the References part of your project: 

C1.C1Report.2 and C1.Win.C1Report.2. 

3. In the Toolbox, double-click the C1PrintDocument icon to add the control to your 

project. The new component will be named C1PrintDocument1, by default, and will 

appear in the component tray below the form. 

You've created a project and added Reports for WinForms previewing components to your 

project and completed step 1 of the quick start guide. In the next step you'll set up the form 

and controls. 

Step 2 of 4: Setting Up the Form and Controls 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > 

C1PrintDocument Quick Start > Step 2 of 4: Setting Up the Form and Controls 

Now that you've added the Reports for WinForms controls to the form, you'll set up the form 

and the controls. Complete the following steps: 

1. Right-click Form1 to select it and select Properties; in the Properties window set the 

Size.Width property to 600 pixels and the Size.Height property to 400 pixels to 
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accommodate the size of the C1PrintDocument. 

 
2. Click C1PrintPreviewControl1's smart tag to open the C1PrintPreviewControl Tasks 

menu and select Dock in parent container. 

 
The form designer should now look similar to the following: 

 
3. Click C1PrintPreviewControl1 to select it and in the Properties window set its 

Document property to the newly added C1PrintDocument1 (which appears in the 

Document property drop-down list). 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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The selected document, here C1PrintDocument1, will show in the preview window at 

run time. 

You've set up the forms and controls and completed step 2 of the printing and previewing 

quick start guide. In the next step you'll add code to the project. 

Step 3 of 4: Adding Code to the Project 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > 

C1PrintDocument Quick Start > Step 3 of 4: Adding Code to the Project 

Show All  

Hide All  

Now that you've added the Reports for WinForms controls to the form and customized the 

form and controls, there's only one last step left before running the project. In this step you'll 

add code to the project to set the text that appears in the project. 

1. Double-click the form's title bar to switch to code view and create a handler for the 

Form_Load event. 

2. Add the following code to the Form_Load event to add text to the preview document:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.Body.Children.Add(New C1.C1Preview.RenderText("Hello, 

World!")) 

To write code in C# 

C# Copy Code  
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this.c1PrintDocument1.Body.Children.Add(new RenderText("Hello, World!")); 

3. Add the following code to the Form_Load event to generate the document:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.Generate() 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.Generate(); 

You've added code to the project and completed step 3 of the printing and previewing quick 

start guide. In the last step you'll run the program. 

Step 4 of 4: Running the Program 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > 

C1PrintDocument Quick Start > Step 4 of 4: Running the Program 

You've set up the form and the Reports for WinForms components, set the properties for the 

components, and added code to the project. All that's left is to run the program and observe 

some of the run-time interactions available in Reports for WinForms previewing controls. 



 

 56 

1. Run the program and observe the following: 

 
The preview should show the document consisting of one page, with the words "Hello 

World!" in the upper left corner of the document. 

2. Click the Zoom In button and repeat until the document text is more easily visible. 

 
3. Click the Page Setup button to open the Page Setup dialog box. In the Page Setup 

dialog box, select Landscape under Orientation and click OK to apply landscape 
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orientation to the document. 

 
4. Click the Text Select button to highlight the document text. 
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5. Click the Hand Tool button and perform a drag-and-drop operation on the document 

body so that the text appears in a different location. 

 
6. You can continue to experiment with the preview by clicking Save or Print to open 

other dialog boxes 

Congratulations, you have just created a "Hello, World!" document and completed the printing 

and previewing quick start guide! Save your project, in the following getting started tutorials 

you will continue to add to the project. 

Creating Tables 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > Creating 

Tables 

Show All  

Hide All  

This topic describes how to create a simple table and a table with three columns and rows, add 

text to cells in the table, add images to specific cells in the table, add text below the table in 

your document, create borders around rows and columns in the table, and create a background 

color for specific cells in the table. 

 

Note: The following topics use the sample application created in the C1PrintDocument 

Quick Start topic as a base. 

Making a Simple Table: 

Tables provide one of the most useful features in documents. They can be used for both tabular 

presentation of data, and for layout of other elements of a document. C1PrintDocument 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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provides full-featured tables. In this section you will learn how to start using tables. We will use 

the "Hello, World!" sample application created in the C1PrintDocument Quick Start topic as our 

base, and add a table to it. 

 

Note: The sample code fragments in this topic assume that the "using C1.C1Preview" 

directive (in C# syntax; or an equivalent for other languages) has been inserted into the file, 

so that instead of fully qualified type names (such as C1.C1Preview.RenderText) we can use 

just the class name part (RenderText). 

1. Open the HelloWorld application created in the C1PrintDocument Quick Start topic 

(alternatively, you can create a new application as described in the previous section). 

2. Switch to code view and in the Form_Load event handler (create it if necessary) add the 

following code before the call to Generate method:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt As New RenderTable()     

Me.C1PrintDocument1.Body.Children.Add(rt) 

 

Dim row As Integer = 0     

Do While (row < 10)     

    Dim col As Integer = 0     

    Do While (col < 6)    

        rt.Cells.Item(row, col).Text = String.Format("Cell ({0},{1})", row, 

col)     

        col += 1    

    Loop     

    row += 1     

Loop 

To write code in C# 

C# Copy Code  

 

RenderTable rt = new RenderTable();     

this.c1PrintDocument1.Body.Children.Add(rt); 

 

for (int row = 0; row < 10; ++ row)     

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~Generate.html
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{     

    for (int col = 0; col < 6; ++ col)    

    {    

        rt.Cells[row, col].Text = string.Format("Cell ({0},{1})", row, col);    

    }    

} 

3. Do not forget to call the Generate method on the document.  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.Generate() 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.Generate(); 

Run the program and observe: 

The preview will show the document similar to the one in the following picture: 

 

This simple example shows several important aspects of using tables in C1PrintDocument: 

 Tables are represented by the RenderTable class, which inherits from RenderObject. 

 Tables follow the model used in Microsoft Excel: their size is unlimited initially; the real 

size of the table when it is rendered is determined by the cell with the largest row and 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderTable.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
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column numbers whose content was set. In our example, the table is 10 rows high and 

6 columns wide, because the cell with the largest row and column indices that was set 

was the cell at position (9,5) (indices are zero-based). If you modify the code to set for 

example the text of the cell at position (10,7), the table will grow to 11 rows and 8 

columns:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

rt.Cells(10, 7).Text = "text at row 10, column 7" 

To write code in C# 

C# Copy Code  

 

rt.Cells[10, 7].Text = "text at row 10, column 7"; 

 By default, tables do not have visible grid lines (the "grid lines" term is used in Reports 

for WinForms for lines used to draw tables, as opposed to borders which can be drawn 

around any render object). To add grid lines (drawn with a black 0.5pt pen), add the 

following line of code to the Form Load event handler:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

rt.Style.GridLines.All = LineDef.Default 

To write code in C# 

C# Copy Code  

 

rt.Style.GridLines.All = LineDef.Default; 

By default, a table is as wide as its parent's client area (in this case, the whole page), 

with equally-sized columns. Rows' heights are automatic, though. So, if you add a line 

setting the text of an arbitrary cell in a table to a long text, you will see that the row 

containing that cell will grow vertically to accommodate all text. For example, adding 

this code to our example will produce a table looking like this (this table includes both 

changes described above): 
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To write code in Visual Basic 

Visual Basic Copy Code  

 

rt.Cells(3, 4).Text = "A long line of text showing that table rows stretch " 

+ "to accommodate all content." 

To write code in C# 

C# Copy Code  

 

rt.Cells[3, 4].Text = "A long line of text showing that table rows stretch " 

+ "to accommodate all content."; 

 

For your reference, here is the complete text of the form load event handler that produced the 

above document: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles MyBase.Load     

    Me.C1PrintDocument1.Body.Children.Add(New RenderText("Hello, World!"))     
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    Dim rt As New RenderTable()     

    Me.C1PrintDocument1.Body.Children.Add(rt) 

 

Dim row As Integer = 0     

Do While (row < 10)    

    Dim col As Integer = 0    

    Do While (col < 6)    

        rt.Cells.Item(row, col).Text = String.Format("Cell ({0},{1})", row, 

col)    

        col += 1    

    Loop    

    row += 1    

Loop    

    rt.Cells(3, 4).Text = "A long line of text showing that table rows " + 

"stretch to accommodate all content."     

    rt.Cells(10, 7).Text = "text at row 10, column 7"     

    rt.Style.GridLines.All = LineDef.Default    

    Me.C1PrintDocument1.Generate()    

End Sub 

To write code in C# 

C# Copy Code  

 

private void Form1_Load(object sender, EventArgs e)     

{    

    this.c1PrintDocument1.Body.Children.Add(new RenderText("Hello, World!"));     

    RenderTable rt = new RenderTable();     

    this.c1PrintDocument1.Body.Children.Add(rt);    

    for (int row = 0; row < 10; ++row)    

    {     

        for (int col = 0; col < 6; ++col)    

        {    

            rt.Cells[row, col].Text = string.Format("Cell ({0},{1})", row, 

col);     

        }    

    }    

    rt.Cells[3, 4].Text = "A long line of text showing that table rows " + 

"stretch to accommodate all content.";     

    rt.Cells[10, 7].Text = "text at row 10, column 7";    

    rt.Style.GridLines.All = LineDef.Default;    
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    this.c1PrintDocument1.Generate();     

} 

See Also 

Creating a Table with Three Columns and Rows 

Creating a Table with Three Columns and Rows 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > Creating 

Tables > Creating a Table with Three Columns and Rows 

Show All  

Hide All  

This topic illustrates the basics of setting up a table with three rows and three columns. 

Complete the following steps: 

1. First, set up the basic framework for the sample that will allow generating and 

previewing the document. Create a new .NET Windows Application project. Add a 

C1PrintPreviewControl and a C1PrintDocument component on the form. 

2. Set the C1PrintPreviewControl Dock property to Fill (the preview will be the only 

control on our form). Set the C1PrintPreviewControl Document property to the 

C1PrintDocument as shown in the following picture: 

 
This will make the C1PrintPreviewControl show the C1PrintDocument. 

3. Double-click the form's title bar to switch to Code view and create a new handler for 

the Form_Load event in the source code. 

4. Second, create a new C1.C1PrintDocument.RenderTable object and assign it to a 

variable by adding the following code to the Form1_Load event:  

To write code in Visual Basic 

Visual Basic Copy Code  

Dim table As C1.C1Preview.RenderTable = New 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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C1.C1Preview.RenderTable(Me.C1PrintDocument1) 

To write code in C# 

C# Copy Code  

C1.C1Preview.RenderTable table = new C1.C1Preview.RenderTable(this.c1PrintDocument1); 

5. Now, add 3 columns to the table and 3 rows to the table's body by adding the 

following code after the code added in the previous step:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Add 3 rows.     

Dim r As Integer = 3 

 

' Add 3 columns.     

Dim c As Integer = 3 

   

Dim row As Integer     

Dim col As Integer 

 

For row = 0 To r - 1 Step +1     

    For col = 0 To c - 1 Step +1     

        Dim celltext As C1.C1Preview.RenderText = New 

C1.C1Preview.RenderText(Me.C1PrintDocument1) 

 

        ' Add empty cells.     

        celltext.Text = String.Format("", row, col)     

        table.Cells(row, col).RenderObject = celltext     

    Next     

Next 

To write code in C# 

C# Copy Code  
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// Add 3 rows.     

const int r = 3; 

 

// Add 3 columns.      

const int c = 3; 

 

for (int row = 0; row < r; ++row)    

{ 

    for (int col = 0; col < c; ++col)    

    {    

        C1.C1Preview.RenderText celltext = new 

C1.C1Preview.RenderText(this.c1PrintDocument1);    

        celltext.Text = string.Format("", row, col);     

 

        // Add empty cells.      

        table.Cells[row, col].RenderObject = celltext;     

    }     

} 

Note also that while we added columns "directly" to the table, rows were added to the 

table's body. That is because a RenderTable always consists of 3 "bands": Header, Body 

and Footer. Any of the three bands may be empty in the table. If you just want a simple 

table you can add rows to the body as we do in this example. 

6. Make the table's width and height fifteen centimeters long, by adding the following 

code:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

table.Height = New C1.C1Preview.Unit(15, C1.C1Preview.UnitTypeEnum.Cm)     

table.Width = New C1.C1Preview.Unit(15, C1.C1Preview.UnitTypeEnum.Cm) 

To write code in C# 

C# Copy Code  

 

table.Height = new C1.C1Preview.Unit(15, C1.C1Preview.UnitTypeEnum.Cm);     

table.Width = new C1.C1Preview.Unit(15, C1.C1Preview.UnitTypeEnum.Cm); 

7. By default, tables have no borders. Add a dark gray gridlines to the table:  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderTable.html
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To write code in Visual Basic 

Visual Basic Copy Code  

 

table.Style.GridLines.All = New C1.C1Preview.LineDef(Color.DarkGray) 

To write code in C# 

C# Copy Code  

 

table.Style.GridLines.All = new C1.C1Preview.LineDef(Color.DarkGray); 

8. When you have created the render object(s), you need to add them to your document. 

The way to do it is to first call the Add method on the document to add the table to the 

body of the document, and then use the Generate method to create the document. 

Here is the code:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.Body.Children.Add(table)     

Me.C1PrintDocument1.Generate() 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.Body.Children.Add(table);     

this.c1PrintDocument1.Generate(); 

Run the program and observe the following: 

Your application will appear similar to the image below at run time: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~Generate.html
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See Also 

Adding Text to Table Cells 

Adding Two Images to Specific Cells of the Table 

Creating Borders Around Rows and Columns in Your Table 

Creating a Background Color for Specific Cells in the Table 

Adding Text to Table Cells 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > Creating 

Tables > Creating a Table with Three Columns and Rows > Adding Text to Table Cells 

Show All  

Hide All  

This topic shows how to use the RenderText class to add text into specific cells of the table. 

1. The following code to set up a table with dark gray gridlines should already exist in 

your source file:  

To write code in Visual Basic 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderText.html
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Visual Basic Copy Code  

 

Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles MyBase.Load 

 

    ' Make a table.     

    Dim table As C1.C1Preview.RenderTable = New 

C1.C1Preview.RenderTable(Me.C1PrintDocument1)     

    table.Style.GridLines.All = New C1.C1Preview.LineDef(Color.DarkGray) 

 

    ' Generate the document.       

    Me.C1PrintDocument1.Body.Children.Add(table)    

    Me.C1PrintDocument1.Generate() 

                 

End Sub 

To write code in C# 

C# Copy Code  

 

private void Form1_Load(object sender, System.EventArgs e)     

{     

    // Make a table.     

    C1.C1Preview.RenderTable table = new 

C1.C1Preview.RenderTable(this.c1PrintDocument1);    

    table.Style.GridLines.All = new C1.C1Preview.LineDef(Color.DarkGray); 

     

    // Generate the document.    

    this.c1PrintDocument1.Body.Children.Add(table);     

    this.c1PrintDocument1.Generate(); 

     

} 

2. Showing any kind of content in a table cell is done by assigning the render object 

representing that content to the cell's RenderObject property. But, because showing 

text in table cells is such a common task, cells have an additional specialized property 

RenderText that we will use. In order to set the texts of all cells in the table, you need to 

loop over the table's rows, and inside that loop do another loop over the row's 

columns. In the body of the nested loop set the Text property to the desired text as 

follows (for the sake of this sample, we leave cells (1,1) and (1,2) empty):  

To write code in Visual Basic 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderText~Text.html
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Visual Basic Copy Code  

 

' Add 3 rows.     

Dim r As Integer = 3 

 

' Add 3 columns.     

Dim c As Integer = 3 

 

Dim row As Integer     

Dim col As Integer 

 

For row = 0 To r - 1 Step +1     

    For col = 0 To c - 1 Step +1     

        If (Not (row = 1 And col = 1)) And (Not (row = 1 And col = 2)) Then     

           Dim celltext As C1.C1Preview.RenderText = New 

C1.C1Preview.RenderText(Me.C1PrintDocument1)     

           celltext.Text = String.Format("Cell ({0},{1})", row, col) 

 

           ' Add cells with text.     

           table.Cells(row, col).RenderObject = celltext     

       End If     

    Next     

Next 

To write code in C# 

C# Copy Code  

 

// Add 3 rows.     

const int r = 3; 

 

// Add 3 columns.     

const int c = 3; 

 

for (int row = 0; row < r; ++row)     

{     

    for (int col = 0; col < c; ++col)    

    {     

        if (!(row == 1 && col == 1) && !(row == 1 && col == 2))     

        {     
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            C1.C1Preview.RenderText celltext = new 

C1.C1Preview.RenderText(this.c1PrintDocument1);     

            celltext.Text = string.Format("Cell ({0}, {1})", row, col); 

 

            // Add cells with text.     

            table.Cells[row, col].RenderObject = celltext;     

        }     

    }     

} 

Run the program and observe the following: 

Your table should look similar to the table below: 

 

Adding Two Images to Specific Cells of the Table 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > Creating 

Tables > Creating a Table with Three Columns and Rows > Adding Two Images to Specific Cells of the 

Table 

Show All  

Hide All  

This topic demonstrates how to add two different images to specific cells in an existing table by 

using the RenderImage class. It also shows how to align images in cells using the 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderImage.html
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ImageAlignHorzEnum. Note that the sample below uses the empty 3 by 3 table which was built 

in Creating a Table with Three Columns and Rows and that you'll need to have two GIF or JPEG 

images on hand to complete the steps in this topic. Complete the following steps: 

1. The following code should already exist in your source file:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles MyBase.Load 

 

    ' Make a table.       

    Dim table As C1.C1Preview.RenderTable = New 

C1.C1Preview.RenderTable(Me.C1PrintDocument1)     

    table.Style.GridLines.All = New C1.C1Preview.LineDef(Color.DarkGray) 

 

    Dim r As Integer = 3     

    Dim c As Integer = 3     

    Dim row As Integer     

    Dim col As Integer 

    For row = 0 To r - 1 Step +1     

        For col = 0 To c - 1 Step +1     

            Dim celltext As C1.C1Preview.RenderText = New 

C1.C1Preview.RenderText(Me.C1PrintDocument1) 

 

            ' Add empty cells.       

            celltext.Text = String.Format("", row, col)     

            table.Cells(row, col).RenderObject = celltext     

        Next     

    Next 

 

    ' Generate the document.       

    Me.C1PrintDocument1.Body.Children.Add(table)     

    Me.C1PrintDocument1.Generate()    

End Sub 

To write code in C# 

C# Copy Code  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ImageAlignHorzEnum.html
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private void Form1_Load(object sender, System.EventArgs e)     

{     

    // Make a table.       

    C1.C1Preview.RenderTable table = new 

C1.C1Preview.RenderTable(this.c1PrintDocument1);     

    table.Style.GridLines.All = new C1.C1Preview.LineDef(Color.DarkGray); 

 

    const int r = 3;     

    const int c = 3;     

    for (int row = 0; row < r; ++row)     

    { 

        for (int col = 0; col < c; ++col)     

        {    

            C1.C1Preview.RenderText celltext = new 

C1.C1Preview.RenderText(this.c1PrintDocument1);     

            celltext.Text = string.Format("", row, col); 

 

            // Add empty cells.       

            table.Cells[row, col].RenderObject = celltext;     

        }     

    } 

 

    // Generate the document.     

    this.c1PrintDocument1.Body.Children.Add(table);     

    this.c1PrintDocument1.Generate();     

} 

2. Add the following code after the line adding the rows (the new code will fix the center 

cell's size in the table):  

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Fix the center cell's size.       

table.Rows(1).Height = New C1.C1Preview.Unit(5, C1.C1Preview.UnitTypeEnum.Cm)     

table.Cols(1).Width = New C1.C1Preview.Unit(8, C1.C1Preview.UnitTypeEnum.Cm) 

To write code in C# 
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C# Copy Code  

 

// Fix the center cell's size.       

table.Rows[1].Height = new C1.C1Preview.Unit(5, 

C1.C1Preview.UnitTypeEnum.Cm);     

table.Cols[1].Width = new C1.C1Preview.Unit(8, C1.C1Preview.UnitTypeEnum.Cm); 

3. Create two JPEG or GIF images or use images that already exist. 

4. Add two PictureBox controls onto your form. Set their Image properties to the two 

images created in the previous step. Also, make the two picture boxes invisible (set 

Visible to False) so that they won't clutter the form (those controls are used only as 

storage for the images. The images will be rendered into the C1PrintDocument). 

5. Use the TableCell.CellStyle property to modify the base styles for the cells content. In 

this sample we will modify the ImageAlign property for the cells. Enter the following 

code to set up the image alignment:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Set up image alignment.       

table.CellStyle.ImageAlign.StretchHorz = False     

table.CellStyle.ImageAlign.StretchVert = False     

table.CellStyle.ImageAlign.AlignHorz = C1.C1Preview.ImageAlignHorzEnum.Center 

To write code in C# 

C# Copy Code  

 

// Set up image alignment.       

table.CellStyle.ImageAlign.StretchHorz = false;     

table.CellStyle.ImageAlign.StretchVert = false;     

table.CellStyle.ImageAlign.AlignHorz = 

C1.C1Preview.ImageAlignHorzEnum.Center; 

6. In C1PrintDocument, images are rendered using the RenderImage class (which 

subclasses the RenderObject). Create two new RenderImage objects for the two 

images as follows:  

To write code in Visual Basic 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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Visual Basic Copy Code  

 

Dim img1 As C1.C1Preview.RenderImage = New 

C1.C1Preview.RenderImage(Me.C1PrintDocument1)     

Dim img2 As C1.C1Preview.RenderImage = New 

C1.C1Preview.RenderImage(Me.C1PrintDocument1) 

To write code in C# 

C# Copy Code  

 

C1.C1Preview.RenderImage img1 = new 

C1.C1Preview.RenderImage(this.c1PrintDocument1);     

C1.C1Preview.RenderImage img2 = new 

C1.C1Preview.RenderImage(this.c1PrintDocument1); 

7. Now, set the RenderImage's Image properties to the images stored in the picture 

boxes:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

img1.Image = Me.PictureBox1.Image     

img2.Image = Me.PictureBox2.Image 

To write code in C# 

C# Copy Code  

 

img1.Image = this.pictureBox1.Image;     

img2.Image = this.pictureBox2.Image; 

8. Assign the RenderImage objects to the RenderObject properties of the cells so that the 

images will render in those cells:  

To write code in Visual Basic 

Visual Basic Copy Code  
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table.Cells(1, 1).RenderObject = img1     

table.Cells(1, 2).RenderObject = img2 

To write code in C# 

C# Copy Code  

 

table.Cells[1, 1].RenderObject = img1;     

table.Cells[1, 2].RenderObject = img2; 

 

Note: The top left cell of the table is at row 0, column 0. 

Run the program and observe the following: 

Your table should look similar to the table below: 

 

Creating Borders Around Rows and Columns in Your 

Table 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > Creating 

Tables > Creating a Table with Three Columns and Rows > Creating Borders Around Rows and Columns in 
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Your Table 

Show All  

Hide All  

This topic demonstrates how to create distinct borders around a row and a column by using the 

LineDef class. This topic assumes you already have a table with three columns and three rows. 

1. The following code should already exist in your source file:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles MyBase.Load     

 

    ' Make a table.     

    Dim table As C1.C1Preview.RenderTable = New 

C1.C1Preview.RenderTable(Me.C1PrintDocument1)     

    table.Style.GridLines.All = New C1.C1Preview.LineDef(Color.DarkGray) 

 

    Dim r As Integer = 3     

    Dim c As Integer = 3     

    Dim row As Integer     

    Dim col As Integer     

    For row = 0 To r - 1 Step +1     

        For col = 0 To c - 1 Step +1     

            Dim celltext As C1.C1Preview.RenderText = New 

C1.C1Preview.RenderText(Me.C1PrintDocument1) 

 

            ' Add empty cells.      

            celltext.Text = String.Format("", row, col)     

            table.Cells(row, col).RenderObject = celltext     

        Next     

    Next 

 

    ' Generate the document.      

    Me.C1PrintDocument1.Body.Children.Add(table)     

    Me.C1PrintDocument1.Generate()     

End Sub 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.LineDef.html
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To write code in C# 

C# Copy Code  

 

private void Form1_Load(object sender, System.EventArgs e)     

{     

        // Make a table.      

    C1.C1Preview.RenderTable table = new 

C1.C1Preview.RenderTable(this.c1PrintDocument1);    

    table.Style.GridLines.All = new C1.C1Preview.LineDef(Color.DarkGray); 

 

    const int r = 3;     

    const int c = 3;     

    for (int row = 0; row < r; ++row)     

    {     

        for (int col = 0; col < c; ++col)     

        {     

        C1.C1Preview.RenderText celltext = new 

C1.C1Preview.RenderText(this.c1PrintDocument1);     

            celltext.Text = string.Format("", row, col); 

 

            // Add empty cells.      

            table.Cells[row, col].RenderObject = celltext;     

        }     

    } 

 

    // Generate the document.      

    this.c1PrintDocument1.Body.Children.Add(table);     

    this.c1PrintDocument1.Generate();     

} 

2. Add the following code to your project to make the table's width and height fifteen 

centimeters long:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

table.Height = New C1.C1Preview.Unit(15, C1.C1Preview.UnitTypeEnum.Cm)     

table.Width = New C1.C1Preview.Unit(15, C1.C1Preview.UnitTypeEnum.Cm) 
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To write code in C# 

C# Copy Code  

 

table.Height = new C1.C1Preview.Unit(15, C1.C1Preview.UnitTypeEnum.Cm);     

table.Width = new C1.C1Preview.Unit(15, C1.C1Preview.UnitTypeEnum.Cm); 

3. Add the following code to your project to assign a new instance of the LineDef class to 

the borders of the third row as follows (note that the constructor we use specifies that 

the new border will be red and 2 points wide):  

To write code in Visual Basic 

Visual Basic Copy Code  

 

table.Rows(2).Style.Borders.All = New C1.C1Preview.LineDef("2pt", Color.Red) 

To write code in C# 

C# Copy Code  

 

table.Rows[2].Style.Borders.All = new C1.C1Preview.LineDef("2pt", Color.Red); 

4. Assign a new instance of the LineDef class to the borders of the first column as follows 

(note that the constructor we use specifies that the new border will be blue and 6 

points wide):  

To write code in Visual Basic 

Visual Basic Copy Code  

 

table.Cols(0).Style.Borders.All = New C1.C1Preview.LineDef("6pt", Color.Blue) 

To write code in C# 

C# Copy Code  

 

table.Cols[0].Style.Borders.All = new C1.C1Preview.LineDef("6pt", 

Color.Blue); 
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Run the program and observe the following: 

Your borders will appear similar to the table below at run time: 

 

Creating a Background Color for Specific Cells in the 

Table 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > Creating 

Tables > Creating a Table with Three Columns and Rows > Creating a Background Color for Specific Cells 

in the Table 

Show All  

Hide All  

This topic demonstrates how to create background colors for specific cells in the table. It also 

demonstrates how to use the TableCell.CellStyle property to set the styles used in the table 

that will be rendered. This topic assumes you have a table with three columns and three rows. 

1. The following code below should already exist in your source file:  

To write code in Visual Basic 

Visual Basic Copy Code  
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Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles MyBase.Load 

 

    ' Make a table.     

    Dim table As C1.C1Preview.RenderTable = New 

C1.C1Preview.RenderTable(Me.C1PrintDocument1)     

    table.Style.GridLines.All = New C1.C1Preview.LineDef(Color.DarkGray) 

 

    Dim r As Integer = 3     

    Dim c As Integer = 3     

    Dim row As Integer     

    Dim col As Integer     

    For row = 0 To r - 1 Step +1     

        For col = 0 To c - 1 Step +1     

            Dim celltext As C1.C1Preview.RenderText = New 

C1.C1Preview.RenderText(Me.C1PrintDocument1) 

 

            ' Add empty cells.      

            celltext.Text = String.Format("", row, col)     

            table.Cells(row, col).RenderObject = celltext     

        Next     

    Next 

                                 

    ' Generate the document.      

    Me.C1PrintDocument1.Body.Children.Add(table)     

    Me.C1PrintDocument1.Generate()     

End Sub 

To write code in C# 

C# Copy Code  

 

private void Form1_Load(object sender, System.EventArgs e)     

{    

    // Make a table.      

    C1.C1Preview.RenderTable table = new 

C1.C1Preview.RenderTable(this.c1PrintDocument1);     

    table.Style.GridLines.All = new C1.C1Preview.LineDef(Color.DarkGray); 

 

    const int r = 3;     
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    const int c = 3;     

    for (int row = 0; row < r; ++row)     

    {     

        for (int col = 0; col < c; ++col)     

        {     

            C1.C1Preview.RenderText celltext = new 

C1.C1Preview.RenderText(this.c1PrintDocument1);     

            celltext.Text = string.Format("", row, col); 

 

            // Add empty cells.      

            table.Cells[row, col].RenderObject = celltext;     

        }     

    } 

 

    // Generate the document.      

    this.c1PrintDocument1.Body.Children.Add(table);     

    this.c1PrintDocument1.Generate();     

} 

2. Make the table's width and height fifteen centimeters long:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

table.Height = New C1.C1Preview.Unit(15, C1.C1Preview.UnitTypeEnum.Cm)     

table.Width = New C1.C1Preview.Unit(15, C1.C1Preview.UnitTypeEnum.Cm) 

To write code in C# 

C# Copy Code  

 

table.Width = new C1.C1Preview.Unit(15, C1.C1Preview.UnitTypeEnum.Cm); 

3. Add the following code below the last line of code listed above. This code will create a 

crimson background color for row 1, column 2.  

To write code in Visual Basic 

Visual Basic Copy Code  
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table.Cells(1, 2).CellStyle.BackColor = Color.Crimson 

To write code in C# 

C# Copy Code  

 

table.Cells[1, 

2].CellStyle.BackColor = 

Color.Crimson; 

 

Note: The rows and columns begin with 0. The code above uses the 

TableCell.CellStyle property to set the cell's style. 

4. Create a blue-violet background color for row 0, column 1. Enter the following code:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

table.Cells(0, 1).CellStyle.BackColor = Color.BlueViolet 

To write code in C# 

C# Copy Code  

 

table.Cells[0, 1].CellStyle.BackColor = Color.BlueViolet; 

Run the program and observe the following: 

Your table should appear similar to the table below: 
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Adding Text 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > Adding Text 

Show All  

Hide All  

This topic describes how to add paragraphs and add text below a table. The following topic 

describes how to modify the font and style of text. 

Adding Paragraphs to the Document: 

All content of a C1PrintDocument is represented by render objects. The Reports for WinForms 

assembly provides a hierarchy of classes derived from RenderObject, designed to represent 

content of various types, such as text, images and so on. For instance, above we used the 

RenderText class to add a line of text to the document. In this section we will show how to 

create paragraphs of text (which may combine fragments of text drawn with different styles, 

inline images, and hyperlinks) using the RenderParagraph class. 

 

Note: The sample code fragments in this topic assume that "using C1.C1Preview;" directive 

(in C# syntax; or an equivalent for other languages) has been inserted into the file, so that 

instead of fully qualified type names (such as C1.C1Preview.RenderText) we can use just the 

class name part (RenderText). 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderText.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderParagraph.html
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A RenderParagraph can be created with the following line of code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rp As New RenderParagraph() 

To write code in C# 

C# Copy Code  

 

RenderParagraph rp = new RenderParagraph(); 

Paragraphs should be used rather than RenderText in any of the following cases: 

 You need to show text in different styles within the same paragraph. 

 Inline images (usually small icon-like images) must be inserted in the text flow. 

 A hyperlink must be associated with a portion of the text (for example, a word) rather 

than with the whole text (please see the Anchors and Hyperlinks section). 

The content of a paragraph is comprised of ParagraphObject objects. ParagraphObject is the 

abstract base class; the two inherited classes are ParagraphText and ParagraphImage, 

representing fragments of text and inline images, correspondingly. You can fill a paragraph with 

content by creating objects of those two types and adding them to the 

RenderParagraph.Content collection. Various constructor overloads and properties are 

provided for convenient creation/setup of those objects. In-paragraph hyperlinks can be 

created by specifying the Hyperlink property of the paragraph object which should be a 

hyperlink. An alternative approach is to use various overloads of the shortcut methods AddText, 

AddImage and AddHyperlink, as shown in the following example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles MyBase.Load 

 

    ' Create a paragraph.      

    Dim rpar As New RenderParagraph()     

    Dim f As New Font(rpar.Style.Font, FontStyle.Bold) 

                 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ParagraphObject.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ParagraphText.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ParagraphImage.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ParagraphObject~Hyperlink.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ParagraphObjectCollection~AddText.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ParagraphObjectCollection~AddImage.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ParagraphObjectCollection~AddHyperlink.html
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    rpar.Content.AddText("This is a paragraph. This is normal text. ")     

    rpar.Content.AddText("This text is bold. ", f)     

    rpar.Content.AddText("This text is red. ", Color.Red)     

    rpar.Content.AddText("This text is superscript. ", 

TextPositionEnum.Superscript)     

    rpar.Content.AddText("This text is bold and red. ", f, Color.Red)     

    rpar.Content.AddText("This text is bold and red and subscript. ", f, 

Color.Red, TextPositionEnum.Subscript)     

    rpar.Content.AddText("This is normal text again. ")     

    rpar.Content.AddHyperlink("This is a link to the start of this 

paragraph.", rpar.Content(0))     

    rpar.Content.AddText("Finally, here is an inline image: ")     

    rpar.Content.AddImage(Me.Icon.ToBitmap())     

    rpar.Content.AddText(".") 

 

    ' Add the paragraph to the document.      

    Me.C1PrintDocument1.Body.Children.Add(rpar)     

    Me.C1PrintDocument1.Generate() 

                 

End Sub 

To write code in C# 

C# Copy Code  

 

private void Form1_Load(object sender, EventArgs e)     

{     

    // Create a paragraph.      

    RenderParagraph rpar = new RenderParagraph();     

    Font f = new Font(rpar.Style.Font, FontStyle.Bold); 

 

    rpar.Content.AddText("This is a paragraph. This is normal text. ");     

    rpar.Content.AddText("This text is bold. ", f);     

    rpar.Content.AddText("This text is red. ", Color.Red);     

    rpar.Content.AddText("This text is superscript. ", 

TextPositionEnum.Superscript);     

    rpar.Content.AddText("This text is bold and red. ", f, Color.Red);     

    rpar.Content.AddText("This text is bold and red and subscript. ", f, 

Color.Red, TextPositionEnum.Subscript);     

    rpar.Content.AddText("This is normal text again. ");     

    rpar.Content.AddHyperlink("This is a link to the start of this 
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paragraph.", rpar.Content[0]);     

    rpar.Content.AddText("Finally, here is an inline image: ");     

    rpar.Content.AddImage(this.Icon.ToBitmap());     

    rpar.Content.AddText("."); 

 

    // Add the paragraph to the document.     

    this.c1PrintDocument1.Body.Children.Add(rpar);     

    this.c1PrintDocument1.Generate(); 

     

} 

Adding Text Below the Table: 

Here you will learn how to use the C1.C1PrintDocument.RenderTable object to render the text 

into the block flow. It also demonstrates how to use the Padding property to advance the block 

position so that the next render object (in this case, text) is rendered there. We will use the 

Padding property to put the text 1 cm below the table in your document. This topic assumes 

you already have a table created. 

1. Use the C1.C1PrintDocument.RenderTable object to create the text to be displayed:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim caption As C1.C1Preview.RenderText = New 

C1.C1Preview.RenderText(Me.C1PrintDocument1)     

caption.Text = "In the table above, there are three rows and three columns." 

To write code in C# 

C# Copy Code  

 

C1.C1Preview.RenderText caption = new 

C1.C1Preview.RenderText(this.c1PrintDocument1);     

caption.Text = "In the table above, there are three rows and three columns."; 

2. Use the Padding property to position the text 1 cm below the table:  

To write code in Visual Basic 

Visual Basic Copy Code  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style~Padding.html
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caption.Style.Padding.Top = New C1.C1Preview.Unit(1, 

C1.C1Preview.UnitTypeEnum.Cm) 

To write code in C# 

C# Copy Code  

 

caption.Style.Padding.Top = new C1.C1Preview.Unit(1, 

C1.C1Preview.UnitTypeEnum.Cm); 

3. Add the text below the table using the Add method. Insert the Add method for the text 

below the Add method for the table, as shown in the following code:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.Body.Children.Add(table)     

Me.C1PrintDocument1.Body.Children.Add(caption) 

 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.Body.Children.Add(table);     

this.c1PrintDocument1.Body.Children.Add(caption); 

 

 

Note: Placing the Add method for the text below the Add method for the table inserts the 

text below the table. If it is placed above the Add method for the table, the text will appear 

above the table. 

Run the program and observe the following: 

The following image shows the paragraph that is added to the document, generated by the 

code given in the section above: 
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The following image shows how the document looks, when you add text below a table: 

 

See Also 

Modifying the Font and Style of the Text 

Modifying the Font and Style of the Text 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > Adding Text 

> Modifying the Font and Style of the Text 

Show All  

Hide All  

C1PrintDocument contains a RenderInLineText method that renders the specified string 

without starting a new paragraph into the block flow. The RenderInLineText method 

automatically wraps the text. This topic illustrates how to use the RenderInLineText method. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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1. Create a new Windows Forms application. Add a C1PrintPreview control onto your 

form. Add a C1PrintDocument component onto your form - it will appear in the 

components' tray below the form. The preview will have the default name 

C1PrintPreview1, the document C1PrintDocument1. Set the value of the Document 

property of C1PrintPreview1 control to C1PrintDocument1, so that the preview will 

show the document when the application runs. 

2. Double click the form to create a handler for the Form_Load event, this is where all 

code shown below will be written. 

3. Begin the document with the StartDoc method and create a line of text using the 

default font. For example:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.StartDoc()     

Me.C1PrintDocument1.RenderInlineText("With C1PrintDocument you can print ") 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.StartDoc();     

this.c1PrintDocument1.RenderInlineText("With C1PrintDocument you can print 

"); 

4. Continue with a different font and color and then go back to the default font and color:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.RenderInlineText("Line by Line", New Font("Times New 

Roman", 30, FontStyle.Bold), Color.FromArgb(0, 0, 125))     

Me.C1PrintDocument1.RenderInlineText(" and modify text attributes as you 

go.") 

To write code in C# 

C# Copy Code  

 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~StartDoc.html
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this.c1PrintDocument1.RenderInlineText("Line by Line", new Font("Times New 

Roman", 30, FontStyle.Bold), Color.FromArgb(0, 0, 125));     

this.c1PrintDocument1.RenderInlineText(" and modify text attributes as you 

go."); 

5. Make the last few words of the line a green color.  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.RenderInlineText(" The text wraps automatically, so your 

life becomes easier.", Color.Green) 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.RenderInlineText(" The text wraps automatically, so 

your life becomes easier.", Color.Green); 

6. 6. End the document with the EndDoc method.  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.EndDoc() 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.EndDoc(); 

Run the program and observe the following: 

The text should appear similar to the text below: 



 

 92 

 

Creating Page Headers in C1PrintDocument 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > Creating 

Page Headers in C1PrintDocument 

Show All  

Hide All  

This topic describes how to create a page header with three parts, and add a background color 

to the page header. 

Creating a Page Header with Three Parts and Adding Background Color to the Page 

Header: 

Here you will learn how to create a header that is divided into three columns. The following key 

points are shown in this topic: 

 Creating a table with one row and three columns in C1PrintDocument. 

 Setting up the text alignment in each section of the page header. 

 The TextAlignHorz property of the Style class is used to specify the horizontal 

alignment of the text. You can assign a member (left, right, justify or center) of the 

AlignHorzEnum to the TextAlignHorz property. 

The following detailed steps demonstrate how to create a header with three parts. 

1. Create a new Windows Forms application. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style~TextAlignHorz.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style.html
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2. Add a C1PrintPreview control onto your form. 

3. Add a C1PrintDocument component onto your form it will appear in the components' 

tray below the form. The preview will have the default name C1PrintPreview1, the 

document C1PrintDocument1. 

4. Set the value of the Document property of the C1PrintPreview1 control to 

C1PrintDocument1, so that the preview will show the document when the application 

runs. 

5. Double click the form to create a handler for the Form_Load event this is where all 

code shown below will be written. In the Form_Load event, we will set up our 

document. Create a RenderTable for the page header:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.StartDoc()     

Dim theader As New C1.C1Preview.RenderTable(Me.C1PrintDocument1) 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.StartDoc();     

C1.C1Preview.RenderTable theader = new 

C1.C1Preview.RenderTable(this.c1PrintDocument1); 

6. Add one row to its body, and 3 columns for the left, middle, and right parts of the 

header. We will use the TextAlignHorz property to set the alignment of the text in each 

column of the page header. We will also assign a new font style for the text in our page 

header. Note, in this example the font type will be Arial and it will be 14 points in size.  

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Set up alignment for the parts of the header.     

theader.Cells(0, 0).Style.TextAlignHorz = C1.C1Preview.AlignHorzEnum.Left     

theader.Cells(0, 1).Style.TextAlignHorz = C1.C1Preview.AlignHorzEnum.Center      

theader.Cells(0, 2).Style.TextAlignHorz = C1.C1Preview.AlignHorzEnum.Right     

theader.CellStyle.Font = New Font("Arial", 14) 

To write code in C# 
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C# Copy Code  

 

// Set up alignment for the columns of the header.     

theader.Cells[0, 0].Style.TextAlignHorz = C1.C1Preview.AlignHorzEnum.Left;     

theader.Cells[0, 1].Style.TextAlignHorz = C1.C1Preview.AlignHorzEnum.Center;     

theader.Cells[0, 2].Style.TextAlignHorz = C1.C1Preview.AlignHorzEnum.Right;     

theader.CellStyle.Font = new Font("Arial", 14); 

7. Add the following code, to assign a gold color to the page header. We will use the Style 

property of the TableRow class to apply the background color to the table, theader.  

To write code in Visual Basic 

Visual Basic Copy Code  

 

theader.Style.BackColor = Color.Gold 

To write code in C# 

C# Copy Code  

 

theader.Style.BackColor = Color.Gold; 

8. We will draw the text into each column of the table for the page header. Set the 

RenderObject property of the document's PageHeader to theader. Finish generating 

the document by calling the EndDoc method.  

To write code in Visual Basic 

Visual Basic Copy Code  

 

theader.Cells(0, 0).Text = "Left part"     

theader.Cells(0, 1).Text = "Center part"     

theader.Cells(0, 2).Text = "Right part"     

Me.C1PrintDocument1.RenderBlock(theader)     

Me.C1PrintDocument1.EndDoc() 

To write code in C# 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style.html
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C# Copy Code  

 

theader.Cells[0, 0].Text = "Left part";     

theader.Cells[0, 1].Text = "Center part";     

theader.Cells[0, 2].Text = "Right part";    

this.c1PrintDocument1.RenderBlock(theader);     

this.c1PrintDocument1.EndDoc(); 

Run the program and observe the following: 

Your new page header with three parts will appear similar to the header below at run time: 

 

Your header should look similar to the following header, when you add a background color: 
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Creating Page Footers 
Getting Started with Reports for WinForms > Getting Started with Printing and Previewing > Creating 

Page Footers 

Show All  

Hide All  

This topic demonstrates how to create a table footer that is divided into two columns. The 

following key points are shown in this topic: 

 Adding a footer to a table with multiple rows and columns in C1PrintDocument. 

 Setting up the table footer at the end of each page. The Count property of the 

TableVectorCollection class is used to insert the footer at the end of the table on each 

page. 

 Setting up the row and column spans for each section of the page footer. 

The SpanRows and SpanCols properties of the TableCell class are used to specify the 

row and column spans. 

 Setting up the text alignment in each section of the page footer. The TextAlignHorz and 

TextAlignVert properties of the Style class are used to specify the horizontal and vertical 

alignment of the text. 

You can assign a member (left, right, justify, or center) of the AlignHorzEnum to the 

TextAlignHorz property or a member (bottom, center, justify, or top) of the 

AlignVertEnum to the TextAlignVert property. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableCell~SpanRows.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableCell~SpanCols.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableCell.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style~TextAlignHorz.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style~TextAlignVert.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.AlignHorzEnum.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.AlignVertEnum.html


 

 97 

 

Note: The sample code fragments in this topic assume that the "using C1.C1Preview;" 

directive (in C# syntax; or an equivalent for other languages) has been inserted into the file, 

so that instead of fully qualified type names (such as C1.C1Preview.RenderText) we can use 

just the class name part (RenderText). 

Complete the following steps to create a table footer with two parts: 

1. Create a new Windows Forms application. 

2. From the Toolbox, add a C1PrintPreview control onto your form. Add a 

C1PrintDocument component onto your form, it will appear in the components' tray 

below the form. The preview will have the default name C1PrintPreview1, the 

document C1PrintDocument1. 

3. Set the value of the Document property of C1PrintPreview1 control to 

C1PrintDocument1, so that the preview will show the document when the application 

runs. 

 
4. Double click the form to switch to code view and create a handler for the Form_Load 

event. In the Form_Load event, we will set up our document. 

5. Add the following code to the Form_Load event to create a RenderTable for the page 

footer and add a table with 4 columns, 100 rows, and sample text:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt1 As New C1.C1Preview.RenderTable(Me.C1PrintDocument1) 

 

' Create a table with 100 rows, 4 columns, and text.      

Dim r As Integer = 100     

Dim c As Integer = 4     

Dim row As Integer     

Dim col As Integer     

For row = 0 To r - 1 Step +1     
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    For col = 0 To c - 1 Step +1     

        Dim celltext As C1.C1Preview.RenderText = New 

C1.C1Preview.RenderText(Me.C1PrintDocument1)     

        celltext.Text = String.Format("Cell ({0},{1})", row, col)     

        rt1.Cells(row, col).RenderObject = celltext     

    Next     

Next 

  

' Add the table to the document.      

Me.C1PrintDocument1.Body.Children.Add(rt1) 

To write code in C# 

C# Copy Code  

 

C1.C1Preview.RenderTable rt1 = new 

C1.C1Preview.RenderTable(this.c1PrintDocument1); 

 

// Create a table with 100 rows, 4 columns, and text.      

const int r = 100;     

const int c = 4;     

for (int row = 0; row < r; ++row)     

{     

    for (int col = 0; col < c; ++col)     

    {     

        C1.C1Preview.RenderText celltext = new 

C1.C1Preview.RenderText(this.c1PrintDocument1);     

        celltext.Text = string.Format("Cell ({0},{1})", row, col);     

        rt1.Cells[row, col].RenderObject = celltext;     

    }     

} 

 

// Add the table to the document.      

this.c1PrintDocument1.Body.Children.Add(rt1); 

6. Add the following code to set the font type to Arial, 10 points and the background 

color to lemon chiffon:  

To write code in Visual Basic 

Visual Basic Copy Code  
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' Set up the table footer.     

rt1.RowGroups(rt1.Rows.Count - 2, 2).PageFooter = True     

rt1.RowGroups(rt1.Rows.Count - 2, 2).Style.BackColor = Color.LemonChiffon    

rt1.RowGroups(rt1.Rows.Count - 2, 2).Style.Font = New Font("Arial", 10, 

FontStyle.Bold) 

To write code in C# 

C# Copy Code  

 

// Set up the table footer.      

rt1.RowGroups[rt1.Rows.Count - 2, 2].PageFooter = true;     

rt1.RowGroups[rt1.Rows.Count - 2, 2].Style.BackColor = Color.LemonChiffon;     

rt1.RowGroups[rt1.Rows.Count - 2, 2].Style.Font = new Font("Arial", 10, 

FontStyle.Bold); 

Here we reserved the last two rows of the page for the footer using the Count property 

and grouped the rows together using the RowGroups property. We then assigned a 

new font style for the text and a new background color for the cells in our page footer. 

7. Next, we'll use the TextAlignHorz and TextAlignVert properties to set the alignment of 

the text in each column of the page footer. We'll span the footer over the last two rows 

and create two columns using the SpanRows and SpanCols properties. We will draw the 

text into each column of the table for the page footer. Finish by using the Generate 

method to create the document.  

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Add table footer text.      

rt1.Cells(rt1.Rows.Count - 2, 0).SpanRows = 2     

rt1.Cells(rt1.Rows.Count - 2, 0).SpanCols = rt1.Cols.Count - 1    

rt1.Cells(rt1.Rows.Count - 2, 0).Style.TextAlignHorz = 

C1.C1Preview.AlignHorzEnum.Left     

rt1.Cells(rt1.Rows.Count - 2, 0).Style.TextAlignVert = 

C1.C1Preview.AlignVertEnum.Center     

Dim tf As C1.C1Preview.RenderText = New 

C1.C1Preview.RenderText(Me.C1PrintDocument1)     

tf = CType(rt1.Cells(rt1.Rows.Count - 2, 0).RenderObject, 

C1.C1Preview.RenderText)     

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableCell~SpanRows.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableCell~SpanCols.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~Generate.html
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tf.Text = "This is a table footer." 

  

' Add page numbers.      

rt1.Cells(rt1.Rows.Count - 2, 3).SpanRows = 2     

rt1.Cells(rt1.Rows.Count - 2, 3).Style.TextAlignHorz = 

C1.C1Preview.AlignHorzEnum.Right     

rt1.Cells(rt1.Rows.Count - 2, 3).Style.TextAlignVert = 

C1.C1Preview.AlignVertEnum.Center 

 

' Tags (such as page no/page count) can be inserted anywhere in the document.      

Dim pn As C1.C1Preview.RenderText = New 

C1.C1Preview.RenderText(Me.C1PrintDocument1)     

pn = CType(rt1.Cells(rt1.Rows.Count - 2, 3).RenderObject, 

C1.C1Preview.RenderText)     

pn.Text = "Page [PageNo] of [PageCount]" 

 

Me.C1PrintDocument1.Generate() 

To write code in C# 

C# Copy Code  

 

// Add table footer text.      

rt1.Cells[rt1.Rows.Count - 2, 0].SpanRows = 2;     

rt1.Cells[rt1.Rows.Count - 2, 0].SpanCols = rt1.Cols.Count - 1;     

rt1.Cells[rt1.Rows.Count - 2, 0].Style.TextAlignHorz = 

C1.C1Preview.AlignHorzEnum.Center;     

rt1.Cells[rt1.Rows.Count - 2, 0].Style.TextAlignVert = 

C1.C1Preview.AlignVertEnum.Center;     

((C1.C1Preview.RenderText)rt1.Cells[rt1.Rows.Count - 2, 0].RenderObject).Text 

= "This is a table footer."; 

 

// Add page numbers.      

rt1.Cells[rt1.Rows.Count - 2, 3].SpanRows = 2;     

rt1.Cells[rt1.Rows.Count - 2, 3].Style.TextAlignHorz = 

C1.C1Preview.AlignHorzEnum.Right;     

rt1.Cells[rt1.Rows.Count - 2, 3].Style.TextAlignVert = 

C1.C1Preview.AlignVertEnum.Center; 

 

// Tags (such as page no/page count) can be inserted anywhere in the 

document.     
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((C1.C1Preview.RenderText)rt1.Cells[rt1.Rows.Count - 2, 3].RenderObject).Text 

= "Page [PageNo] of [PageCount]"; 

 

this.c1PrintDocument1.Generate(); 

Run the program and observe the following: 

Your new page footer with two parts should appear to the footer below: 

 

Reports for WinForms Top Tips 
This topic lists tips and best practices that may be helpful when working with Reports for 

WinForms. The following tips were compiled from frequently asked user questions posted in 

the C1DataObjects newsgroup and forum. Additionally the tips detail some newer and/or less 

used but very useful features. 

The following topics detail tips for the C1PrintDocument component, tips for the C1Report 

component, and tips for the WinForms preview controls (C1PrintPreviewControl and so on). 

Note that C1PrintDocument and C1Report components' tips may apply also to Reports for 

WPF and C1Report tips may apply to WebReports for ASP.NET. 

See Also 

C1PrintDocument Tips 

http://forums.componentone.com/CS/forums/7.aspx
C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
C1.C1Report.4~C1.C1Report.C1Report.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
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C1Report Tips 

Visual Previewing Control Tips 

C1ReportScheduler Tips 

C1PrintDocument Tips 
Reports for WinForms Top Tips > C1PrintDocument Tips 

Show All  

Hide All  

The following tips relate to the C1PrintDocument component. 

Tip 1: Setting RenderTable Width and Auto-sizing 

When setting up RenderTable objects it is important to take into account that by default, the 

width of a RenderTable is set to the width of its containing object which usually defaults to the 

width of the page. This sometimes leads to unexpected results, in particular if you want the 

table's columns to auto-size; to do so the table's Width must be explicitly set to Auto (which 

for a table means the sum of the columns widths). 

For example, the following code builds a document with an auto-sized table: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

 

' Create a RenderTable object:     

Dim rt As New RenderTable() 

 

' Adjust table's properties so that columns are auto-sized:     

' 1) By default, table width is set to parent (page) width,     

' for auto-sizing we must change it to auto (so based on content):     

rt.Width = Unit.Auto     

' 2) Set ColumnSizingMode to Auto (default means Fixed for columns):     

rt.ColumnSizingMode = TableSizingModeEnum.Auto     

' That's it, now the table's columns will be auto-sized. 

 

' Turn table grid lines on to better see auto-sizing, add some padding:     

rt.Style.GridLines.All = LineDef.[Default]     

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderTable.html
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rt.CellStyle.Padding.All = "2mm" 

 

' Add the table to the document     

doc.Body.Children.Add(rt) 

 

' Add some data     

rt.Cells(0, 0).Text = "aaa"     

rt.Cells(0, 1).Text = "bbbbbbbbbb"     

rt.Cells(0, 2).Text = "cccccc"     

rt.Cells(1, 0).Text = "aaa aaa aaa"     

rt.Cells(1, 1).Text = "bbbbb"     

rt.Cells(1, 2).Text = "cccccc cccccc"     

rt.Cells(2, 2).Text = "zzzzzzzzzzzzzzz zz z" 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument();     

  

// Create a RenderTable object:     

 RenderTable rt = new RenderTable(); 

 

// adjust table's properties so that columns are auto-sized:     

// 1) By default, table width is set to parent (page) width,     

// for auto-sizing you must change it to auto (so based on content):     

rt.Width = Unit.Auto;     

// 2) Set ColumnSizingMode to Auto (default means Fixed for columns):     

rt.ColumnSizingMode = TableSizingModeEnum.Auto;     

// That's it, now the table's columns will be auto-sized. 

 

// Turn table grid lines on to better see auto-sizing, add some padding:     

rt.Style.GridLines.All = LineDef.Default;     

rt.CellStyle.Padding.All = "2mm"; 

 

// Add the table to the document     

doc.Body.Children.Add(rt); 

 

// Add some data     

rt.Cells[0, 0].Text = "aaa";     

rt.Cells[0, 1].Text = "bbbbbbbbbb";     
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rt.Cells[0, 2].Text = "cccccc";     

rt.Cells[1, 0].Text = "aaa aaa aaa";     

rt.Cells[1, 1].Text = "bbbbb";     

rt.Cells[1, 2].Text = "cccccc cccccc";     

rt.Cells[2, 2].Text = "zzzzzzzzzzzzzzz zz z"; 

For a complete example see the AutoSizeTable sample installed with Reports for WinForms. 

Tip 2: Using Parent/Ambient Parent Styles to Optimize Memory Usage 

When rendered, paragraphs and other C1PrintDocument objects have styles that can be 

modified "inline". For example, like this: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim RenderText rt As New RenderText("testing...")     

rt.Style.TextColor = Color.Red 

To write code in C# 

C# Copy Code  

 

RenderText rt = new RenderText("testing...");     

rt.Style.TextColor = Color.Red; 

This is fine for small documents or styles used just once in the whole document. For large 

documents and styles used throughout the document, it is much better to use parent styles 

using the following pattern: 

1. Identify the styles you will need. For instance, if you are building a code pretty printing 

application, you may need the following styles:  

o Default code style 

o Language keyword style 

o Comments style 

2. Add a child style to the document's root Style for each of the styles identified in step 1, 

like this for example:  

To write code in Visual Basic 

Visual Basic Copy Code  
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Dim doc As New C1PrintDocument()     

' Add and set up default code style:     

Dim sDefault As Style = doc.Style.Children.Add()     

sDefault.FontName = "Courier New"     

sDefault.FontSize = 10     

' Add and set up keyword style:     

Dim sKeyword As Style = doc.Style.Children.Add()     

sKeyword.FontName = "Courier New"     

sKeyword.FontSize = 10     

sKeyword.TextColor = Color.Blue     

' Add and set up comments style:     

Dim sComment As Style = doc.Style.Children.Add()     

sComment.FontName = "Courier New"     

sComment.FontSize = 10     

sComment.FontItalic = True     

sComment.TextColor = Color.Green 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument();     

// Add and set up default code style:     

Style sDefault = doc.Style.Children.Add();     

sDefault.FontName = "Courier New";     

sDefault.FontSize = 10;     

// Add and set up keyword style:     

Style sKeyword = doc.Style.Children.Add();     

sKeyword.FontName = "Courier New";     

sKeyword.FontSize = 10;     

sKeyword.TextColor = Color.Blue;     

// Add and set up comments style:     

Style sComment = doc.Style.Children.Add();     

sComment.FontName = "Courier New";     

sComment.FontSize = 10;     

sComment.FontItalic = true;     

sComment.TextColor = Color.Green; 

3. In your code, whenever you create a C1PrintDocument element representing a part of 

source code you're pretty printing, assign the corresponding style to the element style's 

Parent, for example:  
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To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim codeLine As New RenderParagraph()     

MessageBox.Show("Hello World!")     

' say hi to the world     

Dim p1 As New ParagraphText("MessageBox")     

p1.Style.AmbientParent = sKeyword     

codeLine.Content.Add(p1)     

Dim p2 As New ParagraphText(".Show(""Hello World!""); ")     

p2.Style.AmbientParent = sDefault     

codeLine.Content.Add(p2)     

Dim p3 As New ParagraphText("// say hi to the world")     

p3.Style.AmbientParent = sComment     

codeLine.Content.Add(p3)     

doc.Body.Children.Add(codeLine) 

To write code in C# 

C# Copy Code  

 

RenderParagraph codeLine = new RenderParagraph();     

MessageBox.Show("Hello World!");  

// say hi to the world     

ParagraphText p1 = new ParagraphText("MessageBox");     

p1.Style.AmbientParent = sKeyword;     

codeLine.Content.Add(p1);     

ParagraphText p2 = new ParagraphText(".Show(\"Hello World!\"); ");     

p2.Style.AmbientParent = sDefault;     

codeLine.Content.Add(p2);     

ParagraphText p3 = new ParagraphText("// say hi to the world");     

p3.Style.AmbientParent = sComment;     

codeLine.Content.Add(p3);     

doc.Body.Children.Add(codeLine); 

That's it, you're done. If you consistently assign your predefined styles to AmbientParent (or 

Parent, see below) properties of various document elements, your code will be more memory 

efficient (and more easily manageable). 

You may have noted that you assigned your predefined styles to the AmbientParent property 

of the elements' styles. Remember, in C1PrintDocument styles, ambient properties affect 
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content of elements, and by default propagate via elements hierarchies so nested objects 

inherit ambient style properties from their parents (unless a style's AmbientParent property is 

explicitly set). In contrast to that, non-ambient properties affect elements' "decorations" and 

propagate via styles own hierarchy determined by styles parents so for a non-ambient style 

property to affect a child object, its style's Parent property must be set. 

The usefulness of this distinction is best demonstrated by an example: suppose you have a 

RenderArea containing a number of RenderText objects. To draw a border around the whole 

render area you would set the area's Style.Borders. Because Borders is a non-ambient 

property, it will draw the border around the area but will not propagate to the nested text 

objects and will not draw borders around each text which is normally what you'd want. On the 

other hand, to set the font used to draw all texts within the area, you again would set the area's 

Style.Font. Because Font, unlike Borders, is an ambient property it will propagate to all nested 

text objects and affect them again usually achieving the desired result. So when you are not 

setting styles parent/ambient parent properties things normally "just work". But when you do 

use styles' parents you must take the distinction between ambient and non-ambient style 

properties into consideration. 

Note that for cases when you want to affect both ambient and non-ambient properties of an 

object, you may use the Style.Parents (note the plural) property it sets both Parent and 

AmbientParent properties on a style to the specified value. 

Tip 3: Using Expressions to Customize Page Headers 

Sometimes it is necessary to use a different page header for the first or last page of a 

document. While C1PrintDocument provides a special feature for that (see the PageLayouts 

note the plural property), for cases when the difference between the header on the first and 

subsequent pages is only in the header text, using an expression may be the best approach. For 

instance if you want to print "First page" as the first page's header and "Page x of y" for other 

pages, the following code may be used: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument()     

doc.PageLayout.PageHeader = New RenderText("[iif(PageNo=1, ""First page"", 

""Page "" & PageNo & "" of "" & PageCount)]") 

To write code in C# 

C# Copy Code  

 



 

 108 

C1PrintDocument doc = new C1PrintDocument();     

doc.PageLayout.PageHeader = new RenderText( "[iif(PageNo=1, \"First page\", 

\"Page \" & PageNo & \" of \" & PageCount)]"); 

In the string representing the expression in the code above, the whole expression is enclosed in 

square brackets - they indicate to the document rendering engine that what is inside should be 

treated as an expression (those are adjustable via TagOpenParen and TagCloseParen 

properties on the document). 

Whatever is inside those brackets should represent a valid expression in the current 

C1PrintDocument's script/expression language. By default it is VB.NET (but can be changed to 

C# see below), hence you use a VB.NET iif function to adjust your page header text depending 

on the page number. Here's the expression that is actually seen/executed by the document 

engine: 

iif(PageNo=1, "First page", "Page " & PageNo & " of " & PageCount)  

Because you must specify this expression as a C# or VB.NET string when assigning it to the page 

header text, you have to escape double quotes. Variables PageNo and PageCount are 

provided by the document engine (for a complete list of special variables accessible in different 

contexts in expressions, see the Expressions, Scripts, Tags topic). 

As was mentioned, the default expression/script language used by C1PrintDocument is VB.NET. 

But C# can also be used as the expression language. For that, the C1PrintDocument Language 

property must be set to C1.C1Preview.Scripting.ScriptLanguageEnum.CSharp. Using C# as 

the expression language, our example would look like this: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument()     

doc.ScriptingOptions.Language = 

C1.C1Preview.Scripting.ScriptLanguageEnum.CSharp     

doc.PageLayout.PageHeader = New RenderText("[PageNo==1 ? ""First page"" : 

""Page "" + PageNo + "" of "" + PageCount]") 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument();     

doc.ScriptingOptions.Language = 

C1.C1Preview.Scripting.ScriptLanguageEnum.CSharp;     
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doc.PageLayout.PageHeader = new RenderText("[PageNo==1 ? \"First page\" : 

\"Page \" + PageNo + \" of \" + PageCount]"); 

There were two changes: 

 Instead of VB.NET iif function, the C# conditional operator (:?) was used. 

 Instead of VB.NET's string concatenation operator (&), C#'s (+) was used. 

Note that expressions are real .NET language expressions, and all normally accessible features 

of the corresponding language may be used in expressions. For instance instead of string 

concatenation you could have used the string.Format method as follows: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

doc.PageLayout.PageHeader = New RenderText("[iif(PageNo=1, ""First page"", " 

& "string.Format(""Page {0} of {1}"", PageNo, PageCount))]") 

To write code in C# 

C# Copy Code  

 

doc.PageLayout.PageHeader = new RenderText("[iif(PageNo=1, \"First page\", " 

+ "string.Format(\"Page {0} of {1}\", PageNo, PageCount))]"); 

Tip 4: Data Binding and Expressions 

Databound render objects together with expressions are among the less known but extremely 

powerful C1PrintDocument features. In this example, you'll build a document with a render 

table data bound to a list of objects in memory. The list elements will represent Customer 

records with just two (for brevity) fields Name and Balance: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Public Class Customer     

    Private _name As String     

    Private _balance As Integer     

    Public Sub New(ByVal name As String, ByVal balance As Integer)     

        _name = name     
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        _balance = balance     

    End Sub     

    Public ReadOnly Property Name() As String     

        Get     

            Return _name     

        End Get     

    End Property     

    Public ReadOnly Property Balance() As Integer     

        Get     

            Return _balance     

        End Get     

    End Property     

End Class 

To write code in C# 

C# Copy Code  

 

public class Customer     

{     

  private string _name;     

  private int _balance;     

  public Customer(string name, int balance)     

  {     

    _name = name;     

    _balance = balance;     

  }     

  public string Name { get { return _name; } }     

  public int Balance { get { return _balance; } }     

} 

The following code can be used to create a list of customer records and fill it with some sample 

data: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' build sample list of customers     

Dim customers As New List(Of Customer)()    

Dim rnd As New Random(DateTime.Now.Second)     
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For i As Integer = 0 To 599     

    customers.Add(New Customer("Customer_" & (i + 1).ToString(), rnd.[Next](-

1000, 1000)))     

Next 

To write code in C# 

C# Copy Code  

 

// build sample list of customers     

List<Customer> customers = new List<Customer>();     

Random rnd = new Random(DateTime.Now.Second);     

  for (int i = 0; i < 600; i++)     

    customers.Add(new Customer("Customer_" + (i+1).ToString(), rnd.Next(-

1000, 1000))); 

Note that the Balance field's value ranges from -1000 to 1000 so the field allows negative 

values. This will be used to demonstrate a new C1PrintDocument feature, style expressions, 

below. 

The following code prints the list created above as a RenderTable in a C1PrintDocument: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument()     

Dim rt As New RenderTable()     

' Define data binding on table rows:      

rt.RowGroups(0, 1).DataBinding.DataSource = customers     

' Bind column 0 to Name:     

rt.Cells(0, 0).Text = "[Fields!Name.Value]"     

' Bind column 1 to Balance:     

rt.Cells(0, 1).Text = "[Fields(""Balance"").Value]"     

' Add the table to the document:     

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  
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C1PrintDocument doc = new C1PrintDocument();     

RenderTable rt = new RenderTable();     

// Define data binding on table rows:      

rt.RowGroups[0, 1].DataBinding.DataSource = customers;     

// Bind column 0 to Name:     

rt.Cells[0, 0].Text = "[Fields!Name.Value]";     

// Bind column 1 to Balance:     

rt.Cells[0, 1].Text = "[Fields(\"Balance\").Value]";     

// Add the table to the document:     

doc.Body.Children.Add(rt); 

Databinding is achieved with just 3 lines of code. The first line defines a row group on the table, 

starting at row 0 and including just that one row: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Define data binding on table rows:      

rt.RowGroups(0, 1).DataBinding.DataSource = customers) 

To write code in C# 

C# Copy Code  

 

// Define data binding on table rows:      

rt.RowGroups[0, 1].DataBinding.DataSource = customers; 

The other two lines show two syntactically different but equivalent ways of binding a table cell 

to a data field: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Bind column 0 to Name:     

rt.Cells(0, 0).Text = "[Fields!Name.Value]"     

' Bind column 1 to Balance:     

rt.Cells(0, 1).Text = "[Fields(""Balance"").Value]" 

To write code in C# 
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C# Copy Code  

 

// Bind column 0 to Name:     

rt.Cells[0, 0].Text = "[Fields!Name.Value]";     

// Bind column 1 to Balance:     

rt.Cells[0, 1].Text = "[Fields(\"Balance\").Value]"; 

As noted, the "Fields!Name" notation is just syntactic sugar for referencing the element called 

Name in the Fields array, and allows to avoid the need to use escaped double quotes. 

Now, remember that the Balance field in the sample data set can be positive or negative. The 

following line will make all negative Balance values appear red colored in the document: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

rt.Cells(0, 1).Style.TextColorExpr = "iif(Fields!Balance.Value < 0, 

Color.Red, Color.Blue)" 

To write code in C# 

C# Copy Code  

 

rt.Cells[0, 1].Style.TextColorExpr = "iif(Fields!Balance.Value < 0, 

Color.Red, Color.Blue)"; 

This demonstrates a new C1PrintDocument feature style expressions. Starting with 2009 v3 

release, all style properties have matching expression properties (ending in "Expr"), which allow 

you to define an expression that would be used at run time to calculate the effective 

corresponding style property. While this feature is independent of data binding, it can be 

especially useful in data bound documents as shown here. 

Style expressions allow the use of predefined C1PrintDocument tags related to pagination. For 

instance, the following code may be used to print a render object ro on red background if it 

appears on page with number greater than 10 and on green background otherwise: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

ro.Style.BackColorExpr = "[iif(PageNo > 10, Color.Red, Color.Green)]" 



 

 114 

To write code in C# 

C# Copy Code  

 

ro.Style.BackColorExpr = "[iif(PageNo > 10, Color.Red, Color.Green)]"; 

Finally, it should be noted that while VB.NET is the default expression language in 

C1PrintDocument, C# can be used instead if the Language property is set on the document: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

doc.ScriptingOptions.Language = 

C1.C1Preview.Scripting.ScriptLanguageEnum.CSharp 

To write code in C# 

C# Copy Code  

 

doc.ScriptingOptions.Language = 

C1.C1Preview.Scripting.ScriptLanguageEnum.CSharp; 

With this in mind, our current sample may be rewritten as follows: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument()     

doc.ScriptingOptions.Language = 

C1.C1Preview.Scripting.ScriptLanguageEnum.CSharp     

Dim rt As New RenderTable()     

' Define data binding on table rows:      

rt.RowGroups(0, 1).DataBinding.DataSource = customers     

' Bind column 0 to Name:     

rt.Cells(0, 0).Text = " [Fields[""Name""].Value]"     

' Bind column 1 to Balance:     

rt.Cells(0, 1).Text = " [Fields[""Balance""].Value]"     

rt.Cells(0, 1).Style.TextColorExpr = "(int)(Fields[""Balance""].Value) < 0 ? 

Color.Red : Color.Blue"     
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' Add the table to the document:     

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument();     

doc.ScriptingOptions.Language = 

C1.C1Preview.Scripting.ScriptLanguageEnum.CSharp;     

RenderTable rt = new RenderTable();     

// Define data binding on table rows:      

rt.RowGroups[0, 1].DataBinding.DataSource = customers;     

// Bind column 0 to Name:     

rt.Cells[0, 0].Text = " [Fields[\"Name\"].Value]";     

// Bind column 1 to Balance:     

rt.Cells[0, 1].Text = " [Fields[\"Balance\"].Value]";     

rt.Cells[0, 1].Style.TextColorExpr = "(int)(Fields[\"Balance\"].Value) < 0 ? 

Color.Red : Color.Blue";     

// Add the table to the document:     

doc.Body.Children.Add(rt); 

Note the following as compared to code that used VB.NET as expressions/scripting language: 

 The use of square brackets as C1PrintDocument's open/close tag parentheses 

(adjustable via TagOpenParen and TagCloseParen properties) does not conflict with 

their C# use for array indexing within the expressions because after seeing the first 

opening bracket, C1PrintDocument tries to find a matching closing one. 

 Because a field's Value property is of type object, we need to cast it to an int for the 

conditional expression to work correctly (VB.NET does that automatically). 

 The "Fields!Name" notation cannot be used as it is purely a VB.NET feature. 

Tip 5: Customizing Databound Table Columns 

In C1PrintDocument's tables, you can have data bound columns rather than rows. Consider our 

example from previous section it only takes a few changes to make the data bound table 

expand horizontally rather than vertically. Here'[s the code rewritten to show customer's name 

in the first row of the table, customer's balance in the second row, with each column 

corresponding to a customer entry: 

To write code in Visual Basic 

Visual Basic Copy Code  
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Dim doc As New C1PrintDocument()     

Dim rt As New RenderTable()     

' Next 3 lines set table up for horizontal expansion:     

rt.Width = Unit.Auto     

rt.ColumnSizingMode = TableSizingModeEnum.Auto     

rt.SplitHorzBehavior = SplitBehaviorEnum.SplitIfNeeded     

' Define data binding on table columns:     

rt.ColGroups(0, 1).DataBinding.DataSource = customers     

' Bind column 0 to Name:     

rt.Cells(0, 0).Text = "[Fields!Name.Value]"     

' Bind column 1 to Balance:     

rt.Cells(1, 1).Text = "[Fields(""Balance"").Value]"     

' Print negative values in red, positive in blue:     

rt.Cells(0, 1).Style.TextColorExpr = "iif(Fields!Balance.Value < 0, 

Color.Red, Color.Blue)"     

' Add the table to the document:     

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument();     

RenderTable rt = new RenderTable();     

// Next 3 lines set table up for horizontal expansion:     

rt.Width = Unit.Auto;     

rt.ColumnSizingMode = TableSizingModeEnum.Auto;     

rt.SplitHorzBehavior = SplitBehaviorEnum.SplitIfNeeded;     

// Define data binding on table columns:      

rt.ColGroups[0, 1].DataBinding.DataSource = customers;     

// Bind column 0 to Name:     

rt.Cells[0, 0].Text = "[Fields!Name.Value]";     

// Bind column 1 to Balance:    

rt.Cells[1, 1].Text = "[Fields(\"Balance\").Value]";     

// Print negative values in red, positive in blue:     

rt.Cells[0, 1].Style.TextColorExpr = "iif(Fields!Balance.Value < 0, 

Color.Red, Color.Blue)";     

// Add the table to the document:     

doc.Body.Children.Add(rt); 

Note the following changes: 
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 The three lines of code following the comment starting with "next 3 lines" ensure that 

the table's width is based on the sum of columns widths, that the columnswidth are 

based on their content, and that the table is allowed to split horizontally if it becomes 

too wide to fit on a single page. 

 Aside from that, all other changes are basically the result of swapping rows and 

columns. 

Tip 6: Including WinForms controls in a document 

It is easy to include a snapshot of a WinForms control from your application in a document that 

is generated. To do that, use a RenderImage object and its Control property. For instance if 

your form contains a button button1, this code will include a snapshot of that button within a 

document: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument()     

Dim ri As New RenderImage()     

ri.Control = Me.button1     

doc.Body.Children.Add(ri) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument();     

RenderImage ri = new RenderImage();     

ri.Control = this.button1;     

doc.Body.Children.Add(ri); 

 

C1Report Tips 
Reports for WinForms Top Tips > C1Report Tips 

Show All  

Hide All  

The following tips relate to the C1Report component. 

Tip 1: Converting Microsoft Access Reports 
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One of the most powerful features of the C1ReportDesigner application is the ability to import 

reports created with Microsoft Access. To import reports from an Access file, click the 

Application button and select Import from the menu. In the dialog box, select a Microsoft 

Access file (MDB or ADP) and reports. 

Note that you must have Access installed on the computer to convert an Access report. Once 

the report is imported into the Designer, Access is no longer required. For details and more 

information, see Importing Microsoft Access Reports. 

Tip 2: Styling Your Reports 

You can use the Style Gallery in the C1ReportDesigner application to style your report using 

one of over 30 built-in styles. You can also create your own custom report styles. Built-in styles 

include standard Microsoft AutoFormat themes, including Vista and Office 2007 themes. You 

can access the Style Gallery from the C1ReportDesigner application by selecting the Arrange 

tab and clicking Styles. For details see Style Gallery. 

Tip 3: Using Script Expressions 

Expressions are widely used throughout a report definition to retrieve, calculate, display, group, 

sort, filter, parameterize, and format the contents of a report. Some expressions are created for 

you automatically (for example, when you drag a field from the Toolbox onto a section of your 

report, an expression that retrieves the value of that field is displayed in the text box). However, 

in most cases, you create your own expressions to provide more functionality to your report. 

For more information about taking advantage of script expressions, see Creating VBScript 

Expressions, Working with VBScript, and Expressions, Scripts, Tags. 

Tip 4: Creating Subreports 

A subreport is a report that is inserted in another report. Subreports are useful when you want 

to combine several reports into one. For example, you may have a main report that integrates 

several subreports into a single main report. Or you can use the main report to show detailed 

information and use subreports to show summary data at the beginning of each group. For 

information about subreports, see the Subreport property in the reference section, and for an 

example see Creating a Master-Detail Report Using Subreports. 

Tip 5: Understanding Reports and Report Definitions 

Reports are based on a report definition, an XML file that describes data and layout. Reports 

for WinForms creates the report definition for you when you add a report item to a project and 

define the report layout. When report execution is triggered (for example, you provide a button 

that the user clicks to view a report), the C1Report control retrieves data using the data 

bindings you have defined and merges the result set into the report layout. The report is 

presented in the native output format for the control you are using. 

You can load report definitions at design time or run time, from XML files, strings, or you can 

create and customize report definitions dynamically using code. 
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Tip 6: CustomFields and Chart/Reports Version 

You can include a chart in a report by adding the C1Chart object to C1Report's custom field. 

This method is demonstrated in detail in the CustomFields sample installed with Reports for 

WinForms. Along with the sample, a pre-built CustomFields assembly just as can be built with 

that sample is shipped, together with several other DLLs (such as the C1Chart assembly) as part 

of the C1ReportDesigner application installed by default in the C1Report/Designer folder in 

the WinForms Edition installation directory. 

You may be tempted to just add a reference to that prebuilt C1.C1Report.CustomFields.2.dll 

(or C1.C1Report.CustomFields.4.dll) file to your own project when including a chart in a report 

in a C1Report-based application. While this may work initially, it may cause unexpected 

problems later. The binary CustomFields assembly shipped with the C1ReportDesigner 

application is built with references to specific versions of C1Report and C1Chart located in the 

C1ReportDesigner application's subfolder. When you install WinForms Edition you will have 

the same versions of the reports and chart products as the components you may use in your 

own application development. But if you later update just one assembly, for example just 

C1Chart, the prebuilt CustomFields in your application will suddenly no longer work since it 

will be referencing an outdated C1Chart assembly after upgrading the chart. 

For that reason it is much better and a best practice to add the actual CustomFields project 

(together with the source code) from the corresponding sample (available in both VB.NET and 

C# variants) to your own solution, and reference that project instead of the prebuilt binary 

CustomFields assembly. Then upgrading any of the involved ComponentOne products will not 

break your application. 

Tip 7: Adding a Custom Outline Entry for Each Data Record 

Outline entries are automatically generated for group headers in C1Report; the 

AddOutlineEntry event allows customizing the text of those entries. To associate a customized 

outline entry with each record of a report that otherwise is not using groups, follow the 

following steps: 

1. Create a group that will always contain exactly one record. The easiest way to do that is 

to group records by a key field. 

2. On that group, create a group header with the minimal height of 1 twip so that it won't 

show in the report. The AddOutlineEntry event will be fired for each instance of that 

group. 

3. Attach a handler to the AddOutlineEntry event to customize the entry's text by 

modifying the Text property on the ReportEventArgs passed to the handler. 

This will associate a customized outline entry with each record of a report that otherwise is not 

using groups. 

Tip 8: Printing Two Subreports Side by Side 

While it is possible to create a report definition with two subreports arranged side by side on a 

page, generally speaking the C1Report component cannot properly render such subreports if 
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they take up more than one page and page breaks are involved. Sometimes though, it is 

possible to render such reports correctly by importing the report definition into a 

C1PrintDocument component and rendering that instead. For example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument()     

doc.ImportC1Report("myReportFile.xml", "myReportName")     

doc.Generate() 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument();     

doc.ImportC1Report("myReportFile.xml", "myReportName");     

doc.Generate(); 

See Generating Reports (C1Report vs. C1PrintDocument) and Deciding on Report Generation 

Method for details concerning advantages and limitations of importing reports into a 

C1PrintDocument instead of using C1Report directly. 

Tip 9: Passing Parameters from the Main Report into a Subreport 

To pass parameters from the main report to a subreport set the ExposeScriptObjects property 

to True in the main report. When you do so, all fields of the main report will become visible in 

the subreport. 

So, for instance, if you took the CommonTasks.xml report shipped with the Reports for 

WinForms samples, and in report "14: Page Headers in Subreports", set ExposeScriptObjects to 

True, you can use the CategoryName (defined in the main report but not in the subreport) in 

the subreport's fields. 

Tip 10: Linking a Subreport to a Report Using Multiple Fields 

Normally when a subreport is used to print part of a report the linkage between the report and 

the subreport is maintained via the Text property of the field containing the subreport, 

somewhat like the following example: 

"SubReportLookupField = \" & ReportKeyField & \""  

At run time that expression is calculated, yielding something similar to the following: 

SubReportLookupField = "1"  
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The result is used as a filter for the subreport's data source (RowFilter property). 

The interesting thing here is that the initial expression may be more complex and may 

references to several fields. For instance, suppose the main report has DateTime type fields 

StartTime and EndTime, while the subreport has an OpenTime field, also of the DateTime 

type. Suppose the subreport must show only those records for which the following condition is 

true: 

OpenTime >= StartTime and OpenTime <= EndTime  

In that case the following string may be used as the subreport filter (all on a single line): 

"OpenTime >= #" & Format(StartTime, \"MM/dd/yyyy\") & "# and OpenTime 

<= #" & Format(EndTime, \"MM/dd/yyyy\") & "#"  

The Format function is used here to format DateTime values using InvariantCulture, as that is 

the format that should be used for the RowFilter. 

Visual Previewing Control Tips 
Reports for WinForms Top Tips > Visual Previewing Control Tips 

Show All  

Hide All  

The following tips relate to the visual previewing controls included in Reports for WinForms 

(such as C1PrintPreviewControl, C1PrintPreviewDialog, C1PreviewPane, 

C1PreviewThumbnailView, C1PreviewOutlineView, and C1PreviewTextSearchPanel). 

Tip 1: Adding a Custom Toolbar Button to C1PrintPreviewControl 

You may want to customize a toolbar in the C1PrintPreviewControl control by adding a custom 

button. To add your own toolbar button to any of the built-in toolbars on the 

C1PrintPreviewControl, add a C1PrintPreviewControl to the form, and complete the following 

steps: 

1. Click once on the C1PrintPreview control on the form to select it, and navigate to the 

Properties window. 

2. In the Properties window, locate and expand the Toolbars top-level property by 

clicking on the plus sign (+) to the left of the item. You should see the list of predefined 

preview toolbars: File, Navigation, Page, Text, and Zoom. 

3. Select and expand the toolbar, for instance File, that will contain the new item. The 

expanded list should show the predefined File buttons: Open, PageSetup, Print, 

Reflow, Save, and a ToolStrip expandable item. 

4. Select and expand the ToolStrip item. The expanded list should contain a single Items 

collection node. 

5. Select the Items node and click on the ellipses (...) button to the right of the item. The 

items collection editor dialog box containing the predefined items will be displayed. 
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6. Add a new button using the collection dialog box's commands, adjust its properties as 

needed, note the name of the button, and press OK to close the dialog box and save 

the changes. Now you should see the newly added button in the designer view. 

7. Select the newly added button in the Properties window (you can do this by either 

clicking on the button in the designer view, or by selecting the button by its name from 

the Properties window's drop-down list). 

Once you have added the toolbar button, you can customize its actions. You can now add a 

Click event handler to the button or further customize its properties. 

Tip 2: Change the Default Toolbar Button Processing 

To change the default processing of a built-in toolbar button on a C1PrintPreviewControl, you 

need to handle the preview pane's UserAction event. 

Add a C1PrintPreviewControl to the form, and complete the following steps: 

1. Click on the preview pane within that control (the main area showing the pages of the 

viewed document) in the Visual Studio designer. 

2. This will select the C1PreviewPane within the preview control into the properties 

window. For example, if your preview control has the name c1PrintPreviewControl1, 

the selected object's name should become c1PrintPreviewControl1.PreviewPane. 

3. Click the lightning bolt icon in the Properties window to view Events, scroll to the 

UserAction event item, and double click the item to create an event handler. 

4. You can customize the default processing of a built-in toolbar button in the UserAction 

event handler. 

The handler receives an instance of UserActionEventArgs which contains two interesting 

properties: PreviewAction and Cancel. PreviewAction is an enum listing all supported user 

events, such as file open, print, and so on. Testing that property you may find the action you're 

interested in. The other important property of UserActionEventArgs is Cancel - if you add your 

own processing to an action and want to omit the standard processing, set 

UserActionEventArgs.Cancel to True, otherwise standard processing will take place after your 

event handler returns. 

Tip 3: Using Preview Pane's PropertyChanged Event 

To monitor interesting preview related properties, use the PropertyChanged event on the 

C1PreviewPane object within the C1PrintPreviewControl. All of the preview pane's own 

properties (not inherited from its base control) fire the PropertyChanged event when their 

values change. 

For instance, the following code will add a handler to the PropertyChanged event provided that 

your form includes a C1PrintPreviewControl named c1PreviewControl1: 

To write code in Visual Basic 

Visual Basic Copy Code  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewPane.html
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AddHandler Me.C1PrintPreviewControl1.PreviewPane.PropertyChanged, AddressOf 

PreviewPane_PropertyChanged 

To write code in C# 

C# Copy Code  

this.c1PrintPreviewControl1.PreviewPane.PropertyChanged += new 

PropertyChangedEventHandler(PreviewPane_PropertyChanged); 

The following property changed event handler will print a debug line each time the current 

page changes in the preview for whatever reason: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub PreviewPane_PropertyChanged(ByVal sender As Object, ByVal e As 

PropertyChangedEventArgs)     

    If e.PropertyName = "StartPageIdx" Then     

        Debug.WriteLine("Current page changed to " & 

Me.c1PrintPreviewControl1.PreviewPane.StartPageIdx.ToString())     

    End If     

End Sub 

To write code in C# 

C# Copy Code  

 

void PreviewPane_PropertyChanged(object sender, PropertyChangedEventArgs e)     

{     

  if (e.PropertyName == "StartPageIdx")     

    Debug.WriteLine("Current page changed to " + 

this.c1PrintPreviewControl1.PreviewPane.StartPageIdx.ToString());     

} 
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C1ReportScheduler Tips 
Reports for WinForms Top Tips > C1ReportScheduler Tips 

The following tips relate to the C1ReportScheduler application. 

Tip 1: Using C1ReportScheduler in Client mode. 

When scheduling a report in client mode using C1ReportScheduler, you may get an an error 

saying it the XML is not found. That's because the XMLl file is accesses from the mapped drive. 

Standalone mode is able to run successfully because in standalone mode the local user account 

is used by the C1ReportsScheduler service which can easily access the network locations. But 

when the mode is switched to client mode the network locations are not accesses because the 

service account used to access the file might not have the right to access the network location. 

In order to remove the problem you'll need to do following: 

1. Open services.msc by typing "services.msc" in run prompt. 

2. Open the C1ReportsScheduler service properties and change its account to either 

local account or any domain account which has the rights to access the network 

locations such as the location of mapped drive (N:). 

3. Restart the C1ReportsScheduler service. 

4. Now in the C1ReportsScheduler window change the file path to actual network 

location instead of map drive path. For example change "N:\SecurityExpirations.xml" to 

the actual network path, such as "\\srv1\\SecurityExpirations.xml ". 

The error should not occur after this. 

Design-Time Support 
You can easily configure Reports for WinForms at design time using the property grid, menus, 

and designers in Visual Studio. The following sections describe how to use Reports for 

WinForms' design-time environment to configure the Reports for WinForms controls. 

See Also 

C1Report Tasks Menu 

C1Report Context Menu 

C1RdlReport Tasks Menu 

C1RdlReport Context Menu 

C1MultiDocument Tasks Menu 

C1MultiDocument Context Menu 
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C1PrintPreviewControl Tasks Menu 

Smart Designers 

Localization 

C1Report Tasks Menu 
Design-Time Support > C1Report Tasks Menu 

In Visual Studio, the C1Report component includes a smart tag. A smart tag represents a short-

cut tasks menu that provides the most commonly used properties. 

The C1Report component provides quick and easy access to the C1Report Wizard (for reports 

definitions that have not been created) or the C1ReportDesigner (for report definitions that 

already exist in the project), as well as loads reports through its smart tag. 

To access the C1Report Tasks menu, click the smart tag ( ) in the upper-right corner of the 

C1Report component. 

 

The C1Report Tasks menu operates as follows: 

 Load Report 

Clicking Load Report opens the Select a report dialog box. See the Loading a Report 

Definition from a File topic for more information about the Select a report dialog box 

and loading a report. 

 Edit Report 

Clicking Edit Report opens the C1Report Wizard if you have not already created a 

report definition or the C1ReportDesigner if you have already created a report. 

For more information on using the C1Report Wizard, see Step 1 of 4: Creating a 

Report Definition. For details on using the C1ReportDesigner, see Working with 

C1ReportDesigner. 

 

Note: If the Edit Report command doesn't appear on the Tasks menu and Properties 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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window, it is probably because the control could not find the C1ReportDesigner 

application. To fix this, simply run the C1ReportDesigner application once in stand-alone 

mode. The designer will save its location to the registry, and the C1Report component 

should be able to find it afterwards. 

 Viewers for this document 

If any visual previewing controls - such as C1PrintPreviewControl control - are included 

in the application, the C1Report Tasks Menu will display them here. When the check 

box next to the name of a previewing control is checked, the C1Report control is 

associated with the previewing control and reports will appear in the previewing 

control. 

 Localize 

Clicking Localize opens the Localize dialog box. In the Localize dialog box, you can 

customize your localization settings. For more information on the Localize dialog box, 

see Localization. 

 About 

Clicking About displays the About dialog box, which is helpful in finding the version 

number of Reports for WinForms, as well as online resources. 

C1Report Context Menu 
Design-Time Support > C1Report Context Menu 

You can also access the C1Report Wizard or the C1ReportDesigner, as well as load a report 

by using the C1Report component's context menu. 

To access C1Report control's context menu, right-click the C1Report component. The context 

menu appears: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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The C1Report context menu operates as follows: 

 Load Report 

Clicking Load Report opens the Select a report dialog box. See the Loading a Report 

Definition from a File topic for more information about the Select a report dialog box 

and loading a report. 

 Edit Report 

Clicking Edit Report opens the C1Report Wizard if you have not already created a 

report definition or the C1ReportDesigner if you have already created a report. 

For more information on using the C1Report Wizard, see Step 1 of 4: Creating a 

Report Definition. For details on using the C1ReportDesigner, see Working with 

C1ReportDesigner. 

 

Note: If the Edit Report command doesn't appear on the context menu and Properties 

window, it is probably because the control could not find the C1ReportDesigner 

application. To fix this, simply run the C1ReportDesigner application once in stand-alone 

mode. The designer will save its location to the registry, and the C1Report component 

should be able to find it afterwards. 

 Localize 

Clicking Localize opens the Localize dialog box. In the Localize dialog box, you can 

customize your localization settings. For more information on the Localize dialog box, 

see Localization. 

 About 
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Clicking About displays the About dialog box, which is helpful in finding the version 

number of Reports for WinForms, as well as online resources. 

C1RdlReport Tasks Menu 
Design-Time Support > C1RdlReport Tasks Menu 

In Visual Studio, the C1RdlReport component includes a smart tag. A smart tag represents a 

short-cut tasks menu that provides the most commonly used properties. 

To access the C1RdlReport Tasks menu, click the smart tag ( ) in the upper-right corner of the 

C1RdlReport component. 

 

The C1RdlReport Tasks menu operates as follows: 

 Load Report 

Clicking Load Report opens the Open dialog box which allows you to select an RDL file 

to load into the C1RdlReport component. 

 Clear 

Clicking Clear clears any report definition that is currently loaded. After clicking this 

option, you will see a dialog box asking you to confirm clearing the loaded report 

definition. In the dialog box, click Yes to continue and No to not clear the report 

definition. 

 Viewers for this document 

If any visual previewing controls such as C1PrintPreviewControl control are included in 

the application, the C1RdlReport Tasks Menu will display them here. When the check 

box next to the name of a previewing control is checked, the C1RdlReport control is 

associated with the previewing control and reports will appear in the previewing 

control. 

 Localize 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Rdl.Rdl2008.C1RdlReport.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
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Clicking Localize opens the Localize dialog box. In the Localize dialog box, you can 

customize your localization settings. For more information on the Localize dialog box, 

see Localization. 

 About 

Clicking About displays the About dialog box, which is helpful in finding the version 

number of Reports for WinForms, as well as online resources. 

C1RdlReport Context Menu 
Design-Time Support > C1RdlReport Context Menu 

To access the C1RdlReport control's context menu, right-click the C1RdlReport component. The 

context menu will appear. 

 

The C1RdlReport context menu operates as follows: 

 Load Report 

Clicking Load Report opens the Open dialog box which allows you to select an RDL file 

to load into the C1RdlReport component. 

 Clear 

Clicking Clear clears any report definition that is currently loaded. After clicking this 

option, you will see a dialog box asking you to confirm clearing the loaded report 

definition. In the dialog box, click Yes to continue and No to cancel clearing the report 

definition. 

 Localize 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Rdl.Rdl2008.C1RdlReport.html
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Clicking Localize opens the Localize dialog box. In the Localize dialog box, you can 

customize your localization settings. For more information on the Localize dialog box, 

see Localization. 

 About 

Clicking About displays the About dialog box, which is helpful in finding the version 

number of Reports for WinForms, as well as online resources. 

C1MultiDocument Tasks Menu 
Design-Time Support > C1MultiDocument Tasks Menu 

In Visual Studio, the C1MultiDocument component includes a smart tag. A smart tag represents 

a short-cut tasks menu that provides the most commonly used properties. 

To access the C1MultiDocument Tasks menu, click the smart tag ( ) in the upper-right corner 

of the C1MultiDocument component. 

 

The C1MultiDocument Tasks menu operates as follows: 

 Viewers for this document 

If any visual previewing controls such as C1PrintPreviewControl control are included in 

the application, the C1MultiDocument Tasks Menu will display them here. When the 

check box next to the name of a previewing control is checked, the C1MultiDocument 

component is associated with the previewing control and reports will appear in the 

previewing control. 

 Localize 

Clicking Localize opens the Localize dialog box. In the Localize dialog box, you can 

customize your localization settings. For more information on the Localize dialog box, 

see Localization. 

 About 

Clicking About displays the About dialog box, which is helpful in finding the version 

number of Reports for WinForms, as well as online resources. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html


 

 131 

C1MultiDocument Context Menu 
Design-Time Support > C1MultiDocument Context Menu 

To access the C1MultiDocument component's context menu, right-click the C1MultiDocument 

component. The context menu will appear. 

 

The C1MultiDocument context menu operates as follows: 

 Localize 

Clicking Localize opens the Localize dialog box. In the Localize dialog box, you can 

customize your localization settings. For more information on the Localize dialog box, 

see Localization. 

 About 

Clicking About displays the About dialog box, which is helpful in finding the version 

number of Reports for WinForms, as well as online resources. 

C1PrintPreviewControl Tasks Menu 
Design-Time Support > C1PrintPreviewControl Tasks Menu 

In the C1PrintPreviewControl Tasks menu, you can quickly and easily dock the 

C1PrintPreviewControl in the parent container, enable the Smart Designer, and access the 

Localize dialog box. 

To access the C1PrintPreviewControl Tasks menu, click the smart tag ( ) in the upper right 

corner of the control. This will open the C1PrintPreviewControl Tasks menu. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
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The C1PrintPreviewControl Tasks menu operates as follows: 

 Dock in parent container/Undock in parent container 

Clicking Dock in parent container sets the Dock property for C1PrintPreviewControl to 

Fill. 

If C1PrintPreviewControl is docked in the parent container, the option to undock 

C1PrintPreviewControl from the parent container will be available. Clicking Undock in 

parent container sets the Dock property for C1PrintPreviewControl to None. 

 Enable Smart Designer 

Selecting the Enable Smart Designer check box activates the Smart Designer on the 

C1PrintPreviewControl for greater design time interaction. By default the Enable 

Smart Designer check box is checked and the smart designer is enabled. For more 

information on the Smart Designer, see Smart Designers. 

 Localize 

Clicking Localize opens the Localize dialog box. In the Localize dialog box, you can 

customize your localization settings. For more information on the Localize dialog box, 

see Localization. 

 About 

Clicking About displays the control's About dialog box, which is helpful in finding the 

build number of the control. 

Smart Designers 
Design-Time Support > Smart Designers 

Reports for WinForms features a Smart Designer to enhance design-time interaction. Using 

the Smart Designer, you can set properties directly on the form. When the mouse is over an 

item in the form, a floating toolbar will appear, as well as a tab at the lower left side of the form 

indicating what item the mouse is over. 
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Items that do not have a floating toolbar associated with them will provide directions on how to 

customize that item directly on the form. 

 

The Smart Designer consists of the following floating toolbars: 

Toolbar Description 

 

Main Menu: The Main 

Menu floating toolbar 

allows you to select 

preset toolbar images, 

hide or show preview 

control panels, hide or 

show toolbars, set 

printing options, set 

preview pane tooltips, set 

export options, and 

localize preview. 

 

ToolStrip: The ToolStrip 

floating toolbar allows 
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Toolbar Description 

you to edit text-related 

properties, images and 

background images, item 

colors, item layout, and 

other properties. 

 

Thumbnails: The 

Thumbnails floating 

toolbar allows you to 

control the appearance 

and behavior of the 

Thumbnail view in the 

Navigation panel. 

 

Outline: The Outline 

floating toolbar allows 

you to control the 

appearance and behavior 

of the Outline view in the 

Navigation panel. 

 

Rulers: The Rulers 

floating toolbar allows 

you to enable or disable 

the horizontal and 

vertical rulers. 

 

Preview Pane 

Appearance: The Preview 

Pane Appearance floating 

toolbar allows you to set 

the padding, colors, and 

border style of the 

preview pane. 
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Toolbar Description 

 

Margins: The Margins 

floating toolbar allow you 

to hide or show the 

document page margins. 

 

Preview Pane: The 

Preview Pane floating 

toolbar allows you to 

control the preview pane 

layout, zoom, and 

behavior settings. 

 

Text Search Panel: The 

Text Search Panel 

floating toolbar allows 

you to control the 

appearance and behavior 

of the Text Search Panel. 

See Also 

Main Menu Floating Toolbar 

ToolStrip Floating Toolbar 

Thumbnails Floating Toolbar 

Outline Floating Toolbar 

Rulers Floating Toolbar 

Preview Pane Appearance Floating Toolbar 

Margins Floating Toolbar 

Preview Pane Floating Toolbar 

Text Seach Panel Floating Toolbar 
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Main Menu Floating Toolbar 
Design-Time Support > Smart Designers > Main Menu Floating Toolbar 

The Main Menu is the only floating toolbar that will appear on the form regardless of the item 

the mouse is positioned over. The main menu can be displayed by clicking the button that 

appears in the upper left corner of the form. 

 

To close the main menu, click the button. 

 

The main menu consists of the following toolbar buttons: 

Button Description 

 

Toolbar Images: Select from preset toolbar 

images. 

 

Layout: Hide or show preview control panels. 

 

Toolbar Buttons: Hide or show toolbars. 

 

Printing: Set printing options. 

 

Tooltips: Set preview pane tooltips. 

 

Export: Set export options. 

 

Localize: Localize preview. 

Each button will open a dialog box where you can customize the settings on the form. 
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Note: If you change the settings in the dialog box the Reset properties to default link will 

appear. Clicking this link will reset all of the properties to the default setting. 

Toolbar Images 

Clicking the Toolbar Images button opens the Toolbar Images dialog box where you can 

select from preset toolbar images. The default preset is XP. 

 

Layout 

Clicking the Layout button opens the Layout dialog box where you can hide or show the 

preview control panels. The default is checked for Toolbars, Navigation panel, and Status bar. 

 

Toolbar Buttons 

Clicking the Toolbar Buttons button opens the Toolbar Buttons dialog box where you can 

hide or show toolbars and buttons. The default is checked for all toolbars and buttons. 
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Printing 

Clicking the Printing button opens the Printing dialog box where you can set printing options. 

Below are the default settings. 

 

Tooltips 

Clicking the Tooltips button opens the Tooltips dialog box where you can customize the 

settings for the preview pane tooltips. Below are the default settings. 
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Export 

Clicking the Export button opens the Export dialog box where you can set export options. The 

default is checked for all formats. 

 

Localize 
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Clicking the Localize button opens the Localize dialog box. In the Localize dialog box, you can 

customize your localization settings. 

 

For more information on the Localize dialog box, see Localization. 

ToolStrip Floating Toolbar 
Design-Time Support > Smart Designers > ToolStrip Floating Toolbar 

The ToolStrip floating toolbar will appear for each item on the toolstrip and consists of the 

following buttons: 

Button Description 

 

Text: Edit text-related properties. 

 

Image: Edit image and background 

image. 

 

Color: Edit item colors. 

 

Layout: Edit item layout. 

 

Properties: Edit other properties. 
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Each button will open a dialog box where you can customize the settings on the form. 

 

Note: If you change the settings in the dialog box the Reset properties to default link will 

appear. Clicking this link will reset all of the properties to the default setting. 

Text 

Clicking the Text button opens the Text dialog box where you can edit text-related properties 

for that toolbar item. 

 

Image 

Clicking the Image button opens the Image dialog box where you can edit the image and 

background image for that toolbar item. 
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Color 

Clicking the Color button opens the Color dialog box where you can edit the colors for that 

toolbar item. 

 

Layout 

Clicking the Layout button opens the Layout dialog box where you can edit the layout for that 

toolbar item. 

 

Properties 

Clicking the Properties button opens the Properties dialog box where you can edit other 

properties for that toolbar item. 
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Thumbnails Floating Toolbar 
Design-Time Support > Smart Designers > Thumbnails Floating Toolbar 

The Thumbnails floating toolbar will appear when the mouse is over the Thumbnail view in the 

Navigation panel. 

Button Description 

 

Appearance: Edit the Thumbnail view appearance. 

 

Behavior: Edit the Thumbnail view behavior. 

Each button will open a dialog box where you can customize the settings on the form. 

 

Note: If you change the settings in the dialog box the Reset properties to default link will 

appear. Clicking this link will reset all of the properties to the default setting. 

Appearance 

Clicking the Appearance button opens the Appearance dialog box where you can set the 

colors, thumbnail settings, and font of the Thumbnail view. 
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Behavior 

Clicking the Behavior button opens the Behavior dialog box where where you can edit the 

behavior settings of the Thumbnail view. 

 

Outline Floating Toolbar 
Design-Time Support > Smart Designers > Outline Floating Toolbar 

The Outline floating toolbar will appear when the mouse is over the Outline view in the 

Navigation panel. 



 

 145 

Button Description 

 

Appearance: Edit the Outline view appearance. 

 

Behavior: Edit the Outline view behavior. 

Each button will open a dialog box where you can customize the settings on the form. 

 

Note: If you change the settings in the dialog box the Reset properties to default link will 

appear. Clicking this link will reset all of the properties to the default setting. 

Appearance 

Clicking the Appearance button opens the Appearance dialog box where you can set the 

colors, tree settings, and font of the Outline view. 

 

Behavior 

Clicking the Behavior button opens the Behavior dialog box where where you can edit the 

behavior settings of the Outline view. 
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Rulers Floating Toolbar 
Design-Time Support > Smart Designers > Rulers Floating Toolbar 

The Rulers floating toolbar will appear when the mouse is over either the horizontal or vertical 

ruler: 

Button Description 

 

Rulers: Enable or disable rulers. 

This button will open a dialog box where you can customize the settings on the form. 

 

Note: If you change the settings in the dialog box the Reset properties to default link will 

appear. Clicking this link will reset all of the properties to the default setting. 

Rulers 

Clicking the Rulers button opens the Rulers dialog box where you can enable or disable the 

rulers and set the mouse tracking. 

 

 

Note: At least one ruler must be present to use the Rulers dialog box. If no rulers are 

visible check the Horizontal and Vertical check boxes under Rulers on the Behavior 

dialog box in the preview pane menu. 
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Preview Pane Appearance Floating Toolbar 
Design-Time Support > Smart Designers > Preview Pane Appearance Floating Toolbar 

The Preview Pane Appearance floating toolbar will appear when the mouse is over either the 

horizontal or vertical page padding: 

Button Description 

 

Appearance: Edit the preview pane appearance. 

This button will open a dialog box where you can customize the settings on the form. 

 

Note: If you change the settings in the dialog box the Reset properties to default link will 

appear. Clicking this link will reset all of the properties to the default setting. 

Appearance 

Clicking the Appearance button opens the Appearance dialog box where you can set the 

padding, colors, and border style of the preview pane. 
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Margins Floating Toolbar 
Design-Time Support > Smart Designers > Margins Floating Toolbar 

The Margins floating toolbar will appear when the mouse is over either the horizontal or vertical 

margins: 

Button Description 

 

Margins: Hide or show document page margins. 

This button will open a dialog box where you can customize the settings on the form. 

 

Note: If you change the settings in the dialog box the Reset properties to default link will 

appear. Clicking this link will reset all of the properties to the default setting. 

Margins 

Clicking the Margins button opens the Margins dialog box where you can set the visibility of 

the document page margins. 

 

Preview Pane Floating Toolbar 
Design-Time Support > Smart Designers > Preview Pane Floating Toolbar 

The Preview Pane floating toolbar will appear when the mouse is over the page body: 

Button Description 

 

Layout: Edit preview pane layout and zoom settings. 

 

Behavior: Edit preview pane behavior. 

Each button will open a dialog box where you can customize the settings on the form. 

 

Note: If you change the settings in the dialog box the Reset properties to default link will 

appear. Clicking this link will reset all of the properties to the default setting. 
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Layout 

Clicking the Layout button opens the Layout dialog box where you can edit preview pane 

layout and zoom settings. 

 

Behavior 

Clicking the Behavior button opens the Behavior dialog box where you can edit preview pane 

behavior settings. 
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Text Search Panel Floating Toolbar 
Design-Time Support > Smart Designers > Text Seach Panel Floating Toolbar 

The Text Search Panel floating toolbar will appear when the mouse is over the Text Search 

panel. 

Button Description 

 

Appearance: Edit the Text Search panel appearance. 

 

Behavior: Edit the Text Search panel behavior. 

Each button will open a dialog box where you can customize the settings on the form. 

 

Note: If you change the settings in the dialog box the Reset properties to default link will 

appear. Clicking this link will reset all of the properties to the default setting. 

Appearance 

Clicking the Appearance button opens the Appearance dialog box where you can set the 

colors, tree settings, and font of the Text Search panel. 
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Behavior 

Clicking the Behavior button opens the Behavior dialog box where you can edit the behavior 

settings of the Text Search panel. 

 

Localization 
Design-Time Support > Localization 
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To localize Reports for WinForms components in your application, select Localize in the 

C1PrintPreviewControl Tasks Menu, in the Main Menu Floating Toolbar, or from the context 

menu of a Reports for WinForms component. 

 

Clicking Localize opens the Localize dialog box: 

 

The Localize dialog box allows you to localize any of the Reports for WinForms assemblies 

(C1.C1Report.2.dll or C1.Win.C1Report.2.dll) and save the localized resources in any project of 

your solution. 

On the left of the Localize dialog box, there is a tree listing the localizable strings' IDs, and on 

the right are the strings themselves. The structure of the tree reflects the hierarchy of sub-

classes in the Strings class. The right panel can show either all strings, or just the strings 

belonging to the selected tree node. 

The strings' list contains the following columns: 

Column Description 
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Column Description 

Name The string's name (ID); this column repeats the selected tree node, and can be 

optionally turned off. 

Default value The default (English) value of the string. 

Value The string value for the currently selected culture (the column header displays 

that culture). 

Below the list, the currently selected string's value is shown, and an optional description. 

Status bar displays the project which will contain the localized resources, and the name of the 

C1 assembly which is currently being localized. 

See Also 

Localization Toolbar 

Localization Toolbar 
Design-Time Support > Localization > Localization Toolbar 

The Localize dialog box contains the following toolbar menu buttons: 

Button Description 

 

Create new translation begins a new localization for a 

ComponentOne assembly. 

 

Open opens an existing translation for a particular 

assembly. 

 

Save saves the current translation. 

 

Save as saves the current translation and allows you to 

select the project in which to save the translation. 

 

Add culture adds a new culture. 

 

Delete culture removes a culture from the translations. 
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Button Description 

 

Select culture selects the culture to display and edit. 

 

Options customizes the appearance and behavior of the 

localization window. 

Create New Translation 

Clicking the Create new translation button begins a new localization for a ComponentOne 

assembly. A dialog box opens for you to select the ComponentOne assembly to localize. 

 

 

Note: The assembly must be referenced in the currently open solution. 

Open 

Clicking the Open button opens an existing translation for a particular assembly. All translations 

that you create are stored as .resx files, and are automatically added to the project that you 

select while saving the translation. Clicking this item shows a dialog box where a previously 

saved translation can be selected. 

When you create a new solution it does not contain any translations, so initially that window 

would look similar to the following image: 
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After you have created and saved a translation, the Available cultures panel shows the list of 

cultures for which translations were created for the selected assembly. 

Save 

Clicking the Save button saves the current translation. 

The translation is saved in the project shown in the status bar. When the translation is saved, a 

folder with the name C1LocalizedResources is created in the selected project (if it does not 

already exist), and the .resx files with translations are saved in that folder, and added to the 

project. For each culture, a separate .resx file is created. These files are visible in the Solution 

Explorer window. 

 

Note: If your translation is only for the invariant culture, the .resx file does not contain a 

culture suffix. 

Save As 

Clicking the Save as button saves the current translation and allows you to select the project in 

which to save the translation. 

Add Culture 

Clicking the Add culture button adds a new culture. 
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You can make translations for several cultures, and dynamically switch between them at run 

time. For each culture, a separate .resx file is created in the C1LocalizedResources folder. 

Clicking the Add culture button opens the Select culture dialog box that provides a list of 

available cultures: 

 

Initially the list contains neutral cultures only. To show all cultures, uncheck the Show only 

neutral cultures checkbox. You can use the English name, Display name, and Code boxes to 

filter the list of shown cultures. After you have selected a culture, press the OK button to add it 

to the translations. The newly added culture will appear in the Culture drop-down in the 

toolbar, and will become current in the window. 

Delete Culture 

Clicking the Delete culture button removes a culture from the translations. The Select cultures 

to delete dialog box provides the list of cultures existing in the translations: 
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Selecting a culture and clicking OK removes it from the translations. 

Select Culture 

The Culture drop-down allows you to select the culture to display and edit. 

Options 

Clicking the Options button allows to customize the appearance and behavior of the 

localization window. The available Localization options include: 

Option Description 

Sync tree with grid When this item is checked, selecting a string in the right panel 

list also selects that string in the tree on the left. By default this 

item is unchecked. 

Show names in grid When this item is checked, the Name column is show in the 

right hand panel, otherwise that column is hidden. By default 

this item is checked. 

Show selected group only When this item is checked, the list of strings on the right 

contains only the strings from the group currently selected in 

the tree on the left. By default this item is unchecked. 
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Working with C1Report 
You can use C1Report in many different scenarios, on the desktop and on the Web. The main 

sequence of steps is always the same: 

1. You start by creating a report using the C1ReportDesigner application to create report 

definitions; report definitions are saved in XML files, and can be designed from scratch 

or imported from existing Microsoft Access reports. You can then modify the basic 

report using C1ReportDesigner. 

2. The C1Report component reads the report definitions and renders the reports using 

data from any standard .NET data source. 

3. The report definitions can be loaded at design time, and embedded in your application, 

or they can be read and modified at run time. (You can even create report definitions 

from scratch, using the C1Report object model.) 

4. Reports can be rendered directly to a printer, into a C1PrintPreview control, or into 

HTML and PDF files that can be published on the Web. 

The following diagram shows the relationship between the components in the Reports for 

WinForms package: 

 

Note: Boxes with a bold border represent code components (controls and applications). 

Boxes with a thin border represent files containing information (report definitions, data, and 

finished reports). 

 

The following numbers refer to the numbered arrows in the image, indicating relationships 

between the components: 

1. Use the C1ReportDesigner application to create, edit, and save XML report definition 

files. 

C1.C1Report.4~C1.C1Report.C1Report.html
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2. The C1Report component loads report definitions from the XML files created with the 

Designer. This can be done at design time (in this case the XML file is persisted with the 

control and not needed at run time) or at run time using the Load method. 

3. The C1Report component loads data from the data source specified in the report 

definition file. Alternatively, you can provide your own custom data source. 

4. The C1Report component formats the data according to the report definition and 

renders reports to a (a) printer, (b) to one of several file formats, or (c) to a print preview 

control. 

5. Custom applications can communicate with the C1Report component using a rich 

object model, so you can easily customize your reports or generate entirely new ones. 

C1ReportDesigner is a good example of such an application. 

See Also 
Object Model Summary 

Sections of a Report 

Developing Reports for Desktop Scenarios 

Developing Reports for Web Scenarios 

Creating, Loading, and Rendering the Report 

Grouping and Sorting Data 

Working with VBScript 

Modifying the Fields 

Advanced Uses 

Object Model Summary 
Working with C1Report > Object Model Summary 

The object model for the C1Report component is largely based on the Microsoft Access model, 

except that Access has different types of controls (label control, textbox control, line control, 

and so on), while C1Report has a single Field object with properties that can make it look like a 

label, textbox, line, picture, subreport, and so on. 

The following table lists all objects, along with their main properties and methods (note that 

C1Report uses twips for all measurements. One twip is 1/20 point, so 72 points = 1440 twips = 1 

inch): 

C1Report Object: the main component 

ReportName, GetReportInfo, Load, Save, Clear, Render, RenderToFile, RenderToStream, 

PageImages, Document, DoEvents, IsBusy, Cancel, Page, MaxPages, Font, OnOpen, OnClose, 

C1.C1Report.4~C1.C1Report.C1Report.html
C1.C1Report.4~C1.C1Report.C1Report~Load.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~ReportName.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~GetReportInfo.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Load.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Save.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Clear.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Render.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~RenderToFile.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~RenderToStream.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~PageImages.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Document.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~DoEvents.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~IsBusy.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Cancel.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Page.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~MaxPages.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Font.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~OnOpen.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~OnClose.html
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OnNoData, OnPage, OnError, Evaluate, Execute 

Layout Object: determines how the report will be rendered on the page 

Width, MarginLeft, MarginTop, MarginRight, MarginBottom, PaperSize, Orientation, Columns, 

ColumnLayout, PageHeader, PageFooter, Picture, PictureAlign, PictureShow 

DataSource Object: manages the data source 

ConnectionString, RecordSource, Filter, MaxRecords, Recordset 

Groups Collection: a report may have many groups 

Group Object: controls data sorting and grouping 

Name GroupBy, Sort, KeepTogether, SectionHeader, SectionFooter, Move 

Sections Collection: all reports have at least 5 sections 

Section Object: contains Field objects (also known as "report band") 

Name, Type, Visible, BackColor, OnFormat, OnPrint, Height, CanGrow, CanShrink, Repeat, 

KeepTogether, ForcePageBreak 

Fields Collection: a report usually has many Fields 

Field Object: a rectangular area within a section where information is displayed 

Name, Section, Text, TextDirection, Calculated, Value, Format, Align, WordWrap, Visible, Left, 

Top, Width, Height, CanGrow, CanShrink, Font, BackColor, ForeColor, BorderColor, BorderStyle, 

LineSlant, LineWidth, MarginLeft, MarginRight, MarginTop, MarginBottom, LineSpacing, 

ForcePageBreak, HideDuplicates, RunningSum, Picture, PictureAlign, Subreport, CheckBox, RTF 

 

Sections of a Report 
Working with C1Report > Sections of a Report 

Every report has at least the following five sections: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~OnNoData.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~OnPage.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~OnError.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Evaluate.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Execute.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~Width.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~MarginLeft.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~MarginTop.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~MarginRight.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~MarginBottom.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~PaperSize.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~Orientation.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~Columns.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~ColumnLayout.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~PageHeader.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~PageFooter.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~Picture.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~PictureAlign.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~PictureShow.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.DataSource~ConnectionString.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.DataSource~RecordSource.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.DataSource~Filter.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.DataSource~MaxRecords.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.DataSource~Recordset.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Group~Name.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Group~GroupBy.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Group~Sort.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Group~KeepTogether.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Group~SectionHeader.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Group~SectionFooter.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Group~Move.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~Name.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~Type.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~Visible.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~BackColor.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~OnFormat.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~OnPrint.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~Height.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~CanGrow.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~CanShrink.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~Repeat.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~KeepTogether.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~ForcePageBreak.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Name.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Section.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Text.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~TextDirection.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Calculated.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Value.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Format.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Align.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~WordWrap.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Visible.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Left.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Top.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Width.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Height.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~CanGrow.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~CanShrink.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Font.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~BackColor.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~ForeColor.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~BorderColor.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~BorderStyle.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~LineSlant.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~LineWidth.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~MarginLeft.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~MarginRight.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~MarginTop.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~MarginBottom.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~LineSpacing.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~ForcePageBreak.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~HideDuplicates.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~RunningSum.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Picture.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~PictureAlign.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Subreport.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~CheckBox.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~RTF.html
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Section Description 

Detail The Detail section contains fields that are rendered once for each record in 

the source recordset. 

Header The Report Header section is rendered at the beginning of the report. 

Footer The Report Footer section is rendered at the end of the report. 

Page Header The Page Header section is rendered at the top of every page (except 

optionally for pages that contain the Report Header). 

Page Footer The Page Footer section is rendered at the bottom of every page (except 

optionally for pages that contain the Report Footer). 

In addition to these five sections, there are two additional sections for each group: a Group 

Header and a Group Footer Section. For example, a report with 3 grouping levels will have 11 

sections. 

Note that sections can be made invisible, but they cannot be added or removed, except by 

adding or removing groups. 

The following diagram shows how each section is rendered on a typical report: 

 

Report Header 

The first section rendered is the Report Header. This section usually contains information that 

identifies the report. 

Page Header 

After the Report Header comes the Page Header. If the report has no groups, this section 

usually contains labels that describe the fields in the Detail Section. 
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Group Headers and Group Footers 

The next sections are the Group Headers, Detail, and Group Footers. These are the sections that 

contain the actual report data. Group Headers and Footers often contain aggregate functions 

such as group totals, percentages, maximum and minimum values, and so on. Group Headers 

and Footers are inserted whenever the value of the expression specified by the GroupBy 

property changes from one record to the next. 

Detail 

The Detail section contains data for each record. It is possible to hide this section by setting its 

Visible property to False, and display only Group Headers and Footers. This is a good way to 

create summary reports. 

Page Footer 

At the bottom of each page is the Page Footer Section. This section usually contains 

information such as the page number, total number of pages in the report, and/or the date the 

report was printed. 

Report Footer 

Finally, the Report Footer section is printed before the last page footer. This section is often 

used to display summary information about the entire report. 

Customized sections 

You can determine whether or not a section is visible by setting its Visible property to True or 

False. Group Headers can be repeated at the top of every page (whether or not it is the 

beginning of a group) by setting their Repeat property to True. Page Headers and Footers can 

be removed from pages that contain the Report Header and Footer sections by setting the 

PageHeader and PageFooter properties on the Layout object. 

Developing Reports for Desktop 

Scenarios 
Working with C1Report > Developing Reports for Desktop Scenarios 

In typical desktop scenarios, C1Report runs on the same computer where the reports will be 

generated and viewed (the report data itself may still come from a remote server). The following 

scenarios assume that C1Report will be hosted in a Visual Studio environment. 

 

From 2015v2 onwards, please add C1.Win.4 and C1.Win.Barcode.4 dlls to the projects 

referencing C1.C1Report.4 dll. 

See Also 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Group~GroupBy.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~Visible.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~Repeat.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~PageHeader.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~PageFooter.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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Embedded Reports (Loaded at Design Time) 

Embedded Reports (Created at Design Time) 

Reports Loaded at Run Time 

Customizable Reports 

Embedded Reports (Loaded at Design Time) 
Working with C1Report > Developing Reports for Desktop Scenarios > Embedded Reports (Loaded at 

Design Time) 

Show All  

Hide All  

Under this scenario, an application generates reports using a fixed set of report definitions that 

are built into the application. This type of application does not rely on any external report 

definition files, and end-users have no way to modify the reports. 

The main advantage of this type of application is that you don't need to distribute the report 

definition file, and you can be sure that no one will modify the report format. The disadvantage 

is that to make any modifications to the report, you must recompile the application. 

If you want to use a report definition that you already have, without any modifications, follow 

these steps (we will later describe how you can edit an embedded report or create one from 

scratch): 

1. Add one C1Report component for each report definition you want to distribute. You 

may want to name each control after the report it will render (this will make your code 

easier to maintain). 

2. Right-click each C1Report component and select the Load Report menu option to load 

report definitions into each control. (You can also click the smart tag ( ) above the 

component to open the C1Report Tasks menu and choose the Load Report option.) 

The Select a report dialog box appears, which allows you to select a report definition 

file and then a report within that file. 

To load a report, click the ellipsis button to select the report definition file you created 

in step 1, then select the report from the drop-down list and click the Load button. The 

property page shows the name of the report you selected and a count of groups, 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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sections, and fields. This is what the dialog box looks like: 

 
3. Add a single C1PrintPreview control to the form (or a Microsoft 

PrintPreviewControl) and also add a control that will allow the user to pick a report 

(this could be a menu, a list box, or a group of buttons). 

4. Add code to render the report selected by the user. For example, if you added a button 

in the previous step with the name btnProductsReport, the code would look like this:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub btnProductsReport_Click(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles btnProductsReport.Click     

  ppv.Document = rptProducts   

End Sub 

To write code in C# 

C# Copy Code  

 

private void btnProductsReport_Click(object sender, System.EventArgs e)      

{     

  ppv.Document = rptProducts;     

} 

Note that rptProducts is the name of the C1Report component that contains the report 

selected by the user and ppv is the name of the C1PrintPreview control. 
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Embedded Reports (Created at Design Time) 
Working with C1Report > Developing Reports for Desktop Scenarios > Embedded Reports (Created at 

Design Time) 

The Load Report command, described in Embedded Reports (Loaded at Design Time), makes it 

easy to embed reports you already have into your application. In some cases, however, you may 

want to customize the report, or use data source objects that are defined in your Visual Studio 

application rather than use connection strings and record sources. In these situations, use the 

Edit Report command instead. 

To create or edit reports at design time, right-click the C1Report component and select the Edit 

Report menu option to invoke the C1ReportDesigner application (you can also click the smart 

tag ( ) above the component to open the C1Report Tasks menu and select the Edit Report 

option). 

 

Note: If the Edit Report command doesn't appear on the context menu and Properties 

window, it is probably because the control could not find the C1ReportDesigner 

application. To fix this, simply run the C1ReportDesigner application once in stand-alone 

mode. The designer will save its location to the registry, and the C1Report component 

should be able to find it afterwards. 

The C1ReportDesigner application will show the report currently loaded in the C1Report 

component. If the C1Report component is empty, the Designer will show the C1Report Wizard 

so you can create a new report. 

This is the same C1ReportDesigner application used in stand-alone mode. The only differences 

you will notice when you start the C1ReportDesigner application in this mode are: 

 You can use the data source objects defined in your application as data sources for 

your new reports. 

 When you close the Designer, any changes you made will be saved back into the 

C1Report component on the form (unless you choose to discard the changes by 

selecting File | Exit from the Designer's menu, and select No to saving the changes). 

To use data source objects defined in your application, click the Data Source button in the 

Designer, then select the Tables option in the Select a Data Source dialog box. 

The Tables page shows a list of data objects currently defined on the form (the page will not be 

visible if there aren't any valid data sources on the form). Alternatively, you can use the Build 

connection string button to build and select a connection string and record source as usual. 

For example, if the main form contains a DataSet object with several DataTables attached to it, 

the data source picker dialog box might look like this: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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Once you are done creating or editing the report, you can close the Designer by selecting File | 

Save and File | Exit from the menu. This will save the report definition directly into the 

component (as if you had loaded it from a file using the Load Report command). 

If you change your mind and decide to cancel the changes, quit the Designer selecting File | 

Exit from the menu and choose No to saving the changes. 

Reports Loaded at Run Time 
Working with C1Report > Developing Reports for Desktop Scenarios > Reports Loaded at Run Time 

Show All  

Hide All  

Loading reports at run time requires a report definition file and works like a viewer. The main 

advantage of this type of application is that if you modify the report format, there's no need to 

update the application. Simply send the new report definition file to the users and you are 

done. 

To create an application with reports loaded at run time, follow these steps: 

1. Use the C1ReportDesigner application to create all the reports you will need. (See 

Working with C1ReportDesigner for details on how to do this.) 

2. Add the following controls to the application:  

o C1Report component named c1r 

o C1PrintPreview component named ppv 

o ComboList control named cmbReport 

o StatusBar control named status 

3. Add the following Import statements to the top of the file:  
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To write code in Visual Basic 

Visual Basic Copy Code  

 

Imports C1.C1Report         

Imports System.IO 

To write code in C# 

C# Copy Code  

 

using C1.C1Report;         

using System.IO; 

This allows you to reference the C1Report and System.IO classes and objects without 

having to specify the full namespaces. 

4. Add code to read the report definition file and build a list of all reports in it. This can be 

done as follows:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

' get application path         

Dim appPath As String         

appPath = Path.GetDirectoryName(Application.ExecutablePath).ToLower()         

Dim i As Integer = appPath.IndexOf("/bin")         

If (i < 0) Then i = appPath.IndexOf("\bin")         

If (i > 0) Then appPath = appPath.Remove(i, appPath.Length - i)        

      

' get names of reports in the report definition file          

m_ReportDefinitionFile = appPath & "\Data\Nwind.xml"        

Dim reports As String() = c1r.GetReportInfo(m_ReportDefinitionFile) 

     

' populate combo box        

cmbReport.Items.Clear()        

Dim report As String         

For Each report In reports         

  cmbReport.Items.Add(report)         

Next 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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To write code in C# 

C# Copy Code  

 

// get application path         

 string appPath;         

appPath = Path.GetDirectoryName(Application.ExecutablePath).ToLower();         

 int i = appPath.IndexOf("/bin");         

if ((i < 0) ) { i = appPath.IndexOf("\bin"); }         

if ((i > 0) ) { appPath = appPath.Remove(i, appPath.Length - i); } 

  

// get names of reports in the report definition file        

m_ReportDefinitionFile = appPath + "\Data\Nwind.xml";         

 string ( reports) = c1r.GetReportInfo(m_ReportDefinitionFile); 

         

// populate combo box         

cmbReport.Items.Clear();         

 string report;         

foreach report In reports         

  cmbReport.Items.Add(report);         

} 

The code starts by getting the location of the file that contains the report definitions. 

This is done using static methods in the system-defined Path and Application classes. 

You may have to adjust the code to reflect the location and name of your report 

definition file. 

Then it uses the GetReportInfo method to retrieve an array containing the names of all 

reports in the report definition file (created in step 1), and populates the combo box 

that will allow users to select the report. 

5. Add code to render the report selected by the user. For example:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub cmbReport_SelectedIndexChanged(ByVal sender As Object, ByVal e As 

EventArgs) Handles cmbReport.SelectedIndexChanged         

  Try         

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~GetReportInfo.html
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    Cursor = Cursors.WaitCursor 

 

    ' load report         

    status.Text = "Loading " & cmbReport.Text         

    c1r.Load(m_ReportDefinitionFile, cmbReport.Text) 

 

    ' render into print preview control         

    status.Text = "Rendering " & cmbReport.Text         

    ppv.Document = c1r 

 

    ' give focus to print preview control         

    ppv.StartPage = 0         

    ppv.Focus()         

 

    Finally         

      Cursor = Cursors.Default         

    End Try         

End Sub 

To write code in C# 

C# Copy Code  

 

private void cmbReport_SelectedIndexChanged(object sender, System.EventArgs 

e)         

{         

  try {         

    Cursor = Cursors.WaitCursor; 

  

    // load report         

    status.Text = "Loading " + cmbReport.Text;         

    c1r.Load(m_ReportDefinitionFile, cmbReport.Text); 

  

    // render into print preview control         

    status.Text = "Rendering " + cmbReport.Text;         

    ppv.Document = c1r; 

 

    // give focus to print preview control         

    ppv.StartPage = 0;         

    ppv.Focus(); 
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    } finally {         

      Cursor = Cursors.Default;         

    }         

} 

 

Customizable Reports 
Working with C1Report > Developing Reports for Desktop Scenarios > Customizable Reports 

Show All  

Hide All  

Customizable reports are a variation on Reports Loaded at Run Time. This scenario consists of 

loading the basic report definitions from a file, then writing code to customize the reports 

according to user selections. 

For example, the following code changes the font used in the Detail section: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Imports C1.C1Report 

      

Dim s As Section = c1r.Sections(SectionTypeEnum.Detail)         

Dim f As Field         

For Each f In s.Fields         

  f.Font.Name = "Arial Narrow"         

Next 

To write code in C# 

C# Copy Code  

 

using C1.C1Report; 

 

Section s = c1r.Sections[SectionTypeEnum.Detail];         

foreach (Field f in s.Fields)         

  f.Font.Name = "Arial Narrow"; 

The following code toggles the display of a group by turning its Sort property on or off and 

setting the Visible property of the Group's Header and Footer sections: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Group~Sort.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~Visible.html
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To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim bShowGroup As Boolean         

bShowGroup = True         

With c1r.Groups(0)         

  If bShowGroup Then         

    .SectionHeader.Visible = True         

    .SectionFooter.Visible = True         

    .Sort = SortEnum.Ascending         

  Else         

    .SectionHeader.Visible = False         

    .SectionFooter.Visible = False         

    .Sort = SortEnum.NoSort         

    End If         

End With 

To write code in C# 

C# Copy Code  

 

bool bShowGroup;         

bShowGroup = true;         

  if (bShowGroup)          

  {         

    c1r.Groups[0].SectionHeader.Visible = true;         

    c1r.Groups[0].SectionFooter.Visible = true;         

    c1r.Groups[0].Sort = SortEnum.Ascending;         

  }          

  else          

  {         

    c1r.Groups[0].SectionHeader.Visible = false;         

    c1r.Groups[0].SectionFooter.Visible = false;         

    c1r.Groups[0].Sort = SortEnum.NoSort;         

  } 

These samples illustrate just a few ways that you can customize reports. There are infinite 

possibilities, because the object model offers access to every aspect of the report. (In fact, you 

can create whole reports entirely with code). 
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Developing Reports for Web Scenarios 
Working with C1Report > Developing Reports for Web Scenarios 

If you are developing reports for the Web (ASP.NET), you can use the C1WebReport control 

included with the ComponentOne Studio Enterprise package. This control encapsulates the 

C1Report component and provides methods and properties that make it very easy to add 

reports to your Web pages. The C1WebReport control is 100% compatible with C1Report, and 

provides advanced caching and rendering options designed specifically for Web scenarios, as 

well as the usual design time editing options provided by ASP.NET server controls. 

You can still use the C1Report component in your Web applications if you like, but you will have 

to write some code to create HTML or PDF versions of the reports. The following sections 

describe how to do this. 

In typical Web scenarios, C1Report runs on the server machine and creates reports either in 

batch mode or on demand. The user can select the reports and preview or print them on the 

client machine, using a Web browser. 

See Also 

Static Web Reports 

Dynamic Web Reports 

Static Web Reports 
Working with C1Report > Developing Reports for Web Scenarios > Static Web Reports 

Show All  

Hide All  

Static Web reports are based on a server application that runs periodically and creates a 

predefined set of reports, saving them to HTML or PDF files. These files are referenced by Web 

pages on your site, and they are downloaded to the client machine like any other Web page. 

To implement this type of application, follow these steps: 

1. Use the C1ReportDesigner application to create all the reports you will need. (See 

Working with C1ReportDesigner for details on how to do this.) 

2. Create an application on the server that contains a C1Report component. If you don't 

want to use forms and windows, create the control using the CreateObject function. 

3. Add a routine that runs periodically and updates all the reports you want to make 

available to your users. The loop would look like this:  

To write code in Visual Basic 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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Visual Basic Copy Code  

 

' this runs every 6 hours: 

   

' get a list of all reports in the definition file         

sFile = "c:\inetpub\wwwroot\Reports\MyReports.xml"         

sList = c1r.GetReportInfo(sFile) 

     

' refresh the reports on the server         

For i = 0 To sList.Length - 1         

  c1r.Load(sFile, sList(i))         

  sFile = "Reports\Auto\" & sList(i) & ".htm"         

  c1r.RenderToFile(sFile, FileFormatEnum.HTMLPaged)         

Next 

To write code in C# 

C# Copy Code  

 

// this runs every 6 hours: 

      

// get a list of all reports in the definition file         

sFile = "c:\inetpub\wwwroot\Reports\MyReports.xml";         

sList = c1r.GetReportInfo(sFile); 

       

// refresh the reports on the server         

for ( i = 0 ; GAIS <= sList.Length - 1         

  c1r.Load(sFile, sList(i));         

  sFile = "Reports\Auto\" + sList(i) + ".htm";         

  c1r.RenderToFile(sFile, FileFormatEnum.HTMLPaged);         

} 

The code uses the GetReportInfo method to retrieve a list of all reports contained in the 

MyReports.xml report definition file (created in step 1), then renders each report into a 

paged HTML file. (Paged HTML files contain one HTML page for each page in the 

original report, with a navigation bar that allows browsing.) 

4. Edit the home HTML page by adding links to the reports that were saved. 

You are not restricted to HTML. C1Report can also export to PDF files, which can be viewed on 

any browser with freely available plug-ins. The PDF format is actually superior to HTML in many 

ways, especially when it comes to producing hard copies of your Web reports. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~GetReportInfo.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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Dynamic Web Reports 
Working with C1Report > Developing Reports for Web Scenarios > Dynamic Web Reports 

Show All  

Hide All  

Dynamic Web reports are created on-demand, possibly based on data supplied by the user. 

This type of solution typically involves using an ASP.NET page that presents a form to the user 

and collects the information needed to create the report, then creates a C1Report component 

to render the report into a temporary file, and returns a reference to that file. 

The example that follows is a simple ASP.NET page that allows users to enter some information 

and to select the type of report they want. Based on this, the ASP code creates a custom version 

of the NorthWind "Employee Sales by Country" report and presents it to the user in the selected 

format. 

The sample uses a temporary file on the server to store the report. In a real application, you 

would have to generate unique file names and delete them after a certain time, to avoid 

overwriting reports before the users get a chance to see them. Despite this, the sample 

illustrates the main techniques involved in delivering reports over the Web with C1Report. 

To implement this type of application, follow these steps: 

1. Start by creating a new Web application with a Web page that looks like this:  

 

The page has five server controls: 

o _1stYear: Contains a list of valid years for which there is data (1994, 1995, and 

1996). Note that you can add the items by clicking the smart tag ( ) and 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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selecting Edit Items from the menu. From the ListItem Collection Editor, add 

three new items. 

o _txtGoal: Contains the yearly sales goal for each employee. 

o _btnHTML, _btnPDF: Buttons used to render the report into HTML or PDF, and 

show the result. 

o _lblStatus: Displays error information if something goes wrong. 

 

Note: If you run this application with a demo or beta version of the C1Report component, 

there will be errors when the control tries to display its About dialog box on the server. If 

that happens, simply reload the page and the problem should go away. 

2. After the page has been set up, you need to add a reference to the C1Report 

component to the project. Just right-click the project in the Solution Explorer window, 

select Add Reference and choose the C1Report component. 

3. Add the Nwind.xml to the project in the Data folder. Just right-click the project in the 

Solution Explorer window, select New Folder and rename the folder Data. Then right-

click the folder, select Add Existing Item and browse for the Nwind.xml definition file, 

which is installed by default in the ComponentOne Samples\WinForms 

Edition\C1Report\C1Report\VB\NorthWind\Data directory in the Documents or My 

Documents folder. 

4. Add a Temp folder to the project. Just right-click the project in the Solution Explorer 

window, select New Folder and rename the folder Temp. 

5. If you have used traditional ASP, this is where things start to become interesting. 

Double-clicking the controls will take you to a code window where you can write full-

fledged code to handle the events, using the same editor and environment you use to 

write Windows Forms projects.  

Add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Imports C1.C1Report 

 

' handle user clicks         

Private Sub _btnHTML_Click(ByVal sender As Object, ByVal e As 

System.EventArgs) Handles _btnHTML.Click         

     RenderReport(FileFormatEnum.HTMLDrillDown)         

End Sub 

  

Private Sub _btnPDF_Click(ByVal sender As Object, ByVal e As 

System.EventArgs) Handles _btnPDF.Click          

     RenderReport(FileFormatEnum.PDF)         

End Sub 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html


 

 176 

To write code in C# 

C# Copy Code  

 

using C1.C1Report; 

        

// handle user clicks         

private void _btnHTML_Click(object sender, System.EventArgs e)         

{         

   RenderReport(FileFormatEnum.HTMLDrillDown);         

} 

                 

private void _btnPDF_Click(object sender, System.EventArgs e)         

{         

   RenderReport(FileFormatEnum.PDF);         

} 

This is the code that gets executed on the server, when the user clicks either button. 

6. The following code delegates the work to the main routine, RenderReport:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub RenderReport(ByVal fmt As FileFormatEnum)     

         

    ' build file names         

    Dim rpt As String = "Employee Sales by Country"         

    Dim fileIn As String = GetDataPath() & "NWind.xml"         

    Dim ext As String = Iif(fmt = FileFormatEnum.PDF, ".pdf", ".htm")         

    Dim fileOut As String = GetOutputPath() & rpt & ext        

     

    Try         

        ' create C1Report component         

        Dim c1r As New C1Report()         

 

        ' load the report         

        c1r.Load(fileIn, rpt) 

 

        ' get user parameters         

        Dim year As String = _lstYear.SelectedItem.Text         
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        Dim goal As String = _txtGoal.Text 

 

        ' customize the report data source         

        Dim sSQL As String = "SELECT DISTINCTROW " & _         

            "Employees.Country, Employees.LastName, " & _         

            "Employees.FirstName, Orders.ShippedDate, Orders.OrderID, " & _         

            "  [Order Subtotals].Subtotal AS SaleAmount " & _         

            "FROM Employees INNER JOIN (Orders INNER JOIN " & _         

            "  [Order Subtotals] ON Orders.OrderID = " & _         

            "  [Order Subtotals].OrderID) " & _         

            "  ON Employees.EmployeeID = Orders.EmployeeID " & _         

            "WHERE Year(Orders.ShippedDate) = " & year & ";"         

        c1r.DataSource.RecordSource = sSQL 

 

        ' customize the report's event handlers         

        Dim sScript As String = _         

            "If SalespersonTotal > " & goal & " Then" & vbCrLf & _         

            "  ExceededGoalLabel.Visible = True" & vbCrLf & _         

            "  SalespersonLine.Visible = True" & vbCrLf & _         

            "Else" & vbCrLf & _         

            "  ExceededGoalLabel.Visible = False" & vbCrLf & _         

            "  SalespersonLine.Visible = False" & vbCrLf & _         

            "End If"         

        c1r.Sections(SectionTypeEnum.GroupHeader2).OnPrint = sScript 

 

        ' render the report into a temporary file         

        c1r.RenderToFile(fileOut, fmt) 

 

        ' redirect user to report file         

        Response.Redirect("Temp/" + rpt + ext) 

         

    Catch x As Exception 

 

        _lblStatus.Text = "*** " & x.Message 

 

    End Try         

End Sub 

To write code in C# 

C# Copy Code  
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// render the report         

private void RenderReport(FileFormatEnum fmt)         

{ 

 

       

   // build file names         

   string rpt  = "Employee Sales by Country";         

   string fileIn = GetDataPath() + "NWind.xml";         

   string ext = (fmt == FileFormatEnum.PDF)? ".pdf": ".htm";         

   string fileOut = GetOutputPath() + rpt + ext; 

 

   try         

   {         

   // create C1Report component         

   C1Report c1r = new C1Report(); 

   

   // load the report         

   c1r.Load(fileIn, rpt); 

         

   // get user parameters         

   string year = _lstYear.SelectedItem.Text;         

   string goal = _txtGoal.Text; 

   

   // customize the report data source         

   string sSQL = "SELECT DISTINCTROW " +         

   "Employees.Country, Employees.LastName, " +         

   "Employees.FirstName, Orders.ShippedDate, Orders.OrderID, " +         

   "  [Order Subtotals].Subtotal AS SaleAmount " +         

   "FROM Employees INNER JOIN (Orders INNER JOIN " +         

   "  [Order Subtotals] ON Orders.OrderID = " +         

   "  [Order Subtotals].OrderID) " +         

   "  ON Employees.EmployeeID = Orders.EmployeeID " +         

   "WHERE Year(Orders.ShippedDate) = " + year + ";";         

   c1r.DataSource.RecordSource = sSQL; 

   

   // customize the report's event handlers         

   string sScript =          

   "If SalespersonTotal > " + goal + " Then \n" +         

   "  ExceededGoalLabel.Visible = True\n" + 

   "  SalespersonLine.Visible = True\n" +         

   "Else\n" +         



 

 179 

   "  ExceededGoalLabel.Visible = False\n" +         

   "  SalespersonLine.Visible = False\n" +         

   "End If";         

   c1r.Sections[SectionTypeEnum.GroupHeader2].OnPrint = sScript; 

                 

   // render the report into a temporary file         

   c1r.RenderToFile(fileOut, fmt);         

   // redirect user to report file         

   Response.Redirect("Temp/" + rpt + ext);         

   }         

   catch (Exception x)         

   {         

   _lblStatus.Text = "*** " + x.Message;         

   }        

} 

The RenderReport routine is long, but pretty simple. It begins working out the names 

of the input and output files. All file names are built relative to the current application 

directory. 

Next, the routine creates a C1Report component and loads the "Employee Sales by 

Country" report. This is the raw report, which you will customize in the next step. 

The parameters entered by the user are available in the _lstYear and _txtGoal server-

side controls. The code reads these values and uses them to customize the report's 

RecordSource property and to build a VBScript handler for the OnPrint property. These 

techniques were discussed in previous sections. 

Once the report definition is ready, the code calls the a RenderToFile, which causes the 

C1Report component to write HTML or PDF files to the output directory. When the 

method returns, the report is ready to be displayed to the user. 

The last step is the call to Response.Redirect, which displays the report you just 

created on the user's browser. 

Note that the whole code is enclosed in a try/catch block. If anything goes wrong while 

the report is being generated, the user gets to see a message explaining the problem. 

7. Finally, there's a couple of simple helper routines that need to be added:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

' get directories to use for loading and saving files         

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~OnPrint.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~RenderToFile.html
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Private Function GetDataPath() As String         

   Return Request.PhysicalApplicationPath + "Data\"         

End Function 

 

Private Function GetOutputPath() As String         

   Return Request.PhysicalApplicationPath + "Temp\"         

End Function 

To write code in C# 

C# Copy Code  

 

// get directories to use for loading and saving files         

private string GetDataPath()         

{         

   return Request.PhysicalApplicationPath + @"Data\";         

}         

private string GetOutputPath()         

{         

   return Request.PhysicalApplicationPath + @"Temp\";         

} 

8. After you enter this code, the application is ready. You can press F5 and trace its 

execution within Visual Studio. 

The following screen shot shows what the result looks like in the browser: 
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Loading, and Rendering the Report 
Working with C1Report > Creating, Loading, and Rendering the Report 

Show All  

Hide All  

Although you can use C1Report in many different scenarios, on the desktop and on the Web, 

the main sequence of steps is always the same: 

1. Create a report definition 

This can be done directly with the C1Report Designer application or using the report 

designer in Microsoft Access and then importing it into C1Report Designer. You can 

also do it using code, either using the object model to add groups and fields or by 

writing a custom XML file. 

2. Load the report into the C1Report component 

This can be done at design time, using the Load Report context menu, or 

programmatically using the Load method. If you load the report at design time, it will 

be persisted (saved) with the control and you won't need to distribute the report 

definition file. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Load.html
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3. Render the report (desktop applications) 

If you are writing a desktop application, you can render the report into a 

C1PrintPreview controleasily. The preview control will display the report on the screen, 

and users will be able to preview it with full zooming, panning, and so on. For example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

C1PrintPreview1.Document = c1r 

To write code in C# 

C# Copy Code  

 

c1printPreview1.Document = c1r; 

4. Render the report (Web applications) 

If you are writing a Web application, you can render reports into HTML or PDF files 

using the RenderToFile method, and your users will be able to view them using any 

browser. 

See Also 

Loading Report Data 

Loading Report Data 
Working with C1Report > Loading, and Rendering the Report > Loading Report Data 

In addition to a report definition, C1Report needs the actual data to create the report. In most 

cases, the data comes from a database, but there are other options. 

See Also 

Loading Data from a Database 

Loading Data from a Stored Procedure 

Loading Data from an XSD File 

Using a DataTable Object as a Data Source 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~RenderToFile.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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Using Custom Data Source Objects 

Loading Data from a Database 
Working with C1Report > Loading, and Rendering the Report > Loading Report Data > Loading Data from 

a Database 

The simplest option for loading the report data is to set the C1Report control's DataSource 

properties: ConnectionString and RecordSource. If these properties are set, C1Report uses them 

to load the data from the database automatically and no additional work is needed. 

To select a data source for a new report: 

1. In the C1ReportDesigner application, select the New Report button: 

 
The C1Report Wizard appears and walks you through the steps of creating a new 

report from start to finish. 

2. In the first step of the wizard you must select a data source. Click the ellipses button of 

Connection string tab. The Data Link Properties dialog box appears. 
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3. You must first select a data provider. Select the Provider tab and select a data provider 

from the list. For this example, select Microsoft Jet 4.0 OLE DB Provider. 

 
4. Click the Next button or select the Connection tab. Now you must choose a data 

source. 

5. To select a database, click the ellipsis button. The Select Access Database dialog box 

appears. For this example, select the C1NWind.mdb located in the ComponentOne 

Samples\Common directory in the Documents or My Documents folder. Note that 

this directory reflects the default installation path and its path may be different if you 

made changes to the installation path. 

6. Click Open. Test the connection, if you choose, and click OK. 

7. Click OK to close the Select Access Database dialog box. 

8. 8. Once you have selected your data source, you can select a table, view, or stored 

procedure to provide the actual data. You can specify the RecordSource string in two 

ways:  

o Click the Table option and select a table from the list. 

o Click the SQL option and type (or paste) an SQL statement into the editor. 

For example: 

select * from products inner join categories on 

categories.categoryid = products.categoryid 

9. Click Next. The wizard will walk you through the remaining steps. 

For more details on the C1Report Wizard, see Step 1 of 4: Creating a Report Definition. 
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Loading Data from a Stored Procedure 
Working with C1Report > Loading, and Rendering the Report > Loading Report Data > Loading Data from 

a Stored Procedure 

Stored procedures (or sprocs) can assist you in achieving a consistent implementation of logic 

across applications, improve performance, and shield users from needing to know the details of 

the tables in the database. One of the major advantages to stored procedures is you can pass in 

parameters to have the database filter the recordset. This returns a smaller set of data, which is 

quicker and easier for the report to manipulate. 

You can populate a report from a stored procedure in the C1Report Wizard. To open the 

C1Report Wizard complete one of the following: 

 From the C1ReportDesigner application, click the New Report button from the 

Reports tab 

 In Visual Studio by select Edit Report from the C1Report context menu 

 In Visual Studio by select Edit Report from the C1Report Tasks menu 

For more information accessing the Edit Report link, see C1Report Tasks Menu or C1Report 

Context Menu. 

Populating a report from a stored procedure is no different than using SQL statements or 

straight tables. In the first screen of the C1ReportWizard, click the ellipses button to choose a 

datasource. Then choose a Stored Procedure from the list of available Data sources: 
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Select Next and continue through the wizard. 

As with loading other forms of data, you have two options: 

 You can use the DataSource's ConnectionString and RecordSource properties to 

select the datasource: 

In the Designer, use the DataSource dialog box to select the connection string (by 

clicking the ellipses button "..."), then pick the table or sproc you want to use from the 

list. For example: 

connectionstring = "Provider=SQLOLEDB.1;Integrated 

Security=SSPI;" + "Persist Security Info=False;Initial 

Catalog=Northwind;Data Source=YOURSQLSERVER;" recordsource = 

"[Employee Sales by Country]('1/1/1990', '1/1/2010')"  

(In this case the stored procedure name has spaces, so it's enclosed in square brackets). 

 You can create the data source using whatever method you want, then assign it to the 

DataSource's Recordset property: 

This method requires you to write code, and is useful when you have your data cached 

somewhere and want to use it to produce several reports. It overrides the previous 

method (it you specify ConnectionString, RecordSource, and Recordset, C1Report 

will use the Recordset). 

The syntax will be different depending on the type of connection/adapter you want to 

use (OleDb, SQL, Oracle, and so on). The easiest way to get the syntax right is to drag 

tables or sprocs from Visual Studio's Server Explorer onto a form. That will add all the 

cryptic elements required, and then you can go over the code and pick up the pieces 

you want. 

You can specify stored procedures as data sources by their name. If the sproc has 

parameters, you pass them as parameters. For example in a report definition built 

against MSSQL and ADVENTURE_WORKS.mdf database, here's the SQL request that is 

specified in the C1Report Designer (adjust the path to ADVENTUREWORKS_DATA.MDF 

as needed): 

PARAMETERS Empoyee Int 290; 

DECLARE @RC int 

DECLARE @EmployeeID int 

set @EmployeeID = [Empoyee] 

EXECUTE @RC = 

[C:\ADVENTUREWORKS_DATA.MDF].[dbo].[uspGetEmployeeManagers] 

@EmployeeID  

Loading Data from an XSD File 
Working with C1Report > Loading, and Rendering the Report > Loading Report Data > Loading Data from 
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an XSD File 

XSD files are XML Schema Documents. Reports for WinForms is compatible with XSD files, 

allowing you to load report data from an XSD file. To load the report data, you can set the 

ConnectionString property to the name of an XSD file. XSD files contain XML representations of 

ADO.NET DataSet objects. So in this case, you would set the RecordSource property to the 

name of a table in the DataSet. 

 

Note: to create an XSD file, take an existing DataSet object and call the WriteXml method 

using the XmlWriteMode.WriteSchema parameter. 

Loading an XSD file in the C1ReportDesigner application is quite simple using the C1Report 

Wizard. Complete the following steps to open an XSD file: 

1. Open the C1Report Wizard by completing one of the following: 

o From the C1ReportDesigner application, click the New Report button from 

the Reports tab 

o In Visual Studio by select Edit Report from the C1Report context menu 

o In Visual Studio by select Edit Report from the C1Report Tasks menu 

This will open the C1Report Wizard. You can select an XSD file in the first screen of the 

C1ReportWizard. For more information accessing the Edit Report link, see C1Report 

Tasks Menu or C1Report Context Menu. 

2. In the C1Report Wizard, click the Select XSD file button next to the Connection 

String text box. The Select XSD file button appears as an open folder icon: 

 

This button will open the Select XML Schema Definition File dialog box. 

3. Navigate to an XSD file, select it, and click the Open button to open the XSD file. 

The selected file will open in the C1ReportDesigner application. You can edit and 

format the file. See Working with C1ReportDesigner for details. 
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Using a DataTable Object as a Data Source 
Working with C1Report > Loading, and Rendering the Report > Loading Report Data > Using a DataTable 

Object as a Data Source 

Show All  

Hide All  

Many applications need to work on the data outside of C1Report and load it into DataTable 

objects. In these cases, you may use these objects as report data sources, avoiding the need to 

load them again when rendering the report. 

This approach is also useful in applications where: 

 Security restrictions dictate that connection strings must be kept private and only the 

data itself may be exposed (not its source). 

 The database is not supported by OleDb (the provider used internally by C1Report). 

 The data does not come from a database at all. Instead, the DataTable is created and 

populated using custom code. 

To use a DataTable object as a C1Report data source, simply load the report definition and then 

assign the DataTable to the C1Report Recordset property. For example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' load DataTable from cache or from a secure/custom provider         

Dim dt As DataTable = GetMyDataTable() 

 

' load report definition (before setting the data source)         

c1r.Load(reportFile, reportName) 

 

' use DataTable as the data source for the C1Report component         

c1r.DataSource.Recordset = dt 

To write code in C# 

C# Copy Code  

 

// load DataTable from cache or from a secure/custom provider         

DataTable dt = GetMyDataTable(); 
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// load report definition (before setting the data source)         

c1r.Load(reportFile, reportName);         

  

// use DataTable as the data source for the C1Report component         

c1r.DataSource.Recordset = dt; 

 

Using Custom Data Source Objects 
Working with C1Report > Loading, and Rendering the Report > Loading Report Data > Using Custom 

Data Source Objects 

Show All  

Hide All  

You can use custom objects as data sources. The only requirement is that the custom object 

must implement the IC1ReportRecordset interface. 

IC1ReportRecordset is a simple and easy-to-implement interface that can be added easily to 

virtually any collection of data. This is often more efficient than creating a DataTable object and 

copying all the data into it. For example, you could use custom data source objects to wrap a 

file system or custom XML files. 

To use a custom data source objects, load the report definition and then assign the object to 

the C1Report's Recordset property. For example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' get custom data source object         

Dim rs As IC1ReportRecordset = CType(GetMyCustomDataSource(), 

IC1ReportRecordset) 

 

' load report definition (before setting the data source)         

c1r.Load(reportFile, reportName) 

 

' use custom data source object in C1Report component         

c1r.DataSource.Recordset = rs 

To write code in C# 

C# Copy Code  
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// get custom data source object         

IC1ReportRecordset rs = (IC1ReportRecordset)GetMyCustomDataSource(); 

         

// load report definition (before setting the data source)         

c1r.Load(reportFile, reportName); 

     

// use custom data source object in C1Report component         

c1r.DataSource.Recordset = rs; 

 

Grouping and Sorting Data 
Working with C1Report > Grouping and Sorting Data 

Show All  

Hide All  

This section shows how you can organize the data in your report by grouping and sorting data, 

using running sums, and creating aggregate expressions. 

Grouping Data: 

After designing the basic layout, you may decide that grouping the records by certain fields or 

other criteria would make the report easier to read. Grouping allows you to separate groups of 

records visually and display introductory and summary data for each group. The group break is 

based on a grouping expression. This expression is usually based on one or more recordset 

fields but it can be as complex as you like. 

You can group the data in your reports using the C1ReportDesigner application or using code: 

Adding grouping and sorting using C1ReportDesigner 

Groups are also used for sorting the data, even if you don't plan to show the Group Header and 

Footer sections. You can add groups to your report using the C1ReportDesigner application. 

 

To add or edit the groups in the report, complete the following steps: 

1. Open the C1ReportDesigner application. For details, see Accessing C1ReportDesigner 

from Visual Studio. 
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2. Click the Sorting and Grouping button on the Home tab in the Data group. The 

Sorting and Grouping dialog box appears. You can use this dialog box to create, edit, 

reorder, and delete groups. 

3. To create a group, click the Add button and set the properties for the new group. The 

Group By field defines how the records will be grouped in the report. For simple 

grouping, you can select fields directly from the drop-down list. For more complex 

grouping, you can type grouping expressions. For example, you could use Country to 

group by country or Left(Country, 1) to group by country initial. 

4. To follow along with this report, select Country for the Group By expression. 

5. Next, select the type of sorting you want (Ascending in this example). You can also 

specify whether the new group will have visible Header and Footer sections, and 

whether the group should be rendered together on a page. 

 

Note: You cannot use memo or binary (object) fields for grouping and sorting. This is a 

limitation imposed by OLEDB. 

Here's what the Sorting and Grouping dialog box should look like at this point: 

 

If you add more fields, you can change their order using the arrow buttons on the right of the 

Groups list. This automatically adjusts the position of the Group Header and Footer sections in 

the report. To delete a field, use the Delete button. 

Once you are done arranging the fields, click OK to dismiss the dialog box and see the changes 

in the Designer. There are two new sections, a Header and Footer for the new group. Both have 

height zero at this point, you can expand them by dragging the edges with the mouse. Notice 

that the Group Header section is visible, and the footer is not. This is because the Group 

Header button in the dialog box has been checked, and the Group Footer button was left 

unchecked. Invisible sections are displayed with a hatch pattern to indicate they are invisible. 
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On the tan bars that mark the top of the new sections there are labels that contain the section 

name and the value of the group's GroupBy property. 

To see how groups work, click the Text button    , select Country from the dropdown 

menu and mark an area in the newly created Group Header Section. Click the new field to select 

it and change its Font property to make the new field stand out a little. 

Adding grouping and sorting using code 

Useful reports don't simply show data, they show it in an organized manner. C1Report uses 

groups to group and sort data. To demonstrate how this works, return to the Creating a Report 

Definition topic's code and group the employees by country. 

The following code creates a group object that sorts and groups records by country: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

If chkGroup.Checked Then            

 

  ' group employees by country, in ascending order             

  Dim grp As Group             

  grp = c1r.Groups.Add("GrpCountry", "Country", SortEnum.Ascending) 

 

  ' format the Header section for the new group             

  With grp.SectionHeader             

    .Height = 500             

    .Visible = True             

    f = .Fields.Add("CtlCountry", "Country", 0, 0, c1r.Layout.Width, 500)             

    f.Calculated = True             
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    f.Align = FieldAlignEnum.LeftMiddle             

    f.Font.Bold = True             

    f.Font.Size = 12             

    f.BorderStyle = BorderStyleEnum.Solid             

    f.BorderColor = Color.FromArgb(0, 0, 150)            

    f.BackStyle = BackStyleEnum.Opaque             

    f.BackColor = Color.FromArgb(150, 150, 220)             

    f.MarginLeft = 100             

  End With 

     

  ' sort employees by first name within each country             

  c1r.Groups.Add("GrpName", "FirstName", SortEnum.Ascending)             

End If 

To write code in C# 

C# Copy Code  

 

if (chkGroup.Checked)             

{             

  // group employees by country, in ascending order             

   Group grp = c1r.Groups.Add("GrpCountry", "Country", SortEnum.Ascending); 

  

  // format the Header section for the new group             

  s = grp.SectionHeader;             

    s.Height = 500;             

    s.Visible = true;            

    f = s.Fields.Add("CtlCountry", "Country", 0, 0, c1r.Layout.Width, 500);             

    f.Calculated = true;             

    f.Align = FieldAlignEnum.LeftMiddle;             

    f.Font.Bold = true;             

    f.Font.Size = 12;             

    f.BorderStyle = BorderStyleEnum.Solid;             

    f.BorderColor = Color.FromArgb(0, 0, 150);             

    //f.BackStyle = BackStyleEnum.Opaque;             

    f.BackColor = Color.Transparent;             

    f.BackColor = Color.FromArgb(150, 150, 220);             

    f.MarginLeft = 100; 

       

  // sort employees by first name within each country             

  c1r.Groups.Add("GrpName", "FirstName", SortEnum.Ascending);             
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} 

Every group has Header and Footer sections. These are invisible by default, but the code above 

makes the Header section visible to show which country defines the group. Then it adds a field 

with the country. The new field has a solid background color. 

Finally, the code adds a second group to sort the employees within each country by their first 

name. This group is only used for sorting, so the Header and Footer sections remain invisible. 

The changes are now complete. To render the new report, you need to finish the routine with a 

call to the method. Enter the following code in the btnEmployees_Click event handler: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' render the report into the PrintPreviewControl             

ppv.Document = c1r 

To write code in C# 

C# Copy Code  

 

// render the report into the PrintPreviewControl             

ppv.Document = c1r; 

Here's an example of a report using a group object: 



 

 195 

 

Sorting Data: 

You can sort data in reports the following two ways: 

 Sort the data source object itself (for example, using a SQL statement with an ORDER 

BY clause). 

 Add groups to the report and specify how each group should be sorted using the 

group's GroupBy and Sort properties. 

Group sorting is done using the DataView.Sort property, which takes a list of column names 

only (not expressions on column names). So if your grouping expression is DatePart("yyyy", 

dateColumn), the control will actually sort on the dates in the dateColumn field, not on the 

years of those dates as most would expect. 

To sort based on the dates, add a calculated column to the data table (by changing the SQL 

statement), and then group/sort on the calculated column instead. See the Sort property for an 

XML discussion of this, including a sample. 

This is what the Sorting and Grouping editor looks like in the C1ReportDesigner application. 

Note the fields where you can specify group sorting: 
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If you use both approaches, the sorting set in the report groups will prevail (it is applied after 

the data has been retrieved from the database). 

 

Note: For the complete report, see report "19: Sorting" in the CommonTasks.xml report 

definition file, which is available in the ComponentOne Samples folder. 

See Also 

Adding Running Sums 

Adding Subtotals and Other Aggregates 

Creating Cross-Tab Reports 

Adding Running Sums 
Working with C1Report > Grouping and Sorting Data > Adding Running Sums 

Show All  

Hide All  

C1Report field objects have a RunningSum property that makes it easy to maintain running 

sums over groups or over the entire report. 

Adding Running Sums over a Group 

To keep running sums over groups, complete the following tasks: 
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1. Open the C1ReportDesigner application. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner application, you can modify the report properties. 

3. Click the Design button to begin editing the report. 

4. In Design mode, select the report from the drop-down list above the Properties 

window. The available properties for the report appear. 

5. Add a calculated field to the report:  

1. Click the Add Calculated Field button from the Designer toolbar. 

2. In the VBScript Editor, enter the following script: 

Sum(ProductSalesCtl) 

3. Drag the mouse over the GroupHeader section of the report and the cursor 

changes into a cross-hair . Click and drag to define the rectangle that the 

new field will occupy, and then release the button to create the new field. 

6. Set the RunningSum property to SumOverGroup. (Note that for this property to 

appear, the properties filter must be turned off. It's the funnel icon above the Properties 

window.) 

Adding Running Sums over the Entire Report 

To keep running sums over pages, you need to use script. For example, you could add a 

pageSum field to the report and update it with script. To do this, complete the following tasks: 

1. Open the C1ReportDesigner application. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner application, you can modify the report properties. 

3. Click the Design button to begin editing the report. 

4. In Design mode, select the report from the drop-down list above the Properties 

window. The available properties for the report appear. 

5. Locate the OnPage property and click the empty field next to it, and then click the 

ellipsis button. 

6. The VBScript Editor appears. Enter the following VBScript expression in the code 

editor: ' VBScript: Report.OnPage 
pageSum = 0 

7. Then select Detail from the drop-down list above the Properties window. The available 

properties for the Detail section appear. 

8. Locate the OnPrint property and click the empty field next to it, and then click the 

ellipsis button. 

9. The VBScript Editor appears. Enter the following VBScript expression in the code 

editor: ' VBScript: Detail.OnPrint 
pageSum = pageSum + UnitsInStock 

 

Note: For the complete report, see report "17: Running Sums" in the CommonTasks.xml 

report definition file, which is available in the ComponentOne Samples folder. 
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Adding Subtotals and Other Aggregates 
Working with C1Report > Grouping and Sorting Data > Adding Subtotals and Other Aggregates 

C1Report supports aggregate expressions in all its calculated fields. The aggregate expressions 

include all the usual Sum, Avg, Min, Max, Count, Range, StDev, and so on. 

All aggregate functions take an expression as an argument and evaluate it within a scope that is 

determined by their position in the report. For example, aggregates in group headers or footers 

have the scope of the group. Aggregates in the report header or footer have the scope of the 

entire report. 

For example, the following aggregate expression would return the sum of all values in the Sales 

field for the scope of the aggregate (group or report): Sum(Sales) 

The following aggregate expression would return the total amount of sales taxes paid for all 

values in the report (assuming an 8.5% sales tax):Sum(Sales * 0.085) 

You can reduce the scope of any aggregate using a second argument called domain. The 

domain argument is an expression that determines whether each value in the current scope 

should be included in the aggregate calculation. 

For example, the following aggregate expression would return the sum of all values in the Sales 

field for products in category 1: Sum(Sales, Category = 1) 

The following aggregate expression would return the number of sales over $10,000: Count(*, 

Sales > 10000) 

 

Note: For the complete report, see report "13: Subtotals and other Aggregates" in the 

CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 

 

Creating Cross-Tab Reports 
Working with C1Report > Grouping and Sorting Data > Creating Cross-Tab Reports 

Cross-tab reports group data in two dimensions (down and across). They are useful for 

summarizing large amounts of data in a format that cross-references information. 

To create cross-tab reports, you will typically start with a GROUP BY query to summarize the 

data into rows, and then use a transformation (pivot) service to create the grouped columns. 

The transformation service can be provided by the database server itself, it can be a custom 

program, or you can use C1Report's built-in domain aggregates. 

In all cases, the most important element in the cross-tab report is the original summarized view 

of the data. For example, a typical summarized view would look like this: 
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Year Quarter Amount 

1990 1 1.1 

1990 2 1.2 

1990 3 1.3 

1990 4 1.4 

1991 1 2.1 

1991 2 2.2 

1991 3 2.3 

1991 4 2.4 

This data would then be transformed by adding columns for each quarter and consolidating the 

values into the new columns: 

Year Total Q1 Q2 Q3 Q4 

1990 5 1.1 1.2 1.3 1.4 

1991 9 2.1 2.2 2.3 2.4 

You can do this using C1Report aggregate functions. The report would be grouped by year. The 

Detail section would be invisible, and the group header would contain the following aggregates: 

Year Total Q1 Q2 Q3 Q4 

[Year] Sum(Amount) Sum(Amount, 

Quarter=1) 

Sum(Amount, 

Quarter=2) 

Sum(Amount, 

Quarter=3) 

Sum(Amount, 

Quarter=4) 

The first aggregate would calculate the total amount sold in the current year. The quarter-

specific aggregates specify a domain to restrict the aggregate to the specified quarter. 

For the complete report, see report "20: Cross-tab Reports" in the CommonTasks.xml report 

definition file, which is available in the ComponentOne Samples folder. 
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Working with VBScript 
Working with C1Report > Working with VBScript 

VBScript expressions are widely used throughout a report definition to retrieve, calculate, 

display, group, sort, filter, parameterize, and format the contents of a report. Some expressions 

are created for you automatically (for example, when you drag a field from the Toolbox onto a 

section of your report, an expression that retrieves the value of that field is displayed in the text 

box). However, in most cases, you create your own expressions to provide more functionality to 

your report. 

Note the following differences between VBScript expressions and statements: 

 Expressions return values, you can assign them to things like Field.Text, for example: 
Field1.Calculated = true 

Field1.Text = "iif( 1=1, 1+2, 1+3 )" 

 Statements don't return values. You can assign them to event properties like 

OnFormat. For example: 
c1r.OnOpen = "if 1=1 then msgbox("OK!!!") else msgbox("ooops")" 

C1Report relies on VBScript to evaluate expressions in calculated fields and to handle report 

events. 

VBScript is a full-featured language, and you have access to all its methods and functions when 

writing C1Report expressions. For the intrinsic features of the VBScript language, refer to the 

Microsoft Developer's Network (MSDN). 

Global Scripts can be written in the new VBScript Editor. This editor allows users to define 

VBScript functions and subroutines that are accessible throughout the report. To directly access 

the VBScript Editor, press F7 and to close the editor and save the changes, use the shortcut 

key Ctrl+W. Users can switch between scripts and also change options such as fonts or colors 

within the editor. The editor also makes the scripting experience intuitive and easy for 

developers with advanced features such as syntax check, pre-defined VBScript functions, and 

rearranged scripting functions. 

To write global scripts using VBScript Editor option, 

1. Go to Home Tab of C1ReportDesigner. 

2. Click VBScript Editor and write desired global script; for example, 

 
 

        function Backcolor() 

        Detail.Backcolor=rgb(255,0,0) 

        end function 

 

You can also write global scripts using GlobalScripts property of C1ReportDesigner as follows: 

1. Select the report in which you want to write global script. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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2. Go to the GlobalScripts property of the report and then click ellipses. This opens 

VBScript Editor dialog box. 

3. Write the global script as above, in the VBScript Editor.        

4.  
5.                                         

    

So, you have defined a global function 'Backcolor()', which can be used throughout the report. 

The VBScript Editor has the following additional features: 

 IntelliSense: Provides auto code completion prompts for the scripts supported by 

VBScript Editor. IntelliSense in VBScript Editor has following features:  

o            

o The IntelliSense window that displays a context-dependent list of available 

words also displays a detailed help on VBScript functions and keywords in a 

small tooltip or help window. The italic font on the detailed help basically 

shows the category to which the current item belongs (such as 'VBScript 

function', 'C1Report aggregate script function', .NET object property, and so 

on). 

o On editing DataSource.Filter, the editor opens as Expression Editor - 

DataSource.Filter and IntelliSense shows keywords or functions available in 

that with corresponding help. 

o Icons associated with IntelliSense entries indicate the type of the entry. The 

icons' color palette is different for VBScript, report built-in stuff, and 

DataSource.Filter. 

o When a user types and Intellisense window is opened, the list is filtered 

according to the letters being typed for example, typing 't' will only show words 
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that contain the letter 't', typing 'te' will narrow the list to words that contain 

'te', and so on. 

o Backspace in the IntelliSense window undoes the last filter. 

o Pressing square bracket '[' shows the list of available db fields. 

o Pressing dot '.' after the name of an object such as a report, field, or section 

shows the .NET properties available for that object 

o Pressing Ctrl+J, Ctrl+Space, or a letter after a non-letter character shows the list 

of available VBScript functions, keywords, etc. depending on the context. 

 Split Window: Lets you view or write two same or different scripts in single 

VBScriptEditor. By default, the VBScript editor opens as a single window. 

To switch to Split Window 

Switch to the split window mode by clicking the split window glyph and dragging it 

down to open another editor at the top. The windows can be resized by dragging the 

divider between the windows. 

To switch back to the single window 

Click the 'x' glyph on the top right corner of the window to close the top window, turn 

the split mode off, and zoom out the bottom window. The enabled or disabled state of 

ribbon buttons depends on the current window, which is shown with a light green 

caption bar. The split window mode has following additional functionalities:    

o Switch between the two windows by pressing F6. 

o Hide the top window in a split window mode by dragging the split window 

glyph or the divider line high enough across the top window. 

 

Note that Global Scripts dropdown in VBScript Editor is enabled only if you have 

previously defined global script(s) in your report. 

C1Report extends VBScript by exposing additional objects, variables, and functions. These 

extensions are described in the sections listed in See Also. 

See Also 

VBScript Elements, Objects, and Variables 

Using Compatibility Functions: Iif and Format 

Using Aggregate Functions 

VBScript Elements, Objects, and Variables 
Working with C1Report > Working with VBScript > VBScript Elements, Objects, and Variables 

The following tables detail VBScript elements, objects, and variables. 

Operators 

The following table contains the VBScript operators: 

Operator Description 
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Operator Description 

And Performs a logical conjunction on two expressions. 

Or Performs a logical disjunction on two expressions. 

Not Performs a logical disjunction on two expressions. 

Mod Divides two numbers and returns only the remainder. 

Reserved symbols 

The following table contains the VBScript reserved symbols and how to use them: 

Keyword Description 

True The True keyword has a value equal to -1. 

False The False keyword has a value equal to 0. 

Nothing Used to disassociate an object variable from any actual object. To 

assign Nothing to an object variable, use the Set statement, for 

example: Set MyObject = Nothing Several object variables 

can refer to the same actual object. When Nothing is assigned to 

an object variable, that variable no longer refers to any actual 

object. When several object variables refer to the same object, 

memory and system resources associated with the object to which 

the variables refer are released only after all of them have been 

set to Nothing, either explicitly using Set, or implicitly after the 

last object variable set to Nothing. 

Null The Null keyword is used to indicate that a variable contains no 

valid data. 

vbCr When you call print and display functions, you can use the 

following constants in your code in place of the actual values. 

vbCrLf When you call print and display functions, you can use the 

following constants in your code in place of the actual values. 
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Keyword Description 

vbLf When you call print and display functions, you can use the 

following constants in your code in place of the actual values. 

vbFormFeed When you call print and display functions, you can use the 

following constants in your code in place of the actual values. 

vbNewLine When you call print and display functions, you can use the 

following constants in your code in place of the actual values. 

vbNullChar When you call print and display functions, you can use the 

following constants in your code in place of the actual values. 

vbTab When you call print and display functions, you can use the 

following constants in your code in place of the actual values. 

vbVerticalTab When you call print and display functions, you can use the 

following constants in your code in place of the actual values. 

vbBlack Black. Value = 0x0. 

vbRed Red. Value = 0xFF. 

vbGreen Green. Value = 0xFF00. 

vbYellow Yellow. Value = 0xFFFF. 

vbBlue Blue. Value = 0xFF0000. 

vbMagenta Magenta. Value = 0xFF00FF. 

vbCyan Cyan. Value = 0xFFFF00. 

vbWhite White. Value = 0xFFFFFF. 

Built-in functions 

The VBScript built-in functions are listed below: 
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Abs Date Iif Minute Sign 

Acos DateAdd InputBox Month Space 

Asc DateDiff InStr MonthName Sqr 

Asin DatePart InStrRev MsgBox StrComp 

Atn DateSerial Int Now String 

CBool DateValue IsDate Oct Tan 

CByte Day IsEmpty Pi Time 

CCur Exp IsNull Replace Timer 

CDate Fix IsNumeric RGB TimeSerial 

CDbl Format IsObject Right TimeValue 

Chr FormatCurrency LCase Rnd Trim 

CInt FormatDateTime Left Round TypeName 

CLng FormatNumber Len RTrim UCase 

Cos FormatPercent Log Second WeekDay 

CSng Hex LTrim Sgn WeekDayName 

CStr Hour Mid Sin Year 

For more information on the VBScript functions, see the MSDN documentation. 

The key features of VBScript that are part of C1Report are as follows: 

 Aggregate functions (Sum, Average, StDev, Var, Count, and so on) 

 Report and Database field names 

 Page/Pages variables 

 Report objects 

 String functions (Chr, Format, and so on) 

http://msdn2.microsoft.com/en-us/library/3ca8tfek.aspx
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 Data Conversion (CBool, CByte, an so on) 

 Math functions (cos, sin, and so on) 

 Functions and Subs 

 Conditional statements 

 Built-in functions (Like and In) 

Built-in script functions, Like and In have functionality similar to SQL operators LIKE and IN and 

return True or False. 

Like(str, template): Compares 'str' to 'template', which can contain wildcard '%'. Some examples 

of Like function are as follows: 

 Like("abc", "%bc") returns True. 

 Like("abc", "%bcd") returns False. 

 Like("abc", "ab%") returns True. 

 Like("abc", "abd%") returns False. 

 Like("abc", "%b%") returns True. 

 Like("abc", "%d%") returns False. 

 Like("abc", "abc") returns True. 

 Like("abc", "abcd") returns False. 

 Like("Abc", "abc") returns False. 

In(obj, obj1, ... objN): Tests whether 'obj' is among objects 'obj1', ... , 'objN'. Some examples of 

In function are as follows: 

 In(1,1,2,3) returns True. 

 In(1,2,3) returns False. 

 In("a", "a", "b", "c") returns True. 

 In("a", "b", "c") returns False. 

 In("A", "a", "b", "c") returns False. 

As you can observe, both the functions are case-sensitive, so "abc" is not the same as "Abc". 

Note that the following VBScript features are not supported in C1Report: 

 Arrays 

 Select/Case statements 

Statement keywords 

The VBScript statement keywords are listed below: 

If ElseIf To While Dim 

Then EndIf Next Wend Redim 

Else For Step Const  

Report Field Names 
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Names of Field objects are evaluated and return a reference to the object, so you can access the 

field's properties. The default property for the Field object is Value, so by itself the field name 

returns the field's current value. For example: 

MyField.BackColor = RGB(200,250,100) 

MyField.Font.Size = 14 

MyField * 2 ' (same as MyField.Value * 2)  

 

Note: If you give a report field the same name as a database field, you won't be able to 

access the report field. 

Report Section Names 

Names of Section objects are evaluated and return a reference to the object, so you can access 

the section's properties. The default property for the Section object is Name. For example: 

If Page = 1 Then [Page Footer].Visible = False 

Database Field Names 

Names of fields in the report's dataset source are evaluated and return the current field value. If 

a field name contains spaces or periods, it must be enclosed in square brackets. For example: 

OrderID 

UnitsInStock 

[Customer.FirstName] 

[Name With Spaces]  

Report Variables 

Page 

The page variable returns or sets the value of the Page property. This property is initialized by 

the control when it starts rendering a report, and is incremented at each page break. You may 

reset it using code. For example: 

If Country <> LastCountry Then Page = 1 

LastCountry = Country 

Pages 

The pages variable returns a token that gets replaced with the total page count when the report 

finishes rendering. This is a read-only property that is typically used in page header or footer 

fields. For example: 

"Page " & Page & " of " & Pages 

Report Object 

The report object returns a reference to the control object, so you can access the full C1Report 

object model from your scripts and expressions. For example: 

"Fields: " & Report.Fields.Count  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field.html
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Cancel 

Set Cancel to True to cancel the report rendering process. For example: 

If Page > 100 Then Cancel = True  

Using Compatibility Functions: Iif and Format 
Working with C1Report > Working with VBScript > Using Compatibility Functions: Iif and Format 

To increase compatibility with code written in Visual Basic and Microsoft Access (VBA), C1Report 

exposes two functions that are not available in VBScript: Iif and Format. 

Iif evaluates a Boolean expression and returns one of two values depending on the result. For 

example: 

Iif(SalesAmount > 1000, "Yes", "No")  

Format converts a value into a string formatted according to instructions contained in a format 

expression. The value may be a number, Boolean, date, or string. The format is a string built 

using syntax similar to the format string used in Visual Basic or VBA. 

The following table describes the syntax used for the format string: 

Value Type Format String Description 

Number Percent, % Formats a number as a percentage, with zero or two decimal 

places. For example: Format(0.33, "Percent") = 

"33%" 

Format(0.3333333, "Percent") = "33.33%" 

#,###.##0 Formats a number using a mask. The following symbols are 

recognized: # digit placeholder 0 digit placeholder, force 

display , use thousand separators ( enclose negative values in 

parenthesis % format as percentage For example: 

Format(1234.1234, "#,###.##") = "1,234.12" 

Format(-1234, "#.00") = "(1234.12)" 

Format(.1234, "#.##") = ".12" 

Format(.1234, "0.##") = "0.12" 

Format(.3, "#.##%") = "30.00%" 

Currency Currency, $ Formats a number as a currency value. Displays number with 

thousand separator, if appropriate; displays two digits to the 

right of the decimal separator. For example: Format(1234, 

"$") = "$1,234.00" 
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Value Type Format String Description 

Boolean Yes/No Returns "Yes" or "No". 

Date Long Date Format(#12/5/1#, "long date") = "December 5, 

2001" 

Short Date Format(#12/5/1#, "short date") = "12/5/2001" 

Medium Date Format(#12/5/1#, "medium date") = "05-Dec-01" 

q,m,d,w,yyyy Returns a date part (quarter, month, day of the month, week 

of the year, year). For example: Format(#12/5/1#, "q") 

= "4" 

String @@-@@/@@ Formats a string using a mask. The "@" character is a 

placeholder for a single character (or for the whole value 

string if there is a single "@"). Other characters are 

intercodeted as literals. For example: Format("AC55512", 

"@@-@@/@@") = "AC-555/12" 

Format("AC55512", "@") = "AC55512" 

@;Missing Uses the format string on the left of the semi-colon if the 

value is not null or an empty string, otherwise returns the 

part on the right of the semi-colon. For example: 

Format("@;Missing", "UK") = "UK" 

Format("@;Missing", "") = "Missing" 

Note that VBScript has its own built-in formatting functions (FormatNumber, FormatCurrency, 

FormatPercent, FormatDateTime, and so on). You may use them instead of the VBA-style 

Format function described here. 

Using Aggregate Functions 
Working with C1Report > Working with VBScript > Using Aggregate Functions 

Aggregate functions are used to summarize data over the group being rendered. When used in 

a report header field, these expressions return aggregates over the entire dataset. When used in 

group headers or footers, they return the aggregate for the group. 

All C1Report aggregate functions take two arguments: 

 A string containing a VBScript expression to be aggregated over the group. 
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 An optional string containing a VBScript expression used as a filter (domain aggregate). 

The filter expression is evaluated before each value is aggregated. If the filter returns 

False, the value is skipped and is not included in the aggregate result. 

C1Report defines the following aggregate functions: 

Function Description 

Avg Average value of the expression within the current group. 

For example, the following expression calculates the 

average sales for the whole group and the average sales for 

a certain type of product: Avg(SalesAmount) 

Avg(SalesAmount, ProductType = 3) 

Sum Sum of all values in the group. 

Count Count of records in the group with non-null values. Use an 

asterisk for the expression to include all records. For 

example, the following expressions count the number of 

employees with valid (non-null) addresses and the total 

number of employees: Count(Employees.Address) 

Count(*) 

CountDistinct Count of records in the group with distinct non-null values. 

Min, Max Minimum and maximum values for the expression. For 

example: "Min Sale = " & Max(SaleAmount) 

Range Range between minimum and maximum values for the 

expression. 

StDev, Var Standard deviation and variance of the expression in the 

current group. The values are calculated using the sample 

(n-1) formulas, as in SQL and Microsoft Excel. 

StDevP, VarP Standard deviation and variance of the expression in the 

current group. These values are calculated using the 

population (n) formulas, as in SQL and Microsoft Excel. 

To use the aggregate functions, add a calculated field to a Header or Footer section, and assign 

the expression to the field's Text property. 
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For example, the "Employee Sales by Country" report in the sample NWind.xml file contains 

several aggregate fields. The report groups records by Country and by Employee. 

The SalespersonTotal field in the Footer section of the Employee group contains the following 

expression: 

=Sum([SaleAmount])  

Because the field is in the Employee group footer, the expression returns the total sales for the 

current employee. 

The CountryTotal and GrandTotal fields contain exactly the same expression. However, 

because these fields are in the Country group footer and report footer, the expression returns 

the total sales for the current country and for the entire recordset. 

You may need to refer to a higher-level aggregate from within a group. For example, in the 

"Employee Sales by Country" report, there is a field that shows sales in the current country as a 

percentage of the grand total. Since all aggregates calculated within a country group refer to 

the current country, the report cannot calculate this directly. Instead, the PercentOfGrandTotal 

field uses the following expression: 

=[CountryTotal]/[GrandTotal]  

CountryTotal and GrandTotal are fields located in the Country and Report Footer sections. 

Therefore, CountryTotal holds the total for the current country and GrandTotal holds the total 

for the whole recordset. 

It is important to realize that evaluating aggregate functions is time-consuming, since it 

requires the control to traverse the recordset. Because of this, you should try to use aggregate 

functions in a few calculated fields only. Other fields can then read the aggregate value directly 

from these fields, rather than evaluating the aggregate expression again. 

For example, the "Employee Sales by Country" report in the NorthWind database has a detail 

field, PercentOfCountryTotal, that shows each sale as a percentage of the country's total sales. 

This field contains the following expression: 

=[SaleAmount]/[CountryTotal]  

SaleAmount is a reference to a recordset field, which varies for each detail record. 

CountryTotal is a reference to a report field that contains an aggregate function. When the 

control evaluates this expression, it gets the aggregate value directly from the report field, and 

does not recalculate the aggregate. 

For the complete report, see report "Employee Sales by Country" in the Nwind.xml report 

definition file, which is available in the ComponentOne Samples folder. 

Modifying the Fields 
Working with C1Report > Modifying the Fields 
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You are not restricted to using VBScript to evaluate expressions in calculated fields. You can 

also specify scripts that are triggered when the report is rendered, and you can use those to 

change the formatting of the report.These scripts are contained in event properties. An event 

property is similar to a Visual Basic event handler, except that the scripts are executed in the 

scope of the report rather than in the scope of the application that is displaying the report. For 

example, you could use an event property to set a field's Font and ForeColor properties 

depending on its value. This behavior would then be a part of the report itself, and would be 

preserved regardless of the application used to render it. 

Of course, traditional events are also available, and you should use them to implement behavior 

that affects the application rather than the report. For example, you could write a handler for 

the StartPage event to update a page count in your application, regardless of which particular 

report is being rendered. 

The following table lists the event properties that are available and typical uses for them: 

The following topics illustrate typical uses for these properties. 

Object Property Description 

Report OnOpen Fired when the report starts rendering. Can be used to modify the 

ConnectionString or RecordSource properties, or to initialize 

VBScript variables. 

OnClose Fired when the report finishes rendering. Can be used to perform 

clean-up tasks. 

OnNoData Fired when a report starts rendering but the source recordset is 

empty. You can set the Cancel property to True to prevent the 

report from being generated. You could also show a dialog box to 

alert the user as to the reason why no report is being displayed. 

OnPage Fired when a new page starts. Can be used to set the Visible 

property of sections of fields depending on a set of conditions. 

The control maintains a Page variable that is incremented 

automatically when a new page starts. 

OnError Fired when an error occurs. 

Section OnFormat Fired before the fields in a section are evaluated. At this point, the 

fields in the source recordset reflect the values that will be 
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Object Property Description 

rendered, but the report fields do not. 

OnPrint Fired before the fields in a section are printed. At this point, the 

fields have already been evaluated and you can do conditional 

formatting. 

See Also 

Formatting a Field According to Its Value 

Hiding a Section If There is no Data for it 

Showing or Hiding a Field Depending on a Value 

Prompting Users for Parameters 

Resetting the Page Counter 

Changing a Field's Dimensions to Create a Bar Chart 

Formatting a Field According to Its Value 
Working with C1Report > Modifying the Fields > Formatting a Field According to Its Value 

Show All  

Hide All  

Formatting a field according to its value is probably the most common use for the OnPrint 

property. Take for example a report that lists order values grouped by product. Instead of using 

an extra field to display the quantity in stock, the report highlights products that are below the 

reorder level by displaying their name in bold red characters. 

To highlight products that are below the reorder level using code: 

To highlight products that are below the reorder level by displaying their name in bold red 

characters, use an event script that looks like this: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim script As String = _     

  "If UnitsInStock < ReorderLevel Then" & vbCrLf & _     
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  "ProductNameCtl.ForeColor = RGB(255,0,0)" & vbCrLf & _     

  "ProductNameCtl.Font.Bold = True" & vbCrLf & _     

  "Else" & vbCrLf & _     

  "ProductNameCtl.ForeColor = RGB(0,0,0)" & vbCrLf & _    

  "ProductNameCtl.Font.Bold = False" & vbCrLf & _     

  "End If"     

c1r.Sections.Detail.OnPrint = script 

To write code in C# 

C# Copy Code  

 

string  script =       

  "if (UnitsInStock < ReorderLevel) then\r\n" +     

  "ProductNameCtl.ForeColor = rgb(255,0,0)\r\n" +      

  "ProductNameCtl.Font.Bold = true\r\n" +      

  "else\r\n" +     

  "ProductNameCtl.ForeColor = rgb(0,0,0)\r\n" +      

  "ProductNameCtl.Font.Bold = false\r\n" +      

  "end if\r\n";     

c1r.Sections.Detail.OnPrint = script; 

The code builds a string containing the VBScript event handler, and then assigns it to the 

section's OnPrint property. 

To highlight products that are below the reorder level using the C1ReportDesigner: 

Alternatively, instead of writing the code, you can use the C1ReportDesigner application to 

type the following script code directly into the VBScript Editor of the Detail section's OnPrint 

property. Complete the following steps: 

1. Select Detail from the Properties window drop-down list in the Designer. This reveals 

the section's available properties. 

2. Click the empty box next to the OnPrint property, then click the drop-down arrow, and 

select Script Editor from the list. 

3. In the VBScript Editor, simply type the following script in the window: 
If UnitsInStock < ReorderLevel Then ProductNameCtl.ForeColor = 

RGB(255,0,0) ProductNameCtl.Font.Bold = True Else 

ProductNameCtl.ForeColor = RGB(0,0,0) ProductNameCtl.Font.Bold = 

False End If 

 

To highlight products that are below the reorder level using the C1ReportDesigner: 

To highlight the products that are below the reorder level using the C1ReportDesigner: 
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Alternatively, instead of writing the code, you can use the C1ReportDesigner to type the 

following script code directly into the VBScript Editor of the Detail section's Section.OnPrint 

property. Complete the following steps: 

1. Select Detail from the Properties window drop-down list in the Designer. This reveals 

the section's available properties. 

2. Click the empty box next to the Section.OnPrint property, then click the drop-down 

arrow, and select Script Editor from the list. 

3. In the VBScript Editor, simply type the following script in the window: 

If UnitsInStock < ReorderLevel Then 

  ProductNameCtl.ForeColor = RGB(255,0,0) 

  ProductNameCtl.Font.Bold = True 

Else 

  ProductNameCtl.ForeColor = RGB(0,0,0) 

  ProductNameCtl.Font.Bold = False 

End If 

4. Click OK to close the editor. 

The control executes the VBScript code whenever the section is about to be printed. The script 

gets the value of the "ReorderLevel" database field and sets the "ProductName" report field's 

Field.Font.Bold and Field.ForeColor properties according to the value. If the product is below 

reorder level, its name becomes bold and red. 

The following screen capture shows a section of the report with the special effects: 
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Hiding a Section If There is no Data for it 
Working with C1Report > Modifying the Fields > Hiding a Section If There is no Data for it 

Show All  

Hide All  

You can change a report field's format based on its data by specifying an expression for the 

Detail section's OnFormat property. 

For example, your Detail section has fields with an image control and when there is no data for 

that record's image you want to hide the record. To hide the Detail section when there is no 

data, in this case a record's image, add the following script to the Detail section's OnFormat 

property: 

 
If isnull(PictureFieldName) Then 

  Detail.Visible = false 

 Else 

  Detail.Visible = true 

End If 

To hide a section if there is no data for it using code: 
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To hide a section if there is no data, in this case a record's image, for it, use an event script that 

looks like this: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

C1Report1.Sections.Detail.OnFormat = "Detail.Visible = not 

isnull(PictureFieldName)" 

To write code in C# 

C# Copy Code  

 

c1Report1.Sections.Detail.OnFormat = "Detail.Visible = not 

isnull(PictureFieldName)"; 

To hide a section if there is no data for it using the C1ReportDesigner: 

Alternatively, instead of writing the code, you can use the C1ReportDesigner to type the 

following script code directly into the VBScript Editor of the Detail section's OnFormat 

property. Complete the following steps: 

1. Select Detail from the Properties window drop-down list in the Designer. This reveals 

the section's available properties. 

2. Click the empty box next to the Section.OnFormat property, then click the drop-down 

arrow, and select Script Editor from the list. 

3. In the VBScript Editor:  

o Simply type the following script in the window: 
If isnull(PictureFieldName) Then 

Detail.Visible = false 

Else 

Detail.Visible = true 

End If 

o Or you could use the more concise version: Detail.Visible = not 
isnull(PictureFieldName) 

See Also 
Getting Started with Printing and Previewing 

Showing or Hiding a Field Depending on a 

Value 
Working with C1Report > Modifying the Fields > Showing or Hiding a Field Depending on a Value 
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Instead of changing the field format to highlight its contents, you could set another field's 

Visible property to True or False to create special effects. For example, if you created a new 

field called "BoxCtl" and formatted it to look like a bold rectangle around the product name, 

then you could change the script as follows: 

 
    

If UnitsInStock < ReorderLevel Then  

BoxCtl.Visible = True 

Else 

BoxCtl.Visible = False 

End If 

 

To highlight products that are below the reorder level using code: 

To highlight products that are below the reorder level by displaying a box, use an event script 

that looks like this: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim script As String = _     

  "If UnitsInStock < ReorderLevel Then" & vbCrLf & _ 

 

  "  BoxCtl.Visible = True" & vbCrLf & _     

  "Else" & vbCrLf & _     

  "  BoxCtl.Visible = False" & vbCrLf & _     

  "End If"     

c1r.Sections.Detail.OnPrint = script 

To write code in C# 

C# Copy Code  

 

string script =       

  "if (UnitsInStock < ReorderLevel) then\r\n" +      

  "BoxCtl.Visible = true\r\n" +      

  "else\r\n" +       

  "BoxCtl.Visible = false\r\n" +       

  "end if\r\n";     
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c1r.Sections.Detail.OnPrint = script; 

The code builds a string containing the VBScript event handler, and then assigns it to the 

section's OnPrint property. 

To highlight products that are below the reorder level using 

C1ReportDesigner: 

Alternatively, instead of writing the code, you can use the C1ReportDesigner application to 

type the following script code directly into the VBScript Editor of the Detail section's OnPrint 

property. Complete the following steps: 

1. Select Detail from the Properties window drop-down list in the Designer. This reveals 

the section's available properties. 

2. Click the empty box next to the OnPrint property, then click the drop-down arrow, and 

select Script Editor from the list. 

3. In the VBScript Editor, simply type the following script in the window: 

4.  
5.  
6. If UnitsInStock < ReorderLevel Then  
7. BoxCtl.Visible = True 
8. Else 
9. BoxCtl.Visible = False    

10. End If 

The following screen capture shows a section of the report with the special effects: 

 

Prompting Users for Parameters 
Working with C1Report > Modifying the Fields > Prompting Users for Parameters 
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Instead of highlighting products which are below the reorder level stored in the database, you 

could have the report prompt the user for the reorder level to use. 

To get the value from the user, you would change the report's RecordSource property to use a 

parameter query. (For details on how to build parameter queries, see Parameter Queries.) 

To write code in Visual Basic 

Visual Basic Copy Code  

 

c1r.DataSource.RecordSource = _         

  "PARAMETERS [Critical Stock Level] Short 10;" & _         

  c1r.DataSource.RecordSource 

To write code in C# 

C# Copy Code  

 

c1r.DataSource.RecordSource =           

"PARAMETERS [Critical Stock Level] short 10;" +           

c1r.DataSource.RecordSource; 

This setting causes the control to prompt the user for a "Critical Stock Level" value, which gets 

stored in a global VBScript variable where your events can use it. The default value for the 

variable is specified as 10. 

To use the value specified by the user, the script should be changed as follows: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim script As String = _         

  "level = [Critical Stock Level]" & vbCrLf & _         

  "If UnitsInStock < level Then" & vbCrLf & _         

  "  ProductNameCtl.ForeColor = RGB(255,0,0)" & vbCrLf & _        

  "  ProductNameCtl.Font.Bold = True" & vbCrLf & _        

  "Else" & vbCrLf & _         

  "  ProductNameCtl.ForeColor = RGB(0,0,0)" & vbCrLf & _         
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  "  ProductNameCtl.Font.Bold = False" & vbCrLf & _         

  "End If"         

c1r.Sections("Detail").OnPrint = script 

To write code in C# 

C# Copy Code  

 

string  script =           

  "level = [Critical Stock Level]\r\n" +           

  "if (UnitsInStock < level) then\r\n" +           

  "ProductNameCtl.ForeColor = rgb(255,0,0)\r\n" +           

  "ProductNameCtl.Font.Bold = true\r\n" +          

  "else\r\n" +           

  "ProductNameCtl.ForeColor = rgb(0,0,0)\r\n" +         

  "ProductNameCtl.Font.Bold = false\r\n" +           

  "end if\r\n";         

c1r.Sections.Detail.OnPrint = script; 

The change is in the first two lines of the script. Instead of comparing the current value of the 

"UnitsInStock" filed to the reorder level stored in the database, the script compares it to the 

value entered by the user and stored in the "[Critical Stock Level]" VBScript variable. 

Resetting the Page Counter 
Working with C1Report > Modifying the Fields > Resetting the Page Counter 

Show All  

Hide All  

The C1Report.Page variable is created and automatically updated by the control. It is useful for 

adding page numbers to page headers or footers. In some cases, you may want to reset the 

page counter when a group starts. For example, in a report that groups records by country. You 

can do this by adding code or using the Designer. 

Using Code: 

To reset the page counter when a group (for example, a new country) starts, set the PageFooter 

field's Text property. Enter the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  
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C1Report1.Fields("PageFooter").Text = "[ShipCountry] & "" "" & [Page]" 

To write code in C# 

C# Copy Code  

 

c1Report1.Fields("PageFooter").Text = "[ShipCountry] + "" "" + [Page]"; 

Using the C1ReportDesigner: 

To reset the page counter when a group (for example, a new country) starts, set the PageFooter 

field's Text property by completing the following steps: 

1. Select the PageFooter's page number field from the Properties window drop-down list 

in the Designer or select the field from the design pane. This reveals the field's available 

properties. 

2. Click the box next to the Text property, then click the drop-down arrow, and select 

Script Editor from the list. 

3. In the VBScript Editor, simply type the following script in the window: 
[ShipCountry] & " - Page " & [Page] 

4. Click OK to close the editor. 

See Also 
Hiding a Section If There is no Data for it 

Changing a Field's Dimensions to Create a 

Bar Chart 
Working with C1Report > Modifying the Fields > Changing a Field's Dimensions to Create a Bar Chart 

Show All  

Hide All  

This is the most sophisticated example. Instead of showing a field's value as text, you can 

change its dimensions to create a chart. 

Create the Chart 

To create a chart, the first thing you need to do is find out the scale, that is, the measurements 

that will be used to the maximum and minimum values. The "Sales Chart" report has a field 

designed to do this. It is a report footer field called SaleAmountMaxFld that has the size of the 

longest bar you want to appear on the chart, and holds the following expression: 

=Max([SaleAmount]) 
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Using Code: 

To set the maximum value for the chart, set the SaleAmountMaxFld.Text property. Enter the 

following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

SaleAmountMaxFld.Text = "Max([SaleAmount])" 

To write code in C# 

C# Copy Code  

 

SaleAmountMaxFld.Text = "Max([SaleAmount])"; 

Using C1ReportDesigner: 

To set the maximum value for the chart, set the SaleAmountMaxFld.Text property by 

completing the following steps: 

1. Select the SaleAmountMaxFld from the Properties window drop-down list in the 

Designer. This reveals the field's available properties. 

2. Click the empty box next to the Text property, then click the drop-down arrow, and 

select Script Editor from the list. 

3. In the VBScript Editor, simply type the following script in the window: 
=Max([SaleAmount]) 

Draw the Chart's Bars 

To draw the actual bars, the report has a detail field called BarFld that is formatted to look like 

a solid box. The Detail section has the following script assigned to its OnPrint property: 

BarFld.Width = SaleAmountMaxFld.Width * (SaleAmountFld / SaleAmountMaxFld) 

This expression calculates the width of the bar based on the width and value of the reference 

field and on the value of the SaleAmountFld for the current record. 

Using Code: 

To draw the actual bars for the chart, set the OnPrint property. Enter the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~OnPrint.html
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c1r.Sections.Detail.OnPrint = & _     

  "BarFld.Width = SaleAmountMaxFld.Width * " & _     

  "(SaleAmountFld / SaleAmountMaxFld)" 

To write code in C# 

C# Copy Code  

 

c1r.Sections.Detail.OnPrint = +       

  "BarFld.Width = SaleAmountMaxFld.Width * " +       

  "(SaleAmountFld / SaleAmountMaxFld)"; 

Using C1ReportDesigner: 

To draw the actual bars for the chart, set the OnPrint property by completing the following 

steps: 

1. Select Detail from the Properties window drop-down list in the Designer. This reveals 

the Detail section's available properties. 

2. Click the empty box next to the OnPrint property, then click the drop-down arrow, and 

select Script Editor from the list. 

3. In the VBScript Editor, simply type the following script in the window:BarFld.Width 
= SaleAmountMaxFld.Width * (SaleAmountFld / SaleAmountMaxFld) 

The following screen capture shows a section of the "Sales Chart" report with the special effects: 
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For the complete report, see report "Sales Chart" in the NWind.xml report definition file, which 

is available as part of the NorthWind sample in the ComponentOne Samples folder. 

Advanced Uses 
Working with C1Report > Advanced Uses 

This section describes how you can add parameter queries, create unbound reports, use custom 

data sources, and add data security to your reports. 

See Also 

Parameter Queries 

Unbound Reports 

Custom Data Sources 

Data Security 

Parameter Queries 
Working with C1Report > Advanced Uses > Parameter Queries 

A parameter query is a query that displays its own dialog box prompting the user for 

information, such as criteria for retrieving records or a value for a report field. You can design 

the query to prompt the user for more than one piece of information; for example, you can 

design it to retrieve two dates. C1Report then retrieves all records that fall between those two 

dates. 

You can also create a monthly earnings report based on a parameter query. When you render 

the report, C1Report displays a dialog box asking for the month that you want the report to 

cover. You enter a month and C1Report prints the appropriate report. 

To create a parameter query, you need to edit the SQL statement in the RecordSource property 

and add a PARAMETERS clause to it. The syntax used to create parameter queries is the same as 

that used by Microsoft Access. 

1. The easiest way to create a parameter query is to start with a plain SQL statement with 

one or more items in the WHERE clause, then manually replace the fixed values in the 

clause with parameters. For example, starting with the plain SQL statement: 

2.  
3.   
4. strSQL = "SELECT DISTINCTROW * FROM Employees " & _ 
5. "INNER JOIN (Orders INNER JOIN [Order Subtotals] " & _ 
6. "ON Orders.OrderID = [Order Subtotals].OrderID) " & _ 
7. "ON Employees.EmployeeID = Orders.EmployeeID " & _ 
8. "WHERE (((Orders.ShippedDate) " & _ 
9. "Between #1/1/1994# And #1/1/2001#));" 

10.  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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11. The next step is to identify the parts of the SQL statement that will be turned into 

parameters. In this example, the parameters are the dates in the WHERE clause, shown 

above in boldface. Let's call these parameters Beginning Date and Ending Date. Since 

these names contain spaces, they need to be enclosed in square brackets: 

12.  
13.   

14. strSQL = "SELECT DISTINCTROW * FROM Employees " & _ 

15. "INNER JOIN (Orders INNER JOIN [Order Subtotals] " & _ 

16. "ON Orders.OrderID = [Order Subtotals].OrderID) " & _ 

17. "ON Employees.EmployeeID = Orders.EmployeeID " & _ 

18. "WHERE (((Orders.ShippedDate) " & _ 

19. "Between [Beginning Date] And [Ending Date]));" 

20.  

21.  

22. Finally, the parameters must be identified in the beginning of the SQL statement with a 

PARAMETERS clause, that includes the parameter name, type, and default value: 

23.  
24.   

25. strSQL = "PARAMETERS [Beginning Date] DateTime 1/1/1994, " & _ 

26. "[Ending Date] DateTime 1/1/2001;" & _ 

27. "SELECT DISTINCTROW * FROM Employees " & _ 

28. "INNER JOIN (Orders INNER JOIN [Order Subtotals] " & _ 

29. "ON Orders.OrderID = [Order Subtotals].OrderID) " & _ 

30. "ON Employees.EmployeeID = Orders.EmployeeID " & _ 

31. "WHERE (((Orders.ShippedDate) " & _ 

32. "Between [Beginning Date] And [Ending Date]));" 

33.  

When this statement is executed, the control shows a dialog box prompting the user for 

Beginning Date and Ending Date values. The values supplied by the user are plugged into the 

SQL statement and the report is generated only for the period selected by the user. 

The dialog box is created on-the-fly by C1Report. It includes all parameters in the query, and 

uses controls appropriate to the parameter type. For example, check boxes are used for Boolean 

parameters, and date-time picker controls are used for Date parameters. Here is what the dialog 

box looks like for the SQL statement listed above: 

 

The syntax for the PARAMETERS clause consists of a comma-separated list of items, ending with 

a semi-colon. Each item describes one parameter and includes the following information: 

 Parameter name. If the name contains spaces, it must be enclosed in square brackets 

(for example, [Beginning Date]). The parameter name appears in the dialog box used to 

collect the information from the user, and it also appears in the WHERE clause for the 

SQL statement, where it is replaced with the value entered by the user. 

 Parameter type. The following types are recognized by the control:  
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Type Name ADO Type 

Date adDate 

DateTime adDate 

Bit, Byte, Short, Long adInteger 

Currency adCurrency 

Single adSingle 

Double adDouble 

Text, String adBSTR 

Boolean, Bool, YesNo adBoolean 

 Default value. This is the value initially displayed in the dialog box. 

The easiest way to build a parameterized query is incrementally. Start with a simple query that 

works, then add the PARAMETERS clause (don't forget to end the PARAMETERS clause with a 

semi-colon). Finally, edit the WHERE clause and add the parameter names at the proper place. 

You can use the GetRecordSource method to retrieve a proper SQL statement (without the 

PARAMETERS clause) from a parameter query. This is useful if you want to create your own 

recordset using data contained in the report. 

 

Note: Instead of using a parameter query, you could write code in Visual Basic or in C# to 

create a dialog box, get the information from the user, and fix the SQL statement or set the 

DataSource object's Filter property as needed. The advantage of using parameter queries is 

that it places the parameter logic in the report itself, and it is independent of the viewer 

application. (It also saves you from writing some code.) 

 

Unbound Reports 
Working with C1Report > Advanced Uses > Unbound Reports 

Show All  

Hide All  
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Unbound reports are reports without an underlying source recordset. This type of report can be 

useful in two situations: 

 You create documents that have a fixed format, and only the content of a few fields 

that change every time you need to render the document. Business forms are a typical 

example: the forms have a fixed format, and the field values change. 

 You want to consolidate several summary reports into a single one. In this case, you 

would create an unbound main report, and you would add bound subreports to it. 

As an example of a simple unbound report, let's create a simple newsletter without a source 

recordset. This is done with the C1ReportDesigner application, except that you leave the 

ConnectionString and RecordSource properties blank and add placeholder fields to the report. 

The placeholder fields are simple labels whose contents will be set by an application. 

Assuming you created a report with six placeholder fields named "FldHeadlineXXX" and 

"FldBodyXXX" (where XXX ranges from 1 to 3), you could use the following code to render the 

report: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub MakeReport() 

 

  ' find report definition file         

  Dim path As String = Application.StartupPath         

  Dim i As Integer = path.IndexOf("\bin")         

  If i > -1 Then path = path.Substring(0, i)         

  path = path & "\" 

 

  ' load unbound report         

  c1r.Load(path & "Newsletter.xml", "NewsLetter") 

 

  ' set field values         

  c1r.Fields("FldHeadline1").Text = "C1Report Launched"         

  c1r.Fields("FldBody1").Text = "ComponentOne unveils..."         

  c1r.Fields("FldHeadline2").Text = "Competitive Upgrades"         

  c1r.Fields("FldBody2").Text = "Get ahead ..."         

  c1r.Fields("FldHeadline3").Text = "C1Report Designer"         

  c1r.Fields("FldBody3").Text = "The C1Report Designer..."         

    

  ' done, show the report         

  c1ppv.Document = c1r         
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  ' and/or save it to an HTML document so your subscribers         

  ' can get to it over the Web         

  c1r.RenderToFile(path & "Newsletter.htm", FileFormatEnum.HTML)         

End Sub 

To write code in C# 

C# Copy Code  

 

private void MakeReport()          

{         

     

  // find report definition file         

   string path = Application.StartupPath;         

   int i = path.IndexOf("\bin");         

  if ( i > -1 ) { path = path.Substring(0, i)         

  path = path + "\"; 

 

  // load unbound report         

  c1r.Load(path + "Newsletter.xml", "NewsLetter"); 

 

  // set field values         

  c1r.Fields["FldHeadline1"].Text = "C1Report Launched";         

  c1r.Fields["FldBody1"].Text = "ComponentOne unveils...";         

  c1r.Fields["FldHeadline2"].Text = "Competitive Upgrades";         

  c1r.Fields["FldBody2"].Text = "get { ahead ...";         

  c1r.Fields["FldHeadline3"].Text = "C1Report Designer";         

  c1r.Fields["FldBody3"].Text = "The C1Report Designer..."; 

 

  // done, show the report         

  c1ppv.Document = c1r; 

 

  // and/or save it to an HTML document so your subscribers         

  // can get to it over the Web 

  

  c1r.RenderToFile(path + "Newsletter.htm", FileFormatEnum.HTML);         

} 

Here's what this issue of ComponentOne's newsletter looks like. Notice that our simple program 

does not deal with any formatting at all; it simply supplies the report contents. The report 
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definition created with the C1ReportDesigner application takes care of all the formatting, 

including a headline with a logo, page footers, fonts and text positioning. 

Separating format from content is one of the main advantages of unbound reports. 

 

Custom Data Sources 
Working with C1Report > Advanced Uses > Custom Data Sources 

By default, C1Report uses the ConnectionString and RecordSource properties to create an 

internal DataTable object that is used as a data source for the report. However, you can also 

create your own recordsets and assign them directly to the Recordset property. In this case, 

C1Report uses the recordset provided instead of opening its own. 

You can assign three types of objects to the Recordset property: DataTable, DataView, or any 

object that implements the IC1ReportRecordset interface. 

See Also 

Using Your Own DataTable Objects 

Writing Your Own Custom Recordset Object 

Using Your Own DataTable Objects 
Working with C1Report > Advanced Uses > Custom Data Sources > Using Your Own DataTable Objects 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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Show All  

Hide All  

The main reason to use your own DataTable objects is in situations where you already have the 

object available, and want to save some time by not creating a new one. You may also want to 

implement security schemes or customize the object in some other way. 

To use your own DataTable object, simply assign it to the RecordSet property before you 

render the report. For example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub CreateReport(strSelect As String, strConn As String) 

 

  ' fill a DataSet object         

  Dim da As OleDbDataAdapter         

  da = new OleDbDataAdapter(strSelect, strConn)         

  Dim ds As DataSet = new DataSet()         

  da.Fill(ds) 

 

  ' get the DataTable object         

  Dim dt As DataTable = ds.Tables(0) 

 

  ' load report           

  c1r.Load("RepDef.xml", "My Report") 

 

  ' render report           

  c1r.DataSource.Recordset = ds.Tables(0)         

  c1ppv.Document = c1r 

 

End Sub 

To write code in C# 

C# Copy Code  

 

private void CreateReport(string  strSelect, string  strConn)          

{ 
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  // fill a DataSet object           

   OleDbDataAdapter da;         

  da = new OleDbDataAdapter(strSelect, strConn);         

  DataSet  DataSet ds = new DataSet();         

  da.Fill(ds); 

 

  // get the DataTable object          

   DataTable dt = ds.Tables[0]; 

 

  // load report          

  c1r.Load("RepDef.xml", "My Report"); 

 

  // render report          

  c1r.DataSource.Recordset = ds.Tables[0];         

  c1ppv.Document = c1r; 

    

} 

The code above creates a DataTable object using standard ADO.NET calls, and then assigns the 

table to the Recordset property. Note that you could also create and populate the DataTable 

object on the fly, without relying on and actual database. 

Writing Your Own Custom Recordset Object 
Working with C1Report > Advanced Uses > Custom Data Sources > Writing Your Own Custom Recordset 

Object 

For the ultimate in data source customization, you can implement your own data source object. 

This option is indicated in situations where: 

1. Your data is already loaded in memory. 

2. Some or all of the data is calculated on demand, and does not even exist until you 

request it. 

3. The data comes from disparate data sources and you don't have an easy way to create 

a standard DataTable object from it. 

To implement your own data source object, you need to create an object that implements the 

IC1ReportRecordset interface. This interface contains a few simple methods described in the 

reference section of this document. 

After you have created the custom data source object, all you need to do is create an instance 

of it and assign that to the Recordset property. 

For the complete project, see the CustomData sample, which is installed in the 

ComponentOne Samples folder. 
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Data Security 
Working with C1Report > Advanced Uses > Data Security 

Data security is an important issue for most corporations. If you plan to create and distribute a 

phone-directory report for your company, you want to show employee names and phone 

extensions. You probably don't want people to change the report definition and create a report 

that includes people's salaries. Another concern is that someone could look at the report 

definition file, copy a connection string and start browsing (or hacking) your database. 

These are legitimate concerns that affect all types of data-based applications, including 

C1Report. This section discusses some measures you can take to protect your data. 

See Also 

Using Windows NT Integrated Security 

Building a ConnectionString with a User-Supplied Password 

Creating Application-Defined Aliases 

Using Windows NT Integrated Security 
Working with C1Report > Advanced Uses > Data Security > Using Windows NT Integrated Security 

One of the strengths of Windows NT is the way it handles security. When a user logs on, the 

system automatically gives him a set of permissions granted by the system administrator. After 

this, each application or service can query Windows NT to see what resources he can access. 

Most popular database providers offer this type of security as an option. 

Under this type of scenario, all you need to do is make sure that the people with whom you 

want to share your data have the appropriate permissions to read it. In this case, the 

ConnectionString in the report definition file doesn't need to contain any passwords. 

Authorized users get to see the data and others do not. 

Building a ConnectionString with a User-Supplied 

Password 
Working with C1Report > Advanced Uses > Data Security > Building a ConnectionString with a User-

Supplied Password 

Show All  

Hide All  

Building a connection string with a user-supplied password is a very simple alternative to 

protect your data. For example, before rendering a report (or when the control reports a "failed 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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to connect" error), you can prompt the user for a password and plug that into the connection 

string: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim strConn         

strConn = "Provider=Microsoft.Jet.OLEDB.4.0;" & _         

          "Data Source=C:\SecureData\People.mdb;" & _         

          "Password={{THEPASSWORD}};" 

 

' get password from the user         

Dim strPwd$         

strPwd = InputBox("Please enter your password:")         

If Len(strPwd) = 0 Then Exit Sub 

   

' build new connection string and assign it to the control         

strConn = Replace(strConn, "{{THEPASSWORD}}", strPwd)         

vsr.DataSource.ConnectionString = strConn 

To write code in C# 

C# Copy Code  

 

// build connection string with placeholder for password         

string strConn = "Provider=Microsoft.Jet.OLEDB.4.0;" +           

          "Data Source=C:\SecureData\People.mdb;" +           

          "Password={{THEPASSWORD}};"; 

 

// get password from the user         

string strPwd = InputBox("Please enter your password:");         

if (strPwd.Length == 0) return; 

 

// build new connection string and assign it to the control         

strConn = Replace(strConn, "{{THEPASSWORD}}", strPwd);         

c1r.DataSource.ConnectionString = strConn; 
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Creating Application-Defined Aliases 
Working with C1Report > Advanced Uses > Data Security > Creating Application-Defined Aliases 

Show All  

Hide All  

Another possible scenario is one where you want to allow certain users to see the reports, but 

you don't want to give them any special authorizations or information about where the data is 

stored. 

There are two simple ways to achieve this with C1Report. One is by using embedded reports. 

Load the report definition into your application at design time, using the Load Report dialog 

box, and the report will be embedded in the application. This way, you don't have to distribute 

a report definition file and no one will have access to the data source information. 

The second way would be for your application to define a set of connection string aliases. The 

report definition file would contain the alias, and your application would replace it with the 

actual connection string before rendering the reports. The alias would be useless in any other 

applications (such as C1ReportDesigner). Depending on how concerned you are with security, 

you could also perform checks on the RecordSource property to make sure no one is trying to 

get unauthorized access to certain tables or fields in the database. 

The following code shows how you might implement a simple alias scheme: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub RenderReport(strReportName As String) 

 

  ' load report requested by the user         

  c1r.Load("c:\Reports\MyReports.xml", strReportName) 

 

  ' replace connection string alias         

  Dim strConn$         

  Select Case c1r.DataSource.ConnectionString 

    Case "CUSTOMERS"         

    Case "EMPLOYEES"         

       strConn = "Provider=Microsoft.Jet.OLEDB.4.0;" & _          

                "Data Source=C:\SecureData\People.mdb;" & _         

                "Password=slekrsldksd;"         

    Case "$$SALES"         

      strConn = "Provider=Microsoft.Jet.OLEDB.4.0;" & _         

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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                "Data Source=C:\SecureData\Numbers.mdb;" & _         

                "Password=slkkdmssids;"          

  End Select 

 

  ' set connection string, render report          

  c1r.DataSource.ConnectionString = strConn         

  ppv1.Document = c1r       

   

End Sub 

To write code in C# 

C# $$copyCode$$  

 

private void RenderReport(string  strReportName) { 

 

  // load report requested by the user         

  c1r.Load("c:\Reports\MyReports.xml", strReportName);        

      

  // replace connection string alias         

  string strConn$;         

  switch (i) { c1r.DataSource.ConnectionString; 

   

    case "$$CUSTOMERS";         

    case "EMPLOYEES";         

      strConn = "Provider=Microsoft.Jet.OLEDB.4.0;" + _          

                "Data Source=CSALES"; 

      strConn = "Provider=Microsoft.Jet.OLEDB.4.0;" +          

               "Data Source=C:\SecureData\Numbers.mdb;" +         

                "Password=slkkdmssids;";         

  } 

 

  // set connection string, render report          

  c1r.DataSource.ConnectionString = strConn;         

  ppv1.Document = c1r;         

} 
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SSRS and ComponentOne Reports 
Working with C1Report > SSRS and ComponentOne Reports  

C1PrintPreviewControl allows you to load SSRS reports with the help of 

C1SSRSDocumentSource. See Previewing SSRS Reports to know how to load an SSRS report in 

C1PrintPreviewControl. 

You can preview the report in both paginated and non-paginated modes. The SsrsPaginated 

property in C1PrintPreviewControl control allows you to change the mode of the SSRS report. 

It is set to false by default, making non-paginated the default mode. 

Paginated Mode Non-Paginated Mode 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
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This mode organizes the report into fixed size 

pages by adding page breaks. 

This mode displays the entire content in a 

single flow and removes all page breaks. 

In both modes, you can change the parameters in a parameterized report and reload the report. 

Click the Report Parameters button to open the Report Parameters dialog and re-select the 

parameters. 
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Features of non-paginated mode: 

 Data is loaded more quickly and efficiently than in paginated mode. There is no need to 

load the entire report, just load the current non-paginated page. 

 Display a report outline (similar to a table of contents) in the outline panel of 

the navigation pane. This allows you to navigate to a specific place in the report quickly. 

 Enable a search toolbar at the bottom of C1PrintPreviewControl. Set 

the TextSearchPanelVisible property to True and TextSearchUIStyle property to 

Toolbar.

 
 Scroll or zoom the report content. 

 Expand or collapse parts of the report or sort items in non-paginated mode. After 

completing these actions, if you switch to paginated mode, you can print the 

updated report with expanded and sorted sections. 

 Drilldown or navigate to a point within the report. Or drill-through to another report. 

Use the Previous View and Next View buttons   to navigate between the 

locations. 

 Tooltips of report elements are visible. 

 Select and copy text to the clipboard. 

Limitation of non-paginated mode: 

Report cannot be printed in non-paginated mode. You need to switch to paginated mode for 

printing the report. 

Features of paginated mode: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl~TextSearchPanelVisible.html
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 240 

C1PrintPreviewControl displays page thumbnails in the navigation pane that allow users to 

navigate to a specific page in the report quickly. 

Limitations of paginated mode: 

 Text cannot be copied to the clipboard in paginated mode. 

 Text search toolbar does not work in paginated mode. 

Working with C1RdlReport 
The C1RdlReport component, a component that represents an RDL (Report Definition 

Language) report defined using the 2008 version of the RDL specification. The C1RdlReport 

component is similar to the C1Report component with the addition of RDL support. The 

C1RdlReport component is located in the C1.C1Report.2.dll assembly. 

RDL import in C1PrintDocument (provided by ImportRdl and FromRdl methods) is now 

obsolete. C1RdlReport should be used instead. 

Important Notes for .NET 2.0/3.0 version users: 

The C1.C1Report.2 assembly uses the System.Windows.Forms.DataVisualization.dll assembly 

that is only included in .NET Framework 3.5 and later. The assembly is installed on your system 

with when you install Reports for WinForms. It MUST BE INCLUDED with other 

ComponentOne Reports assemblies when you deploy your application that uses Reports for 

WinForms to other systems. 

Also, if you update the Reports for WinForms DLLs manually, you MUST put 

DataVisualization where those assemblies are, and make sure that your project references it. 

This does not apply to .NET 4.0 users as DataVisualization is already included in the 

Framework. 

See Also 

Report Definition Language (RDL) 

C1RdlReport Advantages and Limitations 

Loading an RDL File 

Report Definition Language (RDL) 
Working with C1RdlReport > Report Definition Language (RDL) 

Report Definition Language (RDL) is a Microsoft-standard XML schema for representing reports. 

The goal of RDL is to promote the interoperability of reporting products by defining a common 

schema that allows interchange of report definitions. RDL is designed to be output format 

C1.C1Report.4~C1.C1Rdl.Rdl2008.C1RdlReport.html
C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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neutral. This means that reports defined using RDL should be able to be outputted to a variety 

of formats including Web and print-ready formats or data-focused formats like XML. 

The C1RdlReport component was added to Reports for WinForms in the 2010 v3 release to 

leverage the flexibility of RDL files. Using C1RdlReport, you can easily import RDL files into your 

reporting applications by adding flexibility and functionality through the use of the familiar 

format. 

C1RdlReport Advantages and Limitations 
Working with C1RdlReport > C1RdlReport Advantages and Limitations 

The C1RdlReport control has several advantages over using the standard Microsoft Reporting 

Services. This control supports most of the features of RDL. However, the initial release of 

C1RdlReport includes some limitations too. 

C1RdlReport Advantages: 

The major advantages provided by C1RdlReport include: 

 Support for the current RDL 2008 specification. 

 Programmatic access to the RDL object model (which follows the 2008 RDL 

specification) - this allows you to modify existing or create new RDL reports completely 

in code. 

 Generation of RDL reports that can consume any data source (such as .mdb files). 

 A self-contained RDL reporting solution without external dependencies such as the 

need to access a Microsoft Reporting Services server. 

 Seamless integration with C1PrintPreviewControl and with other Reports for 

WinForms reporting engines including C1Report and C1PrintDocument. 

C1RdlReport Limitations: 

The following objects are not supported: 

 Gauge objects are not supported. 

The following RDL properties are not currently supported: 

 Document.AutoRefresh 

 Document.Width 

 Document.Language 

 Document.DataTransform 

 Document.DataSchema 

 Document.DataElementName 

 Document.DataElementStyle 

 DataSet.CaseSensitivity 

 DataSet.Collation 

 DataSet.AccentSensitivity 

 DataSet.KanatypeSensitivity 

 DataSet.WidthSensitivity 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Rdl.Rdl2008.C1RdlReport.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Rdl.Rdl2008.C1RdlReport.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html


 

 242 

 DataSet.InterpretSubtotalsAsDetails 

 TextBox.UserSort 

 TextBox.ListStyle 

 TextBox.ListLevel 

 TextRun.ToolTip 

 TextRun.MarkupType 

C1RdlReport can now load reports created with Report Builder 3.0 (MS SQL 2008 R2) that use 

the 2010 RDL spec, PROVIDED that the report definition contains only one ReportSection. If 

the report contains more than one ReportSection, an exception will be thrown. 

Important Note for .NET 2.0/3.0 version users: 

The C1.C1Report.2 assembly uses the System.Windows.Forms.DataVisualization.dll 

assembly that is only included in .NET Framework 3.5 and later. The assembly is installed on 

your system with when you install Reports for WinForms. It MUST BE INCLUDED with other 

ComponentOne Reports assemblies when you deploy your application that uses Reports for 

WinForms to other systems. 

Also, if you update the Reports for WinForms DLLs manually and use charts in C1RDLReport 

you MUST put DataVisualization where those assemblies are, and make sure that your project 

references it. The DataVisualization dll is actually only needed for charts in C1RDLReport. So 

unless your report has charts, it is not needed. This does not apply to .NET 4.0 users as 

DataVisualization is already included in the Framework. 

Loading an RDL File 
Working with C1RdlReport > Loading an RDL File 

Show All  

Hide All  

To load an RDL file into the C1RdlReport component you can use the Load method. To remove 

an RDL file, you would use the Clear method. This method clears any RDL file previously loaded 

into the C1RdlReport control. The C1RdlReport component includes design-time options to 

load and clear an RDL file. 

To load an RDL file in the Tasks menu: 

Complete the following steps: 

1. In Design View, click the C1RdlReport component's smart tag to open the C1RdlReport 

Tasks menu. 

2. In the C1RdlReport Tasks menu choose Load Report. The Open dialog will appear. 

3. In the Open dialog box, locate and select an RDL file and then click Open. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Rdl.Rdl2008.C1RdlReport.html
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The report will be loaded and if the C1RdlReport control is connected to a previewing control, 

such as C1PrintPreviewControl, the report will appear previewed in the previewing control at 

design time. 

To load an RDL file in code: 

To load an RDL file into the C1RdlReport component you can use the Load method. Complete 

the following steps: 

1. In Design View, double-click on the form to open the Code Editor. 

2. Add the following code to the Load event, replacing "C:/Report.rdl" with the location 

and name of the RDL file you want to load.  

To write code in Visual Basic 

Visual Basic Copy Code  

 

C1RdlReport1.Load("C:/Report.rdl") 

C1RdlReport1.Render() 

To write code in C# 

C# Copy Code  

 

c1RdlReport1.Load(@"C:/Report.rdl"); 

c1RdlReport1.Render(); 

The report will be loaded and if the C1RdlReport control is connected to a previewing control, 

such as C1PrintPreviewControl, when you run the application, the report will appear in the 

previewing control. 

Working with C1ReportDesigner 
The following topics contain important information about C1ReportDesigner, a stand-alone 

application similar to the report designer in Microsoft Access, including how to create a basic 

report definition file, modify, print, and export the report definition. This section also 

demonstrates how to import reports created with Microsoft Access. 

See Also 

About C1ReportDesigner 

Accessing C1ReportDesigner from Visual Studio 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
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Setting C1ReportDesigner Options 

Modifying the Report Layout 

Enhancing the Report with Fields 

Creating a Master-Detail Report Using Subreports 

Previewing and Printing a Report 

Exporting and Publishing a Report 

Managing Report Definition Files 

Importing Microsoft Access Reports 

Importing Crystal Reports 

Charting in Reports 

Maps in Reports 

About C1ReportDesigner 
Working with C1ReportDesigner > About C1ReportDesigner 

The C1ReportDesigner application is a tool used for creating and editing C1Report report 

definition files. The Designer allows you to create, edit, load, and save files (XML) that can be 

read by the C1Report component. It also allows you to import report definitions from Microsoft 

Access files (MDB) and VSReport 1.0 (VSR). 

To run the Designer, double-click the C1ReportDesigner.exe file located by default in the 

following path for .NET 4.0: 

 C:\Program Files (x86)\ComponentOne\Apps\v4.0 for 64 bit platform 

 C:\Program Files\ComponentOne\Apps\v4.0 for 32 bit platform 

Note that this directory reflects the default installation path and its path may be different if you 

made changes to the installation path. For steps on running the Designer from Visual Studio, 

see Accessing C1ReportDesigner from Visual Studio. 

Here's what the Designer looks like with the CommonTasks.xml file opened: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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The main Designer window has the following components: 

 File menu: Click the File menu to load and save report definition files and to import 

and export report definitions. See File Menu for more information. 

 Design mode: Provides shortcuts to the Edit, Text, Data, etc. menu functions. By 

default, Design Mode is selected which consists of Home, Insert, Arrange, Page Setup 

Tabs. 

 Preview mode: Provides a preview of the report. See Preview Mode for more 

information. 

 Help button: Provides options to open the online help file and view the About screen, 

which displays information about the application. 

 Reports tab: Lists all reports contained in the current report definition file. You can 

double-click a report name to preview or edit the report. You can also use the list to 

rename, copy, and delete reports. 

 Fields tab: Lists all the fields contained in the current report. 

 Properties tab: Allows you to edit properties for the objects that are selected in the 

Designer. 

 Status bar: The status bar displays information about what the Designer is working on 

(for example, loading, saving, printing, rendering, importing, and so on). You can zoom 

in and out of a selected report by dragging the zoom slider at the right of the status 

bar. 

The topics that follow explain how you can use the C1ReportDesigner application to create, 

edit, use, and save report definition files. 

See Also 

Preview Mode 

Design Mode 
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File Menu 

File Menu 
Working with C1ReportDesigner > About C1ReportDesigner > File Menu 

The File menu provides shortcut to load and save report definition files and to import and 

export report definitions. You can also access the C1ReportDesigner application's options 

through the File menu. 

The following image displays the File menu: 

  

The menu includes the following options: 

 New: Creates a new report definition file. 

 Open: Brings up the Open Report Definition File dialog box, enabling you to select an 

existing file to open. 

 Close: Closes the current report definition file. 

 Save: Saves the report definition file, to the location previously saved. 

 Save As: Opens the Save Report Definition dialog box allowing you to save your 

report definition as an XML file. 

 Print: Prints the current report. Note that Print button is enabled only in preview mode 

of C1ReportDesigner application. 

 Import: Opens the Import Report Definition dialog box enabling you to import 

Microsoft Access (.mdb and .adp) files and Crystal Reports (.rpt) files. See Importing 

Microsoft Access Reports and Importing Crystal Reports for more information. 

 Export: Exports the current report file as an HTML, PDF, RTF, XLS, XLSX, TIF, TXT, ZIP, 

XPS, or C1DX file. Note that Export button is enabled only in preview mode of 

C1ReportDesigner application. 
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 Recent files: Lists recently opened report definition files. To reopen a file, select it from 

the list. 

 Options: Opens the C1ReportDesigner Options dialog box which allows you to 

customize the default appearance and behavior of the C1ReportDesigner application. 

See Setting C1ReportDesigner Options for more information. 

 Exit: Closes the C1ReportDesigner application. 

Design Mode 
Working with C1ReportDesigner > About C1ReportDesigner > Design Mode 

In Design mode, sections and fields of the selected report are displayed. This is the main 

working area of the designer where reports can be created or modified. The ribbon on the 

Design mode consists of the following tabs: 

 

 Home tab: Provides shortcuts to the Edit, Text, Border, Format, Data, and View menu 

functions. See Home Tab for more information. 

 Insert tab: Provides shortcuts to various fields such as Arrow, Calculated, and Chart. 

See Insert Tab for more information. 

 Arrange tab: Provides shortcuts to Grid, Alignment, Position, and Size menu functions. 

See Arrange Tab for more information. 

 Page Setup tab: Provides shortcuts to Page Layout menu functions. See Page Setup 

Tab for more information. 

  

See Also 

Home Tab 

Insert Tab 

Arrange Tab 

Page Setup Tab 

Home Tab 
Working with C1ReportDesigner > About C1ReportDesigner > Design Mode > Home Tab 

Home tab consists of several menu functions arranged in following groups:  

Edit group: The following image displays Edit group: 
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It consists of the following options: 

 Paste: Pastes the last copied item. 

 Cut: Cuts the selected item, removing it from the report and allowing it to be pasted 

elsewhere. 

 Copy: Copies the selected item so that it can be pasted elsewhere. 

 Delete: Deletes the selected item. 

 Undo: Undoes the last change that was made to the report definition. 

 Redo: Redoes the last change that was made to the report definition. 

Text group: The following image displays Text group: 

 

It consists of the following options: 

 Font: Displays the current font of the selected text and allows you to choose another 

font for the selected item (to do so, click the drop-down arrow next to the font name). 

 Font Size: Displays the current font size of the selected text and allows you to choose 

another font size. Type a number in the font size box or click the drop-down arrow to 

choose a font size. 

 Increase Font Size: Increases the font size by one point. 

 Decrease Font Size: Decreases the font size by one point. 

 Bold: Makes the selected text bold (you can also press CTRL+B). 

 Italic: Italicizes the selected text (you can also press CTRL+I). 

 Underline: Underlines the selected text (you can also press CTRL+U). 

 Align Text Left: Aligns text to the left. 

 Center Text: Aligns text to the center. 

 Align Text Right: Aligns text to the right. 

 Justify Text: Justifies the selected text. 

 Font Color: Allows you to select the color of the selected text. 

 Fill Color: Allows you to select the background color of the selected text. 

Border group: The following image displays Border group: 
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It consists of the following options: 

 Border Line Style: Defines the style of the border lines of the currently selected field(s). 

The styles available are: Solid, Dash, Dot, Dash-Dot, Dash-Dot-Dot, and Transparent. 

 Border Line Color: Defines the color of the border lines of the currently selected 

field(s). 

 Border Line Width: Defines the thickness of border line of the currently selected 

field(s) in twips. 

Format group: The following image displays Format Group: 

  

The Format group consists of the following options: 

 Report Styles: Opens the Report Style Editor dialog box, where you can choose a 

built-in style or create and edit your own custom style. 

 Format Painter: Applies style to the current selection. 

 As Table Row: Formats the current selection as a table row. 

You can access the Report Style Editor dialog box by clicking Report Styles in the Format 

group. 
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It consists of following elements: 

 Style Gallery List: Displays all the currently available built-in and custom styles. See 

Style Gallery for information about the available built-in styles. 

 Add button: Adds a custom style to the Style Gallery list. The style that is added  is 

based on the style selected in the Style Gallery list when the Add button was clicked. 

 Remove button: Removes a selected custom style. The button is enabled only when a 

custom style is selected in the Style Gallery list. 

 Property grid: Lets you change the properties and edit a custom style. The Property 

grid is only available and editable when a custom style is selected in the Style Gallery 

list. 

 Preview window: Displays a preview of the style selected in the Style Gallery list. 

 Apply button: Applies the style to your selection without closing the dialog box. 

 OK button: Closes the dialog box, applies your changes, and sets the style as the 

current selected style. 

 Cancel button: Cancels any changes you have made to styles. 

Data group: The following image displays Data group: 

 

file:///C:/Users/dipti_000/Desktop/C1Reports_ContentImprovementReference%20-%20Copy/Reports_ContentImprovement/stylegallery.html
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It consists of the following options: 

 Sorting and grouping: Clicking this button opens the Sorting and Grouping dialog 

box where you can add and delete sorting and grouping criteria. For more information 

see Grouping Data and Sorting Data. 

 Data Source: Clicking this button opens the Select a Data Source dialog box. The 

Select a Data Source dialog box allows you to choose a new data source, change the 

connection string, and edit the SQL statement. Clicking the Data source tab displays 

the tables, views, and stored procedures in the current data source. Clicking the Sql 

statement tab allows you to view the current SQL statement: 

     

To change the connection string, click the ellipses button. This will open the Data Link 

Properties dialog box. To open an XML Schema Definition file (XDS) see Loading Data 

from an XSD File. To edit or change the SQL statement, click the Query builder... 

button which will open the Sql Builder dialog box. 

 Report Info: Opens the Report Information dialog box. This dialog box allows you to 

set the report's Title, Author, Subject, Creator, and Keywords. You can also choose to 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/groupingdata.html
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apply report information to all reports. 

    

 VBScript Editor: Opens VBScript Editor-Report.GlobalScripts dialog box. Multiple 

scripts can be easily edited in the VBScript Editor, allowing switching between 

statements and expressions.

 

View group: The following image displays View group: 
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 It consists of the following options: 

 Property Grid: Brings the Properties tab into view on the left pane. Note that you can 

also use F4 to view the Properties tab. 

 Field List: Brings the Fields tab into view on the left pane. 

 Zoom: Allows you to select a value to set the zoom level of the report. 

Insert Tab 
Working with C1ReportDesigner > About C1ReportDesigner > Design Mode > Insert Tab 

Insert tab consists of several fields which can be inserted while designing a report. Each field 

button creates a field and initializes its properties. The Insert tab consists of two groups: 

Fields group: The following image displays Fields group: 

 

 It consists of the following items: 

 Arrow: Returns the mouse cursor to an arrow cursor. 

 Text: Creates a field bound to the source recordset or an unbound (static) text label. 

When you click this button, a menu appears and you can select the recordset field. 

Bound fields are not limited to displaying raw data from the database. You can edit 

their Text property and use any VBScript expression. 

 RTF : Creates an RTF field. When you click this button, a menu appears where you can 

select other fields that are contained in the same report definition file to be displayed in 

RTF format. 

 Checkbox: Creates a bound field that displays a Boolean value as a check box. By 

default, the check box displays a regular check mark. You can change it into a radio 

button or cross mark by changing the value of the field's Checkbox property after it has 

been created. 

 Barcode : Creates a field that displays a barcode. When you click this button, a menu 

appears where you can select other fields that are contained in the same report 

definition file to be displayed as a barcode. See Barcodes in Reports for more 

information. 

 Calculated: Creates a calculated field. When you click this button, the code editor 

dialog box appears so you can enter the VBScript expression or an arbitrary 

formula whose value you want to evaluate. When you click the drop down, you can 

select commonly used expressions that render the date or time when the report was 

created or printed, the page number, page count, or "page n of m", or the report name. 

 Picture: Creates a field for data bound stored in the recordset picture or static 

(unbound) picture. When you click this button, a drop down appears so you can select a 

picture field in the source recordset (if there is one; not all recordsets contain this type 

of field). If there are no data bound pictures, then this option creates a field that 

displays a static picture, such as a logo. A dialog box appears on clicking Picture to 

prompt you for a picture file to insert in the report. A copy is made of the picture you 

file:///C:/Users/dipti_000/Desktop/C1Reports_ContentImprovementReference%20-%20Copy/Reports_ContentImprovement/C1.C1Report.4~C1.C1Report.Field~Text.html
file:///C:/Users/dipti_000/Desktop/C1Reports_ContentImprovementReference%20-%20Copy/Reports_ContentImprovement/C1.C1Report.4~C1.C1Report.Field~CheckBox.html


 

 254 

select and placed in the same directory as the report file. You must distribute this file 

with the application unless you embed the report file in the application. When you 

embed a report file in your application, any unbound picture files are embedded too. 

 Line: Creates a line. Lines are often used as separators. 

 Rectangle: Creates a rectangle. Rectangles are often used to highlight groups of fields 

or to create tables and grids. 

 Sub-Report : Creates a field that displays another report. When you click this button, a 

menu appears and you can select other reports that are contained in the same report 

definition file. See Creating a Master-Detail Report Using Subreports for more 

information. 

 Page Break: Creates a field that inserts a page break. 

Custom Fields group: The following image displays Custom Fields group: 

 

 It consists of the following items: 

 Chart Field: Creates a field that displays a chart. Unlike most bound fields, Chart fields 

display multiple values. To select the data you want to display, set the Chart field's 

Chart.DataX and Chart.DataY properties. To format the values along the X and Y axis, 

set the Chart.FormatX and Chart.FormatY properties. See Adding Chart Fields for 

more information. 

 Gradient Field: Creates a gradient field. Gradients are often used as a background 

feature to make other fields stand out. See Adding Gradient Fields for more 

information. 

 SuperLabel Field: Creates a field that renders HTML formatted text. The text property 

of the field is set to any HTML text that is required to be rendered. 

 QRCode Field: Creates a Quick Response code field that renders 2D bar codes. 

 Map Field: Creates a field that displays a region of earth, i.e., a map. See Maps in 

Reports for more information. 

See Enhancing the Report with Fields for more information. For more information on adding 

fields to your report, see Creating Report Fields. 

Arrange Tab 
Working with C1ReportDesigner > About C1ReportDesigner > Design Mode > Arrange Tab 

The Arrange tab provides shortcuts to grid, alignment, positioning , and sizing. It consists of 

the following groups. 

Grid group: The following image displays Grid group: 

file:///C:/Users/dipti_000/Desktop/C1Reports_ContentImprovementReference%20-%20Copy/Reports_ContentImprovement/creatingamasterdetai.html
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The Grid group consists of the following items:    

 Snap to Grid: Snaps fields to the grid. When this item is selected fields cannot be 

placed in between lines of the grid. 

 Show Grid: Shows a grid in the background of the report in the preview. The grid can 

help you place and align fields. By default, this option is selected. 

 Lock Fields: Locks and unlocks the fields in the report. After you've placed the fields in 

the desired positions, you can lock them to prevent inadvertent moving of fields with 

mouse or keyboard. 

 Grid Properties: Opens the C1ReportDesigner Options dialog box. For details see 

Setting C1ReportDesigner Options. 

Alignment group: The following image displays Alignment group: 

 

The Alignment group consists of the following items: 

 Left: Aligns the selected field horizontally to the left. 

 Right: Aligns the selected field horizontally to the right. 

 Center: Aligns the selected field horizontally to the center.  

 Top: Aligns the selected field vertically to the top. 

 Bottom: Aligns the selected field vertically to the bottom. 

 Middle: Aligns the selected field vertically to the middle. 

Note that the elements in a report can be both horizontally and vertically aligned - so, for 

example, an element can be both left and top aligned. 

Position group: The following image displays Position group: 

 

The Position group controls spacing between elements and how elements are layered. It 

consists of the following items: 

 Equalize Horizontal: Equalizes horizontal spacing between selected fields. 

 Increase Horizontal: Increases the horizontal spacing between selected fields. 

 Decrease Horizontal: Decreases the horizontal spacing between selected fields.    
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 Equalize Vertical: Equalizes vertical spacing between selected fields. 

 Increase Vertical: Increases the vertical spacing between selected fields. 

 Decrease Vertical: Decreases the vertical spacing between selected fields. 

 Snap to Grid: Snaps the currently selected field(s) to the nearest grid line(s). 

 Bring to Front: Brings the selected field to the front of all layered fields. 

 Send to Back: Sends the selected field behind all layered  fields. 

Size group: The following image displays the Size group: 

 

The Size group consists of the following items:    

 To Tallest: Sets the height of all selected fields to the tallest field. 

 To Shortest: Sets the height of all selected fields to the shortest field. 

 To Widest: Sets the width of all selected fields to the width of the widest field. 

 To Narrowest: Sets the width of all selected fields to the width of the narrowest field. 

 Size to Grid: Snaps the bounds of the selected fields to the nearest grid lines. 

Page Setup Tab 
Working with C1ReportDesigner > About C1ReportDesigner > Design Mode > Page Setup Tab 

The Page Setup tab provides shortcuts to Page Layout menu functions. 

The following image displays the Page Layout group on the Page Setup tab: 

 

It consists of the following options: 

 Portrait: Changes the layout of your report to Portrait view (where the height is longer 

than the width). 

 Landscape: Changes the layout of your report to Landscape view (where the height is 

shorter than the width). 

 Page Setup: Opens the printer's Page Setup dialog box.  

Preview Mode 
Working with C1ReportDesigner > About C1ReportDesigner > Preview Mode 

The Preview mode displays current report. The ribbon on the Preview mode consists of the 

following items: 
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Page Layout group: The following image displays the Page Layout group in Preview mode of 

the C1ReportDesigner: 

 

It consists of the following options: 

 Portrait: Changes the layout of your report to Portrait view (where the height is longer 

than the width). 

 Landscape: Changes the layout of your report to Landscape view (where the height is 

shorter than the width). 

 Page Setup: Opens the printer's Page Setup dialog box. 

View group: The following image displays the View group: 

   

It consists of the following options: 

 One page: Allows you to preview one page at a time. 

 Two pages: Allows you to preview two pages at a time. 

 More pages: Clicking the drop-down arrow allows you to preview multiple pages at a 

time and includes the following options: Four pages, Eight pages, Twelve pages. 

 Zoom: Zooms the page in to a specific percent or to fit in the window. 

Navigation group: The following image displays the Navigation group: 

 

It consists of the following options: 

 First Page: Navigates to the first page of the preview. 

 Previous Page: Navigates to the previous page of the preview. 

 Page: Entering a number in this textbox navigates the preview to that page. 

 Next Page: Navigates to the next page of the preview. 

 Last Page: Navigates to the last page of the preview. 

 Previous View: Returns to the last page viewed. 

 Next View: Moves to the next page viewed. This is only visible after the Previous View 

button is clicked. 
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Tools group: The following image displays the Tools group: 

 

It consists of the following options: 

 Hand Tool: The hand tool allows you to move the preview through a drag-and-drop 

operation. 

 Text Select Tool: The text select tool allows you to select text through a drag-and-drop 

operation. You can then copy and paste this text to another application. 

 Find: Clicking the Find option opens the Find pane where you can search for text in the 

document. To find text enter the text to find, choose search options (if any), and click 

Search. 

Export Group:The following image displays the Export group: 

 

Each item in the Export group opens the Export Report to File dialog box where you can 

choose a location for your exported file. The Export group consists of the following options: 

 PDF: Exports the document to a PDF file. The drop-down arrow includes options for 

PDF (system fonts) and PDF (embedded fonts) to choose if you want to use system 

fronts or embed your chosen fonts in the PDF file. 

 HTML: Exports the document to an HTML file. You can then copy and paste this text to 

another application. The drop-down arrow includes options for Plain HTML, Paged 

HTML, and Drilldown HTML, and Table-based HTML allowing you to choose if you 

want to export to a plain HTML file, multiple HTML files that can be paged using 

included arrow links,or an HTML file that displays content that can be drilled down to, 

or a table-based HTML file that avoids use of absolute positioning. 

 Excel: Exports the document to a Microsoft Excel file. The drop-down arrow includes 

options for Microsoft Excel 97 and Microsoft Excel 2007 - OpenXML allowing you to 

choose if you want to save the document as an XLS or XLSX file. 

 RTF: Exports the document to a Rich Text File (RTF). 

 Text: Exports the document to a Text file (TXT). 

 More: Clicking the More drop-down arrow includes additional options to export the 

report including: Tagged Image File Format (export as TIFF), RTF (fixed positioning), 

Single Page Text, Compressed Metafile (export as ZIP), XML Paper Specification, 

ComponentOne OpenXml (C1DX). 

For more information on exporting, see Exporting and Publishing a Report. 

Generate: 
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It consists of Refresh button. Clicking Refresh regenerates the current report. This button 

changes to Stop while the document is regenerating; so you can also stop regenerating the 

report. 

Other options available in the Preview mode of C1ReportDesigner are as follows: 

 Pages tab: Only available when in preview mode, this tab includes thumbnails of all the 

pages in the document. 

 Outline tab: Only available when in preview mode, this tab displays a text outline of the 

document. 

 Find tab: Only available when in preview mode, this tab displays find pane allowing you 

to search for text in the document. 

Style Gallery 
Working with C1ReportDesigner > About C1ReportDesigner > Style Gallery 

The Style Gallery dialog box details all the available built-in and custom styles that you can use 

to format your report. Built-in styles include standard Microsoft AutoFormat themes, including 

Vista and Office 2007 themes. You can access the Style Gallery from the C1ReportDesigner 

application by selecting the Home tab and clicking Report Styles. 

The following built-in styles are included: 

Style Name Preview 

Access 2007 

 

Access 2003 

 

Style Name Preview 

Oriel 

 

Origin 
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Apex 

 

Aspect 

 

Civic 

 

Concourse 

 

ComponentOne 

 

Equity 

 

Flow 

 

Paper 

 

Solstice 

 

Technic 

 

Trek 

 

Urban 

 

Verve 

 

Windows Vista 
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Foundry 

 

Median 

 

Metro 

 

Module 

 

None 

 

Northwind 

 

Office 

 

Bold 

 

Casual 

 

Compact 

 

Corporate 

 

Formal 

 

Soft Gray 

 

Verdana 
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Opulent 

 

 

WebReport 

 

 

 

Accessing C1ReportDesigner from Visual 

Studio 
Working with C1ReportDesigner > Accessing C1ReportDesigner from Visual Studio 

To access the C1ReportDesigner application from Visual Studio, use any one of the following 

methods: 

 C1Report Tasks Menu  

Click the smart tag ( ) in the upper-right corner of the C1Report component to open 

the C1Report Tasks menu, and select Edit Report. 

 Context Menu  

Right-click the C1Report component and select Edit Report from the context menu. 

 Properties Window  

Below the Properties window, click the Edit Report link. 

Setting C1ReportDesigner Options 
Working with C1ReportDesigner > Setting C1ReportDesigner Options 

To access the C1ReportDesigner Options dialog box, click the File menu and then Options. 

For more information, see  File Menu. 

The C1ReportDesigner Options dialog box includes five tabs to control the appearance and 

behavior of the application. The tabs and the options available under each tab are: 

General tab: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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It consists of the following options: 

 Categorize property grid: Categorizes the Properties grid by property type. The 

Properties grid can be accessed by clicking the Properties tab located in the bottom of 

the left pane in Design view. 

 Enable undo/redo: Enables undo and redo in the application. 

 Filter field properties: Filters the Properties grid by properties that have been set. The 

Properties grid can be accessed by clicking the Properties tab located in the bottom of 

the left pane in Design view. 

 Sort report list: Sorts the list of reports listed on the Reports tab. Reports can be 

accessed by clicking the Reports tab located in the bottom of the left pane in Design 

view. 

 Designer Theme: Sets the theme from the options in Built in or in Themes folder. 

Design Pane tab: 
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It consists of the following options: 

 Show grid: Shows the grid in the report preview window. 

 Snap to grid: Snaps all objects the grid in the report. If this option is selected, you will 

not be able to place objects between grid lines. 

 Show subreport content: Shows sub-report content in the report. 

 Use C1Report.CreationGraphics as reference graphics to render fields: Uses 

C1Report.CreationGraphics as reference to render fields. 

 Grid units: Indicates how the grid is spaced. Options include Automatic, English (in), 

Metric (cm), and Custom. 

 Grid spacing: Sets the spacing of grid lines. This option is only available when the Grid 

Units option is set to Custom. 

 Grid major color: Set the color of major grid lines. 

 Grid minor color: Sets the color of minor grid lines. 

 Field edges color: Sets the color of field edges in the report. 

Save/Load tab: 
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 It consists of the following options:    

 Reload last file on startup: If this option is checked, the last opened file will appear 

whenever the C1ReportDesigner application is opened. 

 Save changes before rendering: Checking this option saves the report before 

rendering. 

 Show options when exporting: Checking this option saves the report's options when 

exporting. 

 Embed images into Xml when saving: Checking this option embeds images into XML 

when the report is saved. 

 Default export format: Sets the default export format. For more information about 

exporting see Export Group. 

Connection tab: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/exportgroup.html
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It consists of the options for transaction isolation level. 

Script Editor: 

 

 It consists of the following options: 
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 Auto syntax checking: Determines if syntax is automatically checked in the VBScript 

Editor dialog box. 

 Syntax coloring: Determines if syntax text is automatically colored in the VBScript 

Editor dialog box. 

 Font: Defines the appearance of the text used in the VBScript Editor dialog box. 

Warnings tab: 

 

 It consists of the following options: 

 Check for updates on startup: Checking this option checks for any updates when 

C1ReportDesigner application is opened. 

 Import from Crystal Reports: warn if RAS API is unavailable: Checking this option 

throws warning if RAS API is unavailable while importing Crystal Reports in 

C1ReportDesigner. 

In each of the above tabs, clicking OK saves the changes and clicking Cancel cancels any 

changes that you have made in the C1ReportDesigner Options dialog box. 

Modifying the Report Layout 
Working with C1ReportDesigner > Modifying the Report Layout 

The report generated for you by the wizard is a good starting point, but you will usually need to 

adjust and enhance it to get exactly what you want. You can do this with the 

C1ReportDesigner application. See Step 1 of 4: Creating a Report Definition, to learn how to 

create a basic report definition. 
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To start using the Designer, click the Design mode. The right pane of the main window switches 

from Preview mode to Design mode, and it shows the controls and fields that make up the 

report: 

 

The picture shows how the report is divided into sections (Header, Page Header, Detail, and so 

on). The sections contain fields that hold the labels, variables, and expressions that you want in 

the printed report. In this example, the Header section contains a label with the report title. The 

Page Header section contains labels that identify the fields in the Detail section, and the Page 

Footer section contains fields that show the current time, the page number and the total page 

count for the report. 

The sections of the report determine what each page, group, and the beginning and end of the 

report look like. The following table describes where each section appears in the report and 

what it is typically used for: 

Section Appears Typically Contains 

Report Header Once per report The report title and summary information for the whole 

report. 

Page Header Once per page Labels that describe detail fields, and/or page numbers. 

Group Header Once per group Fields that identify the current group, and possibly 

aggregate values for the group (for example, total, 
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Section Appears Typically Contains 

percentage of the grand total). 

Detail Once per record Fields containing data from the source recordset. 

Group Footer Once per group Aggregate values for the group. 

Page Footer Once per page Page number, page count, date printed, report name. 

Report Footer Once per report Summary information for the whole report. 

Note that you cannot add and delete sections directly. The number of groups determines the 

number of sections in a report. Every report has exactly five fixed sections (Report 

Header/Footer, Page Header/Footer, and Detail) plus two sections per group (a Header and 

Footer). You can hide sections that you don't want to display by setting their Visible property to 

False. 

You can modify sections by changing their properties with the Properties window, or move and 

resize them with the mouse. 

Resizing a Section 

To resize a section, select its border and with your mouse pointer drag to the position where 

you want it. The rulers on the left and on top of the design window show the size of each 

section (excluding the page margins). Note that you cannot make the section smaller than the 

height and width required to contain the fields in it. To reduce the size of a section beyond that, 

move or resize the fields in it first, then resize the Section. 

To see how this works, move the mouse to the area between the bottom of the Page Header 

section and the gray bar on top of the Detail Section. The mouse cursor changes to show that 

you are over the resizing area. Click the mouse and drag the line down until the section is about 

twice its original height. 

 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~Visible.html
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Release the mouse button and the section is resized. 

Enhancing the Report with Fields 
Working with C1ReportDesigner > Enhancing the Report with Fields 

To enhance your report, you can add fields (for example, lines, rectangles, labels, pictures, 

charts, and so on) to any Section. You can also modify the existing fields by changing their 

properties with the Properties window, or move and resize the fields with the mouse. 

Report Fields 

The Fields group of the Design tab in the C1ReportDesigner application provides tools for 

creating report fields. This toolbar is enabled only in design mode. Each button creates a field 

and initializes its properties. For more information about the Fields group, see Fields Group. For 

more information on adding fields to your report, see Creating Report Fields. 

See Also 

Adding Chart Fields 

Adding Gradient Fields 

Selecting, Moving, and Copying Fields 

Changing Field, Section, and Report Properties 

Changing the Data Source 

Adding Chart Fields 
Working with C1ReportDesigner > Enhancing the Report with Fields > Adding Chart Fields 

Chart fields are implemented using the C1Chart control. 

 

Note: You must deploy the C1Chart assembly with your application if you use charts. 

To add a Chart field to your report, complete the following steps: 

1. Open the report in the C1ReportDesigner application. 

2. Click the Chart button in the Custom Fields group of the Insert tab and mark the area 

in the report where the Chart should be displayed. 

3. Set the field properties as usual. 

The only unusual aspect of Chart fields is that unlike most bound fields, they display multiple 

values. To select the data you want to display, set the Chart field's Chart.DataX and 

Chart.DataY properties. To format the values along the X and Y axis, set the Chart.FormatX 

and Chart.FormatY properties. You can also customize the chart appearance by setting other 

properties such as Chart.ChartType, Chart.Palette, and so on. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/399688b5-11d9-476f-99b7-9ea5ae0e5784
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To create a new report with an embedded chart, use the C1Report Wizard and complete the 

following steps: 

1. Select the data source for the new report. 

1. Click the ellipses button (...) next to Connection string. The Data Link 

Properties dialog box appears. 

2. Select the Provider tab and then select Microsoft Jet 4.0 OLE DB Provider 

from the list. 

3. Click Next. 

4. In the Connection tab, click the ellipsis button to browse for the 

C1Nwind.mdb database. 

5. This is the standard Visual Studio Northwind database. By default, the database 

is installed in the ComponentOne Samples\Common directory. 

6. Click the Data source tab and then select the Sales by Category view. The 

following image illustrates this step: 

 
2. Select the fields you want to display. 

This example groups the data by Category and shows ProductName and ProductSales 

in the Detail section of the report. To add groups and detail fields, with your mouse 
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pointer drag them from the Available list on the left to the Groups or Detail lists on 

the right: 

 

The wizard walks you through the remaining steps of selecting layout, style and title of 

the report. The initial version of the report is created. 

3. Add the Chart to the Group Header section of the report. 

Charts usually make sense in the Group Header sections of a report, to summarize the 

information for the group. To add the chart to the Group Header section: 

1. Click the Design button to switch to Design mode and begin editing the report. 

2. Expand the Group Header Section by performing a drag-and-drop operation 

with the section's borders. 

3. Click the Chart button in the Custom Fields group of the Insert tab and place 

the field in the report in the Group Header Section. 

4. Resize the chart by clicking and dragging the chart field. 

5. From the Properties window, set the Chart.DataY property to the name of the 

field that contains the values to be charted, in this case, ProductSales. 
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6. Note that the Chart.DataY property may specify more than one chart series. 

Just add as many fields or calculated expressions as you want, separating them 

with semicolons. 

7. Set the Chart.DataX property to the name of the field that contains the labels 

for each data point, in this case, ProductName. 

8. From the Properties window, set the Chart.FormatY property to "#,###" to set 

the values along the axis to thousand-separated values. 

The Chart control will now display some sample data so you can see the effect of the 

properties that are currently set (the actual data is not available at design time). You 

may want to experiment changing the values of some properties such as 

Chart.ChartType, Chart.DataColor, and Chart.GridLines. You can also use the regular 

field properties such as Font and ForeColor. 

Your report should look similar to the following report: 

 

Click the Preview button to see the report and click the Next page button to scroll 

through the report to view the Chart field for each group. The sample report should 

look like the following image: 
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Note that the Report field is sensitive to its position in the report. Because it is in a 

Group Header section, it only includes the data within that group. If you place the Chart 

field in a Detail section, it will include all the data for the entire report. This is not useful 

because there will be one chart in each Detail section and they will all look the samIf 

you need more control over what data should be displayed in the chart, you can use 

the DataSource property in the chart field itself. 

You can now save the report and use it in your WinForms and ASP.NET applications. 

See Also 

Charting in Reports 

Adding Gradient Fields 
Working with C1ReportDesigner > Enhancing the Report with Fields > Adding Gradient Fields 

Gradient fields are much simpler than charts. They are mainly useful as a background feature to 

make other fields stand out. 

The following image shows a report that uses gradient fields over the labels in the Group 

Header section: 
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To create a similar gradient field, complete the following steps: 

1. In Design mode of the Designer, select the Gradient button from the Custom Fields 

group in the Insert tab. 

2. Move your mouse cursor (which has changed to a cross-hair) over the labels in the 

Group Header section and drag the field to the desired size. 

3. To ensure that the field is behind the labels, right-click the gradient field and select 

Send To Back. 

4. Set the Gradient.ColorFrom and Gradient.ColorTo properties to SteelBlue and 

White, respectively. 

Note that you may change the angle of the gradient field by setting the Gradient.Angle 

property another value (default value is 0). 
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Now, the gradient field can be further customized to obtain rounded corners by 

using CornerRadius property.

 

To create a similar gradient, you need to set both the X and Y values of the corner radius. The 

CornerRadius property provides following options to set the X and Y values for the corners: 

 All: Set X and Y values of all corners. 

 AllX: Set X value of all corners.  

 AllY: Set Y value of all corners. 

 BottomLeftX: Set X value of bottom left corner. 

 BottomLeftY: Set Y value of bottom left corner.   

 BottomRightX: Set X value of bottom right corner. 

 BottomRightY: Set Y value of bottom right corner. 

 TopLeftX: Set X value of top left corner. 

 TopLeftY: Set Y value of top left corner. 

 TopRightX: Set X value of top right corner. 

 TopRightY: Set Y value of top right corner. 

You can also obtain different shapes of a gradient by setting ShapeType property from the 

Properties pane to the options available as: 

 Line 

 IsoscelesTriangle 

 RightTriangle 

 Rectangle 

 Ellipse 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.CustomFields.4~C1.C1Report.CustomFields.CornerRadius.html
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 Arc 

 Pie 

There are some limitations for four corner round radii in a gradient field: 

1. Range of Radius X is from 0 to field's width. 

2. Range of Radius Y is from 0 to field's height. 

3. For Radius X, TopLeft + TopRight/BottomLeft + BottomRight should not be greater 

than field's width. 

4. For Radius Y, TopLeft + BottomLeft/TopRight + BottomRight should not be greater 

than field's height. 

5. If customer's settings break rules 3 and 4, the TopRight or BottomLeft radius are 

reduced, keeping the TopLeft and BottomRight settings, as it is. For example, if the 

field's size is (200, 100) with TopLeft: (150, 80), BottomRight: (150, 80), TopRight: (100, 

50), and  BottomLeft: (100, 50), then TopRight will change to (50, 20) and BottomLeft 

will change to (50, 20). 

  

  

Selecting, Moving, and Copying Fields 
Working with C1ReportDesigner > Enhancing the Report with Fields > Selecting, Moving, and Copying 

Fields 

You can use the mouse to select fields in the C1ReportDesigner application as usual: 

 Click a field to select it. 

 Shift-click a field to toggle its selected state. 

 Control-drag creates a copy of the selected fields. 

 Click the empty area and drag your mouse pointer to select multiple fields. 

 With your mouse pointer, drag field corners to resize fields. 

 Double-click right or bottom field corners to auto size the field. 

To select fields that intersect vertical or horizontal regions of the report, click and drag the 

mouse on the rulers along the edges of the Designer. If fields are small or close together, it may 

be easier to select them by name. You can select fields and sections by picking them from the 

drop-down list above the Properties window. 

Show a grid 

The Snap to grid and Show grid buttons located in the Grid group in the Arrange tab provide 

a grid that helps position controls at discrete positions. While the grid is on, the top left corner 

of the fields will snap to the grid when you create or move fields. You can change the grid units 

(English or metric) by clicking the File menu and selecting Options from the menu. 
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Lock fields 

After you have placed fields in the desired positions, you can lock them to prevent inadvertently 

moving them with the mouse or keyboard. Use the Lock Fields button to lock and unlock the 

fields. 

Format fields 

 

When multiple fields are selected, you can use the buttons on the Alignment, Position, and 

Size groups of the Arrange tab to align, resize, and space them. When you click any of these 

buttons, the last field in the selection is used as a reference and the settings are applied to the 

remaining fields in the selection. 

Apply styles 

 

The Report Styles button applies the style of the reference field to the entire selection. The 

style of a field includes all font, color, line, alignment, and margin properties. You can use the 

Properties window to set the value of individual properties to the entire selection. 

Determine order for overlapping fields 

 

If some fields overlap, you can control their z-order using the Bring to Front/Send to Back 

buttons in the Position group. This determines which fields are rendered before (behind) the 

others. 

Move fields using the keyboard 
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The C1ReportDesigner application also allows you to select and move fields using the 

keyboard: 

 Use the TAB key to select the next field. 

 Use SHIFT-TAB to select the previous field. 

 Use the arrow keys to move the selection one pixel at a time (or shift arrow to by 5 

pixels). 

 Use the DELETE key to delete the selected fields. 

 When a single field is selected, you can type into it to set the Text property. 

Changing Field, Section, and Report 

Properties 
Working with C1ReportDesigner > Enhancing the Report with Fields > Changing Field, Section, and Report 

Properties 

Once an object is selected, you can use the Properties window to edit its properties. 

When one or more fields are selected, the Properties window shows property values that all 

fields have in common, and leaves the other properties blank. If no fields are selected and you 

click on a section (or on the bar above a section), the Section properties are displayed. If you 

click the gray area in the background, the Report properties are displayed. 

To see how this works, click the label in the Header section and change its Font and ForeColor 

properties. You can also change a field's position and dimensions by typing new values for the 

Left, Top, Width, and Height properties. 

The Properties window expresses all measurements in twips (the native unit used by C1Report), 

but you can type in values in other units (in, cm, mm, pix, pt) and they will be automatically 

converted into twips. For example, if you set the field's Height property to 0.5in, the Properties 

window will convert it into 720 twips. 

Changing the Data Source 
Working with C1ReportDesigner > Enhancing the Report with Fields > Changing the Data Source 

The data source is defined by the ConnectionString, RecordSource, and Filter properties. These 

are regular Report properties and may be set one of the following ways: 

 From the Properties window, select the ellipsis button next to the DataSource property 

(if you click the gray area in the background, the Report properties are displayed).  

OR 

 Click the DataSource button in the Data group of the Design tab to open the Select a 

Data Source dialog box that allows you to set the ConnectionString and RecordSource 

properties directly. 
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Creating a Master-Detail Report Using 

Subreports 
Working with C1ReportDesigner > Creating a Master-Detail Report Using Subreports 

Subreports are regular reports contained in a field in another report (the main report). 

Subreports are usually designed to display detail information based on a current value in the 

main report, in a master-detail scenario. 

In the following example, the main report contains categories and the subreport in the Detail 

section contains product details for the current category: 

 

To create a master-detail report based on the Categories and Products tables, you need to 

create a Categories report (master view) and a Products report (details view). 

Step 1: Create the master report 

1. Create a basic report definition using the C1Report Wizard.  

1. Select the Categories table from the Northwind database (C1NWind.mdb 

located in the ComponentOne Samples\Common folder). 

2. Include the CategoryName and Description fields in the report. 

2. In the C1ReportDesigner application, click the Design button to begin editing the 

report. 

3. Set the Page Header and Header section's Visible property to False. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/creatingabasicreport.html
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4. In the Detail section, select the DescriptionCtl and move it directly below the 

CategoryNameCtl. 

5. Use the Properties window to change the Appearance settings (Font and ForeColor). 

Note that for this example, a Gradient field was added to the Detail Section. For 

information on Gradient fields, see Adding Gradient Fields. 

6. Select the Preview button, the Categories report should now look similar to the 

following image:

 

Step 2: Create the detail report 

1. In the C1ReportDesigner application, click the New Report button to create a basic 

report definition using the C1Report Wizard.  

1. Select the Products table from the Northwind database. 

2. Include the following fields in the report: ProductName, QuantityPerUnit, 

UnitPrice, UnitsInStock, and UnitsOnOrder. 

2. In the Report Designer, click the Design button to begin editing the report.  

1. Set the Page Header and Header section's Visible property to False. 

2. In the Detail section, arrange the controls so that they are aligned with the 

heading labels. Use the Properties window to change the Appearance settings. 

Step 3: Create the subreport field 

The C1ReportDesigner application now has two separate reports, Categories Report and 

Products Report. The next step is to create a subreport: 

1. From the Reports list in the Designer, select Categories Report (master report). 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/creatingabasicreport.html
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2. In design mode, click the Sub-report  in the Fields group of the Insert tab and 

select Products Report from the drop-down menu. 

3. In the Detail section of your report, click and drag the mouse pointer to make the field 

for the subreport: 

 

Step 4: Link the subreport to the master report 

The master-detail relationship is controlled by the Text property of the subreport field. This 

property should contain an expression that evaluates into a filter condition that can be applied 

to the subreport data source. 

The Report Designer can build this expression automatically for you. Complete the following 

steps: 

1. Right-click the subreport field and select Link Subreport from the menu. 
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2. A dialog box appears that allows you to select which fields should be linked. 

 
3. Once you make a selection and click OK, the Report Designer builds the link expression 

and assigns it to the Text property of the subreport field. In this case, the expression is: 
"[CategoryID] = '" & [CategoryID] & "'" 

Alternatively, you can also link the subreport to the master report by completing the following 

steps: 

1. From the Properties window, click the Text property of the subreport field and select 

Script Editor from the drop-down list. 

2. Enter the following expression in the VBScript Editor: 
"[CategoryID] = '" & [CategoryID] & "'" 

3. Click OK to close the VBScript Editor and build the expression. 

Previewing and Printing a Report 
Working with C1ReportDesigner > Previewing and Printing a Report 

To preview a report, select the report to view from the Reports list on the left pane of the 

Designer window and click the Preview button, which appears on each Ribbon tab: 

 

The report is displayed on the right pane, as shown in the following screen shot: 
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The main window has a preview navigation toolbar, with buttons that let you page through the 

document and select the zoom mode. 

At this point, you can print the report by clicking File menu and then Print.
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Exporting and Publishing a Report 
Working with C1ReportDesigner > Exporting and Publishing a Report 

Instead of printing the report, you may want to export it into a file and distribute it 

electronically to your clients or co-workers. The Designer supports the following export formats: 

Format Description 

Paged HTML (*.htm) Creates one HTML file for each page in the report. The HTML pages 

contain links that let the user navigate the report. 

Drilldown HTML (*.htm) Creates a single HTML file with sections that can be collapsed and 

expanded by the user by clicking on them. 

Plain HTML (*.htm) Creates a single HTML file with no drill-down functionality. 

Table-based HTML (*.htm) Creates a table-based HTML file that avoids use of absolute 

positioning. 

PDF with system fonts 

(*.pdf) 

Creates a PDF file that can be viewed on any computer equipped 

with Adobe's Acrobat viewer or browser plug-ins. 

PDF with embedded fonts 

(*.pdf) 

Creates a PDF file with embedded font information for extra 

portability. This option significantly increases the size of the PDF 

file. 

RTF (*.rtf) Creates an RTF file that can be opened by most popular word 

processors (for example, Microsoft Word, WordPad). 

RTF with fixed positioning 

(*.rtf) 

Creates an RTF file with fixed positioning that can be opened by 

most popular word processors (for example, Microsoft Word, 

WordPad). 

Microsoft Excel 97 (*.xls) Creates an XLS file that can be opened by Microsoft Excel. 

Microsoft Excel 2007/2010 

Open XML (*.xlsx) 

Creates an XLS file that can be opened by Microsoft Excel 2007 and 

later. 
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Format Description 

TIFF (*.tif) Creates a multi-page TIFF (Tag Image File Format) file. 

Text (*.txt) Creates a plain text file. 

Single Page Text (*.txt) Creates a single-page plain text file. 

Compressed Metafile 

(*.txt) 

Creates a compressed metafile text file. 

XML Paper 

Specification(*.xps) 

Creates a file of XPS format 

ComponentOne OpenXml 

Document (*.c1dx) 

Creates a file of C1DX format. 

To create an export file, select File | Export from the menu and use the Export Report to 

File dialog box to specify the location, File name and Save as type. 

 

Note: When a document is exported to the RTF or the DOCX formats with the "preserve 

pagination" option selected, text is placed in text boxes and the ability to reflow text in the 

resulting document may be limited. 

 

Managing Report Definition Files 
Working with C1ReportDesigner > Managing Report Definition Files 

A report definition file may contain several reports. Occasionally, you may want to copy or move 

a report from one file to another. 

To move a report from one file to another, open two instances of the C1ReportDesigner 

application and drag the report from one instance to the other. If you hold down the CTRL key 

while doing this, the report will be copied. Otherwise, it will be moved. 

You can also copy a report within a single file. This creates a new copy of the report, which is a 

good way to start designing a new report that is similar to an existing one. 

Note that the report definition files are saved in XML, so you can also edit and maintain them 

using any text editor. 
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Importing Microsoft Access Reports 
Working with C1ReportDesigner > Importing Microsoft Access Reports 

Show All  

Hide All  

One of the most powerful features of the C1ReportDesigner application is the ability to import 

reports created with Microsoft Access. This feature requires Access to be installed on the 

computer. Once the report is imported into the Designer, Access is no longer required. 

 

To import reports from an Access file, click the File menu and select Import from the menu. A 

dialog box prompts you for the name of the file you want to import. 

Select a Microsoft Access file (MDB or ADP) and the Designer scans the file and shows a dialog 

box where you can select which reports you would like to import: 
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The dialog box also allows you to specify if the Designer should clear all currently defined 

reports before starting the import process. 

The import process handles most elements of the source reports, with a few exceptions: 

 Event handler code  

Access reports can use VBA, macros and forms to format the report dynamically. 

C1Report can do the same things, but it only uses VBScript. Because of this, all report 

code needs to be translated manually. 

 Form-oriented field types 

Access reports may include certain fields that are not handled by the Designer's import 

procedure. The following field types are not supported: Chart, CommandButton, 

ToggleButton, OptionButton, OptionGroup, ComboBox, ListBox, TabCtl, and 

CustomControl. 

 Reports that use VBScript reserved words 

Because Access does not use VBScript, you may have designed reports that use 

VBScript reserved words as identifiers for report objects or dataset field names. This 

causes problems when the VBScript engine tries to evaluate the expression, and 

prevents the report from rendering correctly. 

Reserved words you shouldn't use as identifiers include Date, Day, Hour, Length, 

Minute, Month, Second, Time, TimeValue, Value, Weekday, and Year. For a 

complete list, please refer to a VBScript reference. 
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 Reports that sort dates by quarter (or weekday, month of the year, and so on) 

C1Report uses the ADO.NET dataset Sort property to sort groups. This property sorts 

datasets according to field values only and does not take expressions. (Note that you 

can group according to an arbitrary expression, but you can't sort.) An Access report 

that sorts groups by quarter will sort them by date after it is imported. To fix this, you 

have two options: create a field that contains the value for the expression you want to 

sort on or change the SQL statement that creates the dataset and perform the sorting 

that way. 

These limitations affect a relatively small number of reports, but you should preview all reports 

after importing them, to make sure they still work correctly. 

Importing the C1NWind.mdb File 

To illustrate how the Designer fares in a real-life example, try importing the C1NWind.mdb file. 

It contains the following 13 reports. (The NWind.xml file that ships with C1Report already 

contains all the following modifications.) 

1. Alphabetical List of Products  

No action required. 

2. Catalog  

No action required. 

3. Customer Labels  

No action required. 

4. Employee Sales by Country  

This report contains code which needs to be translated manually. The following code 

should be assigned to the Group 1 Header OnPrint property: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

If SalespersonTotal > 5000 Then             

  ExceededGoalLabel.Visible = True             

  SalespersonLine.Visible = True             

Else             

  ExceededGoalLabel.Visible = False             

  SalespersonLine.Visible = False             

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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End If 

To write code in C# 

C# Copy Code  

 

if (SalespersonTotal > 5000)                  

{                 

  ExceededGoalLabel.Visible = true;                 

  SalespersonLine.Visible = true;                 

} else {                 

  ExceededGoalLabel.Visible = false;                 

  SalespersonLine.Visible = false;                

} 

5. Invoice 

No action required. 

6. Products by Category 

No action required. 

7. Sales by Category 

This report contains a Chart control that is not imported. To add a chart to your report, 

you could use an unbound picture field, then write a VB event handler that would 

create the chart and assign it to the field as a picture. 

8. Sales by Category Subreport 

No action required. 

9. Sales by Year 

This report contains code and references to a Form object which need to be translated 

manually. To replace the Form object, edit the RecordSource property to add a [Show 

Details] parameter: 

To write code in Visual Basic 

Visual Basic Copy Code  
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PARAMETERS (Beginning Date) DateTime 1/1/1994,                     

  (Ending Date) DateTime 1/1/2001,                     

  (Show Details) Boolean False; ... 

To write code in C# 

C# Copy Code  

 

PARAMETERS [Beginning Date] DateTime 1/1/1994,                         

  [Ending Date] DateTime 1/1/2001,                        

  [Show Details] Boolean False; ... 

Use the new parameter in the report's OnOpen event: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim script As String = _                             

  "bDetails = [Show Details]" & vbCrLf & _                             

  "Detail.Visible = bDetails" & vbCrLf & _                             

  "[Group 0 Footer].Visible = bDetails" & vbCrLf & _                             

  "DetailsLabel.Visible = bDetails" & vbCrLf & _                             

  "LineNumberLabel2.Visible = bDetails" & vbCrLf & _                             

  "Line15.Visible = bDetails" & vbCrLf & _                            

  "SalesLabel2.Visible = bDetails" & vbCrLf & _                             

  "OrdersShippedLabel2.Visible = bDetails" & vbCrLf & _                             

  "ShippedDateLabel2.Visible = bDetails" & vbCrLf & _                             

  "Line10.Visible = bDetails"                         

c1r.Sections.Detail.OnPrint = script 

To write code in C# 

C# Copy Code  

 

string script = "bDetails = [Show Details]" +                                   

  "Detail.Visible = bDetails\r\n" +                                   

  "[Group 0 Footer].Visible = bDetails\r\n" +                                   

  "DetailsLabel.Visible = bDetails\r\n" +                                   

  "LineNumberLabel2.Visible = bDetails\r\n" +                                   



 

 292 

  "Line15.Visible = bDetails\r\n" +                                   

  "SalesLabel2.Visible = bDetails\r\n" +                                   

  "OrdersShippedLabel2.Visible = bDetails\r\n" +                                  

  "ShippedDateLabel2.Visible = bDetails\r\n" +                                  

  "Line10.Visible = bDetails";                                 

c1r.Sections.Detail.OnPrint = script; 

Finally, two more lines of code need to be translated: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Sections ("Detail").OnPrint = _                                     

  "PageHeader.Visible = True"                                     

Sections("Group 0 Footer).OnPrint = _                                     

  "PageHeader.Visible = False" 

To write code in C# 

C# Copy Code  

 

Sections ("Detail").OnPrint =                                           

  "PageHeader.Visible = true";                                         

Sections("Group 0 Footer).OnPrint =                                          

  "PageHeader.Visible = false"; 

10. Sales by Year Subreport 

No action required. 

11. Sales Totals by Amount 

This report contains code that needs to be translated manually. The following code 

should be assigned to the Page Header OnPrint property: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

PageTotal = 0 
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To write code in C# 

C# Copy Code  

 

PageTotal = 0; 

The following code should be assigned to the Detail OnPrint property: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

PageTotal = PageTotal + SaleAmount                                                     

HiddenPageBreak.Visible = (Counter = 10) 

To write code in C# 

C# Copy Code  

 

PageTotal = PageTotal + SaleAmount;                                                         

HiddenPageBreak.Visible = (Counter = 10); 

12. Summary of Sales by Quarter 

This report has a group that is sorted by quarter (see item 4 above). To fix this, add a 

field to the source dataset that contains the value of the ShippedDate quarter, by 

changing the RecordSource property as 

follows:                                                        

SELECT DISTINCTROW 

Orders.ShippedDate,                                             

           

  

Orders.OrderID,                                                 

        

  [Order 

Subtotals].Subtotal,                                            

            

  DatePart("q",Orders.ShippedDate) As 

ShippedQuarter                                                  

     

FROM Orders INNER JOIN [Order 

Subtotals]                                                      

  

  ON Orders.OrderID = [Order 

Subtotals].OrderID                                              
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  WHERE (((Orders.ShippedDate) Is Not Null)); 

Change the group's GroupBy property to use the new field, ShippedQuarter. 

13. Summary of Sales by Year 

No action required. 

Summing up the information on the table, out of the 13 reports imported from the NorthWind 

database: eight did not require any editing, three required some code translation, one required 

changes to the SQL statement, and one had a chart control that was not replaced. 

Importing Crystal Reports 
Working with C1ReportDesigner > Importing Crystal Reports 

The C1ReportDesigner application can import Crystal report definition files (.rpt files). 

  

To import reports from a Crystal report definition file: 

1. Click the File menu and select Import. The Import Report Definition dialog box opens 

and prompts you for the name of the file you want to import. 

2. Select a Crystal report definition file (.rpt). The C1ReportDesigner application converts 

the report into the C1Report format. 

The C1ReportDesigner application supports some of the following conversions on import of 

Crystal Reports: 
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 Reports bound to internal or external data sources can be imported and run without 

any changes required to the original data source path. 

 Date, time, and number formats are retained during conversion. 

 Expressions with percentage aggregates are sucessfully imported. 

 RAS API is supported for TextObject conversion of some expressions such as those 

where a single Textbox containing combination of text and other expressions (Text + 

[Expression]) are to be interpreted. 

 

Note: Before you import the report, please ensure that you have compatible versions of 

Crystal Reports and Visual Studio installed on your system. Also note that if you have 

Crystal Reports 2013 installed on the system, then on conversion of Crystal Report to 

C1Report, the database path to xtreme.mdb will have to be changed manually in order to 

run the report. 

The import process handles most elements of the source reports, with a few exceptions for 

elements that are not exposed by the Crystal object model or not supported by C1Report. The 

exceptions include image fields, charts, and cross-tab fields. 

Charting in Reports 
Working with C1ReportDesigner > Charting in Reports 

Aggregate charting is a powerful, yet simple and easy-to-use feature. Reports for WinForms 

supports chart fields using its extensible custom field architecture. The Chart field is 

implemented as a custom field in the C1.Win.C1Report.CustomFields.2.dll assembly, which is 

installed with the report designer application and is also included as a sample with full source 

code (CustomFields). In the following topics, you'll see how you can customize chart fields in 

reports using the C1ReportDesigner application. The C1ReportDesigner application is 

installed with both Reports for WinForms and Reports for WPF. 

For more information on this topic, see the blog post on Charting in Reports for WinForms 

See Also 

Plotting Data in Charts 

Chart Properties 

Charts with Multiple Series 

Charts in Grouped Reports 

Creating Aggregate Charts 

Chart Types 

http://our.componentone.com/2009/12/18/charting-in-reports-for-winforms/761/
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Chart Types 
Working with C1ReportDesigner > Charting in Reports > Chart Types 

The Chart Field in Report for WinForms allows you to insert various types 

of charts using ChartTypeEnum. There are ten chart types that are supported in 

C1Report: Area, Bar (horizontal bars), Column (vertical columns), Scatter (X-Y values), Line,  

Pie, Step, Histogram, Radar, and Polar. The chart types can be easily selected using the 

ChartType property in the Properties pane of the C1ReportDesigner. 

Area chart: An Area chart draws each series as connected points of data, filled below the 

points. Each series is drawn on top of the preceding series. 

 

Bar and Column charts: A Bar chart or a Column chart represents each series in the form of 

bars of the same color and width, whose length is determined by its value. Each new series is 

plotted in the form of bars next to the bars of the preceding series. A Bar or Column chart 

draws each series as a bar in a cluster. The number of clusters is the number of points in the 

data. Each cluster displays the nth data point in each series. When the bars are arranged 

horizontally, the chart is called a bar chart and when the bars are arranged vertically, the chart is 

called column chart. 

The following image represents a Bar chart: 

 

The following image represents a Column chart: 
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Scatter chart: A Scatter chart uses two values to represent each data point. This type of chart is 

often used to support statistical techniques that quantify the relationship between the variables 

(typically Linear Regression Analysis). 

 

Pie chart: A Pie chart draws each series as a slice in a pie. The number of pies is the number of 

points in the data. Each pie displays the nth data point in each series. You can also customize 

Pie charts for displaying legends and labels; see Chart Properties for more information. 

 

 

Radar chart: A Radar chart draws the y value in each data set along a radar line (the x value is 

ignored except for labels). If the data has n unique points, then the chart plane is divided into n 

equal angle segments, and a radar line is drawn (representing each point) at n/360 degree 
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increments. By default, the radar line representing the first point is drawn vertically (at 90 

degrees). Radar charts can be further customized; see Chart Properties for more information. 

 

 

Step chart: A Step chart is a form of XY plot chart that draws series as connected points of 

data. These charts are often used when Y values change by discret amounts, at specific values of 

X with a sudden change of value. A simple, everyday example would be a plot of a checkbook 

balance with time. As each deposit is made, and each check is written, the balance (Y value) of 

the check register changes suddenly, rather than gradually, as time passes (X value). During the 

time that no deposits are made, or checks written, the balance (Y value) remains constant as 

time passes. 

 

Line chart: A Line chart draws each series as connected points of data. It is the most effective 

way of denoting changes in values between different groups of data. These charts are 

commonly used to show trends and performance over time. 
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Histogram chart: A Histogram chart takes a collection of raw data values and plots the 

frequency distribution. It is frequently used with grouped data, which is generated by 

measuring a collection of raw data and plotting the number of data values that fall within 

defined intervals. Note that raw values are not used to generate data for a histogram, but are 

used to generate a frequency instead. While showing similarities to bar charts, it is important to 

note that histograms are used with quantitative variables whereas bar charts are commonly 

used with qualitative variables. 

While the histogram and bar charts' appearances relate, their functionality does not. A bar chart 

is created from data points whereas a Histogram is created from the frequency distribution of 

the data. The charts following illustrate the difference between a bar chart and a histogram 

chart. Both of the charts use exactly the same Y data. The bar chart (top) shows each average 

mean temperature for each year in which it occurred. The histogram chart (bottom) using the 

same input temperature data automatically tabulates the number of temperatures that fall 

within each interval and draws the resulting histogram. For convenience, chart labels with the 

count in each interval have been added at the top of each interval.  
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A histogram is beneficial for pinpointing prominent features of the distribution of data for a 

quantitative variable. The important features for a quantitative variable include the following: 

 It reveals the typical average value. 

 The data yields a general shape. The data values can be distributed symmetrically 

around the middle or they can be skewed. 

 If there are distant values from the group of data it shows them as outlier values. 

 The data values can be near or far to the typical value. 

 The distribution may result in a single peak or multiple peaks and valleys. 

Polar chart: A Polar chart draws the x and y coordinates in each series as (theta,r), where theta 

is amount of rotation from the origin and r is the distance from the origin. Theta may be 

specified in either degrees (default) or radians. Since the X-axis is a circle, the X-axis maximum 

and minimum values are fixed. The series can be drawn independently, or stacked. Polar charts 

can be further customized; see Chart Properties for more information. 
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Chart Properties 
Working with C1ReportDesigner > Charting in Reports > Chart Properties 

The appearance of charts can be customized by using several other chart properties provided 

by the Chart field. Few chart properties that are commonly used are as follows: 

 Aggregate: This property allows you to create charts that automatically aggregate data 

values that have the same category using an aggregate function of your choice (sum, 

average, standard deviation, and so on). See  

Creating Aggregate Charts for more details. 

 DataColor: This property selects the color used to draw the bars, columns, areas, 

scatter symbols, and pie slices. If the chart contains multiple series, then the Chart field 

automatically generates different shades of the selected color for each series. If you 

want to select specific colors for each series, use the Palette property instead, and set 

its value to a semi-colon separated list containing the colors to use (for example 

"Red;Green;Blue"). 

 DataX, DataY: These properties allows you to set the fields and the plot data required 

to be displayed in the chart. See Plotting Data in Charts for more details. 

 FormatX, FormatY: These properties determine the format used to display the values 

along each axis. For example, setting FormatY to "c" causes the Chart field to format 

the values along the Y axis as currency values. This is analogous to the Format property 

in regular report fields. 

 XMin, XMax, YMin, YMax: These properties allow you to specify ranges for each axis. 

Setting any of them to -1 cause the Chart to calculate the range automatically. For 

example, if you set the YMax property to 100, then any values higher than 100 will be 

truncated and won't appear on the chart. 

These properties apply to all chart types. There are some additional properties which are 

specific to the chart types. 

The following properties apply only to Pie charts: 

 ShowPercentages: Each pie slice has a legend that shows the X value for the slice. If 

the ShowPercentages property is set to true, the legend will also include a percentage 

value that indicates the size of the slice with respect to the pie. The percentage is 

formatted using the value specified by the FormatY property. For example, if you set 

FormatY to "p2", then the legends will include the X value and the percentage with two 

decimal points (for example "North Region (15.23%)"). 

 RadialLabels: This property specifies that instead of showing a legend on the right side 

of the chart, labels with connecting lines should be attached to each slice. This works 

well for pies with few slices (up to about ten). 

The following properties apply to Radar charts: 

 Start: Specifies the starting angle of these charts on a 360 degree circle. The angle is 

measured in the counter-clockwise direction. The measuring unit of the start angle is 

degrees if the Degrees property is set to true, otherwise it is radians. 

 Degrees: Specifies the measuring unit of the starting angle for these charts. If this 

property is set to true, the measuring unit is degrees, otherwise it is radians. 
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 Filled: The area enclosed by the data points in the radar charts can be set to filled by 

setting this property to true. 

 FlatGridLines: The radar charts by default have circular Y coordinate gridlines. Using 

FlatGridLines property, the gridlines can be set to flat Y coordinate gridlines. 

The following properties apply to Polar charts: 

 Start: Specifies the starting angle of these charts on a 360 degree circle. The angle is 

measured in the counter-clockwise direction. The measuring unit of the start angle is 

degrees if the Degrees property is set to true, otherwise it is radians. 

 Degrees: Specifies the measuring unit of the starting angle for these charts. If this 

property is set to true, the measuring unit is degrees, otherwise it is radians. 

 PiRatioAnnotations: If Degrees is set to False and the chart reflects radian values, then 

C1Chart provides the option of having the chart annotated with ratios of Pi rather than 

radians. Setting this property to true annotates the values on the polar chart in ratios of 

Pi. 

The following properties apply only to Histogram charts, exposed by HistogramOptions: 

 DisplayType: Specifies the method in which frequency data should be displayed for a 

particular series. This is useful for displaying different frequency data uniquely in a 

single chart group. 

 IntervalCreationMethod: This property is used to specify different interval boundaries 

in histogram charts. You can choose one of the following three methods from the 

IntervalCreationMethod property:  

o Automatic: When the Automatic method is used, the chart calculates the upper 

and lower limits of the intervals using the maximum and minimum data values, 

and restricting the intervals to lie within 3 standard deviations of the data 

mean. The number of intervals is optional. Interval boundaries are calculated 

uniformly. 

o SemiAutomatic: When the SemiAutomatic method is used, the upper and 

lower limits of the intervals are specified together with the number of intervals. 

Interval boundaries are calculated uniformly. The IntervalStart, IntervalWidth, 

and IntervalNumber properties are available when you select the 

SemiAutomatic method. The IntervalStart property gets or sets the numeric 

value of the beginning of the first interval. 

o XDataBoundaries: When the XDataBoundaries method is used, the X values of 

the data series are used to explicitly set each interval boundary. The X values 

are sorted and duplicate values are eliminated. Each ascending value of the 

result is used determine the next interval boundary. Thus, the first and second 

resulting X values define the first interval and each successive X value specifies 

the end of the next interval. Note that specification of N intervals requires N+1 

unique X values. 

 IntervalNumber: Specifies the number of intervals for the histograms created by 

Automatic and SemiAutomatic methods. 

 IntervalStart: Specifies the numeric value of the beginning of the first interval for the 

histograms created by SemiAutomatic method. 

 IntervalWidth: Specifies the numeric value of width of the interval for the the 

histograms created by SemiAutomatic method. 

 NormalDisplay: Specifies the properties that are used to display the Normal (Gaussian) 

curve for comparison with the histogram. 
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 NormalizationInterval: Specifies the normalization interval width for the histograms 

with non-uniform intervals. It preserves the shape of the histogram by normalizing the 

width such that each interval height represents the same frequency per unit width. 

 Normalized: Specifies if each histogram series interval is normalized. 

The Chart field is actually a wrapper for a C1Chart control, which provides all the charting 

services and has an extremely rich object model of its own. If you want to customize the Chart 

field even further, you can use the ChartControl property to access the inner C1Chart object 

using scripts. 

For example, the Chart field does not have a property to control the position of the legend. But 

the C1Chart control does, and you can access this property through the ChartControl property. 

For example, the script below causes the chart legend to be positioned below the chart instead 

of on the right: 

' place legend below the chart 

chartField.ChartControl.Legend.Compass = "South" 

If you assign this script to the report's OnLoad property, the chart will look like the image 

below: 

 

The other properties used to create these chart are as follows: 

ChartType = Pie 

FormatY = "p1" 

ShowPercentage = true 

Palette = "Red;Gold;Orange;Beige;DarkGoldenrod;Goldenrod;" 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.CustomFields.4~C1.C1Report.CustomFields.Chart~ChartControl.html
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Charts with Multiple Series 
Working with C1ReportDesigner > Charting in Reports > Charts with Multiple Series 

To create charts with multiple series, simply set the DataY property to a string that contains the 

names of each data field you want to chart, separated by semi-colons. 

For example, to create a chart showing product prices and discounts you would set the DataY 

property as shown below: 

DataY = "UnitPrice;Discount" 

If you want to specify the color used to display each series, set the Palette property to a list of 

colors separated by semi-colons. For example, the value displayed below would cause the chart 

to show the UnitPrice" series in red and the "Discount" series in blue: 

Palette = "Red;Blue" 

Charts in Grouped Reports 
Working with C1ReportDesigner > Charting in Reports > Charts in Grouped Reports 

Reports for WinForms allows you to create reports with multiple groups. For example, instead 

of listing all products in a single flat report, you could group products by category. Each group 

has a header and a footer section that allow you to display information about the group, 

including titles and subtotals, for example. 

If you add a chart to a group header, the chart will display only the data for the current group. 

By contrast, adding a chart to the report header or footer would include all the data in the 

report. 

To illustrate this, here is a diagram depicting a report definition as shown in the report designer 

and showing the effect of adding a Chart field to the report header and to a group header: 

Report Header section 

A chart field here would generate 

only one chart for the entire report. 

 

The chart would show all the data 

in the report's data source. 

Page Header section 

Group Header section (CategoryName) 
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A chart field here would generate 

one chart for each CategoryName value. 

 

Each chart would show all the data 

for the current CategoryName. 

Detail section 

Group Footer section (CategoryName) 

Page Footer section 

Report Footer section 

Continuing with the example mentioned above, if you added a chart to the group header and 

set the DataX property to "ProductName" and the DataY property to "UnitPrice", the final 

report would contain one chart for each category, and each chart would display the unit prices 

for the products in that category. 

The images below show screenshots of the report described above with the group headers, the 

charts they contain, and a few detail records to illustrate: 
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The above chart shows unit prices for products in the "Beverages" category. The below chart 

shows unit prices for products in the "Condiments" category. 

 

DataX = "Product Name" 

DataY = "Unit Price" 

Because the chart automatically selects the data based on the scope of the section that contains 

it, creating charts in grouped reports is very easy. 

Plotting Data in Charts 
Working with C1ReportDesigner > Charting in Reports > Plotting Data in Charts 

To plot data in a simple chart, the properties DataX and DataY are set as follows: 

1. Open the C1ReportDesigner application and create or open a report definition file. 

2. Add a Chart field to the report, then select it to show its properties in the designer's 

property window. 

3. Set the chart's DataX property to the name of the field whose values should be 

displayed in the X axis (chart categories). 

4. Set the chart's DataY property to the name of the field whose values should be 

displayed in the Y axis (chart values). 

5. Optionally set additional properties such as ChartType and DataColor. 

For example, the chart below was created based on the NorthWind Products table. In this case, 

the following properties were set: 
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DataX = "ProductName" 

DataY = "UnitPrice" 

 

Note that for this chart type (Bar), the value axis (where the DataY field is displayed) is the 

horizontal one, and the category axis is the vertical one. 

In this case, a filter was applied to the data in order to limit the number of values shown. 

Without the filter, the chart would contain too many values and the vertical axis would not be 

readable. 

The DataY property is not restricted to field names. You can also plot series with calculated 

values. The strings that specify the series are actually treated as full expressions, and are 

calculated like any regular field in the report. 

For example, to create a chart showing the actual price of each field you could set the DataY 

property to the value shown below: 

DataY = "UnitPrice * (1 - Discount)" 

  

Creating Aggregate Charts 
Working with C1ReportDesigner > Charting in Reports > Creating Aggregate Charts 

The Chart field of Reports for WinForms has a powerful feature called "aggregated charting". 

This feature allows you to create charts that automatically aggregate data values (DataY) that 

have the same category (DataX) using one of the following aggregate functions: 

 Sum 

 Count 

 Average 

 Minimum 

 Maximum 

 Variance 

 VariancePop 

 StandardDeviation 
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 StandardDeviationPop 

To illustrate this feature, consider an "Invoices" report that groups data by country, customer, 

and order ID. The general outline for the report is as follows: 

Report Header section 

Page Header section 

Group Header section (Country) 

Group Header section (Customer) 

Group Header section (OrderID) 

Detail section 

Group Footer section (OrderID) 

Group Footer section (Customer) 

Group Footer section (Country) 

Page Footer section 

Report Footer section 

Now imagine that you would like to add a chart to each Country header displaying the total 

value of all orders placed by each customer in the current country. 

You would start you adding a Chart field to the "Country" header section and set the DataX 

and DataY properties as follows: 

DataX = "CustomerName" 

DataY = "ExtendedPrice" 

This would not work. The data for each country usually includes several records for each 

customer, and the chart would create one data point for each record. The chart would not be 

able to guess you really want to add the values for each customer into a single data point. 

To address this scenario, we added an Aggregate property to the Chart field. This property tells 

the chart how to aggregate values that have the same category into a single point in the chart. 

The Aggregate property can be set to perform any of the common aggregation functions on 

the data: sum, average, count, maximum, minimum, standard deviation, and variance. 
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Continuing with our example, we can now simply set the chart's Aggregate property to "Sum". 

This will cause the chart to add all "ExtendedPrice" values for records that belong to the same 

customer into a single data point. The result is shown below: 

 

Notice how each customer appears only once. The values shown on the chart correspond to the 

sum of the "ExtendedPrice" values for all fields with the same "Customer". 

Because the chart appears in the "Country" header field, it is repeated for each country, showing 

all the customers in that country. 

If you place the chart in the report header section, it will aggregate data over the entire report. 

For example, suppose you want to start the "Invoices" report with a chart that shows the total 

amount ordered by each salesperson. To accomplish this, you would add a Chart field to the 

report header section and would set the following properties: 

DataX = "Salesperson" 

DataY = "ExtendedPrice" 

Aggregate = "Sum" 

The image below shows the resulting chart: 

 

Since the chart is placed in the report header section, the values displayed include all countries 

and all customers. If you moved the chart field from the report header to the "Country" group 
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header, you would obtain a similar chart for each country, showing the total amounts sold by 

each salesperson in that country. 

Maps in Reports 
Working with C1ReportDesigner > Maps in Reports 

Reports for WinForms supports map fields using its extensible custom field architecture. The 

Map custom field is implemented as a custom field in two using two assemblies from 

ComponentOne Studio WPF Edition: C1.WPF and C1.WPF.Maps, which are installed with the 

report designer application. In the following topics, you'll see how you can customize map fields 

in reports using the C1ReportDesigner application. 

Note that the Map custom field uses two assemblies from ComponentOne Studio WPF 

Edition: C1.WPF and C1.WPF.Maps. Make sure that these assemblies are available and 

referenced by your project before you begin. 

To start using the Map custom field in the C1ReportDesigner application, complete the 

following steps: 

1. Run the C1ReportDesigner application. See Accessing C1ReportDesigner from Visual 

Studio for details. 

2. Confirm that the map icon is present in the C1ReportDesigner toolbar. If it is not 

included, you may need to add the following line to the <customfields> section of the 

C1ReportDesigner.EXE.settings file: <item 
value="C1.C1Report.CustomFields.4;C1.C1Report.CustomFields.Map" 

/> 

3. Create a new report or open an existing report. See Step 1 of 4: Creating a Report 

Definition for an example. 

4. Click the map icon and drag it onto your report to add a Map field. 

That's it! The main aspects of the Map field include: 

 tile and data layers 

 legends 

 styles 

 expressions 

 auto zooming/centering and data tracking 

For more information, see the following topics which describe some of the most important 

properties of the Map custom field. 

See Also 

Layers 

Tracking 

Styles 
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Spatial Locations 

Points Layer 

Lines Layer 

KML Layer 

Legends 

Maps Walkthrough 

Layers 
Working with C1ReportDesigner > Maps in Reports > Layers 

The main part of a map is the tile layer which provides raster graphics representing the Earth 

surface or part of it, and zero or more layers representing spatial data. 

The tile layer is specified by the TileSource property. It may be set to a VirtualEarth tile source 

(road, aerial, or hybrid). The tile source may be set to "none" in which case no tiles will be drawn 

on the map. This may be useful especially when other layers such as KML provide enough data 

for the map visualization. 

Note that unless the tile source is "none", the tiles are loaded from a network location when the 

report runs, which may slow things down considerably. 

Except for the tile layer, all other layers are contained in the Layers collection. Currently, three 

layer types are supported: 

 Points. A "points" layer allows to show spatial data as points on the map. A marker is 

drawn for each data row by the "points" layer. 

 Lines. A "lines" layer draws a straight line between two points for each data row. 

 KML Layer. KML (Keyhole Markup Language) is an XML based language that allows to 

describe various geographic information. For more info on KML see 

http://en.wikipedia.org/wiki/Keyhole_Markup_Language. A KML layer allows to load into 

the map and show a local or Web-based KML file. 

Specifying the Layer Data Source 

For each layer in the Layers collection, the layer's own RecordSource (a SQL statement) may be 

specified. If it is omitted, data (except for KML layers) is retrieved directly from the parent report 

(filtered according to the current grouping scope). If provided, RecordSource is used on the 

parent report's connection string. 

Tracking 
Working with C1ReportDesigner > Maps in Reports > Tracking 

http://en.wikipedia.org/wiki/Keyhole_Markup_Language
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The map shown by a Map field can automatically center and zoom in on the data shown on the 

map. This behavior is determined by two factors: 

 The AutoCenter and AutoZoom properties' values specified for the whole Map field, 

together with several related properties fine-tuning the automatic centering and 

zooming (AutoZoomPadLon, AutoZoomPadLat, MaxAutoZoom, RoundAutoZoom). 

 The spatial data represented by the layers, provided that data is "tracked". Tracking 

(such as whether or not a particular piece of spatial data should be used for automatic 

centering and zooming) is determined by the layer's Track property. Additionally, for 

KML layers an expression may be specified which will determine whether a specific KML 

item should be tracked or not. 

Styles 
Working with C1ReportDesigner > Maps in Reports > Styles 

Visual attributes of map elements are mostly defined by styles. There are several types of styles 

(point marker styles, line styles and KML item styles); the applicable type is determined by the 

context, such as points layers use point marker styles, lines layers use line styles, and so on. 

Usually a style may be specified as a data driven expression (so that the actual style depends on 

run time data), with a fallback style used by default. How style expressions are specified and 

evaluated is described next. 

The Map custom field contains 3 style collections: 

 MarkerStyles 

 LineStyles 

 KmlItemStyles 

These styles are available to all layers defined on the Map, and also to other Map fields in the 

current report. The styles in each collection are addressable either by index or - preferably - by 

name (using the Name property). When a style expression evaluates to a string, that string is 

used to search for a matching style, first in the current map and if that fails, in all other maps on 

the current report (only matching type styles are searched; for example, only MarkerStyles 

collections are searched for a point marker style, and so on). 

Spatial Locations 
Working with C1ReportDesigner > Maps in Reports > Spatial Locations 

Points and lines layers provide two different ways to specify spatial locations for the data: 

 As a pair of expressions that evaluate to a longitude/latitude pair at run time. Typically 

these would directly reference corresponding data fields (longitude and latitude) stored 

in the data source. 

 As a MapLocation, an expression (or a list of expressions) that evaluates to a string that 

can be used to retrieve the corresponding spatial location using an external online 

service (Google Maps). If the specified MapLocation contains semicolons, it is treated 
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as a list of semicolon-delimited expressions, each of which is evaluated separately and 

then combined to use as the query. A typical MapLocation could look like this: 

"Address;City;PostalCode;Country" 

which would fetch Address, City, PostalCode, and Country fields from the data source 

and then combine them to query the external service. 

Note that using MapLocation may be very time consuming due to Internet access. 

Hence by default the retrieved spatial data is stored in a local disk file. The path to that 

file is specified by the Map.GeoCachePath property. By default the file's name is 

"geocache.xml", and it is stored in the same directory as the report definition. Disabling 

geocaching is not recommended. 

Points Layer 
Working with C1ReportDesigner > Maps in Reports > Points Layer 

A points layer is used to show point location markers, one marker per each record of the data 

source. A marker's location is specified either by a Longitude/Latitude pair, or by a 

MapLocation, as described in Spatial Locations. The following points describe important 

aspects of the points layer. 

 Data access: when a points layer is processed at run time, the record source (either the 

layer's own RecordSource if specified, or the report's record source filtered by the 

current group) is looped through, and a mark is drawn for each data record. 

 Visual Styles: the way point markers look is determined by the applied marker style. A 

points layer provides a default MarkerStyle property that allows to specify markers' 

shape, color and so on. Additionally, a MarkerStyleExpr expression may be specified, 

in which case at runtime it will be evaluated for each data record, and if a matching 

marker style is found in the MarkerStyles collection of the current map, or failing that 

of other maps in the report, that style will be applied instead of the default. (As 

described above, a style expression should evaluate to a string matching a style name 

in the styles collection.) 

 Clustering: when several point markers are located close to one another they may be 

"clustered" together into a single marker. That marker always shows the number of 

clustered point markers it represents. The visual style of the cluster marker may differ 

from the style of the point markers, and may even vary depending on the number of 

points it represents. Cluster styles are specified by the points layer's ClusterStyles 

collection, if more than one styles are provided the specific style is determined by the 

cluster size. Relevant points layer properties are: ClusterDistance, ClusterDistribution 

and ClusterStyles. 

 Tracking: if the Track property is True, automatic centering and zooming includes all 

layer's points. 

Lines Layer 
Working with C1ReportDesigner > Maps in Reports > Lines Layer 



 

 314 

A lines layer is used to draw lines between points on the map, one line connecting two points 

per each data record. Spatial location for each point may be specified in the same manner as for 

the Points Layer: either with two Longitude/Latitude pairs (one for each end of the line), or 

with two MapLocations used to request locations from an online service. The following points 

describe important aspects of the lines layer. 

 Data access: as with the points layer, a lines layer allows to specify its own 

RecordSource, or uses the report's record source filtered by the current group. 

 Visual Styles: styles are handled much in the same manner as with points layers, but 

instead of MarkerStyles, the LineStyles collection is used. 

 Tracking: if the Track property is True, automatic centering and zooming includes all 

layer's lines. 

KML Layer 
Working with C1ReportDesigner > Maps in Reports > KML Layer 

A KML Layer renders a KML (Keyhole Markup Language) or KMZ (compressed KML) file on the 

map. The file name is specified by the KmlFileName property on the layer. The file may be 

loaded from a URL, from a local disk file, or embedded in the report. If the file is not embedded 

(EmbedKmlFile is False), and the directory is not specified, the file is loaded from the directory 

containing the report definition. 

 KML item expressions: when a KML layer is rendered, items present in the KML file are 

processed in sequence. As each item is loaded, several expressions specified on the 

layer are evaluated allowing to control the process - for example, only load certain 

items based on various criteria, or modify items' visual attributes. Additionally, if a 

RecordSource is specified for the KML layer, the data may be filtered for each KML 

item prior to evaluating the item expressions. Following is a detailed explanation of the 

properties involved in evaluating KML item expressions. Note that in all those 

expressions, the special variable kmlItemName may be used, and refers to the KML 

item name that is currently being processed. 

 ItemFilterExpr: if (and only if) a RecordSource is specified on the KML layer, this filter 

is applied to the retrieved data prior to evaluating other expressions. For example, if the 

layer's record source contains a Country field, and the KML file includes country items, 

the following filter: 
kmlItemName=Country 

will ensure that for each KML item, other item expressions will evaluate with data 

corresponding to the current item's country. 

 ItemTrackExpr: if specified, determines whether an item is used to automatically 

center/zoom the map. If left empty, true is assumed. 

 ItemVisibleExpr: if specified, determines an item's visibility. If left empty, true is 

assumed. 

 ItemStyleExpr: if this expression evaluates to a valid style name in the KmlItemStyles 

collection (of the current or any other Map in the report), this style is applied to the 

item. This may be used for instance to fill different states with different colors 

depending on a data value such as orders total for that state. 

 ItemStyle.ItemNameExpr: the KML item style itself contains one calculated property, 

the item's name. This allows to suppress the name rendered on the map, or replace it 

with report data (such as orders total). 
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Legends 
Working with C1ReportDesigner > Maps in Reports > Legends 

A map can have several associated legends, rendered within its bounds. To facilitate placing a 

legend outside the map's bounds, the legend can be associated with any map field in the 

report, so you can add an empty map field just to hold a legend describing another map. 

Legends are contained within the Legends collection of the Map field. To add a legend, add an 

item to that collection. The location of a legend within its map's bounds is determined by the 

LegendAlignment property. Orientation determines whether items within the legend are 

placed vertically (default) or horizontally. Several other properties allow to fine-tune the way the 

legend looks. 

Items within the legend are represented by the Items collection. That collection may be 

populated automatically with data from non-KML layers of the current map, if the Automatic 

property of the legend is set to True. In that case the Items collection cannot be edited. 

Otherwise, the legend items must be added manually. 

The following types of legend items are supported: 

 LegendLayerStyleItem: represents a layer style. The designer allows to select an 

existing layer or style represented by the legend item. Depending on the selected layer 

style, the legend item may represent a point marker (for points layers/styles), a line (for 

line layers/styles) or a color swatch (for KML item styles). 

 LegendColorSwatchItem: represents an arbitrary color swatch. 

 LegendTextItem: represents arbitrary text. 

Maps Walkthrough 
Working with C1ReportDesigner > Maps in Reports > Maps Walkthrough 

In this walkthrough you'll add a map to a report showing order totals for the US states, 

summarized by state. The report without the map is very simple, it just lists the total of all 

orders for each state. Here's the whole of it: 

OrderValue StateName 

16325.15 Alaska 

3490.02 California 

115673.39 Idaho 

1947.24 Montana 

52245.9 New Mexico 

30393.93 Oregon 
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31001.65 Washington 

12489.7 Wyoming 

You will add a map to this report that will fill each state with a color ranging from green for 

states with no orders to shades of yellow and red depending on the total orders amount. 

Additionally, each state will have a circular mark with the diameter proportional to the total, and 

a label stating that total. Finally, you'll add two small inset maps to show Alaska and Hawaii. 

Note that this walkthrough uses the following files: 

 C1NWind.mdb: C1NWind database with spatial and some other data added. 

 us_states_abbr.kmz: a compressed KML file containing US states bounds with 

abbreviated state names. 

Complete the following steps: 

1. Create the base report.  

Add a new report in the designer, with C1NWind.mdb as the data source, with the 

following SQL query:     

  SELECT Orders.ShipRegion, Orders.ShipCountry, 

StateNamesGeo.StateName,    

  Sum([Order Details].UnitPrice*[Order Details].Quantity) AS 

OrderValue,    

  (select Longitude from StateNamesGeo where StateNamesGeo.Abbr 

= Orders.ShipRegion) as Longitude,    

  (select Latitude from StateNamesGeo where StateNamesGeo.Abbr = 

Orders.ShipRegion) as Latitude    

  FROM ((Categories INNER JOIN Products ON Categories.CategoryID 

= Products.CategoryID)    

  INNER JOIN (Orders INNER JOIN [Order Details] ON 

Orders.OrderID = [Order Details].OrderID)    

    ON Products.ProductID = [Order Details].ProductID)    

  INNER JOIN StateNamesGeo on Orders.ShipRegion = 

StateNamesGeo.Abbr    

  WHERE Orders.ShipCountry = "USA"    

  GROUP BY Orders.ShipRegion, Orders.ShipCountry, 

StateNamesGeo.StateName    

  ORDER BY Orders.ShipRegion; 

Use the report wizard to add OrderValue and StateName fields to the detail section, 

run the report to make sure that it prints data shown above. 

2. Add the main map.  

You'll add the map to the report's header: 

o Make some room for the map by dragging the header's bottom edge down in 

the report designer. 

o Click on the Map custom field icon (a globe) and drag it onto the header. 
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o Set the map's size to12870 by 7620 twips or similar, arrange as needed. 

3. Adjust the map's properties.  

Set the map's properties as follows (only non-defaults are shown here): 

o AutoCenter: false 

o AutoZoom: false 

o CenterLatitude: 38 

o CenterLongitude: -103 

o ShowScale: false 

o TileSource: None 

o ZoomLevel: 3 

Note that because we are showing the map of the US, we set the coordinates manually 

as needed (in particular, we leave enough space on the right for the Alaska and Hawaii 

insets). 

4. Add point marker style.  

Open the MarkerStyles collection, add a single style to it. Set its properties as follows: 

o CaptionExpr: StateName & ":" & vbCr & "$" & OrderValue 

o FillColor: 120, 255, 128, 0 

o Name: msTotalSales 

o SizeExpr: sqr(OrderValue / 100) 

This style will be used to draw circle markers on states with size indicating the orders 

total. Note that the fill color is semi-transparent which works better in this case. Note 

also that the size of the marker is proportional to the square root of the order value 

(total). The style name (msTotalSales) will be used to reference this style. 

You may set other properties (font, stroke and text colors) as you like. 

5. Add KML item styles.  

You'll divide all states, depending on their orders total, into 6 groups: 

o states with no orders at all 

o states with up to $10,000 order totals 

o states with order totals between $10,000 and $30,000 

o states with order totals between $30,000 and $50,000 

o states with order totals between $50,000 and $100,000 

o states with order totals above $100,000 

So you'll need to create a KML item style for each of those groups. Open the 

KmlItemStyles collection, and add 6 styles with names corresponding to groups listed 

above, and FillColor values to differentiate the states on the map: 

o Name: ksNoOrders, FillColor: 143, 188, 139 

o Name: ks0k10k, FillColor: 255, 250, 205 
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o Name: ks10k30k, FillColor: 255, 222, 173 

o Name: ks30k50k, FillColor: 255, 160, 122 

o Name: ks50k100k, FillColor: 205, 92, 92 

o Name: ks100kup, FillColor: 178, 34, 34 

The names are very important here as we will use them in KML item expressions to 

select a style according to the state's order totals value. 

6. Add the KML layer.  

The most important part of our map is the KML layer showing the state bounds and 

filling the states with the appropriate colors. To add it, go to the map's Layers 

collection editor and add a KML layer. Set its properties as follows: 

o KmlFileName: us_states_abbr.kmz (specifying the file name without the path 

will load the file from the same location as the report definition); 

o RecordSource: 
o  
o SELECT Orders.ShipRegion, 

o     Sum([Order Details].UnitPrice*[Order 

Details].Quantity) AS OrderValue 

o     FROM (Categories INNER JOIN Products ON 

Categories.CategoryID = Products.CategoryID) 

o     INNER JOIN (Orders INNER JOIN [Order Details] ON 

Orders.OrderID = [Order Details].OrderID) 

o     ON Products.ProductID = [Order Details].ProductID 

o     WHERE Orders.ShipCountry = "USA" 

o     GROUP BY Orders.ShipRegion 

o     ORDER BY Orders.ShipRegion; 

o ItemFilterExpr: kmlItemName=ShipRegion (ensures that KML item 

expressions, in particular the style used to draw the KML item, is evaluated with 

data for the state corresponding to the current KML item); 

o KmlVisibleExpr: kmlItemName<>"AK" (ensures that the main map does not 

show Alaska); 

o ItemStyleExpr: 
o  
o iif (OrderValue > 100000, "ks100kup", 

o     iif (OrderValue > 50000, "ks50k100k", 

o     iif (OrderValue > 30000, "ks30k50k", 

o     iif (OrderValue > 10000, "ks10k30k", 

o     iif (OrderValue > 0, "ks0k10k", 

o     "ksNoOrders" 

o     ))))) 
 

The above expression evaluates to one of our KML item style names (see 

above) depending on the current OrderValue which, as per our RecordSource, 

is the sum of all orders for a state, and ItemFilterExpr specified above ensures 

that this expression evaluates for the state currently being loaded from the KML 

file. 

7. Add Circular Markers.  
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To make the map even more visual, you'll also add a points layer with circular markers 

placed on states, sized proportionally to the state's total orders. To do it, add a 

PointsLayer to the Layers collection, and move above the KML layer so that it shows 

on top of it when the map is rendered. Set the layer properties as follows: 

MarkerStyleExpr: "msTotalSales" (this will use the style that we already added to the 

map's MarkerStyles collection; proportional sizing is built into that style so no need to 

do anything else here) 

Latitude: Latitude (use spatial data provided by the record source). 

Longitude: Longitude (use spatial data provided by the record source). 

8. Add legends.  

You'll add two legends to our map: a legend that is just a title, in the top right corner, 

and a color key to our KML item styles, in the bottom right. 

o To add the legends, open the Legends collection editor. 

o To add the title, add an item, set its Caption to "Order Totals by State", and 

leave LegendAlignment at its default TopRight value. Adjust other properties 

as you see fit. 

o To add the color key, add another legend, set its alignment to BottomRight, 

and open its Items collection to add the following items: 

 Text item, with the text "Color key:" - this will be the legend's caption 

 6 LayerStyle items, one for each of our KML item styles. For each item, 

select the style it describes from the LayerStyle drop-down box - this 

will fill most of other properties automatically with values from the 

selected style. The only thing you will have to set manually is the item's 

text - set appropriately for each style, from "No orders", to "less than 

$30k", to "$10k-$30k" and so on to "$100k and up" 

9. Add inset maps.  

We will add two inset maps, for Alaska and Hawaii. To do it: 

o Click on the Map custom field icon, and draw two small maps over the upper 

left part of the main map for Alaska, and in the lower left part for Hawaii.  

Both inset maps will reuse styles defined on the main map, so no styles need to 

be added to the inset maps' style collections. 

o Layers will duplicate the layers of the main map, so add two layers to the Layers 

collection of each inset map: 

 A points layer, with MarkerStyleExpr set to "msTotalSales", and 

MarkerVisibleExpr set to 

StateName = "Alaska"  

("Hawaii" for the Hawaii inset), and all other properties as in the points 

layer of the main map. 
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 A KML layer, with all properties (including RecordSource) copied from 

the corresponding properties of the KML layer of the main map, but 

with ItemVisibleExpr set to 

kmlItemName="AK"  

(kmlItemName="HI" for Hawaii). In particular note that ItemStyleExpr 

will work even though style names it evaluates to reference styles in 

another map's style collection. 

o Finally, add a legend with a single fixed text to each inset map, with the state's 

name. 

That's it. Now run the report and make sure it works. 

Using Barcodes in Reports 
Barcodes in Reports for WinForms let you integrate several industry-standard barcodes in 

Barcode field, that can be quickly and easily generated in your reports. Simply drop the barcode 

field on your report, select the barcode symbology, provide the text, and you are done! 

The functionality of barcodes in Reports for WinForms is further extended 

by properties associated with them. The checksums to the value being encoded are 

automatically added to eliminate reader errors. 

 

From 2015v2 release onward, a new barcode engine has been added to Reports. To ensure 

the compatibility of the old barcodes in new reports, UseCompatibleBarcode property is 

used, with default value as True. For the new barcodes, the default value of 

UseCompatibleBarcode property False. 

  

  

  

See Also 

Barcode Symbology 

Barcode Properties 

Barcode Symbology 
Using Barcodes in Reports > Barcode Symbology 

C1.C1Report.4~C1.C1Report.CompatibilityOptions~UseCompatibleBarcode.html
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Barcode symbology specifies the encoding scheme used to convert character data into the 

pattern of wide and narrow bars and spaces in a barcode. The following table illustrates the 

barcode symbology used in Report for WinForms. 

Style Name Example Description 

Ansi39 

 

  

ANSI 3 of 9 (Code 39) uses 

upper case, numbers, - , * 

$ / + %. This is the default 

barcode style. 

Ansi39x 

 

ANSI Extended 3 of 9 

(Extended Code 39) uses 

the complete ASCII 

character set. 

Codabar 

 

Codabar uses A B C D + - 

: . / $ and numbers. 

Code_128_A 

 

Code 128 A uses control 

characters, numbers, 

punctuation, and upper 

case. 

Code_128_B 

 

Code 128 B uses 

punctuation, numbers, 

upper case and lower case. 

Code_128_C 

 

Code 128 C uses only 

numbers. 

Code_128auto 

 

Code 128 Auto uses the 

complete ASCII character 

set.  Automatically selects 

between Code 128 A, B 

and C to give the smallest 

barcode. 
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Code_2_of_5 

 

Code 2 of 5 uses only 

numbers. 

Code93 

 

Code 93 uses uppercase, % 

$ * / , + -,  and numbers. 

Code25intlv 

 

Interleaved 2 of 5 uses 

only numbers. 

Code39 

 

Code 39 uses numbers, % * 

$ /. , - +, and upper case. 

Code39x 

 

Extended Code 39 uses the 

complete ASCII character 

set. 

Code49 

 

Code 49 is a 2D high-

density stacked barcode 

containing two to eight 

rows of eight characters 

each. Each row has a start 

code and a stop code. 

Encodes the complete 

ASCII character set. 

Code93x 

 

Extended Code 93 uses the 

complete ASCII character 

set. 

DataMatrix 

 

Data Matrix is a high 

density, two-dimensional 

barcode with square 

modules arranged in a 

square or rectangular 

matrix pattern. 
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EAN_13 

 

EAN-13 uses only numbers 

(12 numbers and a check 

digit). It takes only 12 

numbers as a string to 

calculate a check digit 

(CheckSum) and add it to 

the thirteenth position. The 

check digit is an additional 

digit used to verify that 

a barcode has been 

scanned correctly. The 

check digit is added 

automatically when the 

CheckSum property is set 

to True. 

EAN8 

 

EAN-8 uses only numbers 

(7 numbers and a check 

digit). 

EAN128FNC1 

 

EAN-128 is an 

alphanumeric one-

dimensional representation 

of Application Identifier 

(AI) data for marking 

containers in the shipping 

industry.  

This type of barcode 

contains the following 

sections: 

 Leading quiet zone 

(blank area) 

 Code 128 start 

character 

 FNC (function) 1 

character which 
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allows scanners to 

identify this as an 

EAN-128 barcode 

 Data (AI plus data 

field) 

 Symbol check 

character (Start 

code value plus 

product of each 

character position 

plus value of each 

character divided 

by 103. The 

checksum is the 

remainder value.) 

 Stop character 

 Trailing quiet zone 

(blank area) 

The AI in the Data section 

sets the type of the data to 

follow (i.e. ID, dates, 

quantity, measurements, 

etc.). There is a specific 

data structure for each 

type of data. This AI is 

what distinguishes the 

EAN-128 code from Code 

128. 

Multiple AIs (along with 

their data) can be 

combined into a 

single barcode. 

EAN128FNC1 is a 

UCC/EAN-128 (EAN128) 

type barcode that allows 
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you to insert FNC1 

character at any place and 

adjust the bar size, etc., 

which is not available in 

UCC/EAN-128. 

To insert FNC1 character, 

set “\n” for C#, or “vbLf” 

for VB to Text property at 

runtime. 

IntelligentMail 

 

Intelligent Mail, formerly 

known as the 4-State 

Customer Barcode, is a 65-

barcode used for domestic 

mail in the U.S. 

JapanesePostal 
 

This is the barcode used by 

the Japanese Postal 

system. Encodes alpha and 

numeric characters 

consisting of 18 digits 

including a 7-digit postal 

code number, optionally 

followed by block and 

house number information. 

The data to be encoded 

can include hyphens. 

Matrix_2_of_5 

 

Matrix 2 of 5 is a higher 

density barcode consisting 

of 3 black bars and 2 white 

bars. 
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MicroPDF417 

 

MicroPDF417 is two-

dimensional (2D), multi-

row symbology, derived 

from PDF417. Micro-

PDF417 is designed for 

applications that need to 

encode data in a two-

dimensional (2D) symbol 

(up to 150 bytes, 250 

alphanumeric characters, 

or 366 numeric digits) with 

the minimal symbol size. 

MicroPDF417 allows you to 

insert an FNC1 character as 

a field separator for 

variable length Application 

Identifiers (AIs). 

To insert FNC1 character, 

set “\n” for C#, or “vbLf” 

for VB to Text property at 

runtime. 

MSI 

 

MSI Code uses only 

numbers. 

Pdf417 

 

Pdf417 is a popular high-

density 2-dimensional 

symbology that encodes 

up to 1108 bytes of 

information. This barcode 

consists of a stacked set of 

smaller barcodes. Encodes 

the full ASCII character set. 

It has ten error correction 

levels and three data 
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compaction modes: Text, 

Byte, and Numeric. This 

symbology can encode up 

to 1,850 alphanumeric 

characters or 2,710 

numeric characters. 

PostNet 

 

PostNet uses only numbers 

with a check digit. 

QRCode 

 

QRCode is a 2D symbology 

that is capable of handling 

numeric, alphanumeric and 

byte data as well as 

Japanese kanji and kana 

characters. This symbology 

can encode up to 7,366 

characters. 

RM4SCC 

 

Royal Mail RM4SCC uses 

only letters and numbers 

(with a check digit).  This is 

the barcode used by the 

Royal Mail in the United 

Kingdom. 

RSS14 

 

RSS14 is a 14-digit 

Reduced Space Symbology 

that uses EAN.UCC item 

identification for point-of-

sale omnidirectional 

scanning. 

RSS14Stacked 

 

RSS14Stacked uses the 

EAN.UCC information with 

Indicator digits as in the 

RSS14Truncated, but 



 

 328 

stacked in two rows for a 

smaller width. 

RSS14Stacked allows you 

to set Composite Options, 

where you can select the 

type of the barcode in the 

Type drop-down list and 

the value of the composite 

barcode in the Value field. 

RSS14StackedOmnidirectio

nal 

 

RSS14StackedOmnidirectio

nal uses the EAN.UCC 

information with 

omnidirectional scanning 

as in the RSS14, but 

stacked in two rows for a 

smaller width. 

RSS14Truncated 

 

RSS14Truncated uses the 

EAN.UCC information as in 

the RSS14, but also 

includes Indicator digits of 

zero or one for use on 

small items not scanned at 

the point of sale. 

RSSExpanded 

 

RSSExpanded uses the 

EAN.UCC information as in 

the RSS14, but also adds AI 

elements such as weight 

and best-before dates. 

RSSExpanded allows you 

to insert an FNC1 character 

as a field separator for 

variable length Application 

Identifiers (AIs). 
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To insert FNC1 character, 

set “\n” for C#, or “vbLf” 

for VB to Text property at 

runtime. 

RSSExpandedStacked 

 

RSSExpandedStacked uses 

the EAN.UCC information 

with AI elements as in the 

RSSExpanded, but stacked 

in two rows for a smaller 

width. 

RSSExpandedStacked 

allows you to insert an 

FNC1 character as a field 

separator for variable 

length Application 

Identifiers (AIs). 

To insert FNC1 character, 

set “\n” for C#, or “vbLf” 

for VB to Text property at 

runtime. 

RSSLimited 
 

RSS Limited uses the 

EAN.UCC information as in 

the RSS14, but also 

includes Indicator digits of 

zero or one for use on 

small items not scanned at 

the point of sale. 

RSSLimited allows you to 

set Composite Options, 

where you can select the 

type of the barcode in the 

Type drop-down list and 

the value of the composite 
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barcode in the Value field. 

UCCEAN128 

 

UCC/EAN –128 uses the 

complete ASCII character 

Set. This is a special 

version of Code 128 used 

in HIBC applications. 

UPC_A 

 

UPC-A uses only numbers 

(11 numbers and a check 

digit). 

UPC_E0 

 

UPC-E0 uses only numbers. 

Used for zero-compression 

UPC symbols. For the 

Caption property, you may 

enter either a six-digit 

UPC-E code or a complete 

11-digit (includes code 

type, which must bezero) 

UPC-A code. If an 11-digit 

code is entered, the 

Barcode control will 

convert it to a six-digit 

UPC-E code, if possible. If 

it is not possible to convert 

from the 11-digit code to 

the six-digit code, nothing 

is displayed. 

UPC_E1 

 

UPC-E1 uses only numbers. 

Used typically for shelf 

labeling in the retail 

environment. The length of 

the input string for U.P.C. 

E1 is six numeric 

characters. 



 

 331 

You can directly insert a barcode field in the C1ReportDesigner using the BarCode property in 

the Properties window. You can also use Barcode to set the type of BarCode in the barcode 

field. 

Note that the following barcodes support FNC1 characters: 

 EAN128FNC1 

 MicroPDF417 

 RSSExpanded 

 RSSExpandedStacked 

Barcode Properties 
Using Barcodes in Reports > Barcode Properties 

The BarcodeOptions provides additional properties for rendering barcodes in Reports for 

WinForms. Following are the common properties exposed by BarcodeOptions: 

 BarDirection: Lets you select the barcode's direction, horizontally or vertically. The 

available options are LeftToRight, RightToLeft, TopToBottom, and BottomToTop. The 

direction of barcode can also be set using BarDirectionEnum. 

 CaptionGrouping: Lets you split the text of the caption into groups for the barcode 

types it supports. Its value is either True or False. 

 CaptionPosition: Lets you select the caption's vertical position relative to the barcode 

symbol. The available options are None, Above, and Below. 

 CheckSumEnabled: Determines whether a checksum of the barcode will be computed 

and included in the barcode when applicable. 

 TextAlign: Lets you select the caption text alignment. The available options are Left, 

Center, and Right. 

 SupplementNumber: Lets you specify the supplement for the barcode data, 

supplement is 2 or 5 digit for EAN or UPC symbologies. 

 SizeOptions:  

o BarHeight: Specifies the height of a barcode in twips. 

o ModuleSize: Specifies the module (narrowest bar width) of a barcode in twips. 

o NarrowWideRatio: Specifies the ratio between the width of narrow and wide 

bars. 

o SizeMode: Specifies the sizing mode of a barcode. The options available 

are:       

                   

 Normal: Keeps the size of a barcode same as the original size. 

 Scale: Scales the barcode image to take as much field area as possible. 

Different type of barcodes are scaled in different ways; for example, 

in Bar type barcodes like Code128, the height is increased and in 

barcodes such as Matrix, Rss, and Composite, height and width get 

scaled proportionally. 

o SupplementSpacing: Specifies the spacing between the main and the 

supplement barcodes. 

Other options exposed by BarcodeOptions corresponding to different barcode styles are as 

follows: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.BarCodeEnum.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.BarcodeOptions.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.BarcodeOptions.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.BarDirectionEnum.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.BarcodeOptions.html
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Code49: 

 Grouping: Lets you use grouping in the barcode. Its value is either True or False. 

 Group: Obtains or sets group numbers for barcode grouping. Its value is between 0 

and 8. 

DataMatrix: 

 EccMode: Lets you select the ECC mode. The possible values are ECC000, ECC050, 

ECC080, ECC100, ECC140, or ECC200. 

 Ecc200SymbolSize: Lets you select the size of the ECC200 symbol. The default value is 

SquareAuto. 

 Ecc200EncodingMode: Lets you select the ECC200 encoding mode. The possible 

values are Auto, ASCII, C40, Text, X12, EDIFACT, or Base256. 

 Ecc000_140SymbolSize: Lets you select the size of the ECC000_140 symbol. 

 StructuredAppend: Lets you select whether the current barcode symbol is part of 

structured append symbols. 

 StructureNumber: Lets you specify the structure number of the current symbol within 

the structured append symbols. 

 FileIdentifier: Lets you specify the file identifier of a related group of structured 

append symbols. The valid file indentifier value should be within [1,254]. Setting file 

identifier to 0 lets the file identifier be calculated automatically. 

GS1Composite: 

 Type: Lets you select the composite symbol type. Its value can be None or CCA. CCA 

(Composite Component - Version A) is the smallest variant of the 2-dimensional 

composite component. 

 Value: Gets or sets the CCA character data. 

MicroPDF417: 

 CompactionMode: Lets you select the type of CompactionMode. The possible values 

are Auto, TextCompactionMode, NumericCompactionMode, or ByteCompactionMode. 

 FileID: Lets you specify the file id of the structured append symbol. It takes the value 

from 0 to 899. 

 SegmentCount: Lets you specify the segment count of the structured append symbol. 

It takes the value from 0 to 99999. 

 SegmentIndex: Lets you specify the segment index of the structured append symbol. It 

takes the value from 0 to 99998 and less than the value of segment count. 

 Version: Lets you select the symbol size. The default value is ColumnPriorAuto. 

PDF417: 

 Column: Lets you specify the column numbers for the barcode. 

 Row: Lets you specify the row numbers for the barcode. 

 ErrorLevel: Lets you specify the error correction level for the barcode. 

 Type: Lets you select the type of PDF417 barcode. The available types are Normal and 

Simple. 

QRCode 
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 Model: Lets you select the model of QRCode. The available models are Model1 and 

Model2. 

 ErrorLevel: Lets you select the error correction level for the barcode. The available 

options are Low, Medium, Quality, and High. 

 Version: Lets you specify the version of the barcode. 

 Mask: Lets you select the pattern used for masking barcode. In order to make sure 

QRCode being successfully read, mask process is required to balance brightness. The 

options available are Auto, Mask000, Mask001, Mask010, Mask011, Mask100, Mask101, 

Mask110, and Mask111.       

 Connection: Lets you select whether connection is used for the barcode. It takes the 

value True of False. 

 ConnectionNumber: Lets you specify the connection number for the barcode. It takes 

the integer value ranging from 0 to 15. 

RssExpandedStacked: 

 RowCount: Lets you specify the number of stacked rows. 

 

The quiet zones for barcodes can be specified easily by using MarginBottom, MarginLeft, 

MarginRight, and MarginTop properties in the Property window of the C1ReportDesigner. 

 

Report and Document Viewer 

Overview 
The Report and Document viewer (C1dView.exe and C1dView32.exe) is a Windows application 

that can be used to generate and view reports, or view previously saved ComponentOne 

documents (.c1d, .c1dx, .c1md, .c1db). 

The Report and Documenter viewer (C1dView.exe and C1dView32.exe) user inteface is based 

on two other ComponentOne products - C1Ribbon and C1Command. 

Two versions of the application executable are provided: C1dView.exe built for "Any CPU" 

target, and C1dView32.exe built for x86 target, because some database providers are only 

available for 32 bit or 64 bit platforms. Notably, if you want to open (generate and view) a .mdb 

based report on a 64 bit system, use C1dView32.exe as there's no 64 bit .mdb driver. 

To run the application, double-click the C1dView.exe file located by default in the following 

path for .NET 4.0: 

 C:\Program Files (x86)\ComponentOne\Apps\v4.0 for 64 bit platform 

 C:\Program Files\ComponentOne\Apps\v4.0 for 32bit platform 

 Note that this directory reflects the default installation path and its path may be different if you 

made changes to the installation path. 
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Here's what the application looks like with the NWindEmbedPics.xml file opened from 

Documents\ComponentOne 

Samples\WinForms\C1Report\C1Report\XML\SampleReports. Notice the name of the 

report is displayed to the left of the application name, C1dView32. 

 

 

If there are more than one type of report to view in the file, the Select a Report to View dialog 

box appears so you can choose the type of report you wish to view.  The Select a Report to 

View dialog box  gets a list of reports available in an xml report definition file. 

 

The main Designer window has the following components: 

 File menu: Provides options to load and save report definition files and to import and 

export report definitions. See File Menu for more information. 
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 View tab: Provides shortcuts to the File, Page, Zoom, Navigation, and Tools menu 

functions. See View Tab for more information. 

 Preview Pane: Displays the document/report shown by the preview. Once a 

document/report is opened, it will appear in the preview pane area. 

 Help button: Provides options to open online sources or view the About screen, which 

displays information about the application. 

 Pages tab: This tab includes thumbnails of all the pages in the document. 

The C1PreviewThumbnailView class is used to create the thumbnails of all the pages in 

the document. 

 Outline tab: This tab includes an outline view of all the pages in the 

document/report. C1PreviewOutlineView class is used to create an outline view of all 

the pages in the document. 

 Status bar: The status bar displays includes ribbon buttons for displaying the document 

in different page views such as single page view, continuous view, pages facing view, 

and pages facing continuous view. You can zoom in and out of a selected report by 

dragging the zoom slider at the right of the status bar. 

The topics that follow explain how you can use the Report and Document Viewer application 

to generate and view reports, or view previously saved ComponentOne documents (.c1d, .c1dx, 

.c1md, .c1db). 

C1dView File Menu 
Report and Document Viewer Overview > C1dView File Menu 

The File menu provides shortcut to load and save report definition files and to import and 

export report definitions. You can also access the C1ReportDesigner application's options 

through the File menu. 

The File menu appears similar to the following: 

 

The menu includes the following options: 

C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewThumbnailView.html
C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewOutlineView.html
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 Open: Brings up the Open dialog box, enabling you to select an existing report or 

document to open. 

 Export: Exports the current report or document. 

 Print: Prints the current report or document. 

 Page Setup: Opens the Page Setup dialog box where you can modify the pages 

settings for the current report or document. 

 New Window: Opens a new window. 

 Close: Closes the current report or document. 

 Recent Documents: Lists recently opened documents. To reopen a document, select it 

from the list. 

 Exit: Closes the C1dView application. 

C1dView View Tab 
Report and Document Viewer Overview > C1dView View Tab 

The View tab is located in the C1dView's Ribbon menu and provides shortcuts to the File, Page, 

Zoom, Navigation, and Tools menu functions. For more information, see the following topics. 

 File Group 

 Page Group 

 Zoom Group 

 Navigation Group 

 Tools Group 

C1dView File Group 
Report and Document Viewer Overview > C1dView File Group 

The File group on the View tab appears similar to the following: 

 

It consists of the following options: 

 Open: Opens a report or document. 

 Export: Exports the current report or document. 

 Print: Prints the current report or document. 

C1dView Page Group 
Report and Document Viewer Overview > C1dView Page Group 

The Page group on the View tab appears similar to the following: 
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It consists of the following options: 

 Page Setup: Opens the Page Setup dialog box 

 Portrait: Changes the report or document's orientation to portrait. It also opens the 

Enter Report Parameters dialog box if the report prompts users to enter parameters, 

where you can specify the settings before changing the current report or document's 

orientation to portrait. 

 Landscape: Changes the report or document's orientation to landscape. It also opens 

the Enter Report Parameters dialog box if the report prompts users to enter 

parameters, where you can specify the settings before changing the current report or 

document's orientation to landscape. 

 Refresh: Refreshes the current document or regenerates the report. 

C1dView Zoom Group 
Report and Document Viewer Overview > C1dView Zoom Group 

The Zoom group on the View tab appears similar to the following: 

 

It consists of the following options: 

 100%: Zooms the document to 100% of the normal size. 

 Fit Window: Zooms pages to fit within the window. 

 Fill Width: Zooms pages to fill the window width.  

 Zoom Arrow: Opens the Zoom dialog box as follows: 
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Here you can specify the zoom percentage, page rows and page columns whether or not the 

report or document is in pages facing view mode, whether or not the report or document is in 

pages facing continuous view mode. You can also specify the report's or document's view mode 

as facing pages, continuous or both. In the Auto Zoom groupbox you can specify zoom of the 

document or report to 100%, fit window, fit width, or fit text width. 

C1dView Navigation Group 
Report and Document Viewer Overview > C1dView Navigation Group 

The Navigation group on the View tab appears similar to the following: 

  

C1dView Tools Group 
Report and Document Viewer Overview > C1dView Tools Group 

The Tools group on the View tab appears similar to the following: 

 

It consists of the following options: 

 Hand Tool: Helps in scrolling the document in window using the mouse. 

 Find: Opens the find bar where you can type the text in the textbox to find the text in 

the document/report. 

 Find Next: Finds the next occurrence of the search text. 

 Text Select Tool: Selects the text in the document to copy. 

 Zoom In Tool: Zooms into a mouse-selected area. 

 Zoom Out Tool: Zooms out of a mouse-selected area. 
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Report Preview Control Overview 
Report Preview control has been introduced as beta version for 2015 v2 release. This control is 

a full-featured single viewer with a modern UI, capable of showing multiple documents or 

reports. The new ribbon Elements, Groups, Sidebars, etc. have been introduced with API 

exposed for customization to the users. 

The Report Preview control is aimed at reducing the implementation complexities for the 

developers who want to show documents or reports from different sources in a single viewer. 

 

To add this control in Visual Studio, add C1.Win.C1RibbonPreview.4.dll in the Toolbox. 

Report Preview Control Highlights and Features 

Preview Multiple Document Types 

Multiple documents or report types such as C1Report, SSRS (in both paginated and non-

paginated modes), C1Document, can be viewed from different sources in a single viewer. 

Export Multiple Formats 

Multiple export format options such as PDF, Doc, Excel (.xls,.xlsx), MHTML, CSV, Tiff, bmp, emf, 

gif, jpeg, png, C1 Open XML, C1 Binary Document, C1 Document, Open XML Excel, Open XML 

Word, Enhanced metafile, XML, Rich Text Format, and XPS are supported that makes this 

control even more flexible for saving and sharing documents. 

Full-Featured Preview Controls 

All major functionalities are grouped in the ribbon of the control. The Report, Page, Navigation, 

Zoom, and Tools groups provide functionalities of opening, closing, and exporting documents 

or reports, setting print layout, navigating and zooming the pages, and support for panels for 

thumbnails, outlines, and text search. 

The following image shows the Report Preview control displaying a report of .c1dx format: 

C1.Win.C1RibbonPreview.4.html


 

 340 

 

The Report Preview control also supports C1SsrsDocumentSource to show SSRS reports; you 

can browse the reports tree available on a SSRS server, and preview individual reports. 

The following image shows the Report Preview control displaying a SSRS report on 

ComponentOne server:
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Working with C1ReportsScheduler 
The following topics contain important information about C1ReportsScheduler, a stand-alone 

application used to schedule report creation to run in the background. Using the 

C1ReportsScheduler application, you can choose what reports to export or print, formats to 

export the report to, and the schedule and frequency for creating reports. 

See Also 

About C1ReportsScheduler 

Installation and Setup 

User Interface 

About C1ReportsScheduler 
Working with C1ReportsScheduler > About C1ReportsScheduler 

The C1ReportsScheduler application is designed to run scheduled Reports for WinForms 

tasks in the background. The following report task types are supported: 

 An XML report definition loaded into a C1Report component. 

 An XML report definition imported into a C1PrintDocument component. 

 A data bound C1PrintDocument loaded from a C1D/C1DX file. 

 An executable user program generating and exporting or printing a report. 

For each task, multiple actions can be specified. For example, a report can be exported to PDF 

and Excel files and also printed. Each task also has an associated schedule that specifies when 

the task needs to be executed. 

The C1ReportsScheduler application consists of two related interacting parts: 

 The C1ReportsScheduler frontend application (C1ReportsScheduler.exe). 

 The C1ReportsScheduler Windows service (C1ReportsSchedulerService.exe). 

In the recommended mode of operation, the service (C1ReportsSchedulerService.exe) runs in 

the background, executing specified tasks according to their schedules. The frontend 

(C1ReportsScheduler.exe) can be used to view or edit the task list, start or stop schedules, and 

control the service. While the frontend is used to install and setup the service, it is not needed 

for the service to run, so normally it would be started to adjust the list of scheduled tasks as 

needed, and exited. (If the service is installed on a machine, the frontend connects to it 

automatically when started.) 

While not recommended, standalone mode of operation is also possible. In this mode, the 

frontend is also used to actually run the scheduled tasks. In that case, of course, terminating the 

frontend application will also stop all schedules. 
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Note that all service specific operations (installation, setup, and un-installation) can be 

performed from the frontend application. 

Installation and Setup 
Working with C1ReportsScheduler > Installation and Setup 

By default, the C1ReportsScheduler application and service (C1ReportsScheduler.exe and 

C1ReportsSchedulerService.exe) for .NET 4.0 is installed in: 

 C:\Program Files (x86)\ComponentOne\Apps\v4.0 for 64 bit platform 

 C:\Program Files\ComponentOne\Apps\v4.0 for 32 bit platform 

To install and setup the application and service, complete the following steps: 

1. Navigate to the installation directory and double-click the C1ReportsScheduler.exe 

application to open it. When the C1ReportsScheduler.exe application is run for the 

first time, a dialog box will appear asking whether you would like to install the 

C1ReportsScheduler service. 

2. Click Yes to install the service (recommended). A form should appear which will allow 

you to set up the service parameters such as the WCF address used by the frontend to 

communicate with the service, the path of the service configuration file (.c1rsconf), 

service startup type (manual or automatic), and log options. 

3. Adjust the parameters if necessary (defaults should normally work), and click OK to 

install the service. 

The progress window should appear, and when it closes the frontend should be running in 

client mode. This is indicated by the words "client mode" in the form's caption, and "[ Client ]" 

in the status line (which should also contain an icon showing a gear with a green checkmark). 

If you clicked No when asked whether to install the service, the frontend will start in standalone 

mode, as indicated in the form's caption and status line. You can still add tasks, specify their 

actions and schedules and start them. The only difference is that in standalone mode you will 

need to keep the frontend running for the tasks to run on schedules. 

Note that when in standalone mode, you can install the service at any time and transfer your 

task list to it. To install the service, open the frontend application, and select Install Service 

from the Service menu. To uninstall the service, select Uninstall Service from the Service 

menu. 

User Interface 
Working with C1ReportsScheduler > User Interface 

When you open the C1ReportsScheduler application, it appears similar to the following image: 
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The main C1ReportsScheduler window is divided into three areas: 

 The upper part of the main window shows the task list. Each task defines a report or 

document scheduled for generation. For more information, see Task List. 

 The lower left part of the main window shows the list of actions defined for the current 

task. For more information, see Action List. 

 The lower right part of the main window shows the schedule for the current task. For 

more information, see Schedule. 

The following topics detail the C1ReportsScheduler application's user interface. 

See Also 

Caption and Status Bar 

Task List 

Action List 

Schedule 

Menu System 

Caption and Status Bar 
Working with C1ReportsScheduler > User Interface > Caption and Status Bar 

When working with the C1ReportsScheduler application, you may notice that the caption and 

status bars provide various indicators and information. 
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The form caption is used to show the current mode (client or standalone). For example, the 

caption bar in the image below indicates that the application is running in client mode and lists 

the service it is connected to: 

 

The status bar has two areas. The right side of the status bar displays an icon and a brief text 

description of the current mode. The two available modes are Client and Standalone mode. For 

example, in the image below, the status bar indicates it is in Client mode: 

 

The left side of the status bar displays any warnings or error messages. If the current task or 

action has errors, the main status area shows a related icon and the error description (for 

example, the report definition file is not found). For example, in the image below the status bar 

displays a warning: 

 

Task List 
Working with C1ReportsScheduler > User Interface > Task List 

The task list appears at upper part of the main window and consists of a grid with several 

columns where you can add various tasks to complete. Each task defines a report or document 

scheduled for generation. The task list appears similar to the following image: 

 

The task list is represented by a grid with the following columns: 
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 File Name 

The File Name column lists the name of the C1Report, C1PrintDocument, or executable file 

on which to schedule an action. For C1Report/Imported C1Report type of tasks, this is the 

name of the report definition file, for C1PrintDocument type of tasks, this is the name of 

C1D/C1DX file containing the document, and for external executable type of tasks, this is the 

name of the executable file to run. To select a file, click the ellipsis button to the right of the file 

name text box. 

 Report Name 

Used only for C1Report/Imported C1Report tasks, this column specifies the name of 

the report. It's a combo box: when a report definition file is selected in the first column, 

the combo drop-down box is automatically filled with available reports' names. 

 Report Type 

This column specifies the type of the current task. The following report task types are 

supported: 

States Description 

C1Report For tasks of the C1Report type, an instance of C1Report component 

is used to load the report definition and generate the report. 

Imported C1Report For tasks of the Imported C1Report type, an instance of 

C1PrintDocument component is used to import the report definition 

and generate the report. 

C1PrintDocument For tasks of the C1PrintDocument type, an instance of 

C1PrintDocument is used to load and generate the document. 

External executable Tasks of the External executable type are represented by external 

programs. The intention is to run applications that rely on code when 

generating reports. 

 Task state  

This column shows a small image representing the current state of the task. Note that 

this column does not have a caption. Image indicators used in the column include: 

 Description 
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 Description 

 A gray ball representing an unchecked task. 

 A green ball representing a successfully checked task that is currently not running. 

 A yellow ball representing a successfully checked task that is currently running. 

 A yellow triangle with an exclamation mark representing a task that has errors. 

 Status  

This column shows the current state of the task. States include: 

States Description 

Ready Task is ready but is not scheduled. This is the only status allowing to edit the 

task. 

Scheduled Task is scheduled for execution. Changes are not allowed to a task with this 

status. 

Busy A scheduled task that is currently running. Changes are not allowed to a task 

with this status. 

Paused Task is scheduled for execution but the schedule is paused. Changes are not 

allowed to a task with this status. 

To manipulate the task list, use the Task menu or the toolbar on the left of the task grid: 
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Action List 
Working with C1ReportsScheduler > User Interface > Action List 

The task action list appears in the bottom-left of the screen and represents the list of actions 

associated with the current task (the task selected in the Task List). The action list appears like 

the following image: 

 

The action list is represented by a grid with the following columns: 

 Action 

This is the type of action. The following action types are supported: 

Type Description 

Export Exports the report or document represented by the current task to one of the 

supported external formats. This action type is not allowed for External executable 

type of tasks. 

Print Prints the report or document represented by the current task. This action type is 

not allowed for External executable type of tasks. 

Run Runs the executable. This action type is only allowed for External executable type of 

tasks. 

 Export Format 

For export actions, this column specifies the export format. Note that different sets of 

export formats are available for tasks using C1Report and C1PrintDocument 

components (this is similar to the way export of those components is handled by the 

preview controls). 
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 Output File/Printer Name 

Specifies either the name of the exported file, or the name of the printer used. 

Click the button to the right of this textbox to select the file or printer name (depending 

on the action type). 

 Current Status 

The last column (without a title) is used to show a small image representing the current 

status of the action: 

 Description 

 A gray ball representing an unchecked task. 

 A green ball representing a successfully checked task that is currently not running. 

 A yellow ball representing a successfully checked task that is currently running. 

 A yellow triangle with an exclamation mark representing a task that has errors. 

To manipulate the action list, use the Action menu or the toolbar on the left of the action grid: 

 

 

Schedule 
Working with C1ReportsScheduler > User Interface > Schedule 
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The scheduling panel displays the schedule associated with the current task and allows you to 

schedule and run the task. The scheduling area appears similar to the following image: 

 

The scheduling section of the application includes the following options: 

 Frequency  

In the upper left part of the panel there are four radio buttons specifying how often the 

task will run: One time, Daily, Weekly, or Monthly. The first option, One time, allows 

the task to repeat every specified number of seconds, minutes or hours. The other 

options allow recurrence on a daily, weekly, or monthly basis. As each radio button is 

selected, the schedule panel shows different scheduling options. 

 Start Date and Time  

The start date and time do what you'd expect set the date and time that the scheduling 

action should begin. 

 Start, Stop, and Pause  

In the bottom part of the panel, there are two buttons allowing you to start, stop, pause 

or resume the current task. The buttons change and become available depending on 

the status of the current task. 

 Next scheduled run  

To the right of the buttons, the time of the next scheduled run of the task is shown. 

 Recurrence  

This section changes depending on the frequency radio button selected. For example, 

the Daily option includes a numeric box allowing you to choose the number of days 

between the schedule tasks, the Monthly option allows you to select the months to run 

the task and the date each month, and so on. 

To start, stop, pause, or resume a scheduled task, you can also use the Schedule menu: 
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Menu System 
Working with C1ReportsScheduler > User Interface > Menu System 

The C1ReportsScheduler application includes several menu options, and the application menu 

includes File, Task, Action, Schedule, Service, and Help options which appear similar to the 

following: 

 

This topic describes each of the available menu options. 

File 

The File menu includes the following options: 

 New  

Clears the current task list. 

 Open  

Opens an existing C1Reports Scheduler configuration file (.c1rsconf). 

 Save  

Saves the current task list. 

 Save As  

Saves the current task list in a C1Reports Scheduler configuration file (.c1rsconf). 

 Exit  
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Closes the program. 

Task 

The Task menu includes the following options: 

 Add Task  

Adds a new task to the task list. The task is added to the end of the list, but can be 

moved up and down in the list using appropriate commands. 

 Remove  

Removes the current task from the list. 

 Move Up  

Moves the current task up in the list. 

 Move Down  

Moves the current task down in the list. 

 Check  

Checks the validity of the current task and all its actions' specification. Items that are 

checked include the existence and validity of report definition, correctness of output file 

names, and so on. A task is checked automatically when it is scheduled. A successfully 

checked task has a green ball icon in the "State" column. If a check failed, the task 

cannot be scheduled, and an exclamation mark icon is displayed. Hover the mouse over 

that icon to see the error message (it is duplicated in the status line when the task is 

current). 

 Check All  

Checks the validity of all tasks in the list. 

 Preview  

Generates the current task's report or document, and shows it in a print preview dialog. 

Note that this command is disabled when the task is scheduled. 

Action 

The Action menu includes the following options: 

 Add Action  
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Adds a new action to the action list of the current task. The action is added to the end 

of the list, but can be moved up and down in the list using appropriate commands. 

 Remove  

Removes the current action from the list. 

 Move Up  

Moves the current action up in the list. 

 Move Down  

Moves the current action down in the list. 

Schedule 

The Schedule menu includes the following options: 

 Start  

Starts the current task's schedule. When the schedule is started, the task or its actions 

cannot be edited. 

 Stop  

Stops the current task's schedule. 

 Pause  

Pauses the current task's schedule. 

 Resume  

Resumes the current task's schedule if it has been paused. 

Service 

The Service menu includes the following options: 

 Connect  

Connects to the C1Reports Scheduler service. This command is only available when the 

service is running. 

 Disconnect  

Disconnects from the C1Reports Scheduler service. 
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 Transfer Tasks  

Transfers the current task list to the C1Reports Scheduler service. This command is 

available when the service is running but the frontend application is disconnected from 

the service and contains its own task list. 

 Start  

Starts the C1Reports Scheduler service. This command is available when the service is 

installed on the machine but is not running. 

 Stop  

Stops the C1Reports Scheduler service. This command is available when the service is 

installed on the machine and is running. 

 Pause  

Pauses the C1Reports Scheduler service. This command is available when the service is 

installed on the machine and is running. 

 Resume  

Resumes the C1Reports Scheduler service. This command is available when the service 

is installed on the machine and is paused. 

 Service Setup  

Launches the C1Reports Scheduler service setup dialog. That dialog allows to adjust the 

service parameters, and will restart the service when OK is pressed in the dialog. This 

command is available if the service is installed on the machine. 

 Install Service  

Installs the C1Reports Scheduler service on the machine. This command is available 

when the service is not installed on the machine. 

 Uninstall Service  

Uninstalls the C1Reports Scheduler service. This command is available when the service 

is installed on the machine. 

 Service Log  

Shows or shows the window with the C1Reports Scheduler service log. 

Help 
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The Help menu includes the following options: 

 Contents  

Shows the help file. 

 About  

Shows the About box which includes information about the application, as well as links 

to online resources. 

Working with C1PrintDocument 
The C1PrintDocument component allows you to create complex documents that can be 

printed, previewed, persisted in a disc file, or exported to a number of external formats 

including PDF (Portable Document Format) and RTF (Rich Text File). 

C1PrintDocument provides a number of unique features, including: 

 Consistent transparent hierarchical document structure. 

 Easy to use and efficient styles. 

 Documents that can be changed and re-rendered to accommodate the changes and/or 

different page settings. 

 Documents' preview, printing, persisting, and export to external formats. 

 Documents that are input forms (supported by the preview components). 

 Complete tables support, including nested tables. 

 Support for multi-style text, including inline images. 

 True type fonts embedding. 

 Hyperlinks. 

 Auto-generated TOC. 

 And more! 

The default namespace used by C1PrintDocument is C1.C1Preview (the Windows Forms 

controls for previewing documents, uses the default namespace C1.Win.C1Preview). 

The whole document is represented by the C1PrintDocument class, which inherits from 

Component. 

The main parts of a C1PrintDocument are: 

 Body  

The actual content of the document text, images and so on. The body represents the 

logical structure of the document (see also the page collection below). 

 Pages  

C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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The collection of pages which were generated based on the content (body) and a 

particular page setup. Normally the page collection can be regenerated without loss of 

information (for example, for a different paper size). 

 Style  

The root style of the document. Styles control most of the visual properties of the 

document elements (such as fonts, colors, line styles and so on). 

 Dictionary  

Images used in multiple places in a document can be put in the dictionary and reused 

to improve performance and reduce memory footprint. 

 EmbeddedFonts  

The collection of embedded true type fonts used by the document. 

 Tags  

The collection of user defined tags that can be inserted in the document to be replaced 

by their values when the document is generated. 

 DataSchema  

Contains the data schema built-in document. 

See Also 

Render Objects 

Styles 

Tables 

Anchors and Hyperlinks 

Expressions, Scripts, Tags 

Data Binding 

Table of Contents 

Word Index 

Outline 

Embedded Fonts 

Dictionary 
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C1Report Definitions 

Report Definition Language (RDL) Files 

Render Objects 
Working with C1PrintDocument > Render Objects 

The following sections discuss the hierarchy of render objects, as well as containment, 

positioning, and stacking rules. 

See Also 

Render Objects Hierarchy 

Render Objects Containment, Positioning, and Stacking Rules 

Render Objects Hierarchy 
Working with C1PrintDocument > Render Objects > Render Objects Hierarchy 

All content of a C1PrintDocument is represented by render objects. A rich hierarchy of render 

objects (based on the RenderObject class) is provided to represent different types of content. 

Below is the hierarchy of render object types, with a brief description for each class (note that 

italics indicate abstract classes): 

Render Object Type Description 

RenderObject  The base class for all render objects. 

 RenderArea  Represents a general-purpose container for 

render objects. 

 RenderToc  Represents a table of contents. 

 RenderReport  Represents a sub-report (a C1Report 

contained within a RenderField and 

specified by its SubReport property). 

 RenderSection  Represents a section of an imported 

C1Report. 

 RenderC1Printable  Represents an external object that can be 

seamlessly rendered in a C1PrintDocument. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderArea.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderToc.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderReport.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderSection.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderC1Printable.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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Render Object Type Description 

(The object must support the IC1Printable 

interface.) 

 RenderEmpty  Represents an empty object. Provides a 

convenient placeholder for things like page 

breaks and so on where no content needs 

to be rendered. 

 RenderGraphics  Represents a drawing on the .NET Graphics 

object. 

 RenderImage  Represents an image. 

 RenderInputBase  The abstract base class for all Preview 

Forms' input controls. Derived types 

represent active UI elements embedded in 

the document when the document is 

shown by the preview. 

 RenderInputButtonBase  The abstract base class for button-like input 

controls (button, check box, radio button). 

 RenderInputButton  Represents a push button. 

 RenderInputCheckBox  Represents a checkbox. 

 RenderInputRadioButton  Represents a radio button. 

 RenderInputComboBox  Represents a combo box (text input control 

with a dropdown list). 

 RenderInputText  Represents a textbox control. 

 RenderRichText  Represents RTF text. 

 RenderShapeBase  The abstract base class for classes 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderEmpty.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderGraphics.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderImage.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderInputBase.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderInputButtonBase.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderInputButton.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderInputCheckBox.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderInputRadioButton.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderInputComboBox.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderInputText.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderRichText.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderShapeBase.html
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Render Object Type Description 

representing shapes (lines, polygons and so 

on). 

 RenderLineBase  The abstract base class for lines and 

polygons. 

 RenderLine  Represents a line. 

 RenderPolygon  Represents a closed or open polygon. 

 RenderRectangle  Represents a rectangle. 

 RenderEllipse  Represents an ellipse. 

 RenderRoundRectangle  Represents a rectangle with rounded 

corners. 

 RenderTable  Represents a table. 

 RenderTextBase  The abstract base class for classes 

representing text and paragraph objects. 

 RenderParagraph  Represents a paragraph (a run of text 

fragments in different styles, and inline 

images). 

 RenderTocItem  Represents an entry in the table of contents 

(RenderToc). 

 RenderText  Represents a piece of text rendered using a 

single style. 

 RenderField  Represents a field of a C1Report. Objects of 

this type are created when a C1Report is 

imported into a C1PrintDocument. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderLineBase.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderLine.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderPolygon.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderRectangle.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderEllipse.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderRoundRectangle.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderTable.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderTextBase.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderParagraph.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderTocItem.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderText.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderField.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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Render Object Type Description 

 RenderBarCode  Represents a barcode. 

 

Render Objects Containment, Positioning, 

and Stacking Rules 
Working with C1PrintDocument > Render Objects > Render Objects Containment, Positioning, and 

Stacking Rules 

Show All  

Hide All  

All visible content of a C1PrintDocument is represented by a tree of render objects (instances of 

types derived from RenderObject, as described above), with the root of the tree being the Body 

of the document. So in order to add a render object to the document, it must be either added 

to the Children collection of the document's Body, or to the Children collection of another 

object already in the hierarchy. For example, the render text in the following code is added to 

the document's Body.Children collection: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Dim rt As New RenderText() 

rt.Text = "This is a text." 

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

RenderText rt = new RenderText(); 

rt.Text = "This is a text."; 

doc.Body.Children.Add(rt); 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderBarCode.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
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A document's Body.Children collection contains all top-level render objects of the document. 

Each render object in its turn also has a Children collection, which contains render objects 

within it, and so on. (This is very similar to the way Windows Forms' controls can be nested 

inside each other - any control has the collection of contained controls, and so on.) 

In addition to the document's body, there are two other places for render objects in a 

document - the page header and footer, accessible via the PageHeader and PageFooter 

properties. 

See Also 

Render Areas 

Stacking 

Specifying Render Objects' Size and Location 

Examples of relative positioning of render objects 

Render Object Shadows 

Object Borders 

Render Areas 
Working with C1PrintDocument > Render Objects > Render Objects Containment, Positioning, and 

Stacking Rules > Render Areas 

Although any render object can contain other render objects as its children, there is one render 

object designed specifically as a container for other objects - RenderArea. The primary 

difference between a render area and other render objects (such a render text) is that for a 

render area, specifying either of its width or height as Auto means that the corresponding 

dimension is determined by the size of the children, while for other types of objects, auto size is 

determined by the object's own content (text size for a RenderText, image size for a 

RenderImage, and so on). 

By default, when a new render area is created, its Width is equal to the width of its parent (so a 

top-level render area stretches across the whole page - or across the current column for multi-

column layouts). The Height of a render area, on the other hand, is by default set to Auto 

(Unit.Auto), and is determined by the combined height of the render area's children. So the 

default behavior of a top-level render area is to take up the whole page width, and stretch 

down as needed (possibly spanning multiple pages) to accommodate all its content. You can 

set the Width of a render area to auto (Unit.Auto), in which case it will adjust to accommodate 

the combined widths of the area's children. In this case, if the combined width of the area's 

children exceeds the width of the page, horizontal page breaks will occur, adding extension 

pages to the right of the current page. To prevent horizontal page breaks (clipping the area on 

the right if necessary), set the area's CanSplitHorz property to False (it is True by default). 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.PageLayout~PageHeader.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~PageFooter.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderArea.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~CanSplitHorz.html
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Stacking 
Working with C1PrintDocument > Render Objects > Render Objects Containment, Positioning, and 

Stacking Rules > Stacking 

Within their container (parent object or document body), render objects by default are placed 

according to the stacking rules, determined by the value of the Stacking property of the 

container (document for top-level objects). This value can be one of the following 

StackingRulesEnum enumeration members: 

 BlockTopToBottom  

Objects are placed one beneath the other within the container. When the bottom edge 

of the current page is reached, a new page is added. This is the default. 

 BlockLeftToRight  

Objects are placed one next to another, from left to right. When the right edge of the 

current page is reached, a new "horizontal" page is added (a horizontal page logically 

extends the preceding page to the right; C1PreviewPane respects this location by 

default, showing such pages arranged in a row). 

 InlineLeftToRight  

Objects are placed inline, one next to another, from left to right. When the right edge of 

the current page is reached, the sequence wraps to the next line. A new page is added 

when the bottom of the current page is reached. 

Stacking rules do not propagate down into the contained objects (children). In other words, if 

you define a render area and set its stacking to the (non-default) value BlockLeftToRight, and 

then add another render area inside the first one - its stacking will be the default 

(BlockTopToBottom) unless you explicitly change it. 

You may also use the X and Y properties of a render object to set its position explicitly (see the 

next section for details). In this case that render object does not participate in the stacking order 

at all - that is, its position neither affects the positioning of its siblings nor is affected by their 

positions. 

Specifying Render Objects' Size and Location 
Working with C1PrintDocument > Render Objects > Render Objects Containment, Positioning, and 

Stacking Rules > Specifying Render Objects' Size and Location 

Show All  

Hide All  

The four properties controlling the size and location of a render object are: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.StackingRulesEnum.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~X.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~Y.html
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 X - specifies the X coordinate of the object. 

 Y - specifies the Y coordinate of the object. 

 Width - specifies the width of the object. 

 Height - specifies the height of the object. 

All those properties have the value type C1.C1Preview.Unit. The default value for X and Y is 

Auto (represented by the static field Unit.Auto), which means that the object is positioned 

according to the stacking rules provided by its parent (see Stacking above for more 

information). Width and height have different defaults depending on the type of the render 

object. 

The following table lists the default sizes (width and height) for all render objects, as well as the 

rules used to calculate auto sizes: 

 Width Height Auto Size 

RenderArea 

RenderToc 

RenderReport 

RenderSection 

RenderC1Printable 

Parent width Auto Determined by the 

combined size of the 

children 

RenderEmpty Auto Auto 0 

RenderGraphics Auto Auto Determined by the 

size of the content 

RenderImage Auto Auto Determined by the 

size of the image 

RenderInputButton 

RenderInputCheckBox 

RenderInputRadioButton 

RenderInputComboBox 

RenderInputText 

Auto Auto Determined by the 

size of the content 

RenderRichText Parent width (auto 

width is not 

supported). 

Auto (determined by 

the text size). 

-- 

RenderLine Auto Auto Determined by the 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~X.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~Y.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~Width.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~Height.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Unit.html
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 Width Height Auto Size 

RenderPolygon 

RenderEllipse RenderArc 

RenderPie 

RenderRectangle 

RenderRoundRectangle 

size of the shape 

RenderTable Parent width (auto 

width is calculated as 

the sum of columns' 

widths). 

Auto Determined by the 

total width of all 

columns for width, 

and by the total 

height of all rows for 

height 

RenderParagraph 

RenderText 

RenderTocItem 

Parent width Auto Determined by the 

size of the text 

RenderField Parent width Auto Determined by the 

size of the content 

RenderBarCode Auto Auto Determined by the 

size of the content 

You can override the default values for any of those properties with custom values (specifying 

anything but Auto as the value for X or Y coordinates excludes the object from the stacking 

flow; see Stacking for more information). The size and location properties can be set in any of 

the following ways (note that ro indicates a render object in the samples below): 

 As auto (semantics depend on the render object type):  

ro.Width = Unit.Auto; 

ro.Height = "auto"; 

 As absolute value:  

ro.X = new Unit(8, UnitTypeEnum.Mm); 

ro.Y = 8; (C1PrintDocument.DefaultUnit is used for the units); 

ro.Width = "28mm"; 
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 As percentage of a parent's size (using this for coordinates is not meaningful and will 

yield 0):  

ro.Height = new Unit(50, DimensionEnum.Width); 

ro.Width = "100%"; 

As a reference to a size or position of another object. The object can be identified by 

any of the following key words: 

self - the current object (the default value, may be omitted); 

parent - the object's parent; 

prev - the previous sibling; 

next - the next sibling; 

page - the current page; 

column - the current column; 

page<N> - page with the specified number (note: the page must already exist, that is 

forward references to future pages are not supported); 

column<M> - a column (specified by number) on the current page; 

page<N>.column<N> - a column (specified by number) on the specified page; 

<object name> - the object with the specified name (the value of the Name property; 

the object is searched first among the siblings of the current object, then among its 

children). 

Sizes and locations of the referenced objects are identified by the following key words: 

left, top, right, bottom, width, height (coordinates are relative to the object's parent). 

Some examples: 

ro.Height = "next.height"; - sets the object's height to the height of its next sibling; 

ro.Width = "page1.width"; - sets the object's width to the width of the first page; 

ro.Height = "width"; - sets the object's height to its own width; 

ro.Y = "prev.bottom"; - sets the object's Y coordinate to the bottom of its previous 

sibling; 

ro.Width = "prev.width"; - sets the object's width to the width of its previous sibling. 

 Using functions "Max" and "Min". For example:  

ro.Width = "Max(prev.width,6cm)"; - sets the object's width to the maximum of 6 cm 

and the object's previous sibling's width; 
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 As an expression. Expressions can use any of the ways described above to reference size 

and position of another object, combined using the operators +, -, *, /, %, functions 

Max and Min, and parentheses ( and ). For example:  

ro.Width = "prev.width + 50%prev.width"; - sets the object's width to the width and 

a half of its previous sibling; 

ro.Width = "150%prev"; - same as above (when referencing the same dimension as 

the one being set, the dimension - "width" in this case - can be omitted). 

ro.Width = "prev*1.5"; - again, same as above but using multiplication rather than 

percentage. 

In all of the above samples where a size or location is set to a string, the syntax using the 

Unit(string) constructor can also be used, for example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

ro.Width = New C1.C1Preview.Unit("150%prev") 

To write code in C# 

C# Copy Code  

 

ro.Width = new Unit("150%prev"); 

Case is not important in strings, so "prev.width", "PrEv.WidTh", and "PREV.WIDTH" are 

equivalent. 

Examples of relative positioning of render objects 
Working with C1PrintDocument > Render Objects > Render Objects Containment, Positioning, and 

Stacking Rules > Examples of relative positioning of render objects 

Show All  

Hide All  

Below are some examples showing the use of relative positioning of objects to arrange an 

image and a text ("myImage" in those samples is an object of type System.Drawing.Image 

declared elsewhere in code): 

This code places the text below the image simply adding one object after another into the 

regular block flow: 
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To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc as New C1PrintDocument 

Dim rt as New RenderText("test") 

Dim ri as New RenderImage(myImage) 

Dim ra As New RenderArea() 

ra.Children.Add(ri) 

ra.Children.Add(rt) 

doc.Body.Children.Add(ra) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

RenderText rt = new RenderText("test"); 

RenderImage ri = new RenderImage(myImage); 

RenderArea ra = new RenderArea(); 

ra.Children.Add(ri); 

ra.Children.Add(rt); 

doc.Body.Children.Add(ra); 

This code produces equivalent result (text below image) while the children are added to the 

area in inverse order (because both objects have non-auto coordinates specified explicitly, 

neither is inserted into the block flow): 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc as New C1PrintDocument 

Dim rt as New RenderText("test") 

Dim ri as New RenderImage(myImage) 

Dim ra As New RenderArea() 

' place image at the top of the parent: 

ri.Y = 0 

' place text below next sibling: 

rt.Y = "next.bottom" 
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' auto-size text width: 

rt.Width = Unit.Auto 

ra.Children.Add(ri) 

ra.Children.Add(rt) 

doc.Body.Children.Add(ra) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

RenderText rt = new RenderText("test"); 

RenderImage ri = new RenderImage(myImage); 

RenderArea ra = new RenderArea(); 

// place image at the top of the parent: 

ri.Y = 0; 

// place text below next sibling: 

rt.Y = "next.bottom"; 

// auto-size text width: 

rt.Width = Unit.Auto; 

ra.Children.Add(rt); 

ra.Children.Add(ri); 

doc.Body.Children.Add(ra); 

The following code inserts the image into the regular block flow, while putting the text to the 

right of the image, centering it vertically relative to the image: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc as New C1PrintDocument 

Dim rt as New RenderText("test") 

Dim ri as New RenderImage(myImage) 

Dim ra As New RenderArea() 

ra.Children.Add(ri) 

rt.Width = Unit.Auto 

' add text after the image: 

ra.Children.Add(rt) 

rt.X = "prev.right" 

rt.Y = "prev.height/2-self.height/2" 
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doc.Body.Children.Add(ra) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

RenderText rt = new RenderText("test"); 

RenderImage ri = new RenderImage(myImage); 

RenderArea ra = new RenderArea(); 

ra.Children.Add(ri); 

rt.Width = Unit.Auto; 

// add text after the image: 

ra.Children.Add(rt); 

rt.X = "prev.right"; 

rt.Y = "prev.height/2-self.height/2"; 

doc.Body.Children.Add(ra); 

This code also places the text to the right of the image, centered vertically - but uses the 

RenderObject.Name in the positioning expressions rather than relative id "prev", Also, the text 

is shifted 2mm to the right, demonstrating the use of absolute lengths in expressions: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc as New C1PrintDocument 

Dim rt as New RenderText("test") 

Dim ri as New RenderImage(myImage) 

Dim ra As New RenderArea() 

ri.Name = "myImage" 

rt.Width = "auto" 

rt.X = "myImage.right+2mm" 

rt.Y = "myImage.height/2-self.height/2" 

ra.Children.Add(ri) 

ra.Children.Add(rt) 

doc.Body.Children.Add(ra) 

To write code in C# 

C# Copy Code  
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C1PrintDocument doc = new C1PrintDocument(); 

RenderText rt = new RenderText("test"); 

RenderImage ri = new RenderImage(myImage); 

RenderArea ra = new RenderArea(); 

ri.Name = "myImage"; 

rt.Width = "auto"; 

rt.X = "myImage.right+2mm"; 

rt.Y = "myImage.height/2-self.height/2"; 

ra.Children.Add(ri); 

ra.Children.Add(rt); 

doc.Body.Children.Add(ra); 

The code below modifies the same example so that the text is shifted to the right at least 6cm, 

using the built-in Max functions: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc as New C1PrintDocument 

Dim rt as New RenderText("test") 

Dim ri as New RenderImage(myImage) 

Dim ra As New RenderArea() 

ri.Name = "myImage" 

rt.Width = "auto" 

rt.X = "Max(myImage.right+2mm,6cm)" 

rt.Y = "myImage.height/2-self.height/2" 

ra.Children.Add(ri) 

ra.Children.Add(rt) 

doc.Body.Children.Add(ra) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

RenderText rt = new RenderText("test"); 

RenderImage ri = new RenderImage(myImage); 

RenderArea ra = new RenderArea(); 

ri.Name = "myImage"; 



 

 370 

rt.Width = "auto"; 

rt.X = "Max(myImage.right+2mm,6cm)"; 

rt.Y = "myImage.height/2-self.height/2"; 

ra.Children.Add(ri); 

ra.Children.Add(rt); 

doc.Body.Children.Add(ra); 

The following code snippet aligns image to the right side of the page (utilizing the default value 

for the width of a render area - parent width), while the text is left-aligned, and centered 

vertically relative to the image: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc as New C1PrintDocument 

Dim rt as New RenderText("test") 

Dim ri as New RenderImage(myImage) 

Dim ra As New RenderArea() 

ri.Name = "myImage" 

' right-align image: 

ri.X = "parent.right-width" 

' left-align text: 

rt.X = "0" 

rt.Y = "myImage.height/2-height/2" 

ra.Children.Add(ri) 

ra.Children.Add(rt) 

doc.Body.Children.Add(ra) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

RenderText rt = new RenderText("test"); 

RenderImage ri = new RenderImage(myImage); 

RenderArea ra = new RenderArea(); 

ri.Name = "myImage"; 

// right-align image: 

ri.X = "parent.right-width"; 

// left-align text: 
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rt.X = "0"; 

rt.Y = "myImage.height/2-height/2"; 

ra.Children.Add(ri); 

ra.Children.Add(rt); 

doc.Body.Children.Add(ra); 

 

Render Object Shadows 
Working with C1PrintDocument > Render Objects > Render Objects Containment, Positioning, and 

Stacking Rules > Render Object Shadows 

Show All  

Hide All  

Reports for WinForms includes support for shadows cast by render objects. The public 

IShadow interface is implemented by a public structure Shadow, and exposed by a non-

ambient public property Shadow. 

It includes the following sub-properties: 

Property Description 

Transparency Gets or sets the transparency of the shadow, in percent. A value of 0 

defines a solid (non-transparent) shadow, a value of 100 (which is the 

default) defines a fully transparent (invisible) shadow. 

Size Gets or sets the size of the shadow relative to the size of the object, in 

percent. A value of 100 (which is the default) indicates that the shadow has 

the same size as the object. 

Distance Gets or sets the distance that the shadow's center is offset from the the 

object's center. Note that only absolute Unit values (such as "0.5in" or 

"4mm") can be assigned to this property. The default is 2mm. 

Angle Gets or sets the angle, in degrees, of the shadow. The angle is measured 

relative to the three o'clock position clockwise. The default is 45. 

Color Gets or sets the color of the shadow. The default is Black. 

The following sample code defines a shadow on a render object: 

To write code in Visual Basic 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Shadow.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style~Shadow.html
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Visual Basic Copy Code  

 

Dim doc As C1PrintDocument = C1PrintDocument1 

Dim rt As New RenderText("Sample Shadow") 

rt.Width = Unit.Auto 

rt.Style.Shadow.Transparency = 20 

rt.Style.Shadow.Color = Color.BurlyWood 

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = c1PrintDocument1; 

RenderText rt = new RenderText("Sample Shadow"); 

rt.Width = Unit.Auto; 

rt.Style.Shadow.Transparency = 20; 

rt.Style.Shadow.Color = Color.BurlyWood; 

doc.Body.Children.Add(rt); 

Note that while you do not need to create a Shadow object when setting shadow properties, 

you may choose to do so, for example, like this: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As C1PrintDocument = C1PrintDocument1 

Dim rt As New RenderText("Sample Shadow") 

rt.Width = Unit.Auto 

rt.Style.Shadow = New Shadow(20, 100, "1mm", 45, Color.CadetBlue) 

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = c1PrintDocument1; 

RenderText rt = new RenderText("Sample Shadow"); 
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rt.Width = Unit.Auto; 

rt.Style.Shadow = new Shadow(20, 100, "1mm", 45, Color.CadetBlue); 

doc.Body.Children.Add(rt); 

 

Note: Shadows do NOT affect the objects' sizes for layout purposes. 

 

Object Borders 
Working with C1PrintDocument > Render Objects > Render Objects Containment, Positioning, and 

Stacking Rules > Object Borders 

Reports for WinForms includes support for a new way of laying out and positioning borders. 

This method of laying out and positioning borders was primarilyadded for RDL compatibility 

but can be useful on its own. For example, now optionally borders can be centered over an 

object's bounds, without affecting either the object's size or the surrounding objects' positions. 

The following public type facilitates this feature: 

Type Description 

BordersModeEnum  Specifies the various modes of accounting for border thickness when 

laying out the objects in a document. 

The BordersModeEnum includes the following members: 

 Default: The whole border is considered to be part of the object. This is the default 

behavior of objects in C1PrintDocument. 

 C1Report: The inner 1/2 of border thickness is considered to be part of the object, the 

outer 1/2 of border is considered to be outside of the object's space. This is the default 

behavior of objects in C1Report (same as in MS Access). 

 Rdl: Border thickness is not taking into account at all when calculating objects' sizes 

and layout. Borders are drawn centered on objects' bounds. 

Styles 
Working with C1PrintDocument > Styles 

Most of the visual aspects of a C1PrintDocument are controlled by styles, which are an integral 

part of the document. The following sections describe styles in detail. 

See Also 

Classes Exposing the Style Property 

Inline and Non-Inline Styles 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.BordersModeEnum.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.BordersModeEnum.html
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Ambient and Non-Ambient Style Properties 

Style Inheritance, Parent and AmbientParent 

Style Properties and Their Default Values 

Sub-Properties of Complex Style Properties 

Calculated Style Properties 

Paragraph Object Styles 

Table Styles 

Classes Exposing the Style Property 
Working with C1PrintDocument > Styles > Classes Exposing the Style Property 

All objects having their own visual representation in the document have a style (of the type 

C1.C1Preview.Style) associated with them. Specifically, the following classes expose the Style 

property: 

 The whole document (C1PrintDocument). 

 Render objects (RenderObject and all derived classes). 

 Paragraph objects (ParagraphText and ParagraphImage, derived from 

ParagraphObject). 

 Table cells (TableCell). 

 User-defined groups of cells in tables (UserCellGroup). 

 Table rows and columns (TableRow and TableCol, derived from TableVector). 

 Groups of table rows and columns such as table headers/footers (TableVectorGroup). 

Inline and Non-Inline Styles 
Working with C1PrintDocument > Styles > Inline and Non-Inline Styles 

Show All  

Hide All  

In C1PrintDocument, there are two kinds of styles - inline and non-inline. If an object has the 

Style property, that property refers to the inline style of the object, which is an integral part of 

the object itself. An inline style cannot be removed or set - it's a read-only property that refers 

to the style instance which always lives together with the object. Thus, style properties can be 

considered to be the properties of the object itself. But, due to inheritance, styles are much 

more flexible and memory-efficient (for example, if none of an object's style properties have 

been modified from their default values, they consume almost no memory, referencing base 

style properties instead). 

Additionally, each Style contains a collection of styles (called Children, and empty by default) 

which are not directly attached to any objects. Instead, those (non-inline) styles can be used as 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ParagraphText.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ParagraphImage.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ParagraphObject.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableCell.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.UserCellGroup.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableRow.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableCol.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableVector.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableVectorGroup.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style~Children.html
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parent styles (see style properties Parent and AmbientParent) to provide values for inherited 

properties of other styles (including, of course, inline styles). 

A style object cannot be created by itself - it is always either an inline style attached directly to a 

render object or other element of the document, or a member of the Children collection of 

another style. 

So, for instance, this code will not compile: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Style s = new Style() ' will not compile 

s.Borders.All = New LineDef("1mm", Color.Red) 

Dim rt As New RenderText("My text.") 

rt.Style = s 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

Style s = new Style(); // will not compile 

s.Borders.All = new LineDef("1mm", Color.Red); 

RenderText rt = new RenderText("My text."); 

rt.Style = s; 

While this code will compile and achieve the desired result: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Dim s As doc.Style.Children.Add() 

s.Borders.All = New LineDef("1mm", Color.Red) 

RenderText rt = New RenderText("My text.") 

rt.Style.Parent = s 

To write code in C# 
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C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

Style s = doc.Style.Children.Add(); 

s.Borders.All = new LineDef("1mm", Color.Red); 

RenderText rt = new RenderText("My text."); 

rt.Style.Parent = s; 

For more about ambient and non-ambient style attributes and parents, see Ambient and Non-

Ambient Style Properties. 

Ambient and Non-Ambient Style Properties 
Working with C1PrintDocument > Styles > Ambient and Non-Ambient Style Properties 

All style properties (font, colors, borders, and so on) can be classified into two groups according 

to their semantics: ambient and non-ambient. Ambient properties are those that affect the 

content of an object (for example, the text font) whereas non-ambient properties are those 

used to paint the object's adornments, or decorations (for example, the borders around the 

object). This distinction is natural and useful, as in most cases the desired behaviors (especially 

the inheritance rules) are different for the two groups. 

For ambient properties, it is usually desirable to propagate them down the hierarchy of objects, 

so that setting of an ambient property on a container object affects all objects contained within 

(consider a table - if you set the font on the table itself, you would normally want that font to be 

applied to texts in all cells of that table, unless explicitly overridden at a lower level - for 

example, for a specific cell). This is markedly different for non-ambient properties. For instance, 

if you wanted to add white space before and after that table, you would set the Spacing 

property on that table - but you would not want that spacing to propagate to all cells. In 

C1PrintDocument, this division of style properties into ambient and non-ambient groups is built 

in. Basically, this means that usually just setting the property on the style of an object (without 

thinking too much about ambience) will do what you expect. 

The complete list of all style properties, indicating which of those properties are ambient and 

which are not, is shown in a separate section below (see Style Properties and Their Default 

Values). But the following general rule applies: 

Ambient style properties control the display of the object's content (such as text font). By 

default, ambient properties propagate down the objects' containment hierarchy - i.e. an 

ambient property set on the style of a container object is applied to all objects within that 

container. 

Non-ambient style properties control the object's decorations (such as borders). By default, 

non-ambient properties do not propagate via objects' containment, but can propagate across 

styles via the Style.Parent property. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html


 

 377 

Style Inheritance, Parent and AmbientParent 
Working with C1PrintDocument > Styles > Style Inheritance, Parent and AmbientParent 

All style properties affecting the appearance of the object to which the style is applied (such as 

Font, BackColor, and so on) may be in one of two states: set or not set. Initially, all properties 

of a newly created style are not set. Their values can be queried, but are obtained from another 

style or object via inheritance (see below). If a property is set though, the set value is stored in 

the style itself, and is no longer affected by other styles via inheritance. 

A style has two special properties to support style inheritance: Parent and AmbientParent. The 

Parent property gets or sets the style that provides values for non-ambient properties that are 

not set on the current style. The AmbientParent property gets or sets the style that provides 

values for ambient properties that are not set on the current style. By default, both parents of a 

newly created inline style are empty (null values in C#, Nothing in VB), whereas for styles 

created on the Children collection of a style, the Parent is set to the style containing that 

collection, while the AmbientParent is empty. 

If the Parent of a style is not specified, the values of non-ambient properties are taken from 

static defaults (see the table below). If the AmbientParent of a style is not specified, the values 

of ambient properties are taken from the object which contains the object the current style 

applies to. 

For example, if a RenderText rt is contained in a RenderArea ra, then the following rules will be 

used to retrieve the font (that is, an ambient style property) used to render the text: 

 If rt.Style.Font is set, it will be used. 

 Otherwise, if rt.Style.AmbientParent is not null, rt.Style.AmbientParent.Font will be 

used, because Font is an ambient property. 

 Otherwise (if rt.Style.AmbientParent is null, which is the default), the font of the 

containing object will be used, that is ra.Style.Font. 

In the same example, the following rules will be used to retrieve the BackgroundImage (a non-

ambient style property) for the RenderText object: 

 If rt.Style.BackgroundImage is set, it will be used. 

 Otherwise, if rt.Style.Parent is not null, rt.Style.Parent.BackgroundImage will be 

used. 

 Otherwise the default value for background image (that is, no image) will be used. 

Please note that although by default styles in the Children collection of a style have their 

Parent set to the style which is the owner of that Children collection, this can be changed. For 

example, the parent of one style in the Children collection may be set to another style in the 

same collection. The Children collection is just a convenient place to group/store related styles, 

but does not really impose any limitations on the styles hierarchy. 
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Style Properties and Their Default Values 
Working with C1PrintDocument > Styles > Style Properties and Their Default Values 

The following table lists all style properties affecting the display of objects, indicates which of 

those are ambient, and specifies the default values: 

Property name Ambient Default value 

ActiveHyperlinkAttrs Yes  

BackColor  Empty 

BackgroundImage  None 

BackgroundImageAlign  Align left/top, stretch horizontally/vertically, keep 

aspect ratio 

BackgroundImageName  None 

Borders  All empty 

Brush  None 

CharSpacing Yes 0 

CharWidth Yes 100 

ClientAreaOnly  False 

FlowAlign  Default flow alignment 

FlowAlignChildren  Near alignment 

Font Yes Arial, 10pt 

FontBold Yes False 

FontItalic Yes False 
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Property name Ambient Default value 

FontName Yes Arial 

FontSize Yes 10 

FontStrikeout Yes False 

FontUnderline Yes False 

GridLines  None 

HoverHyperlinkAttrs Yes  

HyperlinkAttrs Yes Blue 

ImageAlign Yes Align left/top, stretch horizontally/vertically, keep 

aspect ratio 

JustifyEndOfLines Yes True 

JustifyLastLine Yes False 

LineSpacing Yes 100% 

MeasureTrailingSpaces Yes False 

MinOrphanLines  0 

Padding  All zeroes 

ShapeFillBrush  None 

ShapeFillColor  Transparent 

ShapeLine  Black, 0.5pt 

Spacing  All zeroes 



 

 380 

Property name Ambient Default value 

TextAlignHorz Yes Left 

TextAlignVert Yes Top 

TextAngle  0 

TextColor Yes Black 

TextIndent  0 

TextPosition  Normal 

VisitedHyperlinkAttrs Yes Magenta 

WordWrap Yes True 

 

Sub-Properties of Complex Style Properties 
Working with C1PrintDocument > Styles > Sub-Properties of Complex Style Properties 

Some of the properties in the table in the Style Properties and Their Default Values topic 

contain sub-properties which can be individually set. For instance, the BackgroundImageAlign 

property has AlignHorz, AlignVert, and several other sub-properties. With the exception of 

read-only sub-properties (as is the case with fonts, which are immutable and whose individual 

sub-properties cannot be set), each sub-property can be set or inherited individually. 

While the sub-properties of a font can not be modified, each of those sub-properties is 

represented by a separate root level property on a style - FontBold, FontItalic, and so on. Each 

of those properties can be set individually, and follows the general style inheritance rules. There 

is a nuance though that must be taken into consideration: if both Font and one of the separate 

font-related properties (FontBold, FontItalic, and so on.) are set, the result depends on the 

order in which the two properties are set. If the Font is set first, and then a font-related 

property is modified (that is, FontItalic is set to True), that modification affects the result. If, on 

the other hand, FontItalic is set to True first, and then Font is assigned to a non-italic font, the 

change to FontItalic is lost. 

Calculated Style Properties 
Working with C1PrintDocument > Styles > Calculated Style Properties 
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In the 2009 v3 release of Reports for WinForms, support was added for calculated style 

properties. For each style property, a matching string property was been added with the same 

name with "Expr" appended. For example, the BackColorExpr and TextColorExpr properties are 

matched to the BackColor and TextColor properties, and so on for all properties. 

Sub-properties of complex properties (such as ImageAlign, Borders, and so on.) also have 

matching expression sub-properties. For example, the LeftExpr property is matched to Left 

property and so on. 

Style Expressions 

The following objects can be used in style expressions: 

 RenderObject: the current style's owner render object. 

 Document: the current document. 

 Page (and other page related objects such as PageNo): the page containing the object 

(but see note below). 

 RenderFragment: the current fragment. 

 Aggregates. 

 Fields, DataBinding: reference the current data source; if the style's owner is within a 

table, and data sources have been specified for both rows and columns, this will 

reference the data source defined for the columns. 

 RowNumber: row number in the associated data source. 

 ColFields, ColDataBinding: only accessible if the style is used within a table, references 

the data source defined for the columns. 

 RowFields, RowDataBinding: only accessible if the style is used within a table, references 

the data source defined for the rows. 

Converted Types 

 When a calculated style property value is assigned to the real value that will be used to 

render the object, the types are converted according to the following rules: 

 If the target property is numeric (int, float, and so on), the calculated value is converted 

to the required numeric type (converted from string, rounded, and so on) as necessary. 

 If the target property is a Unit (for example, spacings), and the expression yields a 

number, the unit is created using the following constructor: new 

Unit(Document.DefaultUnitType, value). If the expression yields a string, that string is 

parsed using the normal Unit rules. 

 In all other cases, an attempt is made to convert the value to the target type using the 

TypeConverter. 

 Finally, if the expression yielded null, the parent style value is used as if the property has 

not been specified on the current style at all (such as the default behavior for 

unspecified style properties). 

Page References 

The following is an important note related to page references. Style expressions may reference 

the current page, for example: 
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ro.Style.BackColor = "iif(PageCount < 3, Color.Red, Color.Blue)"; 

Such expressions cannot be calculated when the document is generated. Thus, during 

generation such expressions are ignored (default values are used), and the values are only 

calculated when the actual page that contains the object is being rendered (for example, for 

drawing in the preview, exporting and so on). 

As the result, style expressions that depend on pagination AND would affect the layout of the 

document may yield unexpected and undesirable results. For example, if the following 

expression is used for font size: 

 
ro.Style.FontSize = "iif(PageCount < 3, 20, 30)"; 

The above expression would be ignored during generation, as the result the rendered text will 

most probably be too large for the calculated object's size and clipping will occur. 

Paragraph Object Styles 
Working with C1PrintDocument > Styles > Paragraph Object Styles 

The RenderParagraph object (as all render objects) has the Style property, which can be used to 

set style properties applied to the paragraph as a whole. Individual paragraph objects 

(ParagraphText and ParagraphImage) also have styles, but the set of style properties that are 

applied to paragraph objects is limited to the following properties: 

 BackColor 

 Brush (only if it is a solid brush) 

 Font (and font-related properties such as FontBold, and so on.) 

 HoverHyperlinkAttrs 

 TextColor 

 TextPosition 

 VisitedHyperlinkAttrs 

Table Styles 
In tables, the number of styles affecting the display of objects increases dramatically. In addition 

to the normal containment (a table, as all other elements of a document, is always contained 

either within another render object, or within the body of the document at the top level), object 

in tables also belong to at least a cell, a row and a column, all of which have their own styles. 

Additionally, an object can belong to a number of table element groups, which complicates the 

things even more. How styles in tables work is described in more detail in the Styles in Tables 

topic. 

Tables 
Working with C1PrintDocument > Tables 

Show All  

Hide All  
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Tables are represented by instances of the RenderTable class. To create a table, just invoke its 

constructor, for example like this: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt1 As New C1.C1Preview.RenderTable() 

To write code in C# 

C# Copy Code  

 

RenderTable rt1 = new RenderTable(); 

C1PrintDocument tables follow the model of Microsoft Excel. Though a newly created table is 

physically empty (that is, it does not take much space in memory), logically it is infinite: you can 

access any element (cell, row, or column) of a table without first adding rows or columns, and 

writing to that element will logically create all elements preceding it. For instance, setting the 

text of the cell of an empty table at row index 9 and column index 3 will make the table grow to 

10 rows and 4 columns. 

To add content to a table, you must fill the cells with data. This can be done in one of the 

following ways: 

 By setting the cell's RenderObject property to an arbitrary render object. This will insert 

the specified render object into that cell. Any render object can be added to a cell, 

including another table, thus allowing nested tables. 

 By setting the cell's Text property to a string. This is actually a handy shortcut to create 

text-only tables, which internally creates a new RenderText object, sets the cell's 

RenderObject property to that RenderText, and sets that object's Text property to the 

specified string. 

So, for example, the following code snippet will create a table with 10 rows and 4 columns: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt1 As New C1.C1Preview.RenderTable() 

Dim row As Integer = 0 

Do While (row < 10) 

    Dim col As Integer = 0 
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    Do While (col < 4) 

        rt1.Cells(row, col).Text = String.Format( _ 

          "Text in cell({0}, {1})", row, col) 

        col += 1 

    Loop 

    row += 1 

Loop 

To write code in C# 

C# Copy Code  

 

RenderTable rt1 = new RenderTable(); 

for (int row = 0; row < 10; ++row) 

{ 

    for (int col = 0; col < 4; ++col) 

        rt1.Cells[row, col].Text = string.Format( 

          "Text in cell({0}, {1})", row, col); 

} 

At any time, you can find out the actual current size of a table by querying the values of 

properties Cols.Count (which returns the current number of columns) and Rows.Count (which 

returns the current number of rows). 

See Also 

Accessing Cells, Columns and Rows 

Table and Column Width, Row Height 

Groups of Rows and Columns, Headers and Footers 

User Cell Groups 

Styles in Tables 

Accessing Cells, Columns and Rows 
Working with C1PrintDocument > Tables > Accessing Cells, Columns and Rows 

Show All  

Hide All  

As can be seen from the sample code in the Tables topic, all cells in a table are represented by 

the Cells collection, which has the type TableCellCollection. Elements in this collection 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderTable~Cells.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableCellCollection.html


 

 385 

representing individual cells have the type TableCell. To access any cell in a table, the Cells 

collection can be indexed by the cell's row and column like this: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt As New C1.C1Preview.RenderTable() 

… 

' get cell at row 10, column 4: 

Dim tc as TableCell = rt.Cells(10, 4) 

To write code in C# 

C# Copy Code  

 

RenderTable rt = new RenderTable(); 

… 

// get cell at row 10, column 4: 

TableCell tc = rt.Cells[10, 4]; 

Table columns are accessed via the Cols collection, which has the type TableColCollection, and 

contains elements of the type TableCol. As with cells, just "touching" a column will create it. For 

instance, if you set a property of a column's Style, that column will be created if it did not exist 

already. 

Table rows are accessed via the Rows collection, which has the type TableRowCollection, and 

contains elements of the type TableRow. As with cells and columns, just "touching" a row will 

create it. For instance, if you set the Height of a row it (and all rows before it) will be 

automatically created. 

Please note, though, that all table rows that do not contain cells with some actual content will 

have a zero height, so will not be visible when the table is rendered. 

Table and Column Width, Row Height 
Working with C1PrintDocument > Tables > Table and Column Width, Row Height 

Show All  

Hide All  

Both rows and columns in C1PrintDocument tables can be auto-sized but the default behavior 

is different for rows and columns. By default, rows have auto-height (calculated based on the 

content of cells in the row), while columns' widths are fixed. The default width of a RenderTable 
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is equal to the width of its parent, and that width is shared equally between all columns. So the 

following code will create a page-wide table, with 3 equally wide columns, and 10 rows with the 

heights that auto-adjust to the height of the cells' content: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt As New C1.C1Preview.RenderTable() 

rt.Style.GridLines.All = LineDef.Default 

Dim row As Integer = 0 

Do While (row < 10) 

  Dim col As Integer = 0 

    Do While (col < 3) 

      rt.Cells(row, col).Text = String.Format( _ 

          "Cell({0},{1})", row, col) 

      col += 1 

    Loop 

  row += 1 

Loop 

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

RenderTable rt = new RenderTable(); 

rt.Style.GridLines.All = LineDef.Default; 

for (int row = 0; row < 10; ++row) 

  for (int col = 0; col < 3; ++col) 

    rt.Cells[row, col].Text = string.Format( 

        "Cell({0}, {1})", row, col); 

doc.Body.Children.Add(rt); 

To make a fully auto-sized table, as compared to the default settings, two things must be done: 

 The width of the whole table must be set to Auto (either the string "auto", or the static 

field Unit.Auto)  

and 

 The table's RenderTable.ColumnSizingMode must be set to 

TableSizingModeEnum.Auto. 
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Here's the modified code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt As New C1.C1Preview.RenderTable() 

rt.Style.GridLines.All = LineDef.Default 

Dim row As Integer = 0 

Do While (row < 10) 

  Dim col As Integer = 0 

    Do While (col < 3) 

      rt.Cells(row, col).Text = String.Format( _ 

          "Cell({0},{1})", row, col) 

      col += 1 

    Loop 

  row += 1 

Loop 

rt.Width = Unit.Auto 

rt.ColumnSizingMode = TableSizingModeEnum.Auto 

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

RenderTable rt = new RenderTable(); 

rt.Style.GridLines.All = LineDef.Default; 

for (int row = 0; row < 10; ++row) 

  for (int col = 0; col < 3; ++col) 

    rt.Cells[row, col].Text = string.Format( 

        "Cell({0}, {1})", row, col); 

rt.Width = Unit.Auto; 

rt.ColumnSizingMode = TableSizingModeEnum.Auto; 

doc.Body.Children.Add(rt); 

The modified code makes each column of the table only as wide as needed to accommodate all 

text within cells. 
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Groups of Rows and Columns, Headers and 

Footers 
Working with C1PrintDocument > Tables > Groups of Rows and Columns, Headers and Footers 

Show All  

Hide All  

Element groups are a very powerful feature of tables. Groups allow accessing several elements 

of a table as a whole (for example, the style can be set on a group as if it were a single element). 

Supported are groups of columns, groups of rows, and groups of cells. 

To access a group of rows, use the collection RowGroups (which has the type 

TableVectorGroupCollection). Elements of that collection have the type TableVectorGroup, with 

some useful properties defined on that type. One of the more interesting of those properties is 

ColumnHeader. That property allows assigning a group of rows to be a table header, to be 

repeated at the top of each new page or page column. A related property is ColumnFooter, 

which allows to assign a group of rows to be a table footer, again repeated either at the end of 

each page or page column. 

The following line of code shows how to assign the first 2 rows of a table to be the table 

header, repeated after each page or column break (rt1 here is a RenderTable object): 

To write code in Visual Basic 

Visual Basic Copy Code  

 

rt1.RowGroups(0, 2).Header = C1.C1Preview.TableHeaderEnum.Page 

To write code in C# 

C# Copy Code  

 

rt1.RowGroups[0, 2].Header = C1.C1Preview.TableHeaderEnum.Page; 

As seen above, the indexer on the TableVectorGroupCollection class accepts two integers. The 

first value is the index of the first row included in the group (0 in the code example above). The 

second value is the count of rows in the group (2 in the code example above). 

To access a group of columns, the collection ColGroups should be used. It has the same type as 

the row groups' collection (TableVectorGroupCollection), and provides the same functionality. 

Of particular interest is the ability to assign a group of columns to be a vertical table header or 

footer. C1PrintDocument supports "horizontal" (or "extension") pages, which allow wide objects 
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to span several pages horizontally. To allow an object (for example, a table) to span several 

pages horizontally, set its SplitHorzBehavior to a value other than SplitBehaviorEnum.Never. If 

the object's width is wider than the page width, it will be split into several horizontal pages. In 

particular, a wide table can be split in this way. To make a group of columns repeat along the 

left edge of each page, set the group's ColumnHeader property to True. To make a group of 

columns repeat along the right edge of each page, set the group's ColumnFooter property to 

True. 

 

Note: Although any group of rows (or columns) of a table can be assigned to be the footer, 

normally you would want to include only the last rows (or columns) of the table into the 

footer group. This will ensure that the footer behaves as a normal footer - that is appears 

only at the bottom (or right edge) of pages, and also appears at the end of the table. (If, for 

example, you assign the first row of a table to be the footer, it will still appear at the 

beginning of the table, and also will not print at the end of the table.) 

Here is an example of code that creates a table with 100 rows and 10 columns, sets the width of 

the table to Auto, explicitly sets the width of each column to 1 inch, and also assigns horizontal 

and vertical table headers and footers: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Create and fill the table. 

Dim rt1 As C1.C1Preview.RenderTable = New C1.C1Preview.RenderTable() 

Dim row As Integer = 0 

Dim col As Integer 

Do While (row < 100) 

    col = 0 

    Do While (col < 6) 

        rt1.Cells(row, col).Text = String.Format("Text in cell({0}, {1})", 

row, col) 

        col += 1 

    Loop 

    row += 1 

Loop 

  

' Set the table and columns' widths. 

rt1.Width = C1.C1Preview.Unit.Auto 

col = 0 

Do While (col < 6) 

    rt1.Cols(col).Width = "1in" 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~SplitHorzBehavior.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.SplitBehaviorEnum.html
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    col += 1 

Loop 

  

' Assign the first 2 rows as the header and set the background. 

rt1.RowGroups(0, 2).PageHeader = True 

rt1.RowGroups(0, 2).Style.BackColor = Color.Red 

  

' Assign the last 2 rows as the footer and set the background. 

rt1.RowGroups(98, 2).PageFooter = True 

rt1.RowGroups(98, 2).Style.BackColor = Color.Blue 

  

' Assign the first column as the header. 

rt1.ColGroups(0, 1).PageHeader = True 

rt1.ColGroups(0, 1).Style.BackColor = Color.BlueViolet 

  

' Assign the last column as the footer. 

rt1.ColGroups(5, 1).PageFooter = True 

rt1.ColGroups(5, 1).Style.BackColor = Color.BurlyWood 

To write code in C# 

C# Copy Code  

 

// Create and fill the table. 

RenderTable rt1 = new RenderTable(); 

for (int row = 0; row < 100; ++row) 

{ 

    for (int col = 0; col < 6; ++col) 

    { 

        rt1.Cells[row, col].Text = string.Format("Text in cell({0}, {1})", 

row, col); 

    } 

} 

  

// Set the table and columns' widths. 

rt1.Width = Unit.Auto; 

for (int col = 0; col < 6; ++col) 

{ 

    rt1.Cols[col].Width = "1in"; 

} 

  



 

 391 

// Assign the first 2 rows as the header and set the background. 

rt1.RowGroups[0, 2].PageHeader = true; 

rt1.RowGroups[0, 2].Style.BackColor = Color.Red; 

  

// Assign the last 2 rows as the footer and set the background. 

rt1.RowGroups[98, 2].PageFooter = true; 

rt1.RowGroups[98, 2]. Style.BackColor = Color.Blue; 

  

// Assign the first column as the header. 

rt1.ColGroups[0, 1].PageHeader = true; 

rt1.ColGroups[0, 1].Style.BackColor = Color.BlueViolet; 

  

// Assign the last column as the footer. 

rt1.ColGroups[5, 1].PageFooter = true; 

rt1.ColGroups[5, 1].Style.BackColor = Color.BurlyWood; 

In this sample, background color is used to highlight row and column groups. 

User Cell Groups 
Working with C1PrintDocument > Tables > User Cell Groups 

Cells, even cells that are not adjacent to each other in the table, can be united into groups. You 

can then set styles on all cells in a group with a single command. To define a user cell group: 

1. Create an object of the type UserCellGroup. This class has several overloaded 

constructors which allow specifying the coordinates of cells to be included in the group 

(all cells must be added to the group in the constructor). 

2. Add the created UserCellGroup object to the UserCellGroups collection of the table. 

3. Now you can set the style on the group. This will affect all cells in the group. 

Styles in Tables 
Working with C1PrintDocument > Tables > Styles in Tables 

Though table cells, columns, and rows are not render objects (they do not derive from the 

RenderObject class), they do have some properties similar to those of render objects. In 

particular, they all have the Style property. 

Manipulating styles affects the corresponding element and all its content. Setting the style of a 

row will affect all cells in that row. Setting the style of a column will affect all cells in that 

column. The style of the cell at the intersection of that row and column will be a combination of 

the styles specified for the row and the column. If the same style property is set on both the row 

and the column, the column will take precedence. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.UserCellGroup.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderTable~UserCellGroups.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
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Additionally, groups (groups of rows, groups of columns, and user cell groups) all have their 

own styles, which also affect the display of data in cells, and the display of table rows and 

columns. 

The following rules govern the application of styles in tables: 

Ambient style properties propagate down through the table elements (the whole table, row and 

column groups, cell groups, individual rows and columns, and individual cells) based on the 

"geometric" containment, similar to how ambient style properties propagate down render 

objects' containment outside of tables. 

Ambient properties affect the cells' content, without affecting those container elements. For 

instance, setting the font on the style of a whole table affects all text within that table unless its 

font was explicitly set at a lower level. Similarly, setting the font on the style of a row within that 

table affects the font of all cells within that row. 

When a specific ambient property is changed on two or more of the table elements involved, 

the following order of precedence is used to calculate the effective value of the property used 

to draw the cell: 

 Cell's own style (has the highest priority) 

 UserCellGroup style, if the cell is included in such 

 Column style 

 Columns group style, if any 

 Row style 

 Rows group style, if any 

 Table style (has the least priority) 

Non-ambient properties set on styles of table elements listed above (whole table, row, column 

and cell groups, rows, columns and cells) are applied to those elements themselves, without 

affecting the content of the cells, even though such elements (with the exception of the whole 

table) are not render objects. For instance, to draw a border around a row in a table, set the 

Style.Borders on the row to the desired value. 

To set a non-ambient style property on all cells in a table, use RenderTable.CellStyle. If 

specified, that style is effectively used as the parent for the style of render object within cells. 

The CellStyle property is also defined on rows, columns, and groups of table elements, and if 

specified all those styles will affect non-ambient properties of the object within the cell. For 

instance, to set the background image for all cells in a table, set the table's 

CellStyle.BackgroundImage. This will repeat that image in all cells in a table, while assigning 

the same image to the table's Style.BackgroundImage will make that image the background 

for the whole table (the difference is apparent if the image is stretched in both cases). 

Anchors and Hyperlinks 
Working with C1PrintDocument > Anchors and Hyperlinks 
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Reports for WinForms hyperlinks. Hyperlinks can be attached to render objects (RenderObject 

and derived classes), and paragraph objects (ParagraphObject and derived classes), and can be 

linked to: 

 An anchor within the current document. 

 An anchor within another C1PrintDocument. 

 A location within the current document. 

 An external file. 

 A page within the current document. 

 A user event. 

Hyperlinks are supported by the preview controls included in C1.Win.C1Preview assembly 

(C1PreviewPane, C1PrintPreviewControl and C1PrintPreviewDialog). When a document with 

hyperlinks in it is previewed, and the mouse hovers over a hyperlink, the cursor changes to a 

hand. Clicking the hyperlink will, depending on the target of the link, either jump to another 

location within the document, open a different document and jump to a location in it, open an 

external file, or invoke the user event. 

 

Note: The sample code fragments in the following topics assume that the "using 

C1.C1Preview" directive (in C# syntax; or an equivalent for other languages) has been 

inserted into the file, so that instead of fully qualified type names (such as 

C1.C1Preview.RenderText) we can use just the class name part (RenderText). 

See Also 

Adding a Hyperlink to an Anchor within the Same Document 

Adding a Hyperlink to an Anchor in a Different C1PrintDocument 

Adding a Hyperlink to a Location Within the Current Document 

Adding a Hyperlink to an External File 

Adding a Hyperlink to a Page in the Same Document 

Adding a Hyperlink to a User Event 

Link Target Classes Hierarchy 

Adding a Hyperlink to an Anchor within the 

Same Document 
Working with C1PrintDocument > Anchors and Hyperlinks > Adding a Hyperlink to an Anchor within the 

Same Document 

Show All  

Hide All  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.ParagraphObject.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewPane.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewDialog.html
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To link one part of your document to another, you have to do two things: 

 Mark the location (called an anchor) where you want the link to point. 

 Add a link to that location (a hyperlink) to another part of the document (you can have 

several hyperlinks pointing to the same anchor, of course). 

To create an anchor on a render object, you can add an element (of the type C1Anchor) to the 

Anchors collection of that render object. For example, if rt is a RenderTable you can write: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

rt.Anchors.Add(New C1.C1Preview.C1Anchor("anchor1")) 

To write code in C# 

C# Copy Code  

 

rt.Anchors.Add(new C1Anchor("anchor1")); 

This will define an anchor with the name anchor1 (the name used to reference the anchor) on 

the render table. 

To link another render object, for example a RenderText, to that anchor, you can write: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rtxt As New C1.C1Preview.RenderText() 

rtxt.Text = "Link to anchor1" 

rtxt.Hyperlink = New C1.C1Preview.C1Hyperlink("anchor1") 

To write code in C# 

C# Copy Code  

 

RenderText rtxt = new RenderText(); 

rtxt.Text = "Link to anchor1"; 

rtxt.Hyperlink = new C1Hyperlink("anchor1"); 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1Anchor.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~Anchors.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderTable.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderText.html
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Of course, you must add both involved render objects (the one containing the anchor, and the 

one with the hyperlink) to the document. 

Hyperlink is a property of the RenderObject class, which is the base class for all render objects, 

so in exactly the same manner as shown above, any render object may be turned into a 

hyperlink by setting that property. 

Adding a Hyperlink to an Anchor in a 

Different C1PrintDocument 
Working with C1PrintDocument > Anchors and Hyperlinks > Adding a Hyperlink to an Anchor in a 

Different C1PrintDocument 

Show All  

Hide All  

To link a location in one document to a location in another, you must do the following: 

 As described above, add an anchor to the target document, generate that document 

and save it as a C1D file on your disk. You can save the document using the Save 

button of the preview control, or in code using the Save method on the document 

itself. 

 Add a link pointing to that anchor to another document, in a way very similar to how an 

internal link is added. The only difference is that in addition to the target' anchor name 

you must also provide the name of the file containing the document. 

Here is the text of a complete program that creates a document with an anchor in it, and saves 

it in a disk file (myDocument1.c1d). It then creates another document, adds a link to the anchor 

in the first document to it, and shows the second document in a preview dialog box: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Make target document with an anchor. 

Dim targetDoc As New C1.C1Preview.C1PrintDocument 

Dim rt1 As New C1.C1Preview.RenderText("This is anchor1 in myDocument1.") 

rt1.Anchors.Add(New C1.C1Preview.C1Anchor("anchor1")) 

targetDoc.Body.Children.Add(rt1) 

targetDoc.Generate() 

targetDoc.Save("c:\myDocument1.c1d") 

  

' Make document with a hyperlink to the anchor. 

Dim sourceDoc As New C1.C1Preview.C1PrintDocument 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~Hyperlink.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
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Dim rt2 As New C1.C1Preview.RenderText("This is hyperlink to myDocument1.") 

Dim linkTarget As C1.C1Preview.C1LinkTarget = New 

C1.C1Preview.C1LinkTargetExternalAnchor("c:\myDocument1.c1d", "anchor1") 

rt2.Hyperlink = New C1.C1Preview.C1Hyperlink(linkTarget) 

sourceDoc.Body.Children.Add(rt2) 

sourceDoc.Generate() 

  

' Show document with hyperlink in preview. 

Dim preview As New C1.Win.C1Preview.C1PrintPreviewDialog() 

preview.Document = sourceDoc 

preview.ShowDialog() 

To write code in C# 

C# Copy Code  

 

// Make target document with an anchor. 

C1PrintDocument targetDoc = new C1PrintDocument(); 

RenderText rt1 = new RenderText("This is anchor1 in myDocument1."); 

rt1.Anchors.Add(new C1Anchor("anchor1")); 

targetDoc.Body.Children.Add(rt1); 

targetDoc.Generate(); 

targetDoc.Save(@"c:\myDocument1.c1d"); 

  

// Make document with a hyperlink to the anchor. 

C1PrintDocument sourceDoc = new C1PrintDocument(); 

RenderText rt2 = new RenderText("This is hyperlink to myDocument1."); 

C1LinkTarget linkTarget = new 

C1LinkTargetExternalAnchor(@"c:\myDocument1.c1d", "anchor1"); 

rt2.Hyperlink = new C1Hyperlink(linkTarget); 

sourceDoc.Body.Children.Add(rt2); 

sourceDoc.Generate(); 

  

// Show document with hyperlink in preview. 

C1PrintPreviewDialog preview = new C1PrintPreviewDialog(); 

preview.Document = sourceDoc; 

preview.ShowDialog(); 

Note the following: 

 The anchor is created in exactly the same manner as for links within the same 

document. In fact, there is no difference; the same anchor may be the target of links 

both from the same document and from other documents. 
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 To save the document, the Save method is used. This method saves the document in 

native C1PrintDocument format, the default extension for which is C1D. Files saved in 

that format can be later loaded into a C1PrintDocument object for further processing, 

or previewed using the print preview control. 

 Before creating the hyperlink, a link target object must be created which is then passed 

to the hyperlink constructor. Several link target types are provided, derived from the 

C1LinkTarget base class. For external anchors, the C1LinkTargetExternalAnchor type is 

used. The link target contains information needed to process the jump to the link, in 

this case the document filename and the name of the anchor in it. 

Adding a Hyperlink to a Location Within the 

Current Document 
Working with C1PrintDocument > Anchors and Hyperlinks > Adding a Hyperlink to a Location Within the 

Current Document 

Show All  

Hide All  

You can add a link to an object within the current document without creating an anchor. 

Instead, you can use the C1LinkTargetDocumentLocation link target created directly on a render 

object, like this, where ro1 is an arbitrary render object in the current document: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim linkTarget = New C1.C1Preview.C1LinkTargetDocumentLocation(ro1) 

To write code in C# 

C# Copy Code  

 

C1LinkTarget linkTarget = new C1LinkTargetDocumentLocation(ro1); 

Setting this link target on a hyperlink will make that hyperlink jump to the specified render 

object when the object owning the hyperlink is clicked. If, for example, ro2 is a render object 

that you want to turn into a hyperlink, the following code will link it to the location of ro1 on 

which the linkTarget was created as shown in the code snippet above: 

To write code in Visual Basic 

Visual Basic Copy Code  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1LinkTarget.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1LinkTargetExternalAnchor.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1LinkTargetDocumentLocation.html
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rt2.Hyperlink = New C1.C1Preview.C1Hyperlink() 

rt2.Hyperlink.LinkTarget = linkTarget 

To write code in C# 

C# Copy Code  

 

rt2.Hyperlink = new C1Hyperlink(); 

rt2.Hyperlink.LinkTarget = linkTarget; 

Note that in this example, the LinkTarget property of the hyperlink was set after the hyperlink 

has been created. 

Adding a Hyperlink to an External File 
Working with C1PrintDocument > Anchors and Hyperlinks > Adding a Hyperlink to an External File 

Show All  

Hide All  

A hyperlink to an external file differs from a link to an external anchor by the link target. The link 

target class for an external file link is called C1LinkTargetFile. Clicking such a link will use the 

Windows shell to open that file. For instance, if in the sample from the preceding section, you 

replace the line creating the external anchor link target with the following line: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim linkTarget = New C1.C1Preview.C1LinkTargetFile("c:\") 

To write code in C# 

C# Copy Code  

 

C1LinkTarget linkTarget = new C1LinkTargetFile(@"c:\"); 

Clicking on that link will open the Windows Explorer on the root directory of the C: drive. 

Again, here is a complete program: 

To write code in Visual Basic 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1Hyperlink~LinkTarget.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1LinkTargetFile.html
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Visual Basic Copy Code  

 

' Make document with a hyperlink to external file. 

Dim doc As New C1.C1Preview.C1PrintDocument 

Dim rt As New C1.C1Preview.RenderText("Explore drive C:...") 

Dim linkTarget As C1.C1Preview.C1LinkTarget = New 

C1.C1Preview.C1LinkTargetFile("c:\") 

rt.Hyperlink = New C1.C1Preview.C1Hyperlink(linkTarget) 

doc.Body.Children.Add(rt) 

doc.Generate() 

  

' Show document with hyperlink in preview. 

Dim preview As New C1.Win.C1Preview.C1PrintPreviewDialog() 

preview.Document = doc 

preview.ShowDialog() 

To write code in C# 

C# Copy Code  

 

// Make document with a hyperlink to external file. 

C1PrintDocument doc = new C1PrintDocument(); 

RenderText rt = new RenderText("Explore drive C:..."); 

C1LinkTarget linkTarget = new C1LinkTargetFile(@"c:\"); 

rt.Hyperlink = new C1Hyperlink(linkTarget); 

doc.Body.Children.Add(rt); 

doc.Generate(); 

  

// Show document with hyperlink in preview. 

C1PrintPreviewDialog preview = new C1PrintPreviewDialog(); 

preview.Document = doc; 

preview.ShowDialog(); 

 

Adding a Hyperlink to a Page in the Same 

Document 
Working with C1PrintDocument > Anchors and Hyperlinks > Adding a Hyperlink to a Page in the Same 

Document 
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Show All  

Hide All  

You can add hyperlinks to other pages in the same document without defining anchors, using 

the C1LinkTargetPage link target. The following page jumps are supported: 

 To the first page of the document. 

 To the last page of the document. 

 To the previous page. 

 To the next page. 

 To a page specified by its absolute page number. 

 To a page specified by an offset relative to the current page. 

For instance, to make a link target jumping to the first page in the document, the following line 

of code may be used: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim linkTarget = New 

C1.C1Preview.C1LinkTargetPage(C1.C1Preview.PageJumpTypeEnum.First) 

To write code in C# 

C# Copy Code  

 

C1LinkTarget linkTarget = new C1LinkTargetPage(PageJumpTypeEnum.First); 

Here, PageJumpTypeEnum specifies the type of the page jump (of course, for jumps requiring 

an absolute or a relative page number, you must use a variant of the constructor accepting 

that). 

This feature allows you to provide simple means of navigating the document in the document 

itself. For example, you can add DVD player-like controls (go to first page, go to previous page, 

go to next page, go to last page) to the document footer. 

Adding a Hyperlink to a User Event 
Working with C1PrintDocument > Anchors and Hyperlinks > Adding a Hyperlink to a User Event 

Show All  

Hide All  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1LinkTargetPage.html
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Finally, you may add a hyperlink that will fire an event on the C1PreviewPane, to be handled by 

your code. For this, C1LinkTargetUser should be used. Here is a complete example illustrating 

the concept: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub UserLinkSetup() 

  

    ' Make document with a user hyperlink. 

    Dim doc As New C1.C1Preview.C1PrintDocument 

    Dim rt As New C1.C1Preview.RenderText("Click this to show message 

box...") 

    Dim linkTarget As C1.C1Preview.C1LinkTarget = New 

C1.C1Preview.C1LinkTargetUser 

    rt.Hyperlink = New C1.C1Preview.C1Hyperlink(linkTarget) 

    rt.Hyperlink.UserData = "My hyperlnk user data" 

    doc.Body.Children.Add(rt) 

    doc.Generate() 

  

    ' Create the preview. 

    Dim preview As New C1.Win.C1Preview.C1PrintPreviewDialog() 

  

    ' Attach an event handler to the UserHyperlinkJump event. 

    AddHandler preview.PreviewPane.UserHyperlinkJump, New 

C1.Win.C1Preview.HyperlinkEventHandler(AddressOf 

Me.C1PreviewPane1_UserHyperlinkJump) 

  

    ' Preview the document. 

    preview.Document = doc 

    preview.ShowDialog()End Sub 

  

Private Sub C1PreviewPane1_UserHyperlinkJump(ByVal sender As Object, ByVal e 

As C1.Win.C1Preview.HyperlinkEventArgs) Handles 

C1PreviewPane1.UserHyperlinkJump 

    MessageBox.Show(e.Hyperlink.UserData.ToString()) 

End Sub 

To write code in C# 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewPane.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1LinkTargetUser.html
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C# Copy Code  

 

private void UserLinkSetup() 

{ 

  

    // Make document with a user hyperlink. 

    C1PrintDocument doc = new C1PrintDocument(); 

    RenderText rt = new RenderText("Click this to show message box..."); 

    C1LinkTarget linkTarget = new C1LinkTargetUser(); 

    rt.Hyperlink = new C1Hyperlink(linkTarget); 

    rt.Hyperlink.UserData = "My hyperlnk user data"; 

    doc.Body.Children.Add(rt); 

    doc.Generate(); 

  

    // Create the preview. 

    C1PrintPreviewDialog preview = new C1PrintPreviewDialog(); 

  

    // Attach an event handler to the UserHyperlinkJump event. 

    preview.PreviewPane.UserHyperlinkJump += new 

HyperlinkEventHandler(PreviewPane_UserHyperlinkJump); 

  

    // Preview the document. 

    preview.Document = doc; 

    preview.ShowDialog(); 

} 

  

private void PreviewPane_UserHyperlinkJump(object sender, HyperlinkEventArgs 

e) 

{ 

    MessageBox.Show(e.Hyperlink.UserData.ToString()); 

} 

This example will show the message box with the string that was assigned to the UserData 

property of the hyperlink when the hyperlink is clicked (in this case, "My hyperlink user data"). 

Link Target Classes Hierarchy 
Working with C1PrintDocument > Anchors and Hyperlinks > Link Target Classes Hierarchy 

To conclude the section on hyperlinks, here is the hierarchy of link target classes: 

Class Description 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1Hyperlink~UserData.html
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Class Description 

C1LinkTarget  The base class for the whole hierarchy. 

 C1LinkTargetAnchor  Describes a target which is an anchor in 

the current document. 

 C1LinkTargetExternalAnchor  Describes a target which is an anchor in a 

different document. 

 C1LinkTargetDocumentLocation  Describes a target which is a render object. 

 C1LinkTargetFile  Describes a target which is an external file 

to be opened by the OS shell. 

 C1LinkTargetPage  Describes a target which is a page in the 

current document. 

 C1LinkTargetUser  Describes a target which invokes a user 

event handler on the C1PreviewPane. 

 

Expressions, Scripts, Tags 
Working with C1PrintDocument > Expressions, Scripts, Tags 

Show All  

Hide All  

Expressions (or scripts - the two terms are used interchangeably here) can be used in various 

places throughout the document. Mark an expression by surrounding it by square brackets, as 

in the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

doc.Body.Children.Add(New RenderText("2 + 2 = [2+2]")) 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1LinkTarget.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1LinkTargetAnchor.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1LinkTargetExternalAnchor.html
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To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

doc.Body.Children.Add(new RenderText("2 + 2 = [2+2]")); 

This code will produce the following text in the generated document: 

2 + 2 = 4  

In this case, the "[2+2]" is interpreted as an expression, and calculated to produce the resulting 

text. 

 

Note: If the expression parser cannot parse the text included in square brackets, such text 

is not interpreted as an expression, and is inserted in the document "as is". 

See Also 

Tags 

Tags/expressions syntax 

Editing Tag Values at Run Time 

Scripting/Expression Language 

Assemblies and Namespaces 

IDs Accessible in Text Expressions 

IDs accessible in expressions within Filter, Grouping and Sorting 

IDs accessible in expressions used to specify calculated fields in a DataSet 

Tags 
Working with C1PrintDocument > Expressions, Scripts, Tags > Tags 

Show All  

Hide All  

Tags are closely related to expressions. In fact, tags are variables that can be used in 

expressions, or simply as expressions. In the simplest case, tags allow you to use a placeholder 

where you want to insert a certain string but do not know the value of that string yet. The 

typical example of a tag is the page number- you want to print the page number but do not 

know yet what it is going to be or realize it may change when the document is regenerated. 
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A tag has two main properties: Name and Value. The name is used to identify the tag, while the 

value is what the tag is replaced with. 

C1PrintDocument provides two kinds of tags: predefined and custom. Predefined tags are: 

 [PageNo] - replaced with the current page number. 

 [PageCount] - replaced with the total number of pages. 

 [PageX] - replaced with the current horizontal page number. 

 [PageXCount] - replaced with the total number of horizontal pages. 

 [PageY] - replaced with the current vertical page number (if there are no horizontal 

pages, this is equivalent to [PageNo]). 

 [PageYCount] - replaced with the total number of vertical pages (if there are no 

horizontal pages, this is equivalent to [PageCount]). 

Custom tags are stored in the Tags collection of the document. To add a tag to that collection, 

you may use the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

doc.Tags.Add(New C1.C1Preview.Tag("tag1", "tag value")) 

To write code in C# 

C# Copy Code  

 

doc.Tags.Add(new C1.C1Preview.Tag("tag1", "tag value")); 

The value of the tag may be left unspecified when the tag is created, and may be specified at 

some point later (even after that tag was used in the document). 

To use a tag, insert its name in square brackets in the text where you want the tag value to 

appear, for example, like this: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt As New C1.C1Preview.RenderText() 

rt.Text = "The value of tag1 will appear here: [tag1]." 

To write code in C# 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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C# Copy Code  

 

RenderText rt = new RenderText(); 

rt.Text = "The value of tag1 will appear here: [tag1]."; 

 

Tags/expressions syntax 
Working with C1PrintDocument > Expressions, Scripts, Tags > Tags/expressions syntax 

Show All  

Hide All  

You can change the square brackets used to include tags or scripts in text to arbitrary strings, if 

desired, via the document's TagOpenParen and TagCloseParen properties. This may be a 

good idea if your document contains a lot of square brackets - by default, they will all trigger 

expression parsing which can consume a lot of resources even if not affecting the result visually. 

So, for instance this: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

doc.TagOpenParen = "@@@[" 

doc.TagCloseParen = "@@@]" 

To write code in C# 

C# Copy Code  

 

doc.TagOpenParen = "@@@["; 

doc.TagCloseParen = "@@@]"; 

will ensure that only strings surrounded by "@@@[" and "@@@]" are interpreted as 

expressions. 

The expression brackets can also be escaped by preceding them with the backslash symbol, for 

instance this code: 

To write code in Visual Basic 
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Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

doc.Body.Children.Add(new RenderText("2 + 2 = \[2+2\]")) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

doc.Body.Children.Add(new RenderText("2 + 2 = \[2+2\]")); 

will produce the following text in the generated document: 

2 + 2 = [2+2]  

because the brackets were escaped. 

The property TagEscapeString on the document can be used to change the escape symbol to 

an arbitrary string. 

Editing Tag Values at Run Time 
Working with C1PrintDocument > Expressions, Scripts, Tags > Editing Tag Values at Run Time 

You can show a form for the end-user to view and edit tag values for tags contained in the Tags 

collection of a C1PrintDocument component. Several new members support this option 

allowing you to create a customized form with specific tags displayed. 

You have several options with the Tags form that you create. You can: 

 Allow the user to edit every tag each time a C1PrintDocument is generated. For more 

information, see Displaying All Tags. 

 Let the user edit some but not all tags, set the Flags property to None on tags you do 

not want to be edited by the user. 

 Finally, you can choose when the end user is presented with the Tags dialog box. set 

ShowTagsInputDialog to False on the document, and call the EditTags() method on the 

document in your own code when you want the user to be presented with the tags 

input dialog. 

See Also 
Displaying All Tags 

Displaying Specific Tags 

Specifying When the Tags Dialog Box is Shown 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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Define the Default Tags Dialog Box 

Displaying All Tags 
Working with C1PrintDocument > Expressions, Scripts, Tags > Editing Tag Values at Run Time > Displaying 

All Tags 

Show All  

Hide All  

By default the ShowTagsInputDialog property is set to False and the Tags dialog box is not 

displayed. To allow the user to input all tags each time a C1PrintDocument is generated, set the 

ShowTagsInputDialog property to True on the document. Any tags you've added to the 

document's Tags collection will then be automatically presented in a dialog box to the user 

each time the document is about to be generated. This will give the end-user the opportunity to 

edit the tags values in the Tags dialog box. 

For example, the following code in the Form_Load event adds three tags to the document and 

text values for those tags: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Me.C1PrintPreviewControl1.Document = doc 

' Show the Tags dialog box on document generation. 

doc.ShowTagsInputDialog = True 

' Create tags that will be shown in the Tags dialog box. 

doc.Tags.Add(New C1.C1Preview.Tag("Statement", "Hello World!")) 

doc.Tags.Add(New C1.C1Preview.Tag("Name", "ComponentOne")) 

doc.Tags.Add(New C1.C1Preview.Tag("Location", "Pittsburgh, PA")) 

' Add tags to the document and generate. 

Dim rt As New C1.C1Preview.RenderText() 

rt.Text = "[Statement] My name is [Name] and my current location is 

[Location]." 

doc.Body.Children.Add(rt) 

doc.Generate() 

To write code in C# 

C# Copy Code  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~ShowTagsInputDialog.html
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C1PrintDocument doc = new C1PrintDocument(); 

this.c1PrintPreviewControl1.Document = doc; 

// Show the Tags dialog box on document generation. 

doc.ShowTagsInputDialog = true; 

// Create tags that will be shown in the Tags dialog box. 

doc.Tags.Add(new C1.C1Preview.Tag("Statement", "Hello World!")); 

doc.Tags.Add(new C1.C1Preview.Tag("Name", "ComponentOne")); 

doc.Tags.Add(new C1.C1Preview.Tag("Location", "Pittsburgh, PA")); 

// Add tags to the document and generate. 

C1.C1Preview.RenderText rt = new C1.C1Preview.RenderText(); 

rt.Text = "[Statement] My name is [Name] and my current location is 

[Location]."; 

doc.Body.Children.Add(rt); 

doc.Generate(); 

When the application is run, the following dialog box is displayed before the document is 

generated: 

 

Changing the text in any of the textboxes in the Tags dialog box will change the text that 

appears in the generated document. If the default text is left, the following willproduce the 

following text in the generated document: 

Hello World! My name is ComponentOne and I'm currently located in 

Pittsburgh, PA.  

Displaying Specific Tags 
Working with C1PrintDocument > Expressions, Scripts, Tags > Editing Tag Values at Run Time > Displaying 

Specific Tags 

Show All  

Hide All  

When the ShowTagsInputDialog property is set to True all tags are displayed by default in the 

Tags dialog box. You can prevent users from editing specific tags by using the 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~ShowTagsInputDialog.html
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Tag.ShowInDialog property. To let users edit some but not all tags, set the Flags property to 

None on tags you do not want to be edited. 

For example, the following code in the Form_Load event adds three tags to the document, one 

of which cannot be edited: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Me.C1PrintPreviewControl1.Document = doc 

' Show the Tags dialog box on document generation. 

doc.ShowTagsInputDialog = True 

' Create a tag but do not show it in the Tags dialog box. 

doc.Tags.Add(New C1.C1Preview.Tag("Statement", "Hello World!")) 

doc.Tags("Statement").ShowInDialog = False 

' Create tags that will be shown. 

doc.Tags.Add(New C1.C1Preview.Tag("Name", "ComponentOne")) 

doc.Tags.Add(New C1.C1Preview.Tag("Location", "Pittsburgh, PA")) 

' Add tags to the document and generate. 

Dim rt As New C1.C1Preview.RenderText() 

rt.Text = "[Statement] My name is [Name] and my current location is 

[Location]." 

doc.Body.Children.Add(rt) 

doc.Generate() 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

this.c1PrintPreviewControl1.Document = doc; 

// Show the Tags dialog box on document generation. 

doc.ShowTagsInputDialog = true; 

// Create a tag but do not show it in the Tags dialog box. 

doc.Tags.Add(new C1.C1Preview.Tag("Statement", "Hello World!")); 

doc.Tags["Statement"].ShowInDialog = false; 

// Create tags that will be shown. 

doc.Tags.Add(new C1.C1Preview.Tag("Name", "ComponentOne")); 

doc.Tags.Add(new C1.C1Preview.Tag("Location", "Pittsburgh, PA")); 
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// Add tags to the document and generate. 

C1.C1Preview.RenderText rt = new C1.C1Preview.RenderText(); 

rt.Text = "[Statement] My name is [Name] and my current location is 

[Location]."; 

doc.Body.Children.Add(rt); 

doc.Generate(); 

When the application is run, the following dialog box is displayed before the document is 

generated: 

 

Changing the text in any of the textboxes in the Tags dialog box will change the text that 

appears in the generated document. Note that the Statement tag is not displayed, and can not 

be changed from the dialog box. If the default text is left, the following willproduce the 

following text in the generated document: 

Hello World! My name is ComponentOne and I'm currently located in Pittsburgh, PA. 

Specifying When the Tags Dialog Box is Shown 
Working with C1PrintDocument > Expressions, Scripts, Tags > Editing Tag Values at Run Time > Specifying 

When the Tags Dialog Box is Shown 

Show All  

Hide All  

When the ShowTagsInputDialog property is set to True, the Tags dialog box is shown just 

before the document is generated. You can programmatically show that dialog whenever you 

want (and independently of the value of the ShowTagsInputDialog property) by calling the 

EditTags method. 

For example, the following code shows the tags input dialog box when a button is clicked: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Public Class Form1 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~ShowTagsInputDialog.html
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    Dim doc As New C1PrintDocument() 

    Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles MyBase.Load 

        Me.C1PrintPreviewControl1.Document = doc 

        ' Create tags to be shown. 

        doc.Tags.Add(New C1.C1Preview.Tag("Statement", "Hello World!")) 

        doc.Tags("Statement").ShowInDialog = True 

        doc.Tags.Add(New C1.C1Preview.Tag("Name", "ComponentOne")) 

        doc.Tags.Add(New C1.C1Preview.Tag("Location", "Pittsburgh, PA")) 

        ' Add tags to the document.    

        Dim rt As New C1.C1Preview.RenderText() 

        rt.Text = "[Statement] My name is [Name] and my current location is 

[Location]." 

        doc.Body.Children.Add(rt) 

    End Sub 

    Private Sub EditTagsNow_Click(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles EditTagsNow.Click 

        ' Show the Tags dialog box on button click.        

        doc.ShowTagsInputDialog = True 

        doc.EditTags() 

    End Sub 

    Private Sub GenerateDocNow_Click(ByVal sender As System.Object, ByVal e 

As System.EventArgs) Handles GenerateDocNow.Click 

        doc.ShowTagsInputDialog = False 

        ' Generate the document on button click. 

        doc.Generate() 

    End Sub 

End Class 

To write code in C# 

C# Copy Code  

 

public partial class Form1 : Form 

{ 

    public Form1() 

    { 

        InitializeComponent(); 

    } 

    C1PrintDocument doc = new C1PrintDocument();   

    private void Form1_Load(object sender, EventArgs e) 
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    { 

        this.c1PrintPreviewControl1.Document = doc; 

        // Create tags to be shown. 

        doc.Tags.Add(new C1.C1Preview.Tag("Statement", "Hello World!")); 

        doc.Tags["Statement"].ShowInDialog = true; 

        doc.Tags.Add(new C1.C1Preview.Tag("Name", "ComponentOne")); 

        doc.Tags.Add(new C1.C1Preview.Tag("Location", "Pittsburgh, PA")); 

        // Add tags to the document. 

        C1.C1Preview.RenderText rt = new C1.C1Preview.RenderText(); 

        rt.Text = "[Statement] My name is [Name] and my current location is 

[Location]."; 

        doc.Body.Children.Add(rt); 

    } 

    private void EditTagsNow_Click(object sender, EventArgs e) 

    { 

        // Show the Tags dialog box on button click. 

        doc.ShowTagsInputDialog = true; 

        doc.EditTags(); 

    } 

    private void GenerateDoc_Click(object sender, EventArgs e) 

    { 

        doc.ShowTagsInputDialog = false; 

        // Generate the document on button click. 

        doc.Generate(); 

    } 

} 

In the example above, the Tags dialog box will appear when the EditTagsNow button is 

clicked. 

Define the Default Tags Dialog Box 
Working with C1PrintDocument > Expressions, Scripts, Tags > Editing Tag Values at Run Time > Define the 

Default Tags Dialog Box 

You can easily customize the Tags dialog box by adding an inherited form to your project that 

is based on either TagsInputForm or TagsInputFormBase. The difference in what approach you 

follow depends on whether you plan to make a small change to the form or if you want to 

completely redesign the form. 

Making a small change 

If you only want to make a small change to the default form (for example, add a Help button), 

you can add an inherited form to your project based on TagsInputForm, adjust it as needed, 

and assign that form's type name to the TagsInputDialogClassName property on the document. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Forms.TagsInputForm.html
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For example, in the following form a Help button was added to the caption bar and the 

background color of the form was changed: 

 

Completely changing the form 

If you choose, you can completely change the default form. For example, you can provide your 

own controls or entering tags' values, and so on. To do so, base your inherited form on 

TagsInputFormBase, change it as needed, and override the EditTags method. 

Scripting/Expression Language 
Working with C1PrintDocument > Expressions, Scripts, Tags > Scripting/Expression Language 

Show All  

Hide All  

The language used in expressions is determined by the value of the property 

C1PrintDocument.ScriptingOptions.Language. That property can have one of two possible 

values: 

 VB. This is the default value, and indicates that the standard VB.NET will be used as the 

scripting language. 

 C1Report. This value indicates that the C1Report scripting language will be used. 

While that language is similar to VB, there are subtle differences. This option is primarily 

provided for backwards compatibility. 

 CSharp. This value indicates that the standard C# will be used as the scripting 

language. 

If VB is used as the expression language, when the document is generated a separate assembly 

is built internally for each expression containing a single class derived from 

ScriptExpressionBase. This class contains the protected properties that can be used in the 

expression. The expression itself is implemented as a function of that class. 

For example: 

To write code in Visual Basic 
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Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

doc.ScriptingOptions.Language = ScriptLanguageEnum.CSharp 

Dim rt As New RenderText("[PageNo == 1 ? ""First"" : ""Not first""]") 

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

doc.ScriptingOptions.Language = ScriptLanguageEnum.CSharp; 

RenderText rt = new RenderText("[PageNo == 1 ? \"First\" : \"Not first\"]"); 

doc.Body.Children.Add(rt); 

 

Assemblies and Namespaces 
Working with C1PrintDocument > Expressions, Scripts, Tags > Assemblies and Namespaces 

Show All  

Hide All  

By default, the following assemblies are available (referenced) for scripts: 

 System 

 System.Drawing 

To add another (system or custom) assembly to the list of assemblies referenced in scripts, add 

it to the C1PrintDocument.ScriptingOptions.ExternalAssemblies collection on the document. 

For instance, the following will add a reference to the System.Data assembly to the document's 

scripts: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

doc.ScriptingOptions.ExternalAssemblies.Add("System.Data.dll") 
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To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

doc.ScriptingOptions.ExternalAssemblies.Add("System.Data.dll"); 

The following namespaces are by default available (imported) for use in scripts: 

 System 

 System.Collections 

 System.Collections.Generic 

 System.Text 

 Microsoft.VisualBasic 

 System.Drawing 

To add another namespace, add it to the C1PrintDocument.ScriptingOptions.Namespaces 

collection on the document. For instance, this will allow the use of types declared in 

System.Data namespace in the document's scripts without fully qualifying them with the 

namespace: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

doc.ScriptingOptions. Namespaces.Add("System.Data") 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

doc.ScriptingOptions. Namespaces.Add("System.Data"); 

 

IDs Accessible in Text Expressions 
Working with C1PrintDocument > Expressions, Scripts, Tags > IDs Accessible in Text Expressions 

Show All  

Hide All  
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As mentioned above, expressions in brackets can be used within the Text property of 

RenderText and ParagraphText objects. In those expressions, the following object IDs are 

available: 

 Document (type C1PrintDocument) 

This variable references the document being generated. This can be used in a number 

of ways, for instance the following code will print the author of the current document: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Dim rt As New RenderText("Landscape is " + _ 

  "[Iif(Page.PageSettings.Landscape,\"TRUE\",\"FALSE\")].") 

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

RenderText rt = new RenderText("Landscape is " + 

  "[Iif(Page.PageSettings.Landscape,\"TRUE\",\"FALSE\")]."); 

doc.Body.Children.Add(rt); 

 RenderObject (type RenderObject) 

This variable references the current render object. For instance, the following code will 

print the name of the current render object: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Dim rt As New RenderText( _ 

  "The object's name is [RenderObject.Name]") 

rt.Name = "MyRenderText" 

doc.Body.Children.Add(rt) 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

RenderText rt = new RenderText( 

  "The object's name is [RenderObject.Name]"); 

rt.Name = "MyRenderText"; 

doc.Body.Children.Add(rt); 

 Page (type C1Page) 

This variable references the current page (object of type C1Page). While the most 

commonly used in scripts members of the page object are accessible directly (see 

PageNo, PageCount and so on below), there is other data that can be accessed via the 

Page variable, such as the current page settings. For instance, the following code will 

print "Landscape is TRUE" if the current page layout has landscape orientation, and 

"Landscape is FALSE" otherwise: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Dim rt As New RenderText("Landscape is " + _ 

  "[Iif(Page.PageSettings.Landscape,\"TRUE\",\"FALSE\")].") 

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

RenderText rt = new RenderText("Landscape is " + 

  "[Iif(Page.PageSettings.Landscape,\"TRUE\",\"FALSE\")]."); 

doc.Body.Children.Add(rt); 

 PageNo (type Integer) 

This name resolves to the current 1-based page number. Equivalent to Page.PageNo. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1Page.html
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 PageCount (type Integer) 

This name resolves to the total page count for the document. Equivalent to 

Page.PageCount. For instance, the following code can be used to generate the 

common "Page X of Y" page header: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

doc.PageLayout.PageHeader = New RenderText( _ 

  "Page [PageNo] of [PageCount]") 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

doc.PageLayout.PageHeader = new RenderText( 

  "Page [PageNo] of [PageCount]"); 

 PageX (type Integer) 

This name resolves to the current 1-based horizontal page number. (For documents 

without horizontal page breaks, will return 1.) 

 PageY (type Integer) 

This name resolves to the current 1-based vertical page number. (For documents 

without horizontal page breaks, will be equivalent to PageNo.) 

 PageXCount (type Integer) 

This name resolves to the total page count for the document. (For documents without 

horizontal page breaks, will return 1.) 

 PageYCount (type Integer) 

This name resolves to the total page count for the document. (For documents without 

horizontal page breaks, will be equivalent to PageCount.) 

It is important to note that any of page numbering-related variables described here can 

be used anywhere in a document not necessarily in page headers or footers. 
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 Fields (type FieldCollection) 

This variable references the collection of available database fields, and has the type 

C1.C1Preview.DataBinding.FieldCollection. It can only be used in data-bound 

documents. For instance, the following code will print the list of product names 

contained in the Products table of the NWIND database: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Dim dSrc As New DataSource() 

dSrc.ConnectionProperties.DataProvider = DataProviderEnum.OLEDB 

dSrc.ConnectionProperties.ConnectString = _ 

  "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C1NWIND.MDB" 

Dim dSet1 As New C1.C1Preview.DataBinding.DataSet( _ 

  dSrc, "select * from Products") 

doc.DataSchema.DataSources.Add(dSrc) 

doc.DataSchema.DataSets.Add(dSet1) 

Dim rt As New RenderText() 

rt.DataBinding.DataSource = dSet1 

rt.Text = "[Fields!ProductName.Value]" 

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

DataSource dSrc = new DataSource(); 

dSrc.ConnectionProperties.DataProvider = DataProviderEnum.OLEDB; 

dSrc.ConnectionProperties.ConnectString = 

  @"Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C1NWIND.MDB"; 

C1.C1Preview.DataBinding.DataSet dSet1 = 

  new C1.C1Preview.DataBinding.DataSet(dSrc, 

  "select * from Products"); 

doc.DataSchema.DataSources.Add(dSrc); 

doc.DataSchema.DataSets.Add(dSet1); 

RenderText rt = new RenderText(); 

doc.Body.Children.Add(rt); 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.FieldCollection.html
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rt.DataBinding.DataSource = dSet1; 

rt.Text = "[Fields!ProductName.Value]"; 

Note the use of "!" to access an element of the fields array in the last line. Alternatively, 

you can write: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

rt.Text = "[Fields(\"ProductName\").Value]" 

To write code in C# 

C# Copy Code  

 

rt.Text = "[Fields(\"ProductName\").Value]"; 

but the notation using "!" is shorter and easier to read. 

 Aggregates (type AggregateCollection) 

This variable allows access to the collection of aggregates defined on the document. 

That collection is of the type C1.C1Preview.DataBinding.AggregateCollection, its 

elements have the type C1.C1Preview.DataBinding.Aggregate. For instance, the 

following code will print the average unit price after the list of products: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Dim dSrc As New DataSource() 

dSrc.ConnectionProperties.DataProvider = DataProviderEnum.OLEDB 

dSrc.ConnectionProperties.ConnectString = _ 

  "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C1NWIND.MDB" 

C1.C1Preview.DataBinding.DataSet dSet1 = _ 

  new C1.C1Preview.DataBinding.DataSet(dSrc, _ 

  "select * from Products") 

doc.DataSchema.DataSources.Add(dSrc) 

doc.DataSchema.DataSets.Add(dSet1) 

Dim rt As New RenderText() 
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doc.Body.Children.Add(rt) 

rt.DataBinding.DataSource = dSet1 

rt.Text = "[Fields!ProductName.Value]" 

doc.DataSchema.Aggregates.Add(new Aggregate( _ 

  "AveragePrice", "Fields!UnitPrice.Value", _ 

  rt.DataBinding, RunningEnum.Document, _ 

  AggregateFuncEnum.Average)) 

doc.Body.Children.Add(new RenderText( _ 

  "Average price: [Aggregates!AveragePrice.Value]")) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

DataSource dSrc = new DataSource(); 

dSrc.ConnectionProperties.DataProvider = DataProviderEnum.OLEDB; 

dSrc.ConnectionProperties.ConnectString = 

  @"Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C1NWIND.MDB"; 

C1.C1Preview.DataBinding.DataSet dSet1 = 

  new C1.C1Preview.DataBinding.DataSet(dSrc,  "select * from Products"); 

doc.DataSchema.DataSources.Add(dSrc); 

doc.DataSchema.DataSets.Add(dSet1); 

RenderText rt = new RenderText(); 

doc.Body.Children.Add(rt); 

rt.DataBinding.DataSource = dSet1; 

rt.Text = "[Fields!ProductName.Value]"; 

doc.DataSchema.Aggregates.Add(new Aggregate( 

  "AveragePrice", "Fields!UnitPrice.Value", 

  rt.DataBinding, RunningEnum.Document, 

  AggregateFuncEnum.Average)); 

doc.Body.Children.Add(new RenderText( 

  "Average price: [Aggregates!AveragePrice.Value]")); 

 DataBinding (type C1DataBinding) 

This variable allows accessing the DataBinding property of the current render object, of 

the type C1.C1Preview.DataBinding.C1DataBinding. For instance, the following code 

(modified from the sample showing the use of Fields variable) will produce a numbered 

list of products using the RowNumber member of the render object's DataBinding 

property in the text expression: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.DataBinding.C1DataBinding.html
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To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Dim dSrc As New DataSource() 

dSrc.ConnectionProperties.DataProvider = DataProviderEnum.OLEDB 

dSrc.ConnectionProperties.ConnectString = _ 

  "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C1NWIND.MDB" 

C1.C1Preview.DataBinding.DataSet dSet1 = _ 

  new C1.C1Preview.DataBinding.DataSet(dSrc, _ 

  "select * from Products") 

doc.DataSchema.DataSources.Add(dSrc) 

doc.DataSchema.DataSets.Add(dSet1) 

Dim rt As New RenderText() 

rt.DataBinding.DataSource = dSet1 

rt.Text = "[DataBinding.RowNumber]: [Fields!ProductName.Value]" 

doc.Body.Children.Add(rt) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

DataSource dSrc = new DataSource(); 

dSrc.ConnectionProperties.DataProvider = DataProviderEnum.OLEDB; 

dSrc.ConnectionProperties.ConnectString = 

  @"Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C1NWIND.MDB"; 

C1.C1Preview.DataBinding.DataSet dSet1 = 

  new C1.C1Preview.DataBinding.DataSet(dSrc, 

  "select * from Products"); 

doc.DataSchema.DataSources.Add(dSrc); 

doc.DataSchema.DataSets.Add(dSet1); 

RenderText rt = new RenderText(); 

rt.DataBinding.DataSource = dSet1; 

rt.Text = "[DataBinding.RowNumber]: [Fields!ProductName.Value]"; 

doc.Body.Children.Add(rt); 
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IDs accessible in expressions within Filter, 

Grouping and Sorting 
Working with C1PrintDocument > Expressions, Scripts, Tags > IDs accessible in expressions within Filter, 

Grouping and Sorting 

In filter, grouping and sorting expressions, the following subset of IDs are accessible: 

 Document (type C1PrintDocument) 

 DataBinding (type C1DataBinding) 

 Fields (FieldCollection) 

For details on those object types, see IDs Accessible in Text Expressions. 

IDs accessible in expressions used to specify 

calculated fields in a DataSet 
Working with C1PrintDocument > Expressions, Scripts, Tags > IDs accessible in expressions used to specify 

calculated fields in a DataSet 

In expressions used to specify calculated fields in data sets, the following subset of IDs are 

accessible: 

 Document (type C1PrintDocument) 

 Fields (FieldCollection) 

For details on those object types, see IDs Accessible in Text Expressions. 

Data Binding 
Working with C1PrintDocument > Data Binding 

In addition to creating a C1PrintDocument fully (including data) in code, a C1PrintDocument 

may be data bound. In that case, the actual document is produced when the document is filled 

with data from the database during generation. 

The main property facilitating data binding is the DataBinding property on RenderObject , of 

the type C1DataBinding, which allows to specify the data source for data shown by the render 

object. Additionally, the data binding can indicate that the render object must be repeated for 

all records in the data source, in which case the render object becomes similar to a "band" from 

a banded report generator. This is similar to the RDL definition from Microsoft. 

Thus for data bound documents, document generation involves two stages: 

 All data bound render objects are selected, and used (as templates) to create the "real" 

render objects based on data. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.DataBinding.C1DataBinding.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.DataBinding.FieldCollection.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.DataBinding.FieldCollection.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.DataBinding.C1DataBinding.html
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 The resulting document is paginated as a non-data bound document. 

The document can contain the database schema (represented by the class C1DataSchema, and 

including the data base connection info, SQL queries, and so on) inside. The C1DataBinding 

objects within the document can reference properties of that schema. If all data bound objects 

in a document reference only the properties of the C1DataSchema of the document itself, the 

document becomes "data reflowable" - that is, the document can be regenerated 

independently of the program used to create it, with data completely updated from the 

database. 

Also, the C1DataBinding may reference existing data sources (DataTable and so on) which were 

created on the form or elsewhere in the program that created that C1PrintDocument. In this 

case, of course, the document can only be regenerated with updating the data only in the 

context of that program, and saving and later loading that document (as a C1D or C1DX file) 

will break any connection with the data. 

See Also 

Data Binding in Render Objects 

Data Binding Examples 

Data Aggregates 

Data Binding in Render Objects 
Working with C1PrintDocument > Data Binding > Data Binding in Render Objects 

Show All  

Hide All  

When a render object is created, the data binding for it is not created initially. It is created when 

the DataBinding property is referenced in user code. For example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt As RenderText = New RenderText 

' ... 

If Not (rt.DataBinding Is Nothing) Then 

MessageBox.Show("Data binding defined.") 

End If 

To write code in C# 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.DataBinding.C1DataSchema.html


 

 426 

C# Copy Code  

 

RenderText rt = new RenderText(); 

// ... 

if (rt.DataBinding != null) 

{ 

MessageBox.Show("Data binding defined."); 

} 

The condition in the previous code will always evaluate to True. Thus if you only want to check 

whether data binding exists on a particular render object, you should use the 

DataBindingDefined property instead: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt As RenderText = New RenderText 

' ... 

If rt.DataBindingDefined Then 

MessageBox.Show("Data binding defined.") 

End If 

To write code in C# 

C# Copy Code  

 

RenderText rt = new RenderText(); 

// ... 

if (rt.DataBindingDefined) 

{ 

MessageBox.Show("Data binding defined."); 

} 

 

Note: This is similar to the Handle and IsHandleCreated properties of the WinForms 

Control class. 

During document generation the RenderObjectsList collection is formed. Three different 

situations are possible as a result: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~DataBindingDefined.html
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 The Copies property on the render object is null. This means that the object is not data 

bound, and is processed as usual. The Fragments property of the object can be used to 

access the actual rendered fragments of the object on the generated pages. 

 The Copies property on the render object is not null, but Copies.Count is 0. This means 

that the object is data bound, but the data set is empty (contains no records). In such 

situations the object is not show in the document at all, that is, no fragments are 

generated for the object. For an example see Binding to the Empty List in the 

DataBinding sample. 

 The Copies property on the render object is not null and Copies.Count is greater than 

0. This means that the object is data bound, and the data source is not empty (contains 

records). During the document generation, several copies of the render object will be 

created and placed in this collection. Those copies will then be processed and 

fragments will be generated for each copy as usual. 

See Also 
Data bound tables 

Data bound tables 
Working with C1PrintDocument > Data Binding > Data Binding in Render Objects > Data bound tables 

Show All  

Hide All  

Using the DataBinding property in the TableVectorGroup, which is the base class for table row 

and column groups, a RenderTable can be data bound. 

For examples of binding to a RenderTable, see the DataBinding sample installed in the 

ComponentOne Samples folder. 

Note that not only groups of rows, but also groups of columns can data bound. That is, a table 

can grow not only down, but also sideways. 

Grouping will work, but note that group hierarchy is based on the hierarchy of 

TableVectorGroup objects, as shown in the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt As C1.C1Preview.RenderTable = New C1.C1Preview.RenderTable 

rt.Style.GridLines.All = C1.C1Preview.LineDef.Default 

  

' Table header: 

Dim c As C1.C1Preview.TableCell = rt.Cells(0, 0) 

c.SpanCols = 3 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableVectorGroup.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderTable.html
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c.Text = "Header" 

  

' Group header: 

c = rt.Cells(1, 0) 

c.Text = "GroupId = [Fields!GroupId.Value]" 

c.SpanCols = 3 

c.Style.TextAlignHorz = C1.C1Preview.AlignHorzEnum.Center 

c.Style.TextAlignVert = C1.C1Preview.AlignVertEnum.Center 

  

' Sub-group header: 

c = rt.Cells(2, 0) 

c.Text = "GroupId = [Fields!GroupId.Value] SubGroupId = 

[Fields!SubGroupId.Value]" 

c.SpanCols = 3 

c.Style.TextAlignHorz = C1.C1Preview.AlignHorzEnum.Center 

c.Style.TextAlignVert = C1.C1Preview.AlignVertEnum.Center 

  

' Sub-group data: 

rt.Cells(3, 0).Text = "GroupId=[Fields!GroupId.Value]" 

rt.Cells(3, 1).Text = "SubGroupId=[Fields!SubGroupId.Value]" 

rt.Cells(3, 2).Text = "IntValue=[Fields!IntValue.Value]" 

  

' Create a group of data bound lines, grouped by the GroupId field: 

Dim g As C1.C1Preview.TableVectorGroup = rt.RowGroups(1, 3) 

g.CanSplit = True 

g.DataBinding.DataSource = MyData.Generate(20, 0) 

g.DataBinding.Grouping.Expressions.Add("Fields!GroupId.Value") 

g.Style.BackColor = Color.LightCyan 

  

' Create a nested group, grouped by SubGroupId: 

Dim ng As C1.C1Preview.TableVectorGroup = rt.RowGroups(2, 2) 

ng.CanSplit = True 

ng.DataBinding.DataSource = g.DataBinding.DataSource 

ng.DataBinding.Grouping.Expressions.Add("Fields!SubGroupId.Value") 

ng.Style.BackColor = Color.LightPink 

  

' Create yet deeper nested data bound group: 

Dim ng2 As C1.C1Preview.TableVectorGroup = rt.RowGroups(3, 1) 

ng2.DataBinding.DataSource = g.DataBinding.DataSource 

ng2.Style.BackColor = Color.LightSteelBlue 

To write code in C# 
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C# Copy Code  

 

RenderTable rt = new RenderTable(); 

rt.Style.GridLines.All = LineDef.Default; 

  

// Table header: 

TableCell c = rt.Cells[0, 0]; 

c.SpanCols = 3; 

c.Text = "Header"; 

  

// Group header: 

c = rt.Cells[1, 0]; 

c.Text = "GroupId = [Fields!GroupId.Value]"; 

c.SpanCols = 3; 

c.Style.TextAlignHorz = AlignHorzEnum.Center; 

c.Style.TextAlignVert = AlignVertEnum.Center; 

  

// Sub-group header: 

c = rt.Cells[2, 0]; 

c.Text = "GroupId = [Fields!GroupId.Value] SubGroupId = 

[Fields!SubGroupId.Value]"; 

c.SpanCols = 3; 

c.Style.TextAlignHorz = AlignHorzEnum.Center; 

c.Style.TextAlignVert = AlignVertEnum.Center; 

  

// Sub-group data: 

rt.Cells[3, 0].Text = "GroupId=[Fields!GroupId.Value]"; 

rt.Cells[3, 1].Text = "SubGroupId=[Fields!SubGroupId.Value]"; 

rt.Cells[3, 2].Text = "IntValue=[Fields!IntValue.Value]"; 

  

// Create a group of data bound lines, grouped by the GroupId field: 

TableVectorGroup g = rt.RowGroups[1, 3]; 

g.CanSplit = true; 

g.DataBinding.DataSource = MyData.Generate(20, 0); 

g.DataBinding.Grouping.Expressions.Add("Fields!GroupId.Value"); 

g.Style.BackColor = Color.LightCyan; 

  

// Create a nested group, grouped by SubGroupId: 

TableVectorGroup ng = rt.RowGroups[2, 2]; 

ng.CanSplit = true; 

ng.DataBinding.DataSource = g.DataBinding.DataSource; 
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ng.DataBinding.Grouping.Expressions.Add("Fields!SubGroupId.Value"); 

ng.Style.BackColor = Color.LightPink; 

  

// Create yet deeper nested data bound group: 

TableVectorGroup ng2 = rt.RowGroups[3, 1]; 

ng2.DataBinding.DataSource = g.DataBinding.DataSource; 

ng2.Style.BackColor = Color.LightSteelBlue; 

The above code can be illustrated by the following table: 

   Header 

Gro

up 

1, 3 

  GroupId = [Fields!GroupId.Value] 

Gro

up 

2, 2 

 GroupId = [Fields!GroupId.Value] SubGroupId = [Fields!SubGroupId.Value] 

Gro

up 

3, 1 

GroupId=[Fields!Group

Id.Value] 

SubGroupId=[Fields!SubGro

upId.Value] 

IntValue=[Fields!IntVal

ue.Value] 

 

Data Binding Examples 
Working with C1PrintDocument > Data Binding > Data Binding Examples 

The DataBinding sample, available on HelpCentral, contains several examples of data bound 

documents. Some of the issues from that sample are discussed in the following topics. 

See Also 

Working With Groups 

Using Aggregates 

Working With Groups 
Working with C1PrintDocument > Data Binding > Data Binding Examples > Working With Groups 

Show All  

Hide All  

A typical use of grouping is demonstrated by the following code: 

To write code in Visual Basic 

http://helpcentral.componentone.com/Samples.aspx
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Visual Basic Copy Code  

 

' A RenderArea is created that is to be repeated for each group. 

Dim ra As C1.C1Preview.RenderArea = New C1.C1Preview.RenderArea 

ra.Style.Borders.All = New C1.C1Preview.LineDef("2mm", Color.Blue) 

  

' MyData array of objects is used as the data source: 

ra.DataBinding.DataSource = MyData.Generate(100, 0) 

  

' Data is grouped by the GroupId field: 

ra.DataBinding.Grouping.Expressions.Add("Fields!GroupId.Value") 

  

' Create a RenderText that will serve as the group header; In a general case, 

the header can be complex and itself be data bound: 

Dim rt As C1.C1Preview.RenderText = New C1.C1Preview.RenderText 

  

' The group header will look like "GroupId = XXX", where XXX is the value of 

the GroupId field in the group: 

rt.Text = "GroupId: [Fields!GroupId.Value]" 

rt.Style.BackColor = Color.Yellow 

  

' Add the header to the group area: 

ra.Children.Add(rt) 

  

' This RenderText will print records within each group: 

rt = New C1.C1Preview.RenderText 

  

' The text to print for each record: 

rt.Text = "GroupId: [Fields!GroupId.Value]" & Microsoft.VisualBasic.Chr(13) & 

"IntValue: [Fields!IntValue.Value]" 

rt.Style.Borders.Bottom = C1.C1Preview.LineDef.Default 

rt.Style.BackColor = Color.FromArgb(200, 210, 220) 

  

' Set the text's data source to the data source of the containing RenderArea 

- this indicates that the render object is bound to the current group 

in the specified object: 

rt.DataBinding.DataSource = ra.DataBinding.DataSource 

  

' Add the text to the area: 

ra.Children.Add(rt) 
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To write code in C# 

C# Copy Code  

 

// A RenderArea is created that is to be repeated for each group. 

RenderArea ra = new RenderArea(); 

ra.Style.Borders.All = new LineDef("2mm", Color.Blue); 

  

// MyData array of objects is used as the data source: 

ra.DataBinding.DataSource = MyData.Generate(100, 0); 

  

// Data is grouped by the GroupId field: 

ra.DataBinding.Grouping.Expressions.Add("Fields!GroupId.Value"); 

  

// Create a RenderText that will serve as the group header; In ageneral case, 

the header can be complex and itself be data bound: 

RenderText rt = new RenderText(); 

  

// The group header will look like "GroupId = XXX", where XXX is thevalue of 

the GroupId field in the group: 

rt.Text = "GroupId: [Fields!GroupId.Value]"; 

rt.Style.BackColor = Color.Yellow; 

  

// Add the header to the group area: 

ra.Children.Add(rt); 

  

// This RenderText will print records within each group: 

rt = new RenderText(); 

  

// The text to print for each record: 

rt.Text = "GroupId: [Fields!GroupId.Value]\rIntValue: 

[Fields!IntValue.Value]"; 

rt.Style.Borders.Bottom = LineDef.Default; 

rt.Style.BackColor = Color.FromArgb(200, 210, 220); 

  

// Set the text's data source to the data source of the containing RenderArea 

- this indicates that the render object is bound to thecurrent group 

in the specified object: 

rt.DataBinding.DataSource = ra.DataBinding.DataSource; 

  

// Add the text to the area: 



 

 433 

ra.Children.Add(rt); 

 

Using Aggregates 
Working with C1PrintDocument > Data Binding > Data Binding Examples > Using Aggregates 

Show All  

Hide All  

The code below expands on the previous example by introducing aggregates in groups and the 

document as a whole: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Create a Render area to be repeated for each group: 

Dim ra As C1.C1Preview.RenderArea = New C1.C1Preview.RenderArea 

ra.Style.Borders.All = New C1.C1Preview.LineDef("2mm", Color.Blue) 

ra.DataBinding.DataSource = MyData.Generate(20, 0, True) 

ra.DataBinding.Grouping.Expressions.Add("Fields!GroupId.Value") 

  

' Make an aggregate that will calc the sum of IntValue fields within each 

group: 

Dim agg As C1.C1Preview.DataBinding.Aggregate = New 

C1.C1Preview.DataBinding.Aggregate("Group_IntValue") 

  

' Define the expression that will calc the sum: 

agg.ExpressionText = "Fields!IntValue.Value" 

  

' Specify that aggregate should have group scope: 

agg.Running = C1.C1Preview.DataBinding.RunningEnum.Group 

  

' Specify the data source for the aggregate: 

agg.DataBinding = ra.DataBinding 

  

' Add the aggregate to the document: 

doc.DataSchema.Aggregates.Add(agg) 

  

' Make an aggregate that will calc the sum of IntValue fields over the whole 

document: 
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agg = New C1.C1Preview.DataBinding.Aggregate("Total_IntValue") 

  

' Define the expression to calc the sum: 

agg.ExpressionText = "Fields!IntValue.Value" 

  

' Specify that aggregate should have document scope: 

agg.Running = C1.C1Preview.DataBinding.RunningEnum.All 

  

' Specify the data source for the aggregate: 

agg.DataBinding = ra.DataBinding 

  

' Add the aggregate to the document: 

doc.DataSchema.Aggregates.Add(agg) 

  

' Make the group header: 

Dim rt As C1.C1Preview.RenderText = New C1.C1Preview.RenderText 

rt.Text = "GroupId: [Fields!GroupId.Value]" 

rt.Style.BackColor = Color.Yellow 

ra.Children.Add(rt) 

  

' This render text will print group records; as can be seen, group aggregate 

values can be referenced not only in group footer but also in group 

header and in group detail: 

rt = New C1.C1Preview.RenderText 

rt.Text = "GroupId: 

[Fields!GroupId.Value]\rIntValue:[Fields!IntValue.Value]\rGroup_IntValue:[Agg

regates!Group_IntValue.Value]\rTotal_IntValue:[Aggregates!Total_IntValue.Valu

e]\rTatalNested_IntValue:[Aggregates!TatalNested_IntValue.Value]" 

 

rt.Style.Borders.Bottom = C1.C1Preview.LineDef.Default 

rt.Style.BackColor = Color.FromArgb(200, 210, 220) 

rt.DataBinding.DataSource = ra.DataBinding.DataSource 

ra.Children.Add(rt) 

  

' This aggregate is also calculated over the group, but is connected to the 

data binding of the nested object: 

agg = New C1.C1Preview.DataBinding.Aggregate("TotalNested_IntValue") 

agg.ExpressionText = "Fields!IntValue.Value" 

agg.Running = RunningEnum.All 

agg.DataBinding = rt.DataBinding 

doc.DataSchema.Aggregates.Add(agg) 
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' Add the area to the document: 

doc.Body.Children.Add(ra) 

To write code in C# 

C# Copy Code  

 

// Create a Render area to be repeated for each group: 

RenderArea ra = new RenderArea(); 

ra.Style.Borders.All = new LineDef("2mm", Color.Blue); 

ra.DataBinding.DataSource = MyData.Generate(20, 0, true); 

ra.DataBinding.Grouping.Expressions.Add("Fields!GroupId.Value"); 

  

// Make an aggregate that will calc the sum of IntValue fields within each 

group: 

Aggregate agg = new Aggregate("Group_IntValue"); 

  

// Define the expression that will calc the sum: 

agg.ExpressionText = "Fields!IntValue.Value"; 

  

// Specify that aggregate should have group scope: 

agg.Running = RunningEnum.Group; 

  

// Specify the data source for the aggregate: 

agg.DataBinding = ra.DataBinding; 

  

// Add the aggregate to the document: 

doc.DataSchema.Aggregates.Add(agg); 

  

// Make an aggregate that will calc the sum of IntValue fields over the whole 

document: 

agg = new Aggregate("Total_IntValue"); 

  

// Define the expression to calc the sum: 

agg.ExpressionText = "Fields!IntValue.Value"; 

  

// Specify that aggregate should have document scope: 

agg.Running = RunningEnum.All; 

  

// Specify the data source for the aggregate: 

agg.DataBinding = ra.DataBinding; 
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// Add the aggregate to the document: 

doc.DataSchema.Aggregates.Add(agg); 

  

// Make the group header: 

RenderText rt = new RenderText(); 

rt.Text = "GroupId: [Fields!GroupId.Value]"; 

rt.Style.BackColor = Color.Yellow; 

ra.Children.Add(rt); 

  

// This render text will print group records; as can be seen, group aggregate 

values can be referenced not only in group footer but also in group 

header and in group detail: 

rt = new RenderText(); 

rt.Text = "GroupId: 

[Fields!GroupId.Value]\rIntValue:[Fields!IntValue.Value]\rGroup_IntValue:[Agg

regates!Group_IntValue.Value]\rTotal_IntValue:[Aggregates!Total_IntValue.Valu

e]\rTatalNested_IntValue:[Aggregates!TatalNested_IntValue.Value]"; 

 

rt.Style.Borders.Bottom = LineDef.Default; 

rt.Style.BackColor = Color.FromArgb(200, 210, 220); 

rt.DataBinding.DataSource = ra.DataBinding.DataSource; 

ra.Children.Add(rt); 

  

// This aggregate is also calculated over the group, but is connected to the 

data binding of the nested object: 

agg = new Aggregate("TotalNested_IntValue"); 

agg.ExpressionText = "Fields!IntValue.Value"; 

agg.Running = RunningEnum.All; 

agg.DataBinding = rt.DataBinding; 

doc.DataSchema.Aggregates.Add(agg); 

  

// Add the area to the document: 

doc.Body.Children.Add(ra); 

Note that there are also aggregate types that can be used in data-bound C1PrintDocument 

without declaring them in the document's aggregates collection (Aggregates). For more details 

and an example, see the Data Aggregates topic. 

Data Aggregates 
Working with C1PrintDocument > Data Binding > Data Aggregates 

Show All  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.DataBinding.C1DataSchema~Aggregates.html
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Hide All  

In the 2010 v1 release, new aggregates were added to Reports for WinForms. These aggregate 

types can be used in data-bound C1PrintDocument without the need to declare them in the 

document's aggregates collection (Aggregates). 

For instance, if "Balance" is a data field in a data-bound document, the following RenderText 

can be used to print the total balance for the dataset: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim rt As New RenderText("[Sum(""Fields!Balance.Value"")]") 

To write code in C# 

C# Copy Code  

 

RenderText rt = new RenderText("[Sum(\"Fields!Balance.Value\")]"); 

The following new properties and methods were added to the DataSet and C1DataBinding 

types to support this feature: 

Class Member Description 

C1DataBinding  Name property Gets or sets the name of the current 

C1DataBinding. That name can be used in 

aggregate functions to indicate which data 

binding the aggregate refers to. 

DataSet  Name property Gets or sets the name of the current 

DataSet. That name can be used in 

aggregate functions to indicate which data 

set the aggregate refers to. 

All aggregate functions have the follwing format: 

AggFunc(expression, scope) 

where: 
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 expression is a string defining an expression calculated for each row group or dataset 

row. 

 scope is a string identifying the set of data for which the aggregate is calculated. If 

omitted, the aggregate is calculated for the current set of data (such as for the current 

group, dataset, and so on). If specified, should be the name of the target group or 

dataset. 

For example, if a dataset has the following fields, ID, GroupID, SubGroupID, NAME, Q, and 

records are grouped by GroupID and SubGroupID, the following document can be created: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

Dim raGroupId As New RenderArea() 

' set up raGroupId properties as desired... 

raGroupID.DataBinding.DataSource = dataSet 

raGroupID.DataBinding.Name = "GroupID" 

raGroupID.DataBinding.Grouping.Expressions.Add("Fields!GroupID.Value") 

  

Dim raSubGroupID As New RenderArea() 

' set up raSubGroupID properties as desired... 

raSubGroupID.DataBinding.DataSource = dataSet 

raSubGroupID.DataBinding.Grouping.Expressions.Add("Fields!SubGroupID.Value") 

raGroupID.Children.Add(raSubGroupID) 

  

Dim raDetail As New RenderArea() 

' set up raDetail properties as desired... 

raDetail.DataBinding.DataSource = dataSet 

raSubGroupID.Children.Add(raDetail) 

  

' show value of Q field: 

Dim rtQ As New RenderText() 

rtQ.Text = "[Fields!Q.Value]" 

raDetail.Children.Add(rtQ) 

  

' show sum of Q field for nested group (SubGroupID): 

Dim rtSumQ1 As New RenderText() 

rtSumQ1.Text = "[Sum(""Fields!Q.Value"")]" 

raDetail.Children.Add(rtSumQ1) 

' show sum of Q field for GroupID: 

Dim rtSumQ2 As New RenderText() 
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rtSumQ2.Text = "[Sum(\"Fields!Q.Value\", "\"GroupID\"")]" 

raDetail.Children.Add(rtSumQ2) 

' show TOTAL sum of Q field for the entire dataset: 

Dim rtSumQ3 As New RenderText() 

rtSumQ3.Text = "[Sum(\"Fields!Q.Value\", "\"DataSet\"")]" 

raDetail.Children.Add(rtSumQ3) 

doc.Body.Children.Add(raGroupId) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

RenderArea raGroupId = new RenderArea(); 

// set up raGroupId properties as desired... 

raGroupID.DataBinding.DataSource = dataSet; 

raGroupID.DataBinding.Name = "GroupID"; 

raGroupID.DataBinding.Grouping.Expressions.Add("Fields!GroupID.Value"); 

  

RenderArea raSubGroupID = new RenderArea(); 

// set up raSubGroupID properties as desired... 

raSubGroupID.DataBinding.DataSource = dataSet; 

raSubGroupID.DataBinding.Grouping.Expressions.Add("Fields!SubGroupID.Value"); 

raGroupID.Children.Add(raSubGroupID); 

  

RenderArea raDetail = new RenderArea(); 

// set up raDetail properties as desired... 

raDetail.DataBinding.DataSource = dataSet; 

raSubGroupID.Children.Add(raDetail); 

  

// show value of Q field: 

RenderText rtQ = new RenderText(); 

rtQ.Text = "[Fields!Q.Value]"; 

raDetail.Children.Add(rtQ); 

// show sum of Q field for nested group (SubGroupID): 

RenderText rtSumQ1 = new RenderText(); 

rtSumQ1.Text = "[Sum(\"Fields!Q.Value\")]"; 

raDetail.Children.Add(rtSumQ1); 

// show sum of Q field for GroupID: 

RenderText rtSumQ2 = new RenderText(); 

rtSumQ2.Text = "[Sum(\"Fields!Q.Value\", "\"GroupID\"")]"; 
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raDetail.Children.Add(rtSumQ2); 

// show TOTAL sum of Q field for the entire dataset: 

RenderText rtSumQ3 = new RenderText(); 

rtSumQ3.Text = "[Sum(\"Fields!Q.Value\", "\"DataSet\"")]"; 

raDetail.Children.Add(rtSumQ3); 

  

doc.Body.Children.Add(raGroupId); 

When the above document is generated, each instance of the raDetail group will show four 

values as follows: 

 the current value of "Q" field 

 the sum of the "Q" field over the current SubGroupID 

 the sum of the "Q" field over the current GroupID 

 the sum of the "Q" field over the whole document 

Table of Contents 
Working with C1PrintDocument > Table of Contents 

C1PrintDocument supports automatic generation of table of contents (TOC). The table of 

contents itself is represented by a dedicated render object, RenderToc, which is derived from 

RenderArea and adds TOC-specific features. Individual items within the TOC are represented by 

RenderTocItem (derived from RenderParagraph). Each TOC item holds a hyperlink (the 

RenderTocItem.Hyperlink property) pointing to a location in the document (represented by an 

anchor). So, the same mechanism is used for connecting TOC items to document content as for 

hyperlinks. Convenient methods are provided to create the TOC, see below. 

To add a table of contents to your document, do the following: 

1. Create an instance of the RenderToc class and add it to your document at the point 

where you want the TOC to appear. 

2. Add individual items (of the type RenderTocItem) to the RenderToc instance. Any of the 

following approaches (or a mix of them) may be used for this:  

o You may add the TOC item to the TOC using any of the overloads of the 

RenderToc.AddItem method, providing the text of the item, the location it 

should point to, and optionally the level in the TOC. 

o You may create an instance of the RenderTocItem class in your code, set 

properties on it, and add it to the Children collection of the TOC render object. 

o An overload of the RenderTocItem constructor is provided which accepts an 

instance of the RenderToc as the argument. When that constructor is used, the 

newly created TOC item is added to the TOC within the constructor, so you do 

not need to add it to the Children collection of the TOC object manually. 

For a complete sample of how to create the table of contents for a document using the 

dedicated RenderToc render object, see the RenderTOC sample installed in the 

ComponentOne Samples folder. 
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Word Index 
Working with C1PrintDocument > Word Index 

You can now automatically generate indexes using C1PrintDocument. Each index (there can be 

several indexes in a document) consists of an alphabetized sorted list of letter headings with 

entries followed by lists of page numbers where the entry occurs. 

An index is represented by an instance of the RenderIndex class, a render object derived from 

RenderArea. You can add that object to the document as you would any other render object, 

but with one important limitation: the index must appear in the document after all occurrences 

of entries (terms) contained in it; so, like the traditional index, the index here would be best 

served to appear at the end of the document. 

Terms are words and word combinations that occur in the document and should appear as 

entries in the index. When the document is created, these terms are added to the RenderIndex 

object together with information about locations where they occur (usually the RenderText or 

RenderParagraph containing the term). Then, when the document generates, the RenderIndex 

object produces the actual index. 

See Also 

Classes Supporting the Index Feature 

Generating an Index In Code 

Customizing the Index's Appearance 

The Structure of the Generated Index 

Classes Supporting the Index Feature 
Working with C1PrintDocument > Word Index > Classes Supporting the Index Feature 

The following specialized classes support indexing: 

 RenderIndex: This class is derived from RenderArea, and produces the index when 

inserted in a C1PrintDocument and that document generates.  

o The RenderIndex must appear in the document after all occurrences of the 

index entries. The reason for this limitation is that the actual content of the 

index (and hence, the amount of space occupied by it) may vary significantly 

depending on the occurrences of the entries. 

 IndexEntry: This class is used to describe an index entry (term) in the index.  

o Each entry can have multiple occurrences (locations in the document where the 

term is described or referenced) associated with it. The collection of all 

occurrences of an entry is exposed via the Occurrences property on the 

IndexEntry. 

o Each occurrence will produce a hyperlinked page number in the index when the 

document is generated. Besides which, an entry may contain a list of sub-
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entries (exposed by the property Children). The nesting level is unlimited, 

though usually up to 3 levels are used. 

o Finally, to allow linking an entry to other entries in the index, the SeeAlso 

property on the entry contains a list of index entries that will be listed as 

references for the current entry in the generated index. 

 IndexEntryOccurrence: This class describes a single occurrence of an entry in the 

document.  

o Elements of this type are contained in the Occurrences collection of an 

IndexEntry. 

o One or more occurrences can be specified (as parameters to the constructor) 

when an instance of an index entry is created, and more occurrences can be 

added to the entry later. 

o The main functional property of this class is Target, of the type C1LinkTarget, 

which points to the location of the occurrence. 

Generating an Index In Code 
Working with C1PrintDocument > Word Index > Generating an Index In Code 

Typically, the following steps would be involved in providing a simple one-level index in a 

document that is created in code: 

1. An instance of the RenderIndex class should be created and stored in a local variable 

(as noted above, the index may not precede the occurrences of its entries). 

2. As content (render objects) is added to the document, some program logic should 

identify strings that are to become entries (terms) in the index. Each such string should 

be tested on whether it has already been added to the Entries collection of the index 

object created in step 1. If this is a new entry, a new IndexEntry object should be 

created for it, and added to the index. 

3. An entry occurrence (IndexEntryOccurrence) should be added to the existing or newly 

created entry, to point to the location of the occurrence in the document. Usually the 

location would be identified by the RenderObject that contains it and is being added to 

the document. 

4. When all occurrences of the entries have been added to the document, the 

RenderIndex object created in step 1 can be added to the document's body. 

5. When the document is generated, the RenderIndex object produces a hyperlinked 

index of the entries that have been added to it. The entries are automatically sorted, 

split into groups corresponding to each letter, and letter headings added. 

Of course, this is only one simple possible scenario designed to demonstrate the relationship 

between the main objects involved in creating an index. Other possibilities include the creation 

of indexed terms (index entries) prior to document creation (for example, based on an external 

dictionary of terms), adding nested entries (sub-entries), and so on. 

Customizing the Index's Appearance 
Working with C1PrintDocument > Word Index > Customizing the Index's Appearance 

Customizing the Index's Appearance 
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The following properties are provided to customize the way the generated index looks: 

Styles (see also Styles): 

 Style: specifies the style for the whole index (including headings, entries, and so on). 

 HeadingStyle: specifies the style used for letter headings (the heading is a letter 

preceding the group of entries starting with that letter). In the generated index, each 

heading (usually just the capitalized letter preceding the group of entries beginning 

with it) is represented by a separate render object (RenderText) to which this style is 

applied. 

 EntryStyles: an indexed property specifying the styles of entries at different levels. For 

instance, EntryStyles[0] (EntryStyles(0) in VB) specifies the style of entries at the top 

level, EntryStyles[1] (EntryStyles(1) in VB) specifies the style of sub-entries, and so on. (If 

the number of nested levels in the index is greater than the number of elements in the 

EntryStyles collection, the last style in the collection is used for nested styles.) 

 In the generated index, each entry (the term followed by the list of pages where it 

appears) is represented by a separate RenderParagraph object, to which the style 

determined by this property indexed by the entry's nesting level is applied. For instance, 

this style allows you to specify the minimum number of lines of an entry text before a 

page break can be inserted (via MinOrphanLines). 

 EntryStyle: this is a shortcut for the first (with index 0) element of the EntryStyles 

collection. 

 SeeAlsoStyle: allows you to specify the style of the "see also" text used to precede cross 

references between entries (see SeeAlso). 

 Style: allows you to override the style for a particular entry. 

 SeeAlsoStyle: allows you to override the style of the "see also" text for a particular entry. 

Other properties: 

 RunIn: a Boolean property (False by default) which, if True, indicates that sub-entries 

should appear in line with the main heading rather than indented on separate lines. 

 EntryIndent: a Unit property specifying the indent of sub-entries relative to the main 

entry. The default is 0.25 inch. 

 EntryHangingIndent: a Unit property specifying the hanging indent (to the left) of the 

first line of an entry's text relative to the following lines (used if the list of references 

does not fit on a single line). The default is -0.125 inch. 

 LetterSplitBehavior: a SplitBehaviorEnumproperty that determines how a letter group 

(entries starting with the same letter) can be split vertically. The default is 

SplitBehaviorEnum.SplitIfNeeded. Note that headings (represented by their letters by 

default) are always printed together with their first entry. 

 Italic: similar to Bold but uses italic face instead of bold. 

 LetterFormat: a string used to format the letter headings. The default is "{0}". 

 TermDelimiter: a string used to delimit the entry term and the list of term's occurrences 

(page numbers). The default is a comma followed by a space. 

 RunInDelimiter: a string used to delimit the entries when a run-in index is generated. 

The default is a semicolon. 

 OccurrenceDelimiter: a string used to delimit the list of occurrences of an entry (page 

numbers). The default is a comma followed by a space. 

 PageRangeFormat: a format string used to format page ranges of entries' occurrences. 

The default is "{0}-{1}". 
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 SeeAlsoFormat: a string used to format the "see also" references. The default is " (see 

{0})" (a space, followed by an opening parentheses, followed by the format item used to 

output the reference, followed by a closing parentheses). 

 FillChar: a character used as filler when the page numbers are aligned to the right 

(PageNumbersAtRight is True). The default value of this property is a dot. 

 PageNumbersAtRight: a Boolean property indicating whether to right-align the page 

numbers. The default is False. 

 EntrySplitBehavior: a SplitBehaviorEnum property that determines how a single entry 

can split vertically. The default is SplitBehaviorEnum.SplitIfLarge. This property applies 

to entries at all levels. 

 Bold: a Boolean property that allows you to highlight the page number corresponding 

to a certain occurrence of an entry using bold face. (For example, this can be used to 

highlight the location where the main definition of a term is provided. 

See Also 
Index Styles Hierarchy 

Index Styles Hierarchy 
Working with C1PrintDocument > Word Index > Customizing the Index's Appearance > Index Styles 

Hierarchy 

The hierarchy of index-specific styles is as follows: 

 Style, of the RenderIndex object, serves as AmbientParent for all other index-specific 

styles 

 HeadingStyle 

 EntryStyles  

o Style 

 SeeAlsoStyle  

o SeeAlsoStyle 

With the exception of the Style of RenderIndex, all of the styles listed above serve as both 

Parent and AmbientParent for the inline styles of related objects. So for example, while setting a 

font on the Style of a RenderIndex will affect all elements of that index (unless overridden by a 

lower-level style), specifying a border on that style will draw that border around the whole index 

but not around individual elements in it. On the other hand, specifying a border on 

SeeAlsoStyle for instance will draw borders around each "see also" element in the index. 

The Structure of the Generated Index 
Working with C1PrintDocument > Word Index > The Structure of the Generated Index 

The following figure shows the structure and hierarchy of the render object tree created by a 

RenderIndex object when the document generates (note that in the figure, only the 

RenderIndex object at the top level is created by user code; all other objects are created 

automatically): 

RenderIndex 
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RenderArea (represents a group of entries starting with the same letter) 

RenderText (prints letter group header) 

RenderParagraph (prints top-level IndexEntry) 

RenderParagraph (prints sub-entry, offset via Left) 

... 

RenderArea (represents a group of entries starting with the same letter) 

RenderText (prints letter group header) 

RenderParagraph (prints top-level IndexEntry) 

RenderParagraph (prints sub-entry, offset via Left) 

... 

Outline 
Working with C1PrintDocument > Outline 

C1PrintDocument supports outlines. The document outline is a tree (specified by the Outlines 

property), with nodes (of the type OutlineNode) pointing to locations in the document. The 

outline is shown on a tab in the navigation panel of the preview, and allows navigating to 

locations corresponding to items by clicking on the items. Also, outlines are exported to formats 

supporting that notion (such as PDF). 

To create an outline node, use any of the overloaded Outline constructors. You can specify the 

text of the outline, the location within the document (a render object or an anchor), and an icon 

to be shown in the outline tree panel in the preview. Top-level nodes should be added to the 

Outlines collection of the document. Each outline node may, in its turn, contain a collection of 

child nodes in the Children collection, and so on. 

 

Tip: The outline nodes for each item that is being rendered on document can be clicked. 

Clicking a node will show the items attached with that node. For an example of how to add 

outline nodes, see Adding Outline Entries to the Outline Tab. 

 

Embedded Fonts 
Working with C1PrintDocument > Embedded Fonts 

When a C1PrintDocument is saved as a C1DX or C1D file, fonts used in the document may be 

embedded in that file. In that case, when that document is loaded from the file on a different 

system, text drawn with fonts that have been embedded is guaranteed to render correctly even 
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if the current system does not have all the original fonts installed. Font embedding may be 

particularly useful when rare or specialized fonts are used (such as, a font drawing barcodes). 

Note that when a font is embedded in a C1PrintDocument that does not mean that all glyphs 

from that font are embedded. Instead, just the glyphs actually used in the font are embedded. 

The following C1PrintDocument properties are related to font embedding: 

 EmbeddedFonts - this is the collection that contains fonts embedded in the document. 

Note that while it may be automatically populated, it may also be manually changed for 

custom control over font embedding (see below for more details). 

 DocumentFonts - this collection is automatically populated, depending on the value of 

the C1PrintDocument.FontHandling property. It may be used to find out which fonts are 

used in the document. 

 FontHandling - this property determines whether and how the two related collections 

(EmbeddedFonts and DocumentFonts) are populated. 

See Also 
Font Substitution 

Selective Font Embedding 

Font Substitution 
Working with C1PrintDocument > Embedded Fonts > Font Substitution 

When a text is rendered using a font, and a glyph appears in the text that is not present in the 

specified font, a substitute font may be selected to render that glyph. For instance, if the Arial 

font is used to render Japanese hieroglyphs, Arial Unicode MS font may be used to actually 

render the text. C1PrintDocument can analyze this and add the actual fonts used (rather than 

those specified) to the DocumentFonts and/or EmbeddedFonts collections. To do that, the 

FontHandling must be set to FontHandling.BuildActualDocumentFonts or 

FontHandling.EmbedActualFonts. The downside to those settings is that it takes time, making 

the document generate slower. Hence it may be recommended that those settings are used 

only if the document contains characters that may be missing from the fonts that are specified 

(for example, text in Far Eastern languages using common Latin fonts). 

When font substitution is analyzed, the following predefined set of fonts is searched for the 

best matching font containing the missing glyphs: 

 MS UI Gothic 

 MS Mincho 

 Arial Unicode MS 

 Batang 

 Gulim 

 Microsoft YaHei 

 Microsoft JhengHei 

 MingLiU 

 SimHei 

 SimSun 
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Selective Font Embedding 
Working with C1PrintDocument > Embedded Fonts > Selective Font Embedding 

If your document uses a specialized font along with the commonly available fonts such as Arial, 

you may want to embed just that specialized font (or several fonts) without embedding all fonts 

used in the document. To do that, follow these steps: 

1. Set FontHandling to a value other than FontHandling.EmbedFonts or 

FontHandling.EmbedActualFonts. This will leave the EmbeddedFonts collection empty 

when the document generates; 

2. Add the specialized fonts (they must be installed on the current system) to the 

document's EmbeddedFonts collection manually in code. To create an 

EmbeddedFont, pass the.NET Font object corresponding to your custom font to the 

EmbeddedFont's constructor. Add the required glyphs to the font using the 

EmbeddedFont.AddGlyphs method (several overloads are provided). 

When a C1PrintDocument with the EmbeddedFonts collection created in this way is saved (as 

C1DX or C1D file), just the fonts specified in that collection are embedded in the document. 

Dictionary 
Working with C1PrintDocument > Dictionary 

Show All  

Hide All  

If one item (for example, an image or an icon) is used in several places in a document, you can 

store that item once in a location available from the whole document and reference that 

instance, rather than inserting the same image or icon in every place it is used. For that, 

C1PrintDocument provides a dictionary. 

To access the dictionary, use the Dictionary property. The dictionary contains items of the base 

type DictionaryItem, which is an abstract type. Two derived classes are provided, 

DictionaryImage and DictionaryIcon, to store images and icons correspondingly. Items in the 

dictionary are referenced by names. In order to use an item, you must assign a name to it. The 

name must be unique within the dictionary. 

Dictionary items may be used in the following places in the document: 

 As the background image of a style, using the property BackgroundImageName. 

 As the image in a RenderImage object, using the property ImageName. 

So, if in your document the same image is used in several places, do the following: 

 Add the image to the dictionary, for instance like this:  

To write code in Visual Basic 
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Visual Basic Copy Code  

 

Me.C1PrintDocument1.Dictionary.Add(New C1.C1Preview.DictionaryImage("image1", 

Image.FromFile("myImage.jpg"))) 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.Dictionary.Add(new DictionaryImage("image1", 

Image.FromFile("myImage.jpg"))); 

 Use that image by setting either the BackgroundImageName on styles, or the 

ImageName property on render images, for example, like this:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim ri As New C1.C1Preview.RenderImage() 

ri.ImageName = "image1" 

To write code in C# 

C# Copy Code  

 

RenderImage ri = new RenderImage(); 

ri.ImageName = "image1"; 

 

C1Report Definitions 
Working with C1PrintDocument > C1Report Definitions 

Show All  

Hide All  

C1PrintDocument has the ability to import and generate C1Report definitions. 
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To import a C1Report into a C1PrintDocument, use the ImportC1Report method. For example, 

the following code can be used to import and preview the Alphabetical List of Products 

report included in the ReportBrowser sample shipped with Reports for WinForms: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As C1PrintDocument = New C1PrintDocument() 

doc.ImportC1Report("NWind.xml", "Alphabetical List of Products") 

Dim pdlg As C1PrintPreviewDialog = New C1PrintPreviewDialog() 

pdlg.Document = doc 

pdlg.ShowDialog() 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

doc.ImportC1Report("NWind.xml", "Alphabetical List of Products"); 

C1PrintPreviewDialog pdlg = new C1PrintPreviewDialog(); 

pdlg.Document = doc; 

pdlg.ShowDialog(); 

After a C1Report has been imported into C1PrintDocument, the document has the following 

structure: 

For a report without grouping: 

 The page footer is represented by a RenderSection object and is assigned to the 

document's PageLayouts.Default.PageFooter. 

 For each section of the report, a RenderSection object is created and added to the Body 

of the document in the following order:  

o Header (the report header, SectionTypeEnum.Header) 

o PageHeader (the page header, SectionTypeEnum.PageHeader) 

o Detail (the data section, SectionTypeEnum.Detail) 

o Footer (the report footer, SectionTypeEnum.Footer) 

A copy of the PageHeader is also assigned to the 

PageHeader.LayoutChangeAfter.PageLayout.PageHeader. This complex structure is needed 

because in C1Report, the first page header is printer after the report header. 

For a report with grouping: 
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For each group, a RenderArea is created, and the following object tree is placed between the 

PageHeader and Footer (for 2 groups): 

 RenderArea representing the top level group  

o RenderSection representing GroupHeader1 

o RenderArea representing the nested group  

 RenderSection representing GroupHeader2 

 Detail 

 RenderSection representing GroupFooter2 

o RenderSection representing GroupFooter1 

See Also 
C1Report Import Limitations 

Working with Printer Drivers 

C1Report Import Limitations 
Working with C1PrintDocument > C1Report Definitions > C1Report Import Limitations 

Importing C1Report into C1PrintDocument has the following limitations: 

 Only a report definition contained in an XML file can be imported. That is, if an 

application that produces a report in code via C# or VB.NET handlers attached to 

C1Report events, that report cannot be imported into C1PrintDocument. 

 In C1Report, if there is no printer installed, and CustomWidth and CustomHeight are 

both set to 0, the paper size is always set to Letter (8.5in x 11in). In C1PrintDocument, 

the paper size is determined based on the current locale, for example, for many 

European countries it will be set to A4 (210cm x 297cm). 

 Scripting limitations:  

C1PrintDocument: 

o The Font property is read-only. 

Field: 

o The Section property is read-only. 

o The Font property is read-only. 

o The LineSpacing property does not exist. 

o The Field.Subreport property is read-only. 

o If the LinkTarget property contains an expression, it will not be evaluated and 

will be used literally. 

o The SubreportHasData property does not exist. 

o The LinkValue property does not exist. 

Layout: 

o The ColumnLayout property is not supported, columns always go top to 

bottom and left to right. 
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o The LabelSpacingX property does not exist. 

o The LabelSpacingY property does not exist. 

o The OverlayReplacements property does not exist. 

 In OnFormat event handlers, properties that affect the pagination of the resulting 

document should not be changed. For example, ForcePageBreak cannot be used. 

 The dialog box for entering the report's parameters is not shown. Instead, default 

values are used. If the default is not specified, it is determined by the type of the 

parameter, for example, 0 is used for numbers, empty string for strings, current date for 

dates, and so on. 

 Database fields cannot be used in PageHeader and PageFooter. 

 In C1Report, in multi-column reports the report header is printed across all columns; in 

C1PrintDocument, it will be printed only across the first column. 

 Across is not supported for columns. 

Working with Printer Drivers 
Working with C1PrintDocument > C1Report Definitions > Working with Printer Drivers 

Show All  

Hide All  

Several new members in Reports for WinForms were added to work around specific problems 

caused by printer drivers. 

The following members were added to resolve issues with printer drivers: 

Class Member Description 

C1PreviewPane  AdjustPrintPage event Fired from within the PrintPage event 

handler of the C1PrintManager used to 

print the document. 

C1PrintManager  AdjustPrintPage event Fired from within the 

PrintDocument.PrintPage event handler 

of current print manager, prior to actually 

printing the page. 

C1PrintOptions  DrawPrintableAreaBounds 

property 

Gets or sets a value indicating whether a 

line is drawn around the printable area of 

the page (useful to debug printer issues). 

 PrintableAreaBoundsPen 

property 

Gets or sets the pen used to draw 

printable area bounds if 
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Class Member Description 

DrawPrintableAreaBounds is True. 

 PrintAsBitmap property Gets or sets a value indicating whether 

page metafiles should be converted to 

bitmaps and clipped to printer's hard 

margins prior to printing. 

The members listed in the table above may be used to work around certain printer issues. For 

instance, consider the following scenario of a machine running Windows Vista 64 with an HP-

CP1700 printer (using Vista's built-in printer driver). In this example, if ClipPage was False 

(default) and a document page was wider than the printer's hard margin, empty pages were 

emitted and document content was not printed. For example, the following document 

produced just two empty pages if printed: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

doc.Style.Font = New Font("Arial", 32) 

For i As Integer = 0 To 19 

Dim rtx As New RenderText(i.ToString()) 

rtx.X = String.Format("{0}in", i) 

rtx.Y = "10cm" 

rtx.Style.FontSize = 64 

doc.Body.Children.Add(rtx) 

Next 

doc.Generate() 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

doc.Style.Font = new Font("Arial", 32); 

for (int i = 0; i < 20; ++i) 

{ 

RenderText rtx = new RenderText(i.ToString()); 
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rtx.X = string.Format("{0}in", i); 

rtx.Y = "10cm"; 

rtx.Style.FontSize = 64; 

doc.Body.Children.Add(rtx); 

} 

doc.Generate(); 

This issue can be now worked around by doing two things: 

1. Set PrintAsBitmap to True (for example, on C1PreviewPane). 

2. Attach the following event handler to the AdjustPrintPage event (available also via 

AdjustPrintPage):  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

doc.Style.Font = New Font("Arial", 32) 

Private Sub PreviewPane_AdjustPrintPage(ByVal sender As Object, ByVal e As 

AdjustPrintPageEventArgs) 

Dim pa As RectangleF = e.PrintableArea 

If Not e.PrintPageEventArgs.PageSettings.Landscape Then 

pa.Width = 800 ' System set to 824 

pa.X = 25 ' System set to 13 

pa.Y = 13 ' System set to 6.666... 

Else 

pa.X = 13 

pa.Y = 0 

End If 

e.PrintableArea = pa 

End Sub 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

doc.Style.Font = new Font("Arial", 32); 

void PreviewPane_AdjustPrintPage(object sender, AdjustPrintPageEventArgs e) 

{ 

RectangleF pa = e.PrintableArea; 
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if (!e.PrintPageEventArgs.PageSettings.Landscape) 

{ 

pa.Width = 800; // System set to 824 

pa.X = 25; // System set to 13 

pa.Y = 13; // System set to 6.666... 

} 

else { 

pa.X = 13; 

pa.Y = 0; 

} 

e.PrintableArea = pa; 

} 

This code fixes the wrong hard page margins set by the printer driver, and avoids the problem 

described above. 

Report Definition Language (RDL) Files 
Working with C1PrintDocument > Report Definition Language (RDL) Files 

Show All  

Hide All  

Import support for RDL files is included in C1PrintDocument. Report Definition Language (RDL) 

import allows reading RDL report definitions into an instance of the C1PrintDocument 

component. The resulting document is a data-bound representation of the imported report. 

RDL support in C1PrintDocument is based on the Microsoft RDL Specification for SQL Server 

2008. 

 

Note: RDL import in C1PrintDocument (provided by ImportRdl and FromRdl methods) is 

now obsolete. C1RdlReport should be used instead. See Working with C1RdlReport for 

more information. 

You can use the following code to import an RDL file: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As New C1PrintDocument() 

doc.ImportRdl("myReport.rdl") 

doc.Generate() 
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To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = new C1PrintDocument(); 

doc.ImportRdl("myReport.rdl"); 

doc.Generate(); 

Note that not all RDL properties are currently supported, but support will be added in future 

releases. For more information, see the RDL Import Limitations topic. 

See Also 

RDL Import Limitations 

RDL Import Limitations 
Working with C1PrintDocument > Report Definition Language (RDL) Files > RDL Import Limitations 

The current implementation of RDL import in Reports for WinFroms has some limitations. 

These limitations include: 

 Gauge, Chart, and SubReport objects are not supported. 

 Expressions for sub-properties of complex RDL properties (such as border width) are 

not supported. 

 Most aggregate functions in RDL have the optional "recursive" parameter. It is not 

supported. 

 The following RDL properties are not fully supported yet: 

 QueryParameter.Value: Only a literal value may be specified. 

 ReportParameter: Parameters referencing data are not supported. 

 Hyperlink: Cannot be specified as expression; if several actions are associated with a 

hyperlink, only the first action is supported. 

 ReportItem.Visibility: Cannot be specified as expression. 

 ReportItem.Bookmark: Cannot be specified as expression. 

 Style.TextAlign.General: Left align is used. 

The following RDL properties are currently not supported: 

 Document.AutoRefresh 

 Document.CustomProperties 

 Document.Code 

 Document.Width 

 Document.Language 

 Document.CodeModules 

 Document.Classes 

 Document.ConsumeContainerWhitespace 

 Document.DataTransform 

 Document.DataSchema 

 Document.DataElementName 
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 Document.DataElementStyle 

 ConnectionProperties.Prompt 

 ConnectionProperties.DataProvider 

 DataSet.CaseSensitivity 

 DataSet.Collation 

 DataSet.AccentSensitivity 

 DataSet.KanatypeSensitivity 

 DataSet.WidthSensitivity 

 DataSet.InterpretSubtotalsAsDetails 

 Body.Height 

 ReportItem.ToolTip 

 ReportItem.DocumentMapLabel 

 ReportItem.CustomProperties 

 ReportItem.DataElementName 

 ReportItem.DataElementOutput 

 TextBox.HideDuplicates 

 TextBox.ToggleImage 

 TextBox.UserSort 

 TextBox.DataElementStyle 

 TextBox.ListStyle 

 TextBox.ListLevel 

 TextRun.ToolTip 

 TextRun.MarkupType 

 Style.Format 

 Style.LineHeight 

 Style.Direction 

 Style.Language 

 Style.Calendar 

 Style.NumeralVariant 

 Style.TextEffect 

 

Note: RDL import in C1PrintDocument (provided by ImportRdl and FromRdl methods) is 

now obsolete. C1RdlReport should be used instead. See Working with C1RdlReport for 

more information. 

 

Working with C1MultiDocument 
Show All  

Hide All  

The C1MultiDocument component is designed to allow creating, persisting, and exporting large 

documents that cannot be handled by a single C1PrintDocument object due to memory 

limitations. 

A C1MultiDocument object provides a Items collection that can contain one or more elements 

of the type C1MultiDocumentItem. Each such element represents a C1PrintDocument. Use of 
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compression and temporary disk storage allows combining several C1PrintDocument objects 

into a large multi-document that would cause an out of memory condition if all pages 

belonged to a single C1PrintDocument. The following snippet of code illustrates how a multi-

document might be created and previewed: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim mdoc As New C1MultiDocument() 

mdoc.Items.Add(C1PrintDocument.FromFile("myDoc1.c1dx")) 

mdoc.Items.Add(C1PrintDocument.FromFile("myDoc2.c1dx")) 

mdoc.Items.Add(C1PrintDocument.FromFile("myDoc3.c1dx")) 

Dim pview As New C1PrintPreviewDialog() 

pview.Document = mdoc 

pview.ShowDialog() 

To write code in C# 

C# Copy Code  

 

C1MultiDocument mdoc = new C1MultiDocument(); 

mdoc.Items.Add(C1PrintDocument.FromFile("myDoc1.c1dx")); 

mdoc.Items.Add(C1PrintDocument.FromFile("myDoc2.c1dx")); 

mdoc.Items.Add(C1PrintDocument.FromFile("myDoc3.c1dx")); 

C1PrintPreviewDialog pview = new C1PrintPreviewDialog(); 

pview.Document = mdoc; 

pview.ShowDialog(); 

C1MultiDocument supports links between contained documents, common TOC, common page 

numeration, and total page count. 

Note that a C1MultiDocument does not store references to the C1PrintDocument objects added 

to it - rather, it serializes them (as .c1d/x) and stores the result. Thus, you can create really large 

multi-documents without running out of memory - provided, of course, that your code itself 

does not keep references to the individual C1PrintDocument objects that were added to the 

C1MultiDocument. So when using C1MultiDocument please make sure that you do not keep 

references to the individual document objects after you have added them to the multi-

document. 

C1MultiDocument can be persisted as "C1 Open XML Multi Document" with the default 

extension of .c1mdx. 
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C1MultiDocument can be exported to most formats using any of the Export method overloads. 

See Exporting a C1MultiDocument File for details. 

C1MultiDocument can be printed using any of the Print and PrintDialog methods overloads. See 

Printing a C1MultiDocument File for details. 

See Also 

C1MultiDocument Limitations 

Creating and Previewing a C1MultiDocument File 

Exporting a C1MultiDocument File 

Printing a C1MultiDocument File 

C1MultiDocument Outlines 

C1MultiDocument Limitations 
Working with C1MultiDocument > C1MultiDocument Limitations 

Show All  

Hide All  

The primary purpose of the C1MultiDocument component is to handle large documents that it 

would otherwise be impossible to create/export/print due to memory limitations. There are no 

limitations on the size and number of documents. But you may have to use disk storage rather 

than (default) memory, see the SetStorage methods for details. 

A multi-document has a limitation that may or may not be significant depending on the specific 

application: it does NOT allow you to access the object model of C1PrintDocuments contained 

within. In other words, while you can write the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim mdoc As New C1MultiDocument() 

mdoc.Items.Add(C1PrintDocument.FromFile("file1.c1dx")) 

mdoc.Items.Add(C1PrintDocument.FromFile("file2.c1dx")) 

mdoc.Items.Add(C1PrintDocument.FromFile("file3.c1dx")) 

To write code in C# 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument~Export.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument~Print.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument~PrintDialog.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument~SetStorage.html
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C# Copy Code  

 

C1MultiDocument mdoc = new C1MultiDocument(); 

mdoc.Items.Add(C1PrintDocument.FromFile("file1.c1dx")); 

mdoc.Items.Add(C1PrintDocument.FromFile("file2.c1dx")); 

mdoc.Items.Add(C1PrintDocument.FromFile("file3.c1dx")); 

You CANNOT then add something like the following: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim doc As C1PrintDocument = mdoc.Items(1) 

To write code in C# 

C# Copy Code  

 

C1PrintDocument doc = mdoc.Items[1]; 

If that limitation is not an issue for a particular application, then you can even use the 

C1MultiDocument component to "modularize" the application even if there are no memory 

problems. 

Creating and Previewing a 

C1MultiDocument File 
Working with C1MultiDocument > Creating and Previewing a C1MultiDocument File 

Show All  

Hide All  

To add an item to the C1MultiDocumentItemCollection, you can use the Add method. To load a 

file into the C1MultiDocument component you can use the Load method. To remove a file, you 

would use the Clear method. This method clears any file previously loaded into the 

C1MultiDocument component. 

To add an item to the C1MultiDocumentItemCollection, you can use the Add method. Complete 

the following steps: 

1. 1. In Design View, double-click on the form to open the Code Editor. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocumentItemCollection.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocumentItemCollection~Add.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument~Load.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocumentItemCollection~Clear.html
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2. 2. Add the following code to the Load event:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim ppc As New C1PrintPreviewControl         

Controls.Add(ppc)         

ppc.Dock = DockStyle.Fill         

Dim pdoc As New C1PrintDocument         

Dim pdoc2 As New C1PrintDocument         

Dim mdoc As New C1MultiDocument         

pdoc.Body.Children.Add(New C1.C1Preview.RenderText("Hello!"))         

pdoc2.Body.Children.Add(New C1.C1Preview.RenderText("World!"))         

mdoc.Items.Add(pdoc)         

mdoc.Items.Add(pdoc2)         

ppc.Document = mdoc         

mdoc.Generate() 

To write code in C# 

C# Copy Code  

 

C1PrintPreviewControl ppc = new C1PrintPreviewControl();         

Controls.Add(ppc);         

ppc.Dock = DockStyle.Fill;         

C1PrintDocument pdoc = new C1PrintDocument();         

C1PrintDocument pdoc2 = new C1PrintDocument();         

C1MultiDocument mdoc = new C1MultiDocument();         

pdoc.Body.Children.Add(new C1.C1Preview.RenderText("Hello!"));         

pdoc2.Body.Children.Add(new C1.C1Preview.RenderText("World!"));         

mdoc.Items.Add(pdoc);         

mdoc.Items.Add(pdoc2);         

ppc.Document = mdoc;         

mdoc.Generate(); 

This code loads two C1PrintDocument into the C1MultiDocument component and displays the 

documents in a C1PrintPreviewControl at run time. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
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Exporting a C1MultiDocument File 
Working with C1MultiDocument > Exporting a C1MultiDocument File 

Show All  

Hide All  

C1MultiDocument can be exported to most formats using any of the Export method overloads. 

For example, in the following example the C1MultiDocument will be exported to a PDF file. The 

Boolean value, True, indicates that a progress dialog box should be shown. 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1MultiDocument1.Export("C:\exportedfile.pdf", True) 

To write code in C# 

C# Copy Code  

 

this.c1MultiDocument1.Export(@"C:\exportedfile.pdf", true); 

If you include the above code in a button's Click event handler, the C1MultiDocument's 

content will be exported to a PDF file when the button is clicked at run time. 

Printing a C1MultiDocument File 
Working with C1MultiDocument > Printing a C1MultiDocument File 

Show All  

Hide All  

C1MultiDocument can be printed using any of the Print and PrintDialog methods overloads. For 

example, the following code opens a Print dialog box. 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1MultiDocument1.PrintDialog() 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument~Export.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument~Print.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument~PrintDialog.html
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To write code in C# 

C# Copy Code  

 

this.c1MultiDocument1.PrintDialog(); 

If you include the above code in a button's Click event handler, the Print dialog box will appear 

when the button is clicked at run time. 

C1MultiDocument Outlines 
Working with C1MultiDocument > C1MultiDocument Outlines 

C1MultiDocument includes outline support. A collection of outline nodes specific to the multi-

document may be specified via the Outlines property. The resulting outline (such as for the 

preview) is built as a combination of outline nodes in that collection and outline nodes in the 

contained documents. This outline can be built programmatically using the MakeOutlines() 

method. 

The multi-document's own Outlines collection is processed first, and nodes from that collection 

are included in the resulting outline. If a node is also specified as the value of the OutlineNode 

of a contained C1MultiDocumentItem (for example, the two properties reference the same 

object), the whole outline of the document or report represented by that item is inserted into 

the resulting outline. Depending on the value of the multi-document item's 

NestedOutlinesMode property, the outline of the document or report is either nested within 

the outline node, or replaces it. Finally, outlines of documents and reports represented by items 

that are not included in the multi-document's Outlines collection are automatically appended 

to the resulting outline sequentially. 

Outlines support is provided by the following properties and methods: 

 Outlines property 

 MakeOutlines method 

 Outlines property 

 OutlineNode property 

Using the C1ReportDesigner Control 
The C1ReportDesigner control displays reports in design mode, and allows users to drag, copy, 

and resize report fields and sections. The control also provides an unlimited undo/redo stack 

and a selection mechanism designed for use with the PropertyGrid control that ships with 

Visual Studio. 

You can use the C1ReportDesigner control to incorporate some report design features into your 

applications, or you can write your own full-fledged report designer application. We include full 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument~MakeOutlines.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocumentItem.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocumentItem~Outlines.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocument~MakeOutlines.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocumentItem~Outlines.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1MultiDocumentItem~OutlineNode.html
C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner.html
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source code for the C1ReportDesigner application that ships with Reports for WinForms and 

uses the C1ReportDesigner control extensively. 

Writing your own customized report designer is useful in many situations, for example: 

 You may want to integrate the designer tightly into your application, rather than 

running a separate application. (For example, see the report designer in Microsoft 

Access). 

 You may want to customize the data sources available to the user, or the types of fields 

that can be added to the report. (For example, you may want to use custom data source 

objects defined by your application). 

 You may want to provide a menu of stock report definitions that makes sense in the 

scope of your application and allows users to customize some aspects of each stock 

report. (For example, see the printing options in Microsoft Outlook). 

 You may want to write a better, more powerful report designer application than the one 

you use now, which makes it easier to do things that are important to you or to your 

co-workers. (For example, add groups of fields to the report). 

To use the C1ReportDesigner control, simply add it to a form, add a C1Report component that 

will contain the report you want to edit, and set the Report property in the designer control. 

When you run the project, you will see the report definition in design mode. You will be able to 

select, move, and resize the report fields and sections. Any changes made through the designer 

will be reflected in the report definition stored in the C1Report component. You can save the 

report at any time using the C1Report.Save method, or preview it using the 

C1Report.Document property and a Preview control. 

To build a complete designer, you will have to add other user interface elements: 

 A PropertyGrid control attached to the designer selection, so the user can change field 

and section properties. 

 A DataSource selection mechanism so the user can edit and change the report data 

source. 

 A Group Editor dialog box if you want to allow the user to create, remove, and edit 

report groups. 

 A Wizard to create new reports. 

 The usual file and editing commands so users can load and save reports, use the 

clipboard, and access the undo/redo mechanism built into the C1ReportDesigner 

control. 

Most of these elements are optional and may be omitted depending on your needs. The Report 

Designer application source code implements all of these, and you can use the source code as a 

basis for your implementation. 

About this section 

This section describes how to implement a simple report designer using the C1ReportDesigner 

control. The purpose of the sample designer is to illustrate how the C1ReportDesigner control 

integrates with a designer application. It supports loading and saving files with multiple reports, 

C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner~Report.html
C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner.html


 

 464 

editing and previewing reports, adding and removing reports from the file, and report editing 

with undo/redo and clipboard support. 

Most designer applications based on the C1ReportDesigner control will have features similar to 

the ones described here. If you follow these steps, you will become familiar with all the basic 

features of the C1ReportDesigner control. 

The sample designer does not provide some advanced capabilities such as import/export, data 

source selection/editing, and group editing. All these features are supported by the full version 

of the C1ReportDesigner application, and you can refer to the source code for details on how 

to implement them. 

The following sections describe the step-by-step implementation of the sample designer. 

For the complete project, see the SimpleDesigner sample, which is installed in the 

ComponentOne Samples folder. 

See Also 

Step 1 of 9: Create and Populate the Main Form 

Step 2 of 9: Add Class Variables and Constants 

Step 3 of 9: Add Code to Update the User Interface 

Step 4 of 9: Add Code to Handle the Toolbar Commands 

Step 5 of 9: Implement the SetDesignMode Method 

Step 6 of 9: Implement the File Support Methods 

Step 7 of 9: Hook Up the Controls 

Step 8 of 9: Add Code to Create and Remove Reports 

Step 9 of 9: Add Code to Create Fields 

Step 1 of 9: Create and Populate the 

Main Form 
Using the C1ReportDesigner Control > Step 1 of 9: Create and Populate the Main Form 

The sample designer consists of a single form with the following main components: 

Control Control 

Name 

Description 
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Control Control 

Name 

Description 

ListBox _list ListBox control with a list of reports currently loaded. 

C1PrintPreview _c1ppv C1PrintPreview control for previewing the reports. 

C1ReportDesigner _c1rd C1ReportDesigner control for designing and editing 

reports. 

PropertyGrid _ppg PropertyGrid control for editing properties of objects 

selected in the designer. 

ToolBar _tb ToolBar control with buttons for each command. 

C1Report _c1r C1Report component used for rendering reports into the 

_c1ppv control. 

The form contains a few other controls such as labels and splitters, which are used to improve 

the layout. Notice that the controls are numbered and the labels and splitters are named in the 

image below. Here's what the form should look like: 
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Refer to the labels on the form to locate the following controls: 

 The ToolBar control _tb appears along the top of the form. 

 The report list _list appears to the left above the property grid _ppg. 

 The property grid _ppg. 

 On the right, the C1ReportDesigner control _c1rd fills the client area of the form. 

 The preview control _c1ppv is invisible in design mode. In preview mode, it becomes 

visible and hides the report designer. 

In this sample designer, the toolbar contains 18 items (14 buttons and 4 separators). If you are 

creating the project from scratch, don't worry about the images at this point. Just add the items 

to the _tb control (which can easily be done using the ToolBarButton Collection Editor) and 

set their names as each command is implemented. 

Step 2 of 9: Add Class Variables and 

Constants 
Using the C1ReportDesigner Control > Step 2 of 9: Add Class Variables and Constants 

Show All  

Hide All  

In this step, add the following code to your simple designer project to add class variables and 

constants: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' fields         

Private _fileName As String  ' name of the current file         

Private _dirty As Boolean    ' current file has changed 

 

' title to display in the form caption         

Dim _appName As String = "C1ReportDesigner Demo" 

To write code in C# 

C# Copy Code  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner.html
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// fields         

private string  _fileName;     // name of the current file         

private bool    _dirty;        // current file has changed 

 

// title to display in the form caption         

private const string _appName = "C1ReportDesigner Demo"; 

 

Step 3 of 9: Add Code to Update the User 

Interface 
Using the C1ReportDesigner Control > Step 3 of 9: Add Code to Update the User Interface 

Show All  

Hide All  

The simple designer has buttons that may be enabled or disabled, depending on whether the 

clipboard and undo buffer are empty, whether a file is loaded, and so on. All this functionality is 

implemented in a single method, called UpdateUI. 

UpdateUI is called often to make sure the UI reflects the state of the application. The first call 

should be made in response to the Form_Load event, to initialize the toolbar and form caption. 

After pasting the following code into the project, remember to set the names of the buttons in 

the toolbar control to match the ones used in the UpdateUI routine. 

Add the following code to update the user interface: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' update UI on startup to show form title and disable clipboard and         

' undo/redo buttons             

Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles MyBase.Load         

    UpdateUI()         

End Sub         

Private  Sub UpdateUI()         

    ' update caption             

    _fileName = _appName         

    If _fileName.Length > 0 Then         
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    _fileName = String.Format("{0} - [{1}]", _appName, _fileName)          

        If _dirty Then _fileName = _fileName + " *"         

End If 

   

    ' push/release design/preview mode buttons            

    Dim design As Boolean =  _c1rd.Visible AndAlso (Not 

IsNothing(_c1rd.Report))         

    _btnDesign.Pushed = design         

    _btnPreview.Pushed = Not design 

 

    ' enable/disable buttons         

    _btnCut.Enabled = design AndAlso _c1rd.ClipboardHandler.CanCut         

    _btnCopy.Enabled = design AndAlso _c1rd.ClipboardHandler.CanCut         

    _btnPaste.Enabled = design AndAlso _c1rd.ClipboardHandler.CanPaste         

    _btnUndo.Enabled = design AndAlso _c1rd.UndoStack.CanUndo         

    _btnRedo.Enabled = design AndAlso _c1rd.UndoStack.CanRedo 

 

    Dim reportSelected As Boolean =  design AndAlso Not 

(IsNothing(_list.SelectedItem))         

    _btnAddReport.Enabled = _c1rd.Visible         

    _btnDelReport.Enabled = reportSelected         

    _btnAddField.Enabled  = reportSelected          

    _btnAddLabel.Enabled  = reportSelected         

End Sub 

To write code in C# 

C# Copy Code  

 

// update UI on startup to show form title and disable clipboard and          

// undo/redo buttons          

private void Form1_Load(object sender, System.EventArgs e)         

{         

    UpdateUI();         

}         

private void UpdateUI()         

{         

    // update caption          

    Text = (_fileName != null && _fileName.Length > 0)         

    ? string.Format("{0} - [{1}] {2}", _appName, _fileName, _dirty? "*": "")         

    : _appName;        
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    // push/release design/preview mode buttons          

    bool design = _c1rd.Visible && _c1rd.Report != null;        

    _btnDesign.Pushed  = design;         

    _btnPreview.Pushed = !design;       

         

    // enable/disable buttons          

    _btnCut.Enabled   = design && _c1rd.ClipboardHandler.CanCut;         

    _btnCopy.Enabled  = design && _c1rd.ClipboardHandler.CanCut;         

    _btnPaste.Enabled = design && _c1rd.ClipboardHandler.CanPaste;         

    _btnUndo.Enabled  = design && _c1rd.UndoStack.CanUndo;         

    _btnRedo.Enabled  = design && _c1rd.UndoStack.CanRedo; 

 

    bool reportSelected = design && _list.SelectedItem != null;         

    _btnAddReport.Enabled = _c1rd.Visible;         

    _btnDelReport.Enabled = reportSelected;         

    _btnAddField.Enabled  = reportSelected;          

    _btnAddLabel.Enabled  = reportSelected;         

} 

Notice how UpdateUI uses the CanCut, CanPaste, CanUndo, and CanRedo properties to enable 

and disable toolbar buttons. 

Step 4 of 9: Add Code to Handle the 

Toolbar Commands 
Using the C1ReportDesigner Control > Step 4 of 9: Add Code to Handle the Toolbar Commands 

Show All  

Hide All  

To handle the clicks on the toolbar buttons and dispatch them to the appropriate handlers, use 

the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' handle clicks on toolbar buttons         

Private Sub _tb_ButtonClick(ByVal sender As System.Object, ByVal e As 

System.Windows.Forms.ToolBarButtonClickEventArgs) Handles _tb.ButtonClick        

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.ClipboardHandler~CanCut.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.ClipboardHandler~CanPaste.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.UndoStack~CanUndo.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.UndoStack~CanRedo.html
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    ' design/preview mode         

    If e.Button.Equals(_btnDesign) Then         

       SetDesignMode(True)         

    End If         

    If e.Button.Equals(_btnPreview) Then         

       SetDesignMode(False)         

         

    ' file commands         

    If e.Button.Equals(_btnNew) Then 

       NewFile()         

    If e.Button.Equals(_btnOpen) Then         

       OpenFile()         

    If e.Button.Equals(_btnSave) Then         

       SaveFile()        

         

    ' allow user to undo clipboard operations         

    If e.Button.Equals(_btnCut) Or e.Button.Equals(_btnPaste) Then         

        _c1rd.UndoStack.SaveState()         

    End If        

         

    ' clipboard         

    If e.Button.Equals(_btnCut) Then         

       _c1rd.ClipboardHandler.Cut()         

    If e.Button.Equals(_btnCopy) Then         

       _c1rd.ClipboardHandler.Copy()         

    If e.Button.Equals(_btnPaste) Then         

             _c1rd.ClipboardHandler.Paste()        

         

    ' undo/redo         

    If e.Button.Equals(_btnUndo) Then         

       _c1rd.UndoStack.Undo()         

    If e.Button.Equals(_btnRedo) Then         

       _c1rd.UndoStack.Redo() 

         

    ' add/remove reports         

    If e.Button.Equals(_btnAddReport) Then         

       NewReport()         

    If e.Button.Equals(_btnDelReport) Then         

       DeleteReport()         

  

    ' add fields         
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    ' (just set create info and wait for CreateField event from designer)         

    If e.Button.Equals(_btnAddField) Then         

       _c1rd.CreateFieldInfo = e.Button         

    End If         

    If e.Button.Equals(_btnAddLabel) Then         

       _c1rd.CreateFieldInfo = e.Button         

    End If         

End Sub 

To write code in C# 

C# Copy Code  

 

// handle clicks on toolbar buttons         

private void _tb_ButtonClick(object sender,         

    System.Windows.Forms.ToolBarButtonClickEventArgs e)         

{         

    // design/preview mode         

    if (e.Button == _btnDesign)     SetDesignMode(true);         

    if (e.Button == _btnPreview)    SetDesignMode(false);        

 

    // file commands         

    if (e.Button == _btnNew)        NewFile();         

    if (e.Button == _btnOpen)       OpenFile();         

    if (e.Button == _btnSave)       SaveFile(); 

   

    // allow user to undo clipboard operations         

    if (e.Button == _btnCut || e.Button == _btnPaste)         

        _c1rd.UndoStack.SaveState(); 

 

    // clipboard         

    if (e.Button == _btnCut)      _c1rd.ClipboardHandler.Cut();         

    if (e.Button == _btnCopy)     _c1rd.ClipboardHandler.Copy();         

    if (e.Button == _btnPaste)    _c1rd.ClipboardHandler.Paste(); 

 

    // undo/redo         

    if (e.Button == _btnUndo)     _c1rd.UndoStack.Undo();         

    if (e.Button == _btnRedo)     _c1rd.UndoStack.Redo();         

 

    // add/remove reports         

    if (e.Button == _btnAddReport)   NewReport();         
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    if (e.Button == _btnDelReport)   DeleteReport(); 

 

    // add fields         

    // (just set create info and wait for CreateField event from designer)         

    if (e.Button == _btnAddField)    _c1rd.CreateFieldInfo = e.Button;         

    if (e.Button == _btnAddLabel)    _c1rd.CreateFieldInfo = e.Button;         

} 

This routine dispatches about half of the commands to specialized handlers. These will be 

described later. The other half (clipboard, undo/redo) is handled directly by the 

C1ReportDesigner control. 

Note that before calling the Cut and Paste methods, the code calls the SaveState method to 

save the current state of the report. This allows the user to undo and redo clipboard operations. 

In general, your code should always call SaveState before making changes to the report. 

Step 5 of 9: Implement the 

SetDesignMode Method 
Using the C1ReportDesigner Control > Step 5 of 9: Implement the SetDesignMode Method 

Show All  

Hide All  

The simple designer has two modes: report design and preview. When the user selects a new 

report or clicks the Design button on the toolbar, the application shows the designer control. 

When the user clicks the Preview button, the application renders the current report into the 

preview control and shows the result. 

Add the following code to implement the SetDesignMode method: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub SetDesignMode(ByVal design As Boolean)         

    ' show/hide preview/design panes         

    _c1rd.Visible  = design         

    _c1ppv.Visible = Not design 

    

    ' no properties in preview mode         

    If Not design Then         

        _lblPropGrid.Text = "Properties"         

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.ClipboardHandler~Cut.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.ClipboardHandler~Paste.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.UndoStack~SaveState.html
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        _ppg.SelectedObject = Nothing         

    End If 

   

    ' attach copy of the report to preview control         

    ' (so changes caused by script aren't saved)         

    If Not design Then         

        _c1ppv.Document = Nothing         

        _c1r.CopyFrom(_c1rd.Report)         

        Cursor = Cursors.WaitCursor         

        _c1r.Render()         

        If _c1r.PageImages.Count > 0 Then         

            _c1ppv.Document = _c1r         

        End If         

        Cursor = Cursors.Default         

    End If 

  

    ' done, update UI         

    UpdateUI()         

End Sub 

To write code in C# 

C# Copy Code  

 

private void SetDesignMode( bool design)          

{         

    // show/hide preview/design panes         

    _c1rd.Visible  = design;         

    _c1ppv.Visible = !design; 

 

    // no properties in preview mode         

    if (!design )          

    {         

        _lblPropGrid.Text = "Properties";         

        _ppg.SelectedObject = null;         

    } 

     

    // attach copy of the report to preview control         

    // (so changes caused by script aren't saved)         

    if (!design )          

    {         
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        _c1ppv.Document = null;         

        _c1r.CopyFrom(_c1rd.Report);         

        Cursor = Cursors.WaitCursor;        

        _c1r.Render();         

        if (_c1r.PageImages.Count > 0 )         

            _c1ppv.Document = _c1r;         

        Cursor = Cursors.Default;         

    } 

 

    // done, update UI          

    UpdateUI();         

} 

Switching to design mode is easy, all you have to do is show the designer and hide the preview 

control. Switching to preview mode is a little more involved because it also requires rendering 

the report. 

Note that the report is copied to a separate C1Report control before being rendered. This is 

necessary because reports may contain script code that changes the report definition (field 

colors, visibility, and so on), and we don't want those changes applied to the report definition. 

Step 6 of 9: Implement the File Support 

Methods 
Using the C1ReportDesigner Control > Step 6 of 9: Implement the File Support Methods 

Show All  

Hide All  

The simple designer has three commands that support files: New, Open, and Save. NewFile 

clears the class variables, report list, preview and designer controls, and then updates the UI. 

Add the following code to implement the NewFile method: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub NewFile()         

    _fileName = ""         

    _dirty = False         

    _list.Items.Clear()         

    _c1ppv.Document = Nothing         
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    _c1rd.Report = Nothing         

    UpdateUI()         

End Sub 

To write code in C# 

C# Copy Code  

 

private void NewFile()         

{         

    _fileName = "";         

    _dirty = false;         

    _list.Items.Clear();         

    _c1ppv.Document = null;         

    _c1rd.Report = null;         

    UpdateUI();         

} 

OpenFile prompts the user for a report definition file to open, then uses the C1Report 

component to retrieve a list of report names in the selected file. Each report is loaded into a 

new C1Report component, which is added to the report list (_list control). 

Instead of adding the C1Report components directly to the list box, the code uses a 

ReportHolder wrapper class. The only function of the ReportHolder class is to override the 

ToString method so the list box shows the report names. 

Add the following code to implement the OpenFile method: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Public Sub OpenFile()          

    ' get name of file to open         

    Dim dlg As New OpenFileDialog         

    dlg.FileName = "*.xml"         

    dlg.Title = "Open Report Definition File"         

    If dlg.ShowDialog() <> DialogResult.OK Then         

        Return         

    End If 

   

    ' check selected file         
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    Try         

        reports = _c1r.GetReportInfo(dlg.FileName)         

    Catch         

        If IsNothing(reports) OrElse reports.Length = 0 Then         

            MessageBox.Show("Invalid (or empty) report definition file")         

            Return         

        End If         

    End Try         

    ' clear list         

    NewFile() 

 

    ' load new file         

    Cursor = Cursors.WaitCursor         

    _fileName = dlg.FileName         

    Dim reportName As String         

    For Each reportName In reports         

        Dim rpt As New C1Report()          

        rpt.Load(_fileName, reportName)         

        _list.Items.Add(New ReportHolder(rpt))         

    Next         

    Cursor = Cursors.Default 

  

  ' select first report         

    _list.SelectedIndex = 0         

End Sub 

   

' ReportHolder         

' Helper class used to store reports in listboxes. The main thing         

' it does is override the ToString() method to render the report name.         

Public Class ReportHolder         

        Public  Sub New(ByVal report As C1Report)         

        Me.Report = report         

    End Sub         

    Public Overrides Function ToString() As String         

        Dim text As String = Me.Report.ReportName          

        If text.Length = 0 Then text = "Unnamed Report"         

        Return text         

    End Function         

    Public ReadOnly Report As C1Report         

End Class 

To write code in C# 
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C# Copy Code  

 

public void OpenFile()         

{         

    // get name of file to open         

    OpenFileDialog dlg = new OpenFileDialog();         

    dlg.FileName = "*.xml";         

    dlg.Title = "Open Report Definition File";         

    if (dlg.ShowDialog() != DialogResult.OK)         

        return; 

 

    // check selected file         

    string[] reports = null;         

    try         

    {        

        reports = _c1r.GetReportInfo(dlg.FileName);         

    }         

    catch {}         

    if (reports == null || reports.Length == 0)         

    {         

        MessageBox.Show("Invalid (or empty) report definition file");         

        return;         

    } 

    

    // clear list         

    NewFile();        

   

    // load new file         

    Cursor = Cursors.WaitCursor;         

    _fileName = dlg.FileName;         

    foreach (string reportName in reports)         

    {         

        C1Report rpt = new C1Report();         

        rpt.Load(_fileName, reportName);         

        _list.Items.Add(new ReportHolder(rpt));        

    }         

    Cursor = Cursors.Default; 

   

    // select first report         

    _list.SelectedIndex = 0;         

}         
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// ReportHolder         

// Helper class used to store reports in listboxes. The main thing         

// it does is override the ToString() method to render the report name.         

public class ReportHolder         

{         

    public readonly C1Report Report;        

    public ReportHolder(C1Report report)         

    {         

        Report = report;         

    }         

    override public string ToString()         

    {         

        string s = Report.ReportName;         

        return (s != null && s.Length > 0)? s: "Unnamed Report";         

    }         

} 

Finally, the SaveFile method prompts the user for a file name and uses an XmlWriter to save 

each report into the new file using C1Report.Save method. Add the following code to 

implement the SaveFile method: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Public Sub SaveFile()         

   ' get name of file to save         

   Dim dlg As New SaveFileDialog()         

   dlg.FileName = _fileName         

   dlg.Title = "Save Report Definition File"         

   If dlg.ShowDialog() <> Windows.Forms.DialogResult.OK Then Return         

 

   ' save file         

   Dim w As New XmlTextWriter(dlg.FileName, System.Text.Encoding.Default)         

   w.Formatting = Formatting.Indented         

   w.Indentation = 2         

   w.WriteStartDocument() 

 

   ' write all reports to it          

   Cursor = Cursors.WaitCursor         

   w.WriteStartElement("Reports")         

   Dim rh As ReportHolder         
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   For Each rh In _list.Items         

      rh.Report.Save(w) 'rh.Report.ReportName         

   Next         

   w.WriteEndElement()         

   Cursor = Cursors.Default 

   

   ' close the file          

   w.Close() 

 

   ' and be done         

   _fileName = dlg.FileName         

   _dirty = False         

   UpdateUI()         

End Sub  

To write code in C# 

C# Copy Code  

 

public void SaveFile()         

{         

    // get name of file to save         

    SaveFileDialog dlg = new SaveFileDialog();         

    dlg.FileName = _fileName;         

    dlg.Title = "Save Report Definition File";         

    if (dlg.ShowDialog() != DialogResult.OK)         

        return; 

   

    // save file         

    XmlTextWriter w = new XmlTextWriter(dlg.FileName, 

System.Text.Encoding.Default);         

    w.Formatting = Formatting.Indented;         

    w.Indentation = 2;         

    w.WriteStartDocument(); 

 

    // write all reports to it         

    Cursor = Cursors.WaitCursor;         

    w.WriteStartElement("Reports");         

    foreach (ReportHolder rh in _list.Items)         

        rh.Report.Save(w); //rh.Report.ReportName;         

    w.WriteEndElement();         
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    Cursor = Cursors.Default; 

 

    // close the file         

    w.Close(); 

   

    // and be done         

    _fileName = dlg.FileName;         

    _dirty = false;         

    UpdateUI();         

} 

 

Step 7 of 9: Hook Up the Controls 
Using the C1ReportDesigner Control > Step 7 of 9: Hook Up the Controls 

Show All  

Hide All  

The next step is to add the event handlers that hook up all the controls together. 

Here is the handler for the SelectedIndexChanged event of the _list control. Add the following 

code so that when the user selects a new report from the list, the code displays it in design 

mode: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' a new report was selected: switch to design mode and show it         

Private Sub _list_SelectedIndexChanged(ByVal sender As System.Object, ByVal e 

As System.EventArgs) Handles _list.SelectedIndexChanged         

   ' switch to design mode         

   SetDesignMode(True)     

         

   ' attach selected report to designer and preview controls         

   _c1rd.Report = Nothing         

   _c1ppv.Document = Nothing         

   If _list.SelectedIndex > -1 Then         

      _c1rd.Report = _list.SelectedItem.Report         

   End If         

End Sub  
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To write code in C# 

C# Copy Code  

 

private void _list_SelectedIndexChanged(object sender, System.EventArgs e)         

{ 

     

    // switch to design mode         

    SetDesignMode(true); 

  

    // attach selected report to designer and preview controls         

    _c1rd.Report = null;         

    _c1ppv.Document = null;         

    if (_list.SelectedItem != null)         

        _c1rd.Report = ((ReportHolder)_list.SelectedItem).Report;         

} 

The designer uses a property grid control (_ppg) to expose the properties of the report 

elements selected in the designer. This is done by setting the SelectedObject property of the 

property grid control; in response the control fires a SelectionChanged event. 

When the user selects a report section or a field in the designer control, it fires the 

SelectionChanged event. The event handler inspects the new selection and assigns it to the 

property grid control. This is a powerful mechanism. The selection can be a single report field, a 

group of fields, a section, or the whole report. 

Add the following code to implement the SelectionChanged event: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' the selection changed, need to update property grid and show the         

' properties of the selected object          

Private Sub _c1rd_SelectionChanged(ByVal sender As Object, ByVal e As 

System.EventArgs) Handles _c1rd.SelectionChanged         

   Dim sel As Object() = _c1rd.SelectedFields         

   If (sel.Length > 0) Then         

      _lblPropGrid.Text = "Field Properties"         

      _ppg.SelectedObjects = sel         

   ElseIf Not IsNothing(_c1rd.SelectedSection) Then         

         _lblPropGrid.Text = "Section Properties"         

         _ppg.SelectedObject = _c1rd.SelectedSection         

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner~SelectionChanged_EV.html
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      ElseIf Not IsNothing(_c1rd.Report) Then         

            _lblPropGrid.Text = "Report Properties"         

            _ppg.SelectedObject = _c1rd.Report         

         ' nothing selected         

         Else         

            _lblPropGrid.Text = "Properties"         

            _ppg.SelectedObject = Nothing         

         End If         

   ' done         

   UpdateUI()        

End Sub 

To write code in C# 

C# Copy Code  

 

// the selection changed, need to update property grid and show the         

// properties of the selected object          

private void _c1rd_SelectionChanged(object sender, System.EventArgs e)         

{         

    object[] sel = _c1rd.SelectedFields;         

    if (sel.Length > 0)         

    {         

        _lblPropGrid.Text = "Field Properties";         

        _ppg.SelectedObjects = sel;         

    }         

    else if (_c1rd.SelectedSection != null)          

    {         

        _lblPropGrid.Text = "Section Properties";         

        _ppg.SelectedObject = _c1rd.SelectedSection;         

    }         

    else if (_c1rd.Report != null)         

    {         

        _lblPropGrid.Text = "Report Properties";         

        _ppg.SelectedObject = _c1rd.Report;         

    }         

    else // nothing selected         

    {         

        _lblPropGrid.Text = "Properties";         

        _ppg.SelectedObject = null;         

    } 
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    // done         

    UpdateUI();         

} 

The property grid (_ppg) displays the properties of the object selected in the designer (_c1rd). 

When the user changes the properties of an object using the grid, the designer needs to be 

notified so it can update the display. Conversely, when the user edits an object using the 

designer, the grid needs to be notified and update its display. 

Add the following code to implement the handlers for the PropertyValueChanged event of the 

_ppg control and the ValuesChanged event of the _c1rd control: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' when a value changes in the property window, refresh the designer to show 

the changes         

Private Sub _ppg_PropertyValueChanged(ByVal s As Object, ByVal e As 

System.Windows.Forms.PropertyValueChangedEventArgs) Handles 

_ppg.PropertyValueChanged         

   _c1rd.Refresh()         

   _dirty = True         

   UpdateUI()         

End Sub  

     

' when properties of the selected objects change in the designer,         

' update the property window to show the changes         

Private Sub _c1rd_ValuesChanged(ByVal sender As Object, ByVal e As 

System.EventArgs) Handles _c1rd.ValuesChanged         

   _c1rd.Refresh()         

   _dirty = True         

   UpdateUI()         

End Sub  

To write code in C# 

C# Copy Code  

 

// when a value changes in the property window, refresh the designer         

// to show the changes         

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner~ValuesChanged_EV.html
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private void _ppg_PropertyValueChanged(object s, 

Systems.Windows.Forms.PropertyValueChangedEventArgs e)         

{         

    _c1rd.Refresh();         

    _dirty = true;         

    UpdateUI();         

}         

// when properties of the selected objects change in the designer,         

// update the property window to show the changes         

private void _c1rd_ValuesChanged(object sender, System.EventArgs e)         

{         

    _ppg.Refresh();         

    _dirty = true;         

    UpdateUI();         

} 

 

Step 8 of 9: Add Code to Create and 

Remove Reports 
Using the C1ReportDesigner Control > Step 8 of 9: Add Code to Create and Remove Reports 

Show All  

Hide All  

To remove reports from the list, use the DeleteReport method. The DeleteReport method 

simply removes the selected item from the report list, clears the Report property of the designer 

control, then makes a new selection if the list is not empty. 

Add the following code to remove reports using the DeleteReport method: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' remove current report from the list         

Private Sub DeleteReport()         

   ' a report must be selected         

   Dim index As Integer = _list.SelectedIndex         

   If (index < 0) Then Return 

 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner~Report.html
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   ' remove report from the designer and from the list           

   _c1rd.Report = Nothing         

   _list.Items.RemoveAt(index) 

  

   ' select another report if we can           

   If (index > _list.Items.Count - 1) Then         

      index = _list.Items.Count - 1         

      If (index > - 1) Then         

          _list.SelectedIndex = index         

      End If          

   End If         

   ' done           

   _dirty = True         

   UpdateUI()         

End Sub  

To write code in C# 

C# Copy Code  

 

// remove current report from the list           

private void DeleteReport()         

{         

       // a report must be selected           

       int index = _list.SelectedIndex;         

       if (index < 0) return; 

 

       // remove report from the designer and from the list           

       _c1rd.Report = null;         

       _list.Items.RemoveAt(index); 

 

       // select another report if we can           

       if (index > _list.Items.Count-1)          

          index = _list.Items.Count-1;         

       if (index > -1)          

          _list.SelectedIndex = index; 

 

       // done           

       _dirty = true;         

       UpdateUI();         

} 
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The AddReport method is a little more complex. In the full-fledged report designer, this 

command invokes a wizard that allows the user to select a data source, grouping options, 

layout, and style. When implementing your designer, you can use the wizard code as-is or 

customize it to suit your needs. 

Rather than just creating a blank new report, the simple designer prompts the user for an MDB 

file, selects the first table it can find, then the first five fields, and creates a report based on that. 

Add the following code to create reports using the AddReport method: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub NewReport()         

   ' select a data source (just mdb files in this sample)           

   Dim dlg As New OpenFileDialog()         

   dlg.FileName = "*.mdb"         

   dlg.Title = "Select report data source"         

   If dlg.ShowDialog() <> Windows.Forms.DialogResult.OK Then Return        

  

   ' select first table from data source           

   Dim connString As String = 

String.Format("Provider=Microsoft.Jet.OLEDB.4.0;Data Source={0}", 

dlg.FileName) 

  

   Dim tableName As String = GetFirstTable(connString) 

 

   If tableName.Length = 0 Then         

      MessageBox.Show("Failed to retrieve data from the selected source.")         

      Return         

   End If 

  

   ' create new report           

   Dim rpt As New C1Report()         

   rpt.ReportName = tableName         

 

   ' set data source           

   rpt.DataSource.ConnectionString = connString         

   rpt.DataSource.RecordSource = tableName 

   

   ' add a title field           

   Dim s As Section = rpt.Sections(SectionTypeEnum.Header)         
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   s.Visible = True         

   s.Height = 600         

   Dim f As Field = s.Fields.Add("TitleField", tableName, 0, 0, 4000, 600)         

   f.Font.Bold = True         

   f.Font.Size = 24         

   f.ForeColor = Color.Navy 

   

   ' add up to 5 calculated fields           

   Dim fieldNames As String() = rpt.DataSource.GetDBFieldList(True)         

   Dim cnt As Integer = Math.Min(5, fieldNames.Length) 

  

   ' add a page header           

   s = rpt.Sections(SectionTypeEnum.PageHeader)         

   s.Visible = True         

   s.Height = 400         

   Dim rc As New Rectangle(0, 0, 1000, s.Height) 

  

   Dim i As Integer         

   For i = 0 To cnt - 1         

      f = s.Fields.Add("TitleField", fieldNames(i), rc)         

      f.Font.Bold = True         

      rc.Offset(rc.Width, 0)         

   Next 

    

   ' add detail section           

   s = rpt.Sections(SectionTypeEnum.Detail)         

   s.Visible = True         

   s.Height = 300         

   rc = New Rectangle(0, 0, 1000, s.Height)         

   For i = 0 To cnt - 1         

      f = s.Fields.Add("TitleField", fieldNames(i), rc)         

      f.Calculated = True         

      rc.Offset(rc.Width, 0)         

   Next 

         

   ' add new report to the list and select it           

   _list.Items.Add(New ReportHolder(rpt))         

   _list.SelectedIndex = _list.Items.Count - 1 

  

   ' done           

   _dirty = True         

   UpdateUI()         
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End Sub  

To write code in C# 

C# Copy Code  

 

private void NewReport()         

{         

       // select a data source (just mdb files in this sample)           

       OpenFileDialog dlg = new OpenFileDialog();         

       dlg.FileName = "*.mdb";         

       dlg.Title = "Select report data source";         

       if (dlg.ShowDialog() != DialogResult.OK) return; 

 

       // select first table from data source           

       string connString =         

              string.Format(@"Provider=Microsoft.Jet.OLEDB.4.0;Data 

Source={0};",         

              dlg.FileName);         

       string tableName = GetFirstTable(connString);         

       if (tableName == null || tableName.Length == 0)         

       {         

              MessageBox.Show("Failed to retrieve data from the selected 

source.");         

              return;         

       } 

 

       // create new report           

       C1Report rpt = new C1Report();         

       rpt.ReportName = tableName; 

 

       // set data source           

       rpt.DataSource.ConnectionString = connString;         

       rpt.DataSource.RecordSource = tableName; 

 

       // add a title field           

       Section s = rpt.Sections[SectionTypeEnum.Header];         

       s.Visible = true;        

       s.Height = 600;         

       Field f = s.Fields.Add("TitleField", tableName, 0, 0, 4000, 600);         

       f.Font.Bold = true;         
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       f.Font.Size = 24;         

       f.ForeColor = Color.Navy; 

 

       // add up to 5 calculated fields           

       string[] fieldNames = rpt.DataSource.GetDBFieldList(true);         

       int cnt = Math.Min(5, fieldNames.Length); 

 

       // add a page header           

       s = rpt.Sections[SectionTypeEnum.PageHeader];         

       s.Visible = true;         

       s.Height = 400;         

       Rectangle rc = new Rectangle(0, 0, 1000, (int)s.Height);         

       for (int i = 0; i < cnt; i++)         

       {         

              f = s.Fields.Add("TitleField", fieldNames[i], rc);         

              f.Font.Bold = true;         

              rc.Offset(rc.Width, 0);         

       } 

 

       // add detail section           

       s = rpt.Sections[SectionTypeEnum.Detail];         

       s.Visible = true;         

       s.Height = 300;         

       rc = new Rectangle(0, 0, 1000, (int)s.Height);         

       for (int i = 0; i < cnt; i++)         

       {         

              f = s.Fields.Add("TitleField", fieldNames[i], rc);         

              f.Calculated = true;         

              rc.Offset(rc.Width, 0);         

       } 

 

       // add new report to the list and select it           

       _list.Items.Add(new ReportHolder(rpt));        

       _list.SelectedIndex = _list.Items.Count-1; 

 

       // done           

       _dirty = true;         

       UpdateUI();         

} 

The following code uses a helper function GetFirstTable that opens a connection, retrieves the 

db schema, and returns the name of the first table it finds. Add the following code: 
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To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Function GetFirstTable(connString As String) As String         

   Dim conn As New OleDbConnection(connString)         

   Try         

      ' get schema           

      conn.Open()         

      Dim dt As DataTable = conn.GetOleDbSchemaTable(OleDbSchemaGuid.Tables, 

Nothing)         

      Dim dr As DataRow         

      For Each dr In dt.Rows        

         ' check the table type           

         Dim type As String = dr("TABLE_TYPE").ToString().ToUpper()         

         If (type <> "TABLE" AndAlso type <> "VIEW" AndAlso type <> "LINK" 

Then         

              'skip this one           

         Else         

             ' get the table name            

             tableName = dr("TABLE_NAME").ToString()         

             Exit For         

         End If         

      Next 

 

      ' done            

      conn.Close()         

   Catch         

   End Try          

   ' return the first table we found            

   Return tableName         

End Function 

To write code in C# 

C# Copy Code  

 

private string GetFirstTable(string connString)         

{         

    string tableName = null;         
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    OleDbConnection conn = new OleDbConnection(connString);         

    try         

    {         

        // get schema            

        conn.Open();      

 

        DataTable dt = conn.GetOleDbSchemaTable(OleDbSchemaGuid.Tables, 

null);         

        foreach (DataRow dr in dt.Rows)         

        {         

            // check the table type            

            string type = dr["TABLE_TYPE"].ToString().ToUpper();         

            if (type != "TABLE" && type != "VIEW" && type != "LINK")         

                continue; 

 

            // get the table name            

            tableName = dr["TABLE_NAME"].ToString();         

                break;         

        } 

 

        // done            

        conn.Close();         

    }         

    catch {} 

 

    // return the first table we found            

    return tableName;         

} 

 

Step 9 of 9: Add Code to Create Fields 
Using the C1ReportDesigner Control > Step 9 of 9: Add Code to Create Fields 

Show All  

Hide All  

The simple designer is almost done; it is only missing the code used to create new fields in the 

report. 

If you look at the code we are using for the toolbar event handler, you will see that it set the 

CreateFieldInfo property on the designer and says to wait for the CreateField event from the 

designer. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner~CreateFieldInfo.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner~CreateField_EV.html
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Add the following code to create new fields in the report: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' handle clicks on toolbar buttons         

Private Sub _tb_ButtonClick(ByVal sender As System.Object, ByVal e As 

System.Windows.Forms.ToolBarButtonClickEventArgs) Handles _tb.ButtonClick 

   ' add fields         

   ' (just set create info and wait for CreateField event from designer)         

   If e.Button.Equals(_btnAddField) Then         

      _c1rd.CreateFieldInfo = e.Button         

   If e.Button.Equals(_btnAddLabel) Then         

      _c1rd.CreateFieldInfo = e.Button         

End Sub  

To write code in C# 

C# Copy Code  

 

// handle clicks on toolbar buttons         

private void _tb_ButtonClick(object sender, 

System.Windows.Forms.ToolBarButtonClickEventArgs e)         

{ 

    // add fields         

    // (just set create info and wait for CreateField event from designer)         

    if (e.Button == _btnAddField)    _c1rd.CreateFieldInfo = e.Button;         

    if (e.Button == _btnAddLabel)    _c1rd.CreateFieldInfo = e.Button;         

} 

The CreateFieldInfo property can be set to any non-null object to indicate to the designer that 

you want to create a new field. The designer doesn't know what type of field you want to create 

or how you want to initialize it, so it tracks the mouse and allows the user to draw the field 

outline on a section. It then fires the CreateField event passing the information you need to 

create the field yourself. 

Add the following code to handle the CreateField event: 

To write code in Visual Basic 

Visual Basic Copy Code  
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Dim _ctr As Integer       

     

Private Sub _c1rd_CreateField(ByVal sender As Object, ByVal e As 

C1.Win.C1ReportDesigner.CreateFieldEventArgs) Handles _c1rd.CreateField         

   ' save undo info         

   _c1rd.UndoStack.SaveState() 

     

   ' add label field         

   _ctr = _ctr + 1         

   Dim fieldName As String = String.Format("NewField{0}", _ctr)         

   Dim fieldText As String = fieldName         

   Dim f As Field = e.Section.Fields.Add(fieldName, fieldText, e.FieldBounds)         

 

   ' if this is a calculated field,          

   ' change the Text and Calculated properties         

   If e.CreateFieldInfo.Equals(_btnAddField) Then         

      Dim fieldNames As String() = 

_c1rd.Report.DataSource.GetDBFieldList(True)         

      If (fieldNames.Length > 0) Then         

         f.Text = fieldNames(0)         

         f.Calculated = True         

      End If         

   End If         

End Sub  

To write code in C# 

C# Copy Code  

 

int _ctr = 0;         

private void _c1rd_CreateField(object sender,          

        C1.Win.C1ReportDesigner.CreateFieldEventArgs e)         

{         

    // save undo info        

    _c1rd.UndoStack.SaveState(); 

  

    // add label field         

    string fieldName = string.Format("NewField{0}", ++_ctr);         

    string fieldText = fieldName;         

    Field f = e.Section.Fields.Add(fieldName, fieldText, e.FieldBounds); 
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    // if this is a calculated field,          

    // change the Text and Calculated properties         

    if (e.CreateFieldInfo == _btnAddField)         

    {        

        string[] fieldNames = _c1rd.Report.DataSource.GetDBFieldList(true);         

        if (fieldNames.Length > 0)         

        {         

            f.Text = fieldNames[0];         

            f.Calculated = true;         

        }         

    }        

} 

Note how the code starts by calling the SaveState method on the designer, so the user can 

undo the field creation. After that, the field is created, and the CreateFieldInfo parameter is used 

to customize the new field and make it behave as a label or as a calculated field. 

That concludes the simple designer application: an introduction to the operation of the 

C1ReportDesigner control. 

Reports for WinForms Samples 
Show All  

Hide All  

Please be advised that this ComponentOne software tool is accompanied by various sample 

projects and/or demos which may make use of other development tools included with the 

ComponentOne Studio Enterprise. 

Please refer to the pre-installed product samples through the following path: 

Documents\ComponentOne Samples\WinForms 

Reporting Samples 

Click one of the following links to view a list of reporting samples: 

Visual Basic Samples 

Sample Description 

Chart Add charts to reports using C1Report and C1Chart. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.UndoStack~SaveState.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner.html
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Sample Description 

CreateReport Create reports dynamically using code. This sample uses the 

C1Report component. 

CustomData Create custom data source objects for use with C1Report. This 

sample uses the C1Report and C1PrintPreview component. 

Embedded Load report definitions into the C1Report component at design 

time. This sample uses the C1Report and C1PrintPreview 

component. 

HtmlFields Render reports to HTML preserving HTML formatting. 

Newsletter Create reports without data sources (unbound reports). This 

sample uses the C1Report and C1PrintPreview components. 

NorthWind View reports imported from the NorthWind database. This sample 

uses the C1Report component. 

C# Samples 

Sample Description 

AddScriptObject Add custom objects to C1Report's script engine. 

AdHocSorting Select the sorting criteria before rendering the report. 

ADOReport Use ADODB.Recordset objects as C1Report data sources. 

AzureC1Report  

C1dView This sample implements a report and document viewer application 

with a user interface based on two other ComponentOne products 

- C1Ribbon and C1Command. It also provides a Visual Studio 

project item template that can be used to add a fully customizable 

ribbon preview form to your application. 
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Sample Description 

C1ReportsScheduler Provides a Windows service C1ReportsSchedulerService that can 

be used to run (generate and export or print) C1Report and 

C1PrintDocument objects on schedule at specified times and 

intervals. For details, run the C1ReportsScheduler.exe frontend, and 

click Help | Contents. 

Chart Add charts to reports using C1Report and C1Chart. This sample 

uses the C1Report and C1Chart components. 

CreateReport Create reports dynamically using code. This sample uses the 

C1Report component. 

CustomFields Create custom Chart and Gradient fields that can be added to any 

report. 

CustomHyperlinks Perform custom actions when hyperlinks are clicked. 

CustomPaperSize Create reports that use custom paper sizes. This sample uses the 

C1Report and C1PrintPreview components. 

DynamicFormat Use script properties to format the report based on its contents. 

This sample uses the C1Report component. 

Email Send reports by e-mail. 

ExportXml Export reports to an XML format. 

FlexReport Use a C1FlexGrid control as a data source for your reports. 

HierReport Create reports based on hierarchical data. This sample uses the 

C1Report component. 

HtmlFields Render reports to HTML preserving HTML formatting. 

Images Load images into a report using two methods. 
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Sample Description 

MixedOrientation Renders two C1Reports (one portrait, one landscape) into a single 

PDF document. 

PageCountGroup Keep separate page counts for each group in a report. 

ParameterizedFilter Create reports with a parameterized filter. 

ParseParameters Parse a PARAMETERS statement in a RecordSource string. This 

sample uses the C1Report component. 

ProgressIndicator Display a progress indicator form while a report is rendered. 

ReportBrowser Open report definition files and list their contents. This sample uses 

the C1Report component. 

ReportBuilder Create report definitions automatically based on DataTables. 

ReportDictionary Add a custom look up dictionary object to C1Report's script 

engine. 

RTFReport Shows how to render RTF fields in a report. This sample uses the 

C1Report component. 

SubReportDataSource Use custom data sources with subreports. This sample uses the 

C1Report component. 

XMLData Use any XML document as a report data source. This sample uses 

the C1Report component. 

ZipReport Compress and encrypt report definition files. This sample uses the 

C1Report and C1Zip components. 

XML Samples 

Sample Description 
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Sample Description 

CommonTasks A collection of reports that show how to perform common tasks. 

SampleReports XML report definition files that show C1Report's features. 

C1ReportDesigner Samples 

Sample Description 

SimpleDesigner Uses the C1ReportDesigner control to implement a simple report 

designer. 

Printing and Previewing Samples 

Click the following link to view a list of previewing samples: 

Visual Basic and C# Samples 

Sample Description 

AutoSizeTable The sample shows how to adjust the widths of a table's columns 

based on their content. The sample provides a method 

AutoSizeTable that can be used as-in in any application that 

needs to automatically size tables based on their content. 

CoordinatesOfCharsInText Shows how to use the GetCharRect() method (advanced). The 

sample shows how to use the GetCharRect() method available 

on RenderText and RenderParagraph classes, which allows to find 

out the position and size of individual characters in the text. In 

the sample, a red rectangle is drawn around each character. 

DataBinding The sample demonstrates binding to a simple list (including 

binding to an empty list), binding to a MS Access database, the 

use of grouping, aggregate functions, and binding of table 

row/column groups. This sample requires a 2006 v3 version 

(C1Preview.2 2.0.20063.41002) or later. 

Hyperlinks Shows how to create various types of hyperlinks The sample 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1ReportDesigner.4~C1.Win.C1ReportDesigner.C1ReportDesigner.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderText.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderParagraph.html
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Sample Description 

demonstrates how to create and set up several types of 

hyperlinks supported by C1PrintDocument and the preview 

controls: hyperlinks to anchors within the same document, 

hyperlinks to anchors in other C1PrintDocument objects, 

hyperlinks to locations within the document (render objects, 

pages), hyperlinks to external files/URLs. 

ObjectCoordinates The sample shows how to connect the coordinates in the preview 

pane with the objects in the C1PrintDocument being previewed. 

Methods are provided that find the RenderObject currently under 

the mouse, query the properties of the object, highlight it in the 

preview, and manipulate it: change the object's background color, 

text, or other properties. The changes are immediately reflected 

in the document. Note that for highlighting to work this sample 

requires a 2006 v2 version (C1Preview.2.0.20062.40855) or later. 

PageLayout1 Shows how to use the PageLayouts property. The sample creates 

a document with different page layouts for the first page, even 

pages and odd pages. The different layouts are specified 

declaratively via the PageLayouts property of C1PrintDocument, 

no even handling is involved. 

PageLayout2 Shows how to use the LayoutChangeBefore property of 

RenderObject. The sample creates a document with an object 

that forces a page break, and a different page layout that is 

"nested" within the current layout, so that the current layout is 

automatically restored when the nested object is over. 

RenderObjects Introduces most of the RenderObject types provided by 

C1PrintDocument. The sample creates and previews a 

C1PrintDocument, in which most of the RenderObject types 

provided by C1PrintDocument are included: RenderArea, 

RenderText, RenderGraphics, RenderEmpty, RenderImage, 

RenderRichText, RenderPolygon, RenderTable, RenderParagraph. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~PageLayouts.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~LayoutChangeBefore.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderArea.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderText.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderGraphics.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderEmpty.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderImage.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderRichText.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderPolygon.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderTable.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderParagraph.html
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Sample Description 

RenderTOC Shows how to use the RenderToc object. The sample 

demonstrates how to create the table of contents for a document 

using the dedicated RenderToc render object. 

RotatedText The sample shows how to insert rotated text into 

C1PrintDocument.Text rotated at different angles is shown. 

Stacking Shows how to use stacking rules for render objects' positioning 

The sample demonstrates how to use the 

RenderObject.Stacking property to set stacking rules for block 

(top to bottom and left to right) and inline (left to right) 

positioning of objects. Relative positioning of objects is also 

demonstrated. 

Tables1 Shows how to create tables, set up table headers and footers. The 

sample creates and previews a C1PrintDocument with a table. 

Demonstrates how to set up table headers (including running 

headers) and footers. Shows how to add orphan control (the 

minimum rows printed on the same page before the footer is 

specified). 

Tables2 The sample shows the basic features of tables in 

C1PrintDocument. The following features of tables are 

demonstrated: Table borders (GridLines property, allowing to 

specify the 4 outer and 2 inner lines). 

 Borders around individual cells and groups of cells. 

 Style attributes (including borders) for groups of 

disconnected cells. 

 Cells spanning rows and columns. 

 Content alignment within the cells (spanned or 

otherwise). 

 Table headers and footers. 

 Tags (such as page number/total page count) in table 

footer. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderToc.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style~GridLines.html
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Sample Description 

 Style attributes: borders, font and background images. 

Tables3 Shows multiple inheritance of styles in C1PrintDocument tables. 

The sample demonstrates multiple inheritance of styles in tables. 

A table with some test data is inserted into the document. Some 

style attributes are redefined for the styles of a row, a column, 

and a cell group. Cells at the intersections of the groups inherit 

styles for all, combining them. 

TabPosition Shows how to use the TabPosition property of text rendering 

objects. The sample creates a document with a RenderParagraph 

object, on which the TabPositions property is defined, specifying 

the tab positions calculated on document reflow depending on 

the current page width. 

VisibleRowsCols Demonstrates the Visible property of table rows/columns. The 

sample shows the Visible property of RenderTable rows and 

columns, that allows to you hide table rows and columns without 

removing them from the table. This sample requires a 2006 v3 

version (C1Preview.2 2.0.20063.41002) or later. 

WideTables Shows how to create wide tables spanning several pages The 

sample demonstrates the feature of C1PrintDocument which 

allows rendering of wide objects spanning multiple pages 

horizontally. To enable this feature, the object's CanSplitHorz 

property should be set to True. The preview is also adjusted to 

better show wide objects (margins are hidden, the gap between 

pages set to zero, and the end user is prevented from showing 

the margins). 

WrapperDoc This sample provides source code for a very simple wrapper 

around the new C1PrintDocument implementing some of the 

RenderBlock/Measure methods from the "classic" (old) 

C1PrintDocument. This sample may be especially useful to 

facilitate conversions of applications using the classic preview to 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.TableVector~Visible.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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Sample Description 

the new preview. 

ZeroWidthRowsCols Demonstrates the treatment of table columns with zero width. 

The sample shows that columns with zero width/rows with zero 

height are not rendered at all (as if their Visible property were set 

to False). This sample requires a 2006 v3 version (C1Preview.2 

2.0.20063.41002) or later. 

 

Reports for WinForms Task-Based 

Help 
The task-based help assumes that you are familiar with programming in .NET, have a basic 

knowledge of reports, and know how to use controls in general. By following the steps outlined 

in the help, you will be able to create projects demonstrating a variety of Reports for 

WinForms features, and get a good sense of what the Reports for WinForms components can 

do. 

See Also 

Reporting Task-Based Help 

Printing and Previewing Task-Based Help 

Reporting Task-Based Help 
Reports for WinForms Task-Based Help > Reporting Task-Based Help 

The task-based help assumes that you are familiar with programming in .NET, have a basic 

knowledge of reports, and know how to use controls in general. By following the steps outlined 

in the help, you will be able to create projects demonstrating a variety of C1Report features, and 

get a good sense of what the C1Report component can do. 

Note that you should have the following namespace referenced to your project: 

 C1.C1Report 

CommonTasks.xml 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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Most of this section's topics have pre-built reports that illustrate them. The pre-built reports can 

be found in the CommonTasks.xml report definition file, which if you have installed the 

WinForms Edition samples, you can find in the Documents or MyDocuments folder in the 

ComponentOne Samples\WinForms Edition\C1Report\C1Report\XML\CommonTasks directory. 

See Also 

Adding Images to the Report 

Creating Report Fields 

Customizing the Page Headers 

Formatting Reports 

Loading Report Definitions 

Modifying Subreports 

Rendering Reports (Previewing, Printing, and Exporting) 

Saving a Report Definition 

Adding Images to the Report 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Adding Images to the Report 

Using the C1ReportDesigner, you can add unbound or bound images and create watermarks. 

See Also 

Creating Unbound Images 

Creating Bound Images 

Creating a Watermark 

Creating Unbound Images 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Adding Images to the Report > 

Creating Unbound Images 

Unbound images are static images such as logos and watermarks that are not stored in the 

database. To add unbound image fields to your report, complete the following tasks: 

1. Open the C1ReportDesigner. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner, you can modify the report properties. 

3. Click the Design button to begin editing the report. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/creatingabasicreport.html
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4. In Design mode, click the Picture button located in the Fields group of the Insert tab. 

The Open dialog box appears. 

5. Select the image file you want to include in the report, and click Open. 

6. Click on your report where you would like to place the image, and then resize the field 

to show the image. The following unbound image has been added to the report and is 

being resized: 

 
Note that the image file can be embedded in the report definition, or it can be a 

reference to an external file. To choose the option you prefer, in the Designer select the 

File menu and select Options. The C1ReportDesigner Options dialog box appears 

where you can choose the Embed images into Xml when saving option:

 

 

Note: For the complete report, see report "03: Unbound Images" in the CommonTasks.xml 

report definition file, which is available in the ComponentOne Samples folder. 

 

Creating Bound Images 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Adding Images to the Report > 

Creating Bound Images 

Show All  
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Hide All  

Bound images are images stored in database fields. To display these images in your reports, 

add a field to the report and set its Picture property to a string containing the name of the 

column where the image is stored. 

To add bound image fields to your report using the C1ReportDesigner: 

1. In Design mode of the C1ReportDesigner, click the drop-down in the Picture 

button located in the Fields group of the Insert tab. This shows a menu with all binary 

fields in the current data source. 

2. Select the field you want to add to the report. 

To add bound image fields to your report using code: 

If the field "Photo" in the database contains embedded OLE objects or raw image streams, and 

the report contains a field called "fEmployeePhoto", then the following code would display the 

employee photo in the field: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

fEmployeePhoto.Picture = "Photo" 

To write code in C# 

C# Copy Code  

 

fEmployeePhoto.Picture = "Photo"; 

 

Note: For the complete report, see report "04: Bound Images" in the CommonTasks.xml 

report definition file, which is available in the ComponentOne Samples folder. 

 

Creating a Watermark 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Adding Images to the Report > 

Creating a Watermark 

Watermarks are images displayed behind the report content. The images are often washed-out 

to prevent them from interfering with the actual report content. 
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To display an image as a watermark, set the Picture property to a file that contains the image. 

You can also control the way the watermark is scaled and the pages on which it should appear 

using the PictureAlign and PictureShow properties. 

 

Note: For the complete report, see report "05: Watermark" in the CommonTasks.xml 

report definition file, which is available in the ComponentOne Samples folder. 

 

Creating Report Fields 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Creating Report Fields 

With the report definition loaded into the component and a data source defined, you can add 

and edit report fields. 

The Fields group in the C1ReportDesigner's Insert tab allows you to easily add fields to your 

report. For button descriptions, see Enhancing the Report with Fields. 

 

To add a field to your report, click any of these buttons and complete the following steps: 

 Drag the mouse over the report and the cursor changes into a cross-hair . Click and 

drag to define the rectangle that the new field will occupy, and then release the button 

to create the new field.  

If you change your mind, hit the ESC key or click the Undo button to cancel the 

operation. 

Note that C1Report only has one type of Field object. The buttons simply set some 

properties on the Field object to make it look and act in a certain way. 

OR 

 You can also add fields by copying and pasting existing fields, or by holding down the 

CTRL key and dragging a field or group of fields to a new position to create a copy. 

See Also 
Creating Charts 

Creating Custom Fields 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~Picture.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~PictureAlign.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~PictureShow.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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Creating Charts 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Creating Report Fields > Creating 

Charts 

In the initial versions of C1Report, adding charts to reports required handling the StartSection 

event, generating the chart, and assigning the chart image to a field's Picture property. This is 

not hard to do, and continues to be the most flexible way to add dynamic images to reports. 

However, this approach has two drawbacks: 

 It requires you to write code outside the report definition, which means only your 

application will be capable of showing the report the way it is meant to be shown. 

 It requires you to write code for generating the chart, which can be tedious. 

The current C1Report supports custom report fields, including a chart field that is based on the 

C1Chart control. 

To add a chart field to a Group Header section in your report, complete the following steps: 

1. Open the C1ReportDesigner. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner, you can modify the report properties. 

3. Click the Design button to begin editing the report. 

4. In the Custom Fields group of the Insert tab, click the Chart Field button. 

5. Click in the Group Header section of your report and drag the field to resize the chart. 

6. From the Properties window, set the chart field's Chart.DataX and Chart.DataY 

properties to the values you want to display on the chart. You can show several series 

by setting the Chart.DataY property to a list of fields delimited by semicolons (for 

example, "UnitsInStock;ReorderLevel"). 

The chart data is automatically scoped to the current report group. For example, when 

rendering the "Beverages" section, only data for that category will be charted. You can 

customize the chart using many other properties such as Chart.ChartType, Chart.GridLines, 

Chart.Use3D, and Chart.Palette properties. 

For more information on creating chart fields, see the Adding Chart Fields topic. 

 

Note: For the complete report, see report "11: Charts" in the CommonTasks.xml report 

definition file, which is available in the ComponentOne Samples folder. 

 

Creating Custom Fields 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Creating Report Fields > Creating 

Custom Fields 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~StartSection_EV.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~Picture.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/creatingabasicreport.html
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You can create your own custom fields and add them to the Report Designer palette. To do 

that, you have to: 

1. Create a custom field class that derives from C1.C1Report.Field. 

2. Register your custom field assembly in C1ReportDesigner.exe.settings. 

For registering a custom field, say MyField, add your control to the <customfields> section 

in the C1ReportDesigner.exe.settings file as follows: 

 
<customfields> 

<!-- THIS LINE ADDS A NEW FIELD TO THE DESIGNER --> 

<item value="MyCustomFieldAssembly;MyCustomFieldAssembly.MyField" /> 

</customfields> 

Note that the code above assumes that your field is called "MyField" and it can be found in the 

assembly called "MyCustomFieldAssembly". 

Following are built-in standard custom fields that are loaded in the C1ReportDesigner 

application by default: 

 Chart 

 Gradient 

 SuperLabel 

 QRCode 

 Map 

 

Note: For more insight on custom fields, see report "12: Custom Fields" in the 

CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 

 

Customizing the Page Headers 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Customizing the Page Headers 

This section explains how to customize the behavior of page headers. 

See Also 

Adding a Continued Label to Headers on Page Breaks 

Changing Page Headers Dynamically 

Adding a Continued Label to Headers on Page 

Breaks 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Customizing the Page Headers > 
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Adding a Continued Label to Headers on Page Breaks 

Group Header sections are repeated across page breaks if their Repeat property is set to True. 

This makes the report easier to read, but it can be hard to tell if a group header on a page 

marks the beginning of a group or is just a continuation. 

One way to address this is to add a field with a "Continued" label named, fContinued, for 

example to the group header and control its visibility with script. To do this, complete the 

following steps: 

1. Open the C1ReportDesigner. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner, you can modify the report properties. 

3. Click the Close Print Preview button to begin editing the report. 

4. In Design mode, select Detail from the drop-down list above the Properties window. 

5. Locate the Detail.OnPrint property and click the empty field next to it, and then click the 

ellipsis button. 

6. The VBScript Editor appears. Enter the following VBScript expression in the code 

editor:  

7.  
8. ' VBScript: Detail.OnPrint 
9. fContinued.Visible = true 

10.  

11. Then select GroupFooter from the drop-down list above the Properties window. 

12. Locate the GroupFooter.OnPrint property and click the empty field next to it, and then 

click the ellipsis button. 

13. The VBScript Editor appears. Enter the following VBScript expression in the code 

editor:  

14.  
15. ' VBScript: GroupFooter.OnPrint 

16. fContinued.Visible = false 

17.  

If the fContinued field is initially invisible, then the script will show the label only on continued 

page headers. This script ensures that the fContinued field is visible within the group. Any page 

breaks created after the group footer and before the next Detail section will not show the label. 

 

Note: For the complete report, see report "18: Continued Headers" in the 

CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 

 

Changing Page Headers Dynamically 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Customizing the Page Headers > 

Changing Page Headers Dynamically 

To specify whether Page Header and Page Footer sections should appear on all pages, or be 

suppressed on the pages that contain the report Header and report Footer sections use 

C1Reports PageHeader and PageFooter properties. 
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Sometimes you may want to further customize this behavior. For example, you may want to 

render different headers on odd and even pages. This can be done with some script that shows 

or hides fields depending on the page being rendered. To do this, complete the following steps: 

1. Open the C1ReportDesigner. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner, you can modify the report properties. 

3. Click the Close Print Preview button to begin editing the report. 

4. In Design mode, select Detail from the drop-down list above the Properties window. 

5. Locate the OnFormat property and click the empty field next to it, and then click the 

ellipsis button. 

6. The VBScript Editor appears. Enter the following VBScript expression in the code 

editor:  

7.  
8. odd = (page mod 2 <> 0) 
9. h1odd.Visible = odd 
10. h2odd.Visible = odd 

11. h1even.Visible = not odd 

12. h2even.Visible = not odd 

This script will show or hide fields for odd and even pages if a report header contains 

several fields named "h<x>odd" and "h<x>even". 

Note that to prevent the page header from showing blank spaces, all the fields should 

have the CanShrink property set to True. 

 

Note: For the complete report, see report "09: Dynamic Page Header" in the 

CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 

 

Customizing the Page Layout 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Customizing the Page Layout 

The following topics explain how you can customize the layout of your report. 

See Also 

Controlling Page Breaks 

Creating CanGrow/CanShrink Fields 

Creating a Gutter Margin 

Defining and Using Global Constants 

Specifying Custom Paper Size 
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Controlling Page Breaks 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Customizing the Page Layout > 

Controlling Page Breaks 

By default, C1Report fills each page until the bottom, inserts a page break, and continues 

rendering in the next page. You can override this behavior using several properties: 

 Group.KeepTogether: Determines whether Group Header sections are allowed to render 

on a page by themselves, if they must be rendered with at least one Detail section, or if 

the entire group should be kept together on a page. 

 Section.KeepTogether: Determines whether page breaks are allowed within sections. It 

has lower precedence than Group.KeepTogether. 

 ForcePageBreak: Allows you to specify that page breaks should be inserted before, 

after, or before and after the section. 

 Field.KeepTogether: Determines whether page breaks are allowed within fields. This 

allows long Text fields to span multiple pages. It has lower precedence than 

Section.KeepTogether. 

 ForcePageBreak: Allows you to specify that page breaks should be inserted before, 

after, or before and after the field. 

Set these properties through the Properties grid of the C1ReportDesigner. 

You can use script to change the properties while the report is being rendered. For example, to 

cause page breaks after each 10 Detail sections, complete the following steps: 

1. Open the C1ReportDesigner application. For more information on how to access 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in 

C1ReportDesigner, you can modify the report properties. 

3. Click the Close Print Preview button to begin editing the report. 

4. In Design mode, select Detail from the drop-down list above the Properties window. 

5. Locate the OnPrint property and click the empty field next to it, and then click the 

ellipsis button. 

6. The VBScript Editor appears. Enter the following VBScript expression in the code 

editor:  

7.  
8. cnt = cnt + 1 
9. detail.forcepagebreak = "none" 
10. if cnt >= 10 then 

11.   cnt = 0 

12.   detail.forcepagebreak = "after" 

13. endif 

 

Note: For the complete report, see report "07: Force Page Breaks" in the 

CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 
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Creating CanGrow/CanShrink Fields 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Customizing the Page Layout > 

Creating CanGrow/CanShrink Fields 

It is common for report fields to have content that may span multiple lines or collapse to no 

lines at all. In some cases, you may want to allow these fields to grow or shrink to fit their 

content rather than clip the excess or leave white spaces in the report. 

To do this, in Design mode of the C1ReportDesigner set the Field object's CanGrow and 

CanShrink properties to True. 

Fields that grow push down the fields below them. Likewise, fields that can shrink push up the 

fields below them. Below in this case means "strictly" below, as shown in the following diagram: 

 

 

Field 1 will push or pull fields 2 and 3 when it grows or shrinks. Field 4 will not be affected 

because it is not directly below field 1. The shaded area in the diagram shows the region 

affected by field 1. 

If you want field 4 to remain aligned with fields 2 and 3, add an extra field spanning the whole 

area above fields 2 and 3. The new field will be pushed down by field 1 and will in turn push 

fields 2, 3, and 4. The following diagram shows this new layout: 

 

 

 

Note: For the complete report, see report "06: CanGrow CanShrink" in the 

CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 
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Creating a Gutter Margin 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Customizing the Page Layout > 

Creating a Gutter Margin 

Gutter margins are extra space added to the margins next to the binding. They make it easier to 

bind the pages into folders, brochures, and so on. 

To add a gutter margin to a report, you should increase the MarginLeft property on odd pages 

and use the default value on even pages. This can be done with script. To add script that 

changes the margins based on the page being rendered, complete the following steps: 

1. Open the C1ReportDesigner. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner, you can modify the report properties. 

3. Click the Close Print Preview button to begin editing the report. 

4. In Design mode, select Detail from the drop-down list above the Properties window. 

5. Locate the OnPrint property and click the empty field next to it, and then click the 

ellipsis button. 

6. The VBScript Editor appears. Enter the following VBScript expression in the code 

editor:  

7.  
8. ' VBScript: Report.OnOpen 
9. gutter = report.layout.marginleft ' initialize variable 
10.   

11. ' VBScript: Report.OnPage 

12. report.layout.marginleft = _ 

13.   Iif(page mod 2 = 1, gutter, gutter - 1440) 

 

Note: For the complete report, see report "10: Gutter" in the CommonTasks.xml report 

definition file, which is available in the ComponentOne Samples folder. 

 

Defining and Using Global Constants 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Customizing the Page Layout > 

Defining and Using Global Constants 

There is no special mechanism for defining and using global constants in a report, but you can 

add hidden fields to the report and use their values as global parameters. To do this, complete 

the following steps: 

1. Open the C1ReportDesigner. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner, you can modify the report properties. 

3. Click the Close Print Preview button to begin editing the report. 

4. In the Fields group of the Design tab, click the Add Label button to add a field to your 

report. 

5. Click on your report where you want the field placed and drag to resize the field. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Layout~MarginLeft.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/creatingabasicreport.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~OnPrint.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/creatingabasicreport.html


 

 514 

6. Set the following properties for the field:  

o Field.Name = linesPerPage 

o Field.Text = 14 

o Field.Visible = False 

7. To control the number of detail lines per page, use script. Select Detail from the drop-

down list above the Properties window. 

8. Locate the OnPrint property and click the empty field next to it, and then click the 

ellipsis button. 

The VBScript Editor appears. 

9. Enter the following VBScript expression in the code editor:  

10.  
11. cnt = cnt + 1 

12. detail.forcepagebreak = "none" 

13. if cnt >= linesPerPage then 

14.   cnt = 0 

15.   detail.forcepagebreak = "after" 

16. endif 

Note that the value in the linesPerPage field can be set prior to rendering the report, 

by changing the field's Text property. 

 

Note: For the complete report, see report "08: Global Constant" in the CommonTasks.xml 

report definition file, which is available in the ComponentOne Samples folder. 

 

Specifying Custom Paper Size 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Customizing the Page Layout > 

Specifying Custom Paper Size 

Show All  

Hide All  

By default, C1Report creates reports using the default paper size on the default printer. 

You can specify the paper size and orientation using the PaperSize and Orientation properties. 

However, C1Report checks that the selected paper size is available on the current printer before 

rendering, and changes to the default paper size if the selected setting is not available. 

If you want to specify a certain paper size and use it regardless of the printers available, set the 

PaperSize property to Custom, and set the CustomWidth and CustomHeight properties to the 

page dimensions (in twips). 

To specify a custom paper size of 25" x 11" for your report using the 

C1ReportDesigner: 

1. Open the C1ReportDesigner. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner, you can modify the report properties. 
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3. Click the Close Print Preview button to begin editing the report. 

4. In Design mode, select your report from the drop-down list above the Properties 

window. 

5. Locate Layout and expand the property node to view all available properties. 

6. Set the Custom Height property to 25" or 25in.  

Notice that the measurement is converted into twips automatically. The Property 

window display the measurement in twips (36000). 

7. Set the Custom Width property to 11" or 11in.  

The Property window displays the measurement in twips (15840). 

8. Set the PaperSize property to Custom. 

To specify a custom paper size of 25" x 11" for your report using code: 

Regardless of what is available on the printer, the following code sets the report paper to 25" x 

11": 

To write code in Visual Basic 

Visual Basic Copy Code  

 

c1r.Layout.PaperSize = PaperKind.Custom 

c1r.Layout.CustomHeight = 25 * 1440 ' in twips 

c1r.Layout.CustomWidth = 11 * 1440 

To write code in C# 

C# Copy Code  

 

c1r.Layout.PaperSize = PaperKind.Custom; 

c1r.Layout.CustomHeight = 25 * 1440; // in twips 

c1r.Layout.CustomWidth = 11 * 1440; 

 

Note: For the complete report, see report "02: Custom Paper Size" in the 

CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 
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Formatting Reports 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Formatting Reports 

The following topics show how to apply formatting to your report. By simply modifying 

properties in the Properties window or adding a few lines of script to your VBScript expression, 

you can visually enhance your report. 

See Also 

Adding Alternating Background Color 

Adding Conditional Formatting 

Editing the Field's Format Based on Value 

Suppressing or Forcing the Display of Zeros 

Adding Alternating Background Color 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Formatting Reports > Adding 

Alternating Background Color 

To create a report with alternating background color, use the OnPrint property of the Detail 

section to change the BackColor property of the section. To do this, complete the following 

steps: 

1. Open the C1ReportDesigner. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner, you can modify the report properties. 

3. Click the Close Print Preview button to begin editing the report. 

4. In Design mode, select the report from the drop-down list above the Properties 

window. 

5. Locate the OnOpen property and enter cnt = 0. This initializes the cnt variable. 

6. Next, select Detail from the drop-down list above the Properties window. 

7. Locate the OnPrint property and click the empty field next to it, and then click the 

ellipsis button. 

8. The VBScrpit Editor appears. Enter the following VBScript expression in the code 

editor:  

9.  
10. cnt = cnt + 1 

11. if cnt mod 2 = 0 then 

12.   detail.backcolor = rgb(200,220,200) 

13. else 

14.   detail.backcolor = rgb(255,255,255) 

15. endif 

16. Click the Preview button to preview the report with alternating background. 

This topic illustrates the following: 
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This report illustrates the alternating background color. 

 

 

Whenever a Detail section is rendered, the counter is incremented and the BackColor property 

of the Detail section is toggled. 

 

Note: For the complete report, see report "01: Alternating Background (Greenbar report)" 

in the CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 

 

Adding Conditional Formatting 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Formatting Reports > Adding 

Conditional Formatting 

In some cases you may want to change a field's appearance depending on the data it 

represents. For example, you may want to highlight items that are expensive, or low in stock. 

This can be done with script. 

To do this, complete the following steps: 

1. Open the C1ReportDesigner. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner, you can modify the report properties. 

3. Click the Close Print Preview button to begin editing the report. 

4. In Design mode, select Detail from the drop-down list above the Properties window 

(since this section contains the fields to add conditional formatting to). 

5. Locate the OnFormat property and click the empty field next to it, and then click the 

ellipsis button. 

6. The VBScript Editor appears. Enter the following VBScript expression in the code 

editor:  

7.  
8. ' VBScript: Detail.OnFormat 
9. If UnitsInStock + UnitsOnOrder < ReorderLevel And _ 
10.    Discontinued = False Then 

11.   Detail.BackColor = rgb(255,190,190) 

12. Else 
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13.   Detail.BackColor = vbWhite 

14. Endif 

The script changes the Detail section's BackColor property depending on the value of 

the fields UnitsInStock, UnitsOnOrder, ReorderLevel, and Discontinued. 

 

Note: For the complete report, see report "16: Conditional Formatting" in the 

CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 

 

Editing the Field's Format Based on Value 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Formatting Reports > Editing the 

Field's Format Based on Value 

You can change a report field's format based on its value by specifying an expression for the 

Detail section's OnFormat property. 

To specify an expression for the OnFormat property, complete the following steps: 

1. Open the C1ReportDesigner. For more information on how to access the 

C1ReportDesigner, see Accessing C1ReportDesigner from Visual Studio. 

2. Create a new report or open an existing report. Once you have the report in the 

C1ReportDesigner, you can modify the report properties. 

3. Click the Close Print Preview button to begin editing the report. 

4. In Design mode, select Detail from the Property window's drop-down list to view the 

available properties for the Detail section. 

5. Locate the OnFormat property and click the ellipsis button next to the property. 

6. The VBScript Editor appears where you can specify an expression.  

The following expression changes the UnitsInStock field's ForeColor to red if the sum of 

the UnitsInStock value and the UnitsOnOrder value is less than the ReorderLevel value. 

There are several ways to write this expression. 

Option 1: 

 
UnitsInStockCtl.Forecolor = Iif(UnitsInStock + UnitsOnOrder < 

ReorderLevel, vbRed, vbBlack) 

Option 2: 

 
lowStock = UnitsInStock + UnitsOnOrder < ReorderLevel 

UnitsInStockCtl.Forecolor = Iif(lowStock, vbRed, vbBlack) 

Option 3: 

 
If UnitsInStock + UnitsOnOrder < ReorderLevel Then 

    UnitsInStockCtl.Forecolor = vbRed 

Else 

    UnitsInStockCtl.Forecolor = vbBlack 
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End If 

Option 4: 

 
color = Iif(UnitsInStock + UnitsOnOrder < ReorderLevel, vbred, 

vbblack) 

UnitsInStockCtl.Forecolor = color 

This topic illustrates the following: 

Notice that the Outback Lager's UnitsInStock value is formatted in red since the sum of the 

UnitsInStock and UnitsOnOrder is less than the ReorderLevel. 

 

 

Suppressing or Forcing the Display of Zeros 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Formatting Reports > Suppressing 

or Forcing the Display of Zeros 

To suppress the display of fields with value zero, set their Format property to #. The pound sign 

is a formatting symbol that displays only significant digits (no leading or trailing zeros). 

To force the display of a certain number of digits, use a format like "0000". The zero forces the 

display of a digit, including leading and trailing zeros. 

Each format string can have up to three sections separated by semi-colons. If two sections are 

provided, the first is used for positive values and zero, the second for negative values. If three 

sections are provided, the first is used for positive values, the second for negative values, and 

the third for zero. For example: "#;(#);ZERO". 

 

Note: For the complete report, see report "21: Suppress or Force Zeros" in the 

CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 

 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Section~OnFormat.html


 

 520 

Loading Report Definitions 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Loading Report Definitions 

C1Report works by combining a report definition with raw data to create reports. In order to 

create reports, you need to load the report definition into C1Report. The following topics 

explain several ways to load report definitions. 

See Also 

Loading a Report Definition from a File 

Loading a Report Definition from a String 

Loading a Report Definition from a File 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Loading Report Definitions > 

Loading a Report Definition from a File 

Show All  

Hide All  

You can use the C1ReportDesigner to create report definition files (XML files that may contain 

one or more report definitions). For details on how to use the C1ReportDesigner, see the 

Working with C1ReportDesigner section of the documentation. 

To load a report definition from a file at design time: 

To load a report definition from a file at design time, complete one of the following tasks: 

 Right-click the C1Report component and select the Load Report menu option.  

OR 

 Click the smart tag ( ) above the C1Report component and select Load Report from 

the C1Report Tasks menu. 

Using the Select a report dialog box to select the report you want, complete the following 

tasks: 

1. Click the ellipsis button. The Open dialog box appears and you can select the XML file. 

2. The available report definitions are listed in the Report drop-down box. Select the 

report definition to load. 

3. Click Load and OK to close the dialog box. 

This is what the report selector dialog box looks like: 
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To load a report definition from a file using code: 

To load a report definition from a file, use the Load method. It takes as parameters the name of 

the report definition file and the name of the report you want to load. If you want to list the 

reports contained in a report definition file, use the GetReportInfo method. It returns a list of 

the reports in the file. 

For example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Get list of reports in a report definition file 

Dim reports As String() = c1r.GetReportInfo(reportFile) 

  

' Load first report into C1Report component 

c1r.Load(reportFile, reports(0)) 

To write code in C# 

C# Copy Code  

 

// Get list of reports in a report definition file 

string[] reports = c1r.GetReportInfo(reportFile); 

  

// Load first report into C1Report component 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Load.html
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c1r.Load(reportFile, reports[0]); 

 

Loading a Report Definition from a String 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Loading Report Definitions > 

Loading a Report Definition from a String 

Show All  

Hide All  

C1Report has a ReportDefinition property that allows you to get or set the entire report 

definition as a string. This is a convenient way to store and retrieve report definitions in 

databases or in data structures within your application. 

The ReportDefinition string contains the exact same XML that would be stored in the report 

definition file, for example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Load report definition into C1Report component 

c1r.Load(reportFile, reportName) 

  

' Copy report definition to the clipboard 

Dim repDef As String = c1r.ReportDefinition 

Clipboard.SetDataObject(repDef) 

  

' Copy report definition to c1r2 component 

c1r2.ReportDefinition = repDef 

To write code in C# 

C# Copy Code  

 

// Load report definition into C1Report component 

c1r.Load(reportFile, reportName); 

  

// Copy report definition to the clipboard 

string repDef = c1r.ReportDefinition; 

Clipboard.SetDataObject(repDef); 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~ReportDefinition.html


 

 523 

  

// Copy report definition to c1r2 component 

c1r2.ReportDefinition = repDef; 

 

Modifying Subreports 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Modifying Subreports 

This section shows how to modify subreports. Subreports are regular reports contained in a field 

in another report - the main report - that are usually designed to display detail information 

based on a current value in the main report, in a master-detail scenario. For more information 

on subreports, see the Subreport property in the reference section. 

See Also 

Adding Page Headers to Subreports 

Retrieving Values from Subreports 

Adding Page Headers to Subreports 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Modifying Subreports > Adding 

Page Headers to Subreports 

C1Report ignores Page Header and Page Footer sections in subreports. Instead, it uses the Page 

Header and Page Footer sections defined in the main report. This is the same behavior as in 

Microsoft Access. 

In many cases, however, you would like your subreports to include header information across 

page breaks. To do this, place the headers in a Group Header section and set the section's 

Repeat property to True. If your subreport doesn't have any groups, add an empty one. 

 

Note: For the complete report, see report "14: Page Headers in Subreports" in the 

CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 

 

Retrieving Values from Subreports 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Modifying Subreports > Retrieving 

Values from Subreports 

In some cases you may want to pass data from the subreport back to the main report. Script 

variables can't be used for this because each report has its own script scope (this avoids the 

possibility of conflicting variable names). 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Subreport.html
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To pass data from a subreport back to the main report, you have to store values in subreport 

fields or in the subreport's Tag property, then have the main report read those values. 

In this sample, the subreport calculates the average unit price per product category and stores 

that value in its Tag property. The main report retrieves and displays that value. 

 

Note: For the complete report, see report "15: Retrieve Values from Subreports" in the 

CommonTasks.xml report definition file, which is available in the ComponentOne 

Samples folder. 

 

Rendering Reports (Previewing, Printing, and 

Exporting) 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Rendering Reports (Previewing, 

Printing, and Exporting) 

Once the report definition has been loaded into the component and a data source has been 

defined, you can render the report to the printer, into preview controls, or to report files. 

See Also 

Displaying a Progress Indicator While the Report Renders 

Previewing Reports 

Printing Reports 

Exporting the Report 

Displaying a Progress Indicator While the Report 

Renders 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Rendering Reports (Previewing, 

Printing, and Exporting) > Displaying a Progress Indicator While the Report Renders 

Show All  

Hide All  

Most preview applications have progress indicators that show which page is being rendered 

and have a button that allows the user to cancel the report while it is being generated. The .NET 

print preview controls provide this automatically for you. If you are printing the report directly 

to the printer or exporting it to a file, however, there is no built-in progress report UI. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.Field~Tag.html
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Use C1Report events to create a progress report dialog, or to update a status bar while the 

report is being rendered. The StartPage and EndReport events are sufficient to provide 

feedback on which page is being printed and when the report is finished. For example, this code 

uses the StartPage event to provide feedback through a status bar (StatusStrip1): 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub c1r_StartPage(ByVal sender As System.Object, ByVal e As 

C1.Win.C1Report.ReportEventArgs) Handles c1r.StartPage 

       StatusStrip1.Text = String.Format("Rendering page {0} of '{1}'...", 

c1r.Page, c1r.ReportName) 

End Sub 

To write code in C# 

C# Copy Code  

 

private void c1r_StartPage(object sender, ReportEventArgs e) 

{ 

       statusStrip1.Text = string.Format("Rendering page {0} of '{1}'...", 

       c1r.Page, c1r.ReportName); 

} 

To cancel the report before it is finished, add a Cancel button to your application and use it to 

set the C1Report.Cancel property to True. For example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub _btnCancel_Click(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles btnCancel.Click 

   c1r.Cancel = True 

   Close() 

End Sub 

To write code in C# 
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C# Copy Code  

 

private void _btnCancel_Click(object sender, System.EventArgs e) 

{ 

       c1r.Cancel = true; 

       Close(); 

} 

Note that you may also want to provide progress bars and "page n of m" indicators, but that is 

generally difficult to do because the page count is not known until the report has been 

rendered. 

 

Note: For a complete sample using a progress indicator, see the ProgressIndicator sample 

installed in the ComponentOne Samples folder. 

 

Previewing Reports 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Rendering Reports (Previewing, 

Printing, and Exporting) > Previewing Reports 

Show All  

Hide All  

To preview the report, use the use the C1Report.Document property. Assign it to the 

Document property in the Reports for WinForms preview control or to the .NET PrintPreview 

or PrintPreviewDialog controls and the preview controls will display the report and allow the 

user to browse, zoom, or print it. For example: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Load report definition 

c1r.Load(reportFile, reportName) 

  

' Preview the document 

c1preview1.Document = c1r 

To write code in C# 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report~Document.html


 

 527 

C# Copy Code  

 

// Load report definition 

c1r.Load(reportFile, reportName); 

  

// Preview the document 

c1preview1.Document = c1r; 

 

Note: C1Report works with the .NET preview components, but it is optimized to work with 

the included Reports for WinForms preview controls. When used with the included 

controls, you can see each report page as it is generated. With the standard controls, you 

have to wait until the entire report is ready before the first page is displayed. 

 

Printing Reports 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Rendering Reports (Previewing, 

Printing, and Exporting) > Printing Reports 

Show All  

Hide All  

To print a report directly to the printer, use the C1Report.Document property. This property 

returns a standard PrintDocument object that has a Print method and exposes printer and 

page settings. 

For example, the following code shows a print dialog and prints the report: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Load report definition 

c1r.Load(reportFile, reportName) 

  

' Get PrintDocument object 

PrintDocument doc = c1r 

  

' Show a PrintDialog so user can customize the printing 

Dim pd As PrintDialog = New PrintDialog() 

  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Report.C1Report.html
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' Use PrinterSettings in report document 

pd.PrinterSettings = doc.PrinterSettings 

  

' Show the dialog and print the report 

If pd.ShowDialog() = DialogResult.OK Then 

       doc.Print() 

End If 

  

' Cleanup and release PrintDialog resources 

pd.Dispose() 

To write code in C# 

C# Copy Code  

 

// Load report definition 

c1r.Load(reportFile, reportName); 

  

// Get PrintDocument object 

PrintDocument doc = c1r; 

  

// Show a PrintDialog so user can customize the printing 

PrintDialog pd = new PrintDialog(); 

  

// Use PrinterSettings in report document 

pd.PrinterSettings = doc.PrinterSettings; 

  

// Show the dialog and print the report 

if (pd.ShowDialog() == DialogResult.OK) 

doc.Print(); 

  

// Cleanup and release PrintDialog resources 

pd.Dispose(); 

 

Exporting the Report 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Rendering Reports (Previewing, 

Printing, and Exporting) > Exporting the Report 

Show All  

Hide All  
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Exporting the report to common file formats 

C1Report has a RenderToFile method that allows you to export your report to several file 

formats, including HTML, RTF, PDF, TIFF, Text, and XLS. For example, the following code creates 

PDF and XLS versions of a report: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Load report definition 

c1r.Load(reportFile, reportName) 

  

' Export to PDF 

c1r.RenderToFile(outFile + ".pdf", FileFormatEnum.PDF) 

c1r.RenderToFile(outFile + ".xls", FileFormatEnum.Excel) 

To write code in C# 

C# Copy Code  

 

// Load report definition 

c1r.Load(reportFile, reportName); 

  

// Export to PDF 

c1r.RenderToFile(outFile + ".pdf", FileFormatEnum.PDF); 

c1r.RenderToFile(outFile + ".xls", FileFormatEnum.Excel); 

 

Note: When a document is exported to the RTF or the DOCX formats with the "preserve 

pagination" option selected, text is placed in text boxes and the ability to reflow text in the 

resulting document may be limited. 

Exporting the report to custom formats 

If you want to export the report to a format that is not supported by C1Report, you can write 

your own export filter class and use the C1Report.RenderToFilter method to render the report 

into your custom filter. 

Custom filters are classes that derive from the C1.Win.C1Report.ExportFilter class and override 

a few simple methods like StartReport, StartSection, RenderField, EndSection, and EndReport. 

Writing a custom export filter is not difficult. It can be used, for example, to create custom XML 

representations of your reports for later processing by other applications. 
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Saving a Report Definition 
Reports for WinForms Task-Based Help > Reporting Task-Based Help > Saving a Report Definition 

When you are done creating and viewing your report in the C1ReportDesigner application, 

select the Application button and select Save to save the report definition file. The Designer 

saves the report definition in XML format, which can be read back into the Designer or directly 

into a C1Report component. 

Printing and Previewing Task-Based Help 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help 

The task-based help assumes that you are familiar with programming in Visual Studio. By 

following the steps outlined in the help, you will be able to create projects demonstrating a 

variety of Reports for WinForms previewing features and get a good sense of what Reports 

for WinForms can do. If you've never used Reports for WinForms before, you may want to 

work through the C1PrintDocument Quick Start first to familiarize yourself with the product. 

For task-based help topic create a new .NET project and place a C1PrintDocument and a 

C1PrintPreview component on the form and set C1PrintPreviewControl1's Document property 

to C1PrintDocument1. Also, you should have the following namespaces referenced to your 

project: 

 C1.Win.C1Preview 

 C1.C1Preview 

See Also 
Setting Document Information 

Hiding the Navigation Panel 

Adding Outline Entries to the Outline Tab 

Adding Columns to a Page 

Customizing the File Formats in the Save As Dialog Box 

Drawing Text at an Angle 

Formatting Tables 

Inserting a Page Break 

Printing in Landscape 

Setting the Page Size 

Resizing or Scaling an Image 
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Adding a Watermark Image 

Setting the Initial Zoom Mode 

Removing an Item from the Context Menu 

Disabling the Context Menu 

Setting Document Information 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Setting Document 

Information 

Show All  

Hide All  

To set the document information, enter values in the Author, Comment, Company, 

CreationTime, Creator, Keywords, Manager, Operator, Producer, RevisionTime, Subject, and Title 

properties either in the designer or in code. 

In the Designer 

1. In the C1PrintDocument Properties window, locate the DocumentInfo property and 

expand the property node. 

 
2. Enter values and press ENTER when finished to set the property.  

 

Note: Some properties have built-in editors to help you set the property, such as:  

Clicking the ellipsis button next to the Keywords property opens the String Collection 

Editor, where you can enter keywords for the document. 
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Clicking the drop-down arrow next to the CreationTime or RevisionTime properties 

allows you to choose a date. 

3. The default value for the Creator property is ComponentOne Document Engine. 

In Code 

The following code should be added to the Form_Load event. 

To set the Author property, add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.DocumentInfo.Author = "Jane Doe" 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.Author = "Jane Doe"; 

To set the Comment property, add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.DocumentInfo.Comment = "This is a C1PrintDocument file." 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.Comment = "This is a C1PrintDocument 

file."; 

To set the Company property, add the following code: 

To write code in Visual Basic 
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Visual Basic Copy Code  

 

Me.C1PrintDocument1.DocumentInfo.Company = "ComponentOne" 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.Company = "ComponentOne"; 

To set the CreationTime property, add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.DocumentInfo.CreationTime = "2/29/08" 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.CreationTime = "2/29/08"; 

To set the Creator property, add the following code. The default value is ComponentOne 

Document Engine. 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.DocumentInfo.Creator = "C1PrintPreview" 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.Creator = "C1PrintPreview"; 
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To set the Keywords property, add the following code. Keywords should be separated with a 

space. 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.DocumentInfo.Keywords = New String() {"C1PrintPreview 

ComponentOne C1PrintDocument"} 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.Keywords = new string() {"C1PrintPreview 

ComponentOne C1PrintDocument"}; 

To set the property, add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.DocumentInfo.Manager = "John Smith" 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.Manager = "John Smith"; 

To set the Operator property, add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.DocumentInfo.Operator = "Joe Brown" 

To write code in C# 
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C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.Operator = "Joe Brown"; 

To set the Producer property, add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.DocumentInfo.Producer = "ComponentOne Preview for .NET" 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.Producer = "ComponentOne Preview for 

.NET"; 

To set the RevisionTime property, add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.DocumentInfo.RevisionTime = "2/29/08" 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.RevisionTime = "2/29/08"; 

To set the Subject property, add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  
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Me.C1PrintDocument1.DocumentInfo.Subject = "Document Creation" 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.Subject = "Document Creation"; 

To set the Title property, add the following code: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.DocumentInfo.Title = "Creating Documents with 

C1PrintPreview" 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.DocumentInfo.Title = "Creating Documents with 

C1PrintPreview"; 

 

Hiding the Navigation Panel 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Hiding the 

Navigation Panel 

To hide the navigational panel, set the NavigationPanelVisible property to False. This can be set 

at either in the designer or in code. 

In the Smart Designer 

1. Open the Main Menu floating toolbar. 

2. Select the Layout button to open the Layout dialog box. 
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3. Uncheck Navigation panel to set the NavigationPanelVisible property to False. 

 

In the Properties Window 

1. Select the C1PrintPreviewControl and navigate to the Properties window. 

2. Set the NavigationPanelVisible property to False. 

 

In Code 

Add the following code to the Form_Load event: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintPreviewControl1.NavigationPanelVisible = False 

To write code in C# 

C# Copy Code  

 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html


 

 538 

this.c1PrintPreviewControl1.NavigationPanelVisible = false; 

What You've Accomplished 

The navigation panel will not be visible: 

 

Adding Outline Entries to the Outline Tab 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Adding Outline 

Entries to the Outline Tab 

Show All  

Hide All  

To add outline entries to the Outline tab, use the OutlineNodeCollection.Add method. 

1. From the Toolbox, add the C1PrintPreviewControl and C1PrintDocument controls to 

your project. 

2. Click C1PrintPreviewControl1 to select it and in the Properties window set its 

Document property to C1PrintDocument1. 

3. Add the following code to the Form_Load event:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Make the document.     
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MakeDoc() 

 

' Generate the document.     

Me.C1PrintDocument1.Generate() 

To write code in C# 

C# Copy Code  

 

// Make the document.     

MakeDoc(); 

 

// Generate the document.     

this.c1PrintDocument1.Generate(); 

4. Add the MakeDoc subroutine, which uses the OutlineNodeCollection.Add method to 

add outline entries to the Outline tab:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub MakeDoc() 

 

   ' Create RenderText1.     

   Dim rt1 As New C1.C1Preview.RenderText     

   rt1.Text = "This is RenderText1." 

 

   ' Add an outline entry point for RenderText1.     

   Me.C1PrintDocument1.Outlines.Add("RenderText1", rt1) 

 

   ' Insert a page break.     

   rt1.BreakAfter = C1.C1Preview.BreakEnum.Page 

 

   ' Create RenderText2.     

   Dim rt2 As New C1.C1Preview.RenderText     

   rt2.Text = "This is RenderText2." 

 

   ' Add an outline entry point for RenderText2.     

   Me.C1PrintDocument1.Outlines.Add("RenderText2", rt2) 
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   ' Add the RenderText to the document.     

   Me.C1PrintDocument1.Body.Children.Add(rt1)     

   Me.C1PrintDocument1.Body.Children.Add(rt2)     

End Sub 

To write code in C# 

C# Copy Code  

 

private void MakeDoc()     

{ 

 

   // Create RenderText1.     

   C1.C1Preview.RenderText rt1 = new C1.C1Preview.RenderText();     

   rt1.Text = "This is RenderText1."; 

 

   // Add an outline entry point for RenderText1.     

   this.c1PrintDocument1.Outlines.Add("RenderText1", rt1); 

 

   // Add a page break.     

   rt1.BreakAfter = C1.C1Preview.BreakEnum.Page; 

 

   // Create RenderText2.     

   C1.C1Preview.RenderText rt2 = new C1.C1Preview.RenderText();     

   rt2.Text = "This is RenderText2."; 

 

   // Add an outline entry point for RenderText2.     

   this.c1PrintDocument1.Outlines.Add("RenderText2", rt2); 

 

   // Add the RenderText to the document.     

   this.c1PrintDocument1.Body.Children.Add(rt1);     

   this.c1PrintDocument1.Body.Children.Add(rt2);     

} 

What You've Accomplished 

The outline entries "RenderText1" and "RenderText2" are added to the Outline tab: 
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Adding Columns to a Page 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Adding Columns to 

a Page 

Show All  

Hide All  

To add columns to a page, use the Add method. 

1. Navigate to the Toolbox, and add the C1PrintPreviewControl and C1PrintDocument 

controls to your project. 

2. Click C1PrintPreviewControl1 to select it and in the Properties window set its 

Document property to C1PrintDocument1. 

3. Add the following code to the Form_Load event:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

// Make the document.     

MakeDoc(); 

  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.PageColumnDefCollection~Add.html
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// Generate the document.     

this.c1PrintDocument1.Generate(); 

To write code in C# 

C# Copy Code  

 

' Make the document.     

MakeDoc() 

 

' Generate the document.     

Me.C1PrintDocument1.Generate() 

4. Add the MakeDoc subroutine, which uses the Add method to add columns to all of the 

pages in the document:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub MakeDoc() 

 

   ' Create page layout.     

   Dim pl As New C1.C1Preview.PageLayout 

 

   ' Add columns.     

   pl.Columns.Add()     

   pl.Columns.Add()     

   pl.PageSettings = New C1.C1Preview.C1PageSettings()     

   Me.C1PrintDocument1.PageLayouts.Default = pl 

 

   ' Create RenderText1.     

   Dim rt1 As New C1.C1Preview.RenderText     

   rt1.Text = "This is the house that Jack built. This is the carrot, that 

lay in the house that Jack built. This is the rat, that ate the carrot, that 

lay in the house that Jack built. This is the cat, that chased the rat, that 

ate the carrot, that lay in the house that Jack built." 

 

   ' Insert column break.     

   rt1.BreakAfter = C1.C1Preview.BreakEnum.Column 
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   ' Create RenderText2.     

   Dim rt2 As New C1.C1Preview.RenderText     

   rt2.Text = "This is the dog that worried the cat, that chased the rat, 

that ate the carrot, that lay in the house that Jack built. This is the cow 

with the crumbled horn, that tossed the dog, that worried the cat, that 

chased the rat, that ate the carrot, that lay in the house that Jack built. 

This is the maiden all forlorn, that milked the cow with the crumbled horn, 

that tossed the dog, that worried the cat, that chased the rat, that ate the 

carrot, that lay in the house that Jack  built. This is the man all tattered 

and torn, that kissed the maiden all forlorn, that milked the cow with the 

crumbled horn, that tossed the dog, that worried the cat, that chased the 

rat, that ate the carrot, that lay in the house that Jack  built." 

 

   ' Insert column break.     

   rt2.BreakAfter = C1.C1Preview.BreakEnum.Column 

 

   ' Create RenderText3.     

   Dim rt3 As New C1.C1Preview.RenderText     

   rt3.Text = "This is the priest all shaven and shorn, that married the man 

all tattered and torn, that kissed the maiden all forlorn, that milked the 

cow with the crumbled horn, that tossed the dog, that worried the cat, that 

chased the rat, that ate the carrot, that lay in the house that Jack built. 

This is the cock that crowed in the morn, that waked the priest all shaven 

and shorn, that married the man all tattered and torn, that kissed the maiden 

all forlorn, that milked the cow with the crumbled horn, that tossed the dog, 

that worried the cat, that chased the rat, that ate the carrot, that lay in 

the house that Jack built. This is the farmer sowing the corn, that kept the 

cock that crowed in the morn, that waked the priest all shaven and shorn, 

that married the man all tattered and torn, that kissed the maiden all 

forlorn, that milked the cow with the crumbled horn, that tossed the dog, 

that worried the cat, that chased the rat, that ate the carrot, that lay in 

the house that Jack built." 

 

   ' Add the RenderText to the document.     

   Me.C1PrintDocument1.Body.Children.Add(rt1)     

   Me.C1PrintDocument1.Body.Children.Add(rt2)     

   Me.C1PrintDocument1.Body.Children.Add(rt3)     

End Sub 

To write code in C# 
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C# Copy Code  

 

public void MakeDoc()     

{ 

 

   // Create page layout.     

   C1.C1Preview.PageLayout pl = new C1.C1Preview.PageLayout(); 

 

   // Add columns.     

   pl.Columns.Add();     

   pl.Columns.Add();      

   pl.PageSettings = new C1.C1Preview.C1PageSettings();     

   this.c1PrintDocument1.PageLayouts.Default = pl; 

 

   // Create RenderText1.     

   C1.C1Preview.RenderText rt1 = new C1.C1Preview.RenderText();     

   rt1.Text = "This is the house that Jack built. This is the carrot, that 

lay in the house that Jack built. This is the rat, that ate the carrot, that 

lay in the house that Jack built. This is the cat, that chased the rat, that 

ate the carrot, that lay in the house that Jack built.";  

 

   // Insert column break.     

   rt1.BreakAfter = C1.C1Preview.BreakEnum.Column; 

 

   // Create RenderText2.     

   C1.C1Preview.RenderText rt2 = new C1.C1Preview.RenderText();     

   rt2.Text = "This is the dog that worried the cat, that chased the rat, 

that ate the carrot, that lay in the house that Jack built. This is the cow 

with the crumbled horn, that tossed the dog, that worried the cat, that 

chased the rat, that ate the carrot, that lay in the house that Jack built. 

This is the maiden all forlorn, that milked the cow with the crumbled horn, 

that tossed the dog, that worried the cat, that chased the rat, that ate the 

carrot, that lay in the house that Jack built. This is the man all tattered 

and torn, that kissed the maiden all forlorn, that milked the cow with the 

crumbled horn, that tossed the dog, that worried the cat, that chased the 

rat, that ate the carrot, that lay in the house that Jack built."; 

 

   // Insert column break.     

   rt2.BreakAfter = C1.C1Preview.BreakEnum.Column; 

 

   // Create RenderText3.     
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   C1.C1Preview.RenderText rt3 = new C1.C1Preview.RenderText();     

   rt3.Text = "This is the priest all shaven and shorn, that married the man 

all tattered and torn, that kissed the maiden all forlorn, that milked the 

cow with the crumbled horn, that tossed the dog, that worried the cat, that 

chased the rat, that ate the carrot, that lay in the house that Jack built. 

This is the cock that crowed in the morn, that waked the priest all shaven 

and shorn, that married the man all tattered and torn, that kissed the maiden 

all forlorn, that milked the cow with the crumbled horn, that tossed the dog, 

that worried the cat, that chased the rat, that ate the carrot, that lay in 

the house that Jack built. This is the farmer sowing the corn, that kept the 

cock that crowed in the morn, that waked the priest all shaven and shorn, 

that married the man all tattered and torn, that kissed the maiden all 

forlorn, that milked the cow with the crumbled horn, that tossed the dog, 

that worried the cat, that chased the rat, that ate the carrot, that lay in 

the house that Jack built."; 

 

   // Add the RenderText to the document.     

   this.c1PrintDocument1.Body.Children.Add(rt1);     

   this.c1PrintDocument1.Body.Children.Add(rt2);     

   this.c1PrintDocument1.Body.Children.Add(rt3);     

} 

What You've Accomplished 

The text appears in two columns on each page of the document: 
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Customizing the File Formats in the Save As 

Dialog Box 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Customizing the File 

Formats in the Save As Dialog Box 

Show All  

Hide All  

To customize the file formats in the Save As dialog box to only save files in a particular file 

format (for example, Adobe PDF), all of the other file formats except for PDF must be disabled 

using the ExportOptions property. 

To save to a file format other than Adobe PDF (.pdf), replace the "PdfExportProvider" text in the 

following code to one of the following options: 

File Format Export Provider 

BMP Image (.bmp) BmpExportProvider 

C1 Document (.c1d) C1dExportProvider 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl~ExportOptions.html
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File Format Export Provider 

Enhanced Metafile (.emf) EmfExportProvider 

GIF Image (.gif) GifExportProvider 

HTML (.htm) HtmlExportProvider 

JPEG Image (.jpg) JpegExportProvider 

Microsoft Excel (.xls) XlsExportProvider 

Open XML MS Excel File (.xlsx) XslsExportProvider 

PNG Image (.png) PngExportProvider 

Rich Text Format (.rtf) RtfExportProvider 

TIFF Image (.tiff) TiffExportProvider 

Add the following code to the Form_Load event: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Dim lp As Integer = 0     

While lp < Me.C1PrintPreviewControl1.ExportOptions.Count     

    If Not TypeOf (C1PrintPreviewControl1.ExportOptions(lp).ExportProvider) 

Is C1.C1Preview.Export.PdfExportProvider Then     

        C1PrintPreviewControl1.ExportOptions(lp).Enabled = False     

    End If     

    lp = lp + 1     

End While 

To write code in C# 

C# Copy Code  
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for (int lp = 0; lp < c1PrintPreviewControl1.ExportOptions.Count; lp++)     

{     

    if (!(c1PrintPreviewControl1.ExportOptions[lp].ExportProvider is 

C1.C1Preview.Export.PdfExportProvider))     

    {     

        c1PrintPreviewControl1.ExportOptions[lp].Enabled = false;     

    }     

} 

What You've Accomplished 

The only available file format in the Save As dialog box is Adobe PDF: 

 

Drawing Text at an Angle 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Drawing Text at an 

Angle 

Show All  

Hide All  

To draw text at an angle, use the Graphics object and create a subroutine to rotate text. 
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1. Navigate to the Toolbox and add the C1PrintPreviewControl and C1PrintDocument 

controls to your project. 

2. Click C1PrintPreviewControl1 to select it and in the Properties window set its 

Document property to C1PrintDocument1. 

3. Add the following code to the Form_Load event:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.StartDoc()     

Me.C1PrintDocument1.RenderBlockGraphicsBegin() 

 

' Declare the graphics object.     

Dim g As System.Drawing.Graphics     

g = Me.C1PrintDocument1.CurrentBlockGraphics    

 

Dim fontb = New Font("Arial", 12, FontStyle.Bold) 

 

' Subroutine to alter text angle.     

RotateText(g, fontb, "Hello World", -45, Brushes.CadetBlue, 10, 100) 

 

Me.C1PrintDocument1.RenderBlockGraphicsEnd()     

Me.C1PrintDocument1.EndDoc() 

To write code in C# 

C# Copy Code  

 

this.c1PrintDocument1.StartDoc();     

this.c1PrintDocument1.RenderBlockGraphicsBegin();  

  

// Declare the graphics object.     

System.Drawing.Graphics g;     

g = this.c1PrintDocument1.CurrentBlockGraphics;  

 

Font fontb = new Font("Arial", 12, FontStyle.Bold); 

 

// Subroutine to alter text angle.     

RotateText(g, fontb, "Hello World", -45, Brushes.CadetBlue, 10, 100); 

 



 

 550 

this.c1PrintDocument1.RenderBlockGraphicsEnd();     

this.c1PrintDocument1.EndDoc(); 

4. Add the following RotateText subroutine, which draws the text at an angle:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Public Sub RotateText(ByVal g As Graphics, ByVal f As Font, ByVal s As 

String, ByVal angle As Single, ByVal b As Brush, ByVal x As Single, ByVal y 

As Single)     

    If angle > 360 Then     

        While angle > 360     

            angle = angle - 360     

        End While     

    ElseIf angle < 0 Then     

        While angle < 0     

            angle = angle + 360     

        End While     

    End If 

 

    ' Create a matrix and rotate it n degrees.     

    Dim myMatrix As New System.Drawing.Drawing2D.Matrix     

    myMatrix.Rotate(angle, Drawing2D.MatrixOrder.Append) 

 

    ' Draw the text to the screen after applying the transform.     

    g.Transform = myMatrix     

    g.DrawString(s, f, b, x, y)     

End Sub 

To write code in C# 

C# Copy Code  

 

public void RotateText(Graphics g, Font f, string s, Single angle, Brush b, 

Single x, Single y)     

{     

    if (angle > 360)     

    {     
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        while (angle > 360)     

        {     

            angle = angle - 360;     

        }     

    }     

    else if (angle < 0)     

    {     

        while (angle < 0)     

        {     

            angle = angle + 360;     

        }     

    } 

 

    // Create a matrix and rotate it n degrees.     

    System.Drawing.Drawing2D.Matrix myMatrix = new 

System.Drawing.Drawing2D.Matrix();     

    myMatrix.Rotate(angle, System.Drawing.Drawing2D.MatrixOrder.Append); 

 

    // Draw the text to the screen after applying the transform.     

    g.Transform = myMatrix;     

    g.DrawString(s, f, b, x, y);     

} 

What You've Accomplished 

The text you added appears at a 45 degree angle: 
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Formatting Tables 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Formatting Tables 

The following task-based help topics customize features of a table. Each topic assumes that you 

have already created a table. For details on how to create a table, see Creating a Table with 

Three Columns and Rows. 

See Also 

Changing the Background Color of Rows and Columns 

Changing the Font 

Changing the Alignment of a Table 

Rendering Overlapping Objects in a Table 

Changing the Background Color of Rows and 

Columns 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Formatting Tables > 

Changing the Background Color of Rows and Columns 

Show All  
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Hide All  

To change the background color of rows and columns in a table, set the BackColor property of 

the row and column. 

 

Note: The column BackColor property overrides the row BackColor property. 

Add the following code to the Form_Load event before the Add and Generate methods: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Set the Column color.     

table.Cols(0).Style.BackColor = Color.PapayaWhip 

 

' Set the Row color.     

table.Rows(0).Style.BackColor = Color.PaleTurquoise 

To write code in C# 

C# Copy Code  

 

// Set the Column color.     

table.Cols[0].Style.BackColor = Color.PapayaWhip; 

 

// Set the Row color.     

table.Rows[0].Style.BackColor = Color.PaleTurquoise; 

What You've Accomplished 

The first column in the table is PapayaWhip and the first row in the table is PaleTurquoise: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style~BackColor.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~Generate.html
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Changing the Font 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Formatting Tables > 

Changing the Font 

Show All  

Hide All  

This topic shows how to change the Font in a single table cell, of a table column or of a table 

row. 

Changing the Font in a Single Table Cell 

To change the font in a single table cell, set the Font property for the cell. Add the following 

code to the Form_Load event before the Add and Generate methods: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

table.Cells(1, 1).Style.Font = New Font("Tahoma", 12, FontStyle.Bold)     

table.Cells(1, 1).Style.TextColor = Color.DarkGreen 

To write code in C# 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~Generate.html
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C# Copy Code  

 

table.Cells[1, 1].Style.Font = new Font("Tahoma", 12, FontStyle.Bold);      

table.Cells[1, 1].Style.TextColor = Color.DarkGreen; 

Changing the Font of a Table Column 

To change the font of a table column, set the Font property for the column. Add the following 

code to the Form_Load event before the Add and Generate methods: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

table.Cols(0).Style.Font = New Font("Arial", 12, FontStyle.Bold) 

To write code in C# 

C# Copy Code  

 

table.Cols[0].Style.Font = new Font("Arial", 12, FontStyle.Bold); 

Changing the Font of a Table Row 

To change the font of a table row, set the Font property for the row. Add the following code to 

the Form_Load event before the Add and Generate methods: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

table.Rows(0).Style.Font = New Font("Arial", 12, FontStyle.Bold) 

 

To write code in C# 

C# Copy Code  

 

table.Rows[0].Style.Font = new Font("Arial", 12, FontStyle.Bold); 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~Generate.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~Generate.html
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What You've Accomplished 

The following image shows how the table will appear, when you change the font in a single 

table cell, using the code given above. The text in cell (1,1) appears in 12 point, Dark Green, 

Bold Tahoma font: 

 

The following image shows how the table will appear, when you change the font of a table 

column, using the code given above. The text in the first column appears in 12 point, Bold Arial 

font: 
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The following image shows how the table will appear, when you change the font of a table row. 

The text in the first row appears in 12 point, Bold Arial font: 
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Changing the Alignment of a Table 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Formatting Tables > 

Changing the Alignment of a Table 

Show All  

Hide All  

To change the alignment of a table, set the FlowAlign property for the table. For example, add 

the following code to the Form_Load event before the Generate method to center the table on 

the page: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

table.Style.FlowAlign = FlowAlignEnum.Center 

To write code in C# 

C# Copy Code  

 

table.Style.FlowAlign = FlowAlignEnum.Center; 

What You've Accomplished 

The table appears centered on the page: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.Style~FlowAlign.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~Generate.html
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Rendering Overlapping Objects in a Table 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Formatting Tables > 

Rendering Overlapping Objects in a Table 

Show All  

Hide All  

You can easily render overlapping objects in a table cell. For example, add the following code to 

the Form_Load event before the Generate method to add a square overlapped by two crossing 

lines in the table: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Create a rectangle, and two lines to form an 'X'.      

Dim rect As New RenderRectangle(New Unit(3, UnitTypeEnum.Cm), New Unit(3, 

UnitTypeEnum.Cm))     

Dim rl1 As New RenderLine(New Unit(0, UnitTypeEnum.Cm), New Unit(0, 

UnitTypeEnum.Cm), New Unit(3, UnitTypeEnum.Cm), New Unit(3, UnitTypeEnum.Cm), 

LineDef.[Default])     

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument~Generate.html
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Dim rl2 As New RenderLine(New Unit(3, UnitTypeEnum.Cm), New Unit(0, 

UnitTypeEnum.Cm), New Unit(0, UnitTypeEnum.Cm), New Unit(3, UnitTypeEnum.Cm), 

LineDef.[Default])     

rect.Style.BackColor = Color.PeachPuff 

 

' Add the objects to the table.     

table.Cells(1, 1).Area.Children.Add(rect)     

table.Cells(1, 1).Area.Children.Add(rl1)     

table.Cells(1, 1).Area.Children.Add(rl2) 

To write code in C# 

C# Copy Code  

 

// Create a rectangle, and two lines to form an 'X'.      

RenderRectangle rect = new RenderRectangle(new Unit(3, UnitTypeEnum.Cm), new 

Unit(3, UnitTypeEnum.Cm));     

RenderLine rl1 = new RenderLine(new Unit(0, UnitTypeEnum.Cm), new Unit(0, 

UnitTypeEnum.Cm), new Unit(3, UnitTypeEnum.Cm), new Unit(3, UnitTypeEnum.Cm), 

LineDef.Default);     

RenderLine rl2 = new RenderLine(new Unit(3, UnitTypeEnum.Cm), new Unit(0, 

UnitTypeEnum.Cm), new Unit(0, UnitTypeEnum.Cm), new Unit(3, UnitTypeEnum.Cm), 

LineDef.Default);     

rect.Style.BackColor = Color.PeachPuff; 

     

// Add the objects to the table.      

table.Cells[1, 1].Area.Children.Add(rect);     

table.Cells[1, 1].Area.Children.Add(rl1);     

table.Cells[1, 1].Area.Children.Add(rl2); 

What You've Accomplished 

The table appears with a square with two overlapping lines: 
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Inserting a Page Break 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Inserting a Page 

Break 

Show All  

Hide All  

To insert a page break, use the BreakAfter property for the RenderObject. 

1. From the Toolbox, add the C1PrintPreviewControl and C1PrintDocument controls to 

your project. 

2. Click C1PrintPreviewControl1 to select it and in the Properties window set its 

Document property to C1PrintDocument1. 

3. Add the following code to the Form_Load event:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

' Make the document.     

MakeDoc() 

 

' Generate the document.     

Me.C1PrintDocument1.Generate() 

To write code in C# 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject~BreakAfter.html
file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.RenderObject.html
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C# Copy Code  

 

// Make the document.     

MakeDoc(); 

 

// Generate the document.     

this.c1PrintDocument1.Generate(); 

4. Add the MakeDoc subroutine, which uses the BreakAfter property to insert a page 

break after each RenderObject:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub MakeDoc() 

 

    ' Create RenderText.     

    Dim rt1 As New C1.C1Preview.RenderText     

    rt1.Text = "This is RenderText. A RenderImage will be on page 2 and a 

RenderGraphic on page 3." 

 

    ' Add a page break.     

    rt1.BreakAfter = C1.C1Preview.BreakEnum.Page 

 

    ' Create RenderImage.     

    Dim ri1 As New C1.C1Preview.RenderImage     

    ri1.Image = System.Drawing.Image.FromFile("c:\c1logo.bmp") 

 

    ' Add a page break.     

    ri1.BreakAfter = C1.C1Preview.BreakEnum.Page 

 

    ' Create a RenderGraphic.     

    Dim rg1 As New C1.C1Preview.RenderGraphics()     

    rg1.Graphics.FillEllipse(Brushes.DarkBlue, 200, 200, 150, 150)     

    rg1.Graphics.FillPie(Brushes.DarkRed, 200, 200, 150, 150, -45, 75) 

 

    ' Add the RenderObjects to the document.     

    Me.C1PrintDocument1.Body.Children.Add(rt1)     

    Me.C1PrintDocument1.Body.Children.Add(ri1)     
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    Me.C1PrintDocument1.Body.Children.Add(rg1)     

End Sub 

To write code in C# 

C# Copy Code  

 

private void MakeDoc()     

{     

    // Create RenderText.     

    C1.C1Preview.RenderText rt1 = new C1.C1Preview.RenderText();     

    rt1.Text = "This is RenderText. A RenderImage will be on page 2 and a 

RenderGraphic on page 3."; 

 

    // Add a page break.     

    rt1.BreakAfter = C1.C1Preview.BreakEnum.Page; 

 

    // Create RenderImage.     

    C1.C1Preview.RenderImage ri1 = new C1.C1Preview.RenderImage();     

    ri1.Image = System.Drawing.Image.FromFile("c:\\c1logo.bmp"); 

 

    // Add a page break.     

    ri1.BreakAfter = C1.C1Preview.BreakEnum.Page; 

 

    // Create a RenderGraphic.     

    C1.C1Preview.RenderGraphics rg1 = new C1.C1Preview.RenderGraphics();     

    rg1.Graphics.FillEllipse(Brushes.DarkBlue, 200, 200, 150, 150);     

    rg1.Graphics.FillPie(Brushes.DarkRed, 200, 200, 150, 150, -45, 75); 

 

    // Add the RenderObjects to the document.     

    this.c1PrintDocument1.Body.Children.Add(rt1);     

    this.c1PrintDocument1.Body.Children.Add(ri1);     

    this.c1PrintDocument1.Body.Children.Add(rg1);     

} 

What You've Accomplished 

A page break is inserted between the different RenderObjects: 
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Printing in Landscape 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Printing in 

Landscape 

Show All  

Hide All  

C1PrintDocument allows to you to specify different printing options and page settings for your 

document. The page settings can be specified in the designer or in code. 

In the Designer 

1. Select the C1PrintDocument control on your form. Its properties will appear in the 

right-pane of the Visual Studio interface. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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2. Locate the PageSettings property for the C1PrintDocument. 

 
3. Locate the Landscape property and set it to True. Your C1PrintDocument will appear 

and print in the Landscape orientation. 

 

In Code 

You can also change your page settings for your C1PrintDocument at run time, by adding the 

following code to the Form_Load event: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintDocument1.PageLayout.PageSettings.Landscape = True 

To write code in C# 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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C# Copy Code  

 

this.c1PrintDocument1.PageLayout.PageSettings.Landscape = true; 

At Run Time 

You can also change the page settings for your C1PrintDocument in the preview at run time 

using the Page Setup dialog box. 

1. Click the Page Setup button located in the toolbar. 

 

The Page Setup dialog box opens. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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The Page Setup dialog box contains the following fields: 

Field Name Description 

Paper Select the size and the source of the paper. The available sizes and 

sources depend on the selected printer. 

Orientation Choose from Portrait or Landscape page orientation. 

Margins Customize the Left, Right, Top, and Bottom margins of your 

C1PrintDocument. 

The Page Setup dialog box has the following Command Buttons: 

Button Name Description 

OK Apply the settings to your C1PrintDocument. 

Cancel Cancel the modified Page Settings for your document. 
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Button Name Description 

Printer Modify or view the settings for your printer. 

2. Locate the Orientation field and select the Landscape option. Your C1PrintDocument 

now appears and will print in the Landscape orientation. 

 

Previewing SSRS Reports 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Previewing SSRS 

Reports 

C1SsrsDocumentSource enables you to specify the location or name of the SSRS report to be 

viewed. It will then allow the C1PrintPreviewControl to display an SSRS report. 

It is not a visual component so it can be added onto a form but it appears in the component 

tray. 

 

Note: You must have access to the SSRS report server and have at least one report on that 

server before you start this topic. 

To preview or export an SSRS report, using the C1PrintPreviewControl, create a new WinForms 

application, using .NET framework 4.0 or above and complete the following steps: 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PrintDocument.html
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In the Designer 

1. From the toolbox, add the C1SSRSDocumentSource component onto the form. It 

appears in the component tray.  

 

If you cannot find the component in the toolbox, right click and select choose items. The 

Choose Toolbox Items dialog appears. Locate the component in 

the C1.Win.C1Document.dll and add it to the toolbox. 

2. Add the C1PrintPreviewControl onto the form, and set its height and width as desired. 

3. Right click the C1PrintPreviewControl and select Properties to open the properties 

window. 

4. Set the SsrsPaginated property to true to view the report in paginated mode. Or set it 

to false to view the report in non-paginated mode. 

5. Click the C1SSRSDocumentSource component, then click the smart tag to open the 

C1SSRSDocumentSource Tasks Menu. 

6. Check the checkbox next to the C1PrintPreviewControl. This assigns the 

C1SSRSDocumentSource component to the C1PrintPreviewControl's Document 

property. 

7. Right click the C1SSRSDocumentSource and select Properties to open the Properties 

window. 

8. Click the drop-down arrow next to the DocumentLocation property. 

9. Specify the address of the SSRS server and the full path to the report in the following 

dialog and click OK. 

     

10. Expand the ConnectionOptions property group. 

11. Click the drop-down arrow next to the Credential property. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl~SsrsPaginated.html
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12. Specify the User Name, Password and Domain in the following dialog and click OK. 

     

 

Note: Ensure that the following DLLs are added to the project references. 

 C1.Win.C1Document.dll 

 C1.Win.dll 

 C1.Win.C1ImportServices.dll 

 C1.Win.C1Report.dll 

 C1.C1Report.dll 

 C1.C1Zip.dll 

What You've Accomplished 

You may be asked to set some parameters, based on which you see the specified SSRS report in 

the preview control. 
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You can now export it to a number of supported external formats. 

Setting the Page Size 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Setting the Page 

Size 

Show All  

Hide All  

To set the page size for the document, use the PaperKind property. 

1. From the Toolbox, add the C1PrintPreviewControl and C1PrintDocument controls to 

your project. 

2. Click C1PrintPreviewControl1 to select it and in the Properties window set its 

Document property to C1PrintDocument1. 

3. Add the following code to the Form_Load event:  

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.C1PageSettings~PaperKind.html
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To write code in Visual Basic 

Visual Basic Copy Code  

 

' Make the document.     

MakeDoc() 

 

' Generate the document.     

Me.C1PrintDocument1.Generate() 

To write code in C# 

C# Copy Code  

 

// Make the document.     

MakeDoc(); 

 

// Generate the document.     

this.c1PrintDocument1.Generate(); 

4. Add the following MakeDoc subroutine, which uses the PaperKind property to set the 

page size to Legal:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub MakeDoc() 

 

    ' Define the page layout for the document.     

    Dim pl As New C1.C1Preview.PageLayout()     

    pl.PageSettings = New C1.C1Preview.C1PageSettings()     

    pl.PageSettings.PaperKind = System.Drawing.Printing.PaperKind.Legal     

    Me.C1PrintDocument1.PageLayouts.Default = pl     

End Sub 

To write code in C# 

C# Copy Code  
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private void MakeDoc()     

{ 

 

    // Define the page layout for the document.     

    C1.C1Preview.PageLayout pl = new C1.C1Preview.PageLayout();     

    pl.PageSettings = new C1.C1Preview.C1PageSettings();     

    pl.PageSettings.PaperKind = System.Drawing.Printing.PaperKind.Legal;    

    this.c1PrintDocument1.PageLayouts.Default = pl;     

} 

What You've Accomplished 

The default page size is set to Legal: 

 

Resizing or Scaling an Image 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Resizing or Scaling 

an Image 

Show All  

Hide All  

You can easily resize or scale a RenderImage to 50% by completing the following steps: 
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1. From the Toolbox, add the C1PrintPreviewControl and C1PrintDocument 

components to your project. 

2. Click C1PrintPreviewControl1 to select it, and in the Properties window set its 

Document property to C1PrintDocument1. 

3. Switch to Code view and add the following namespace declaration:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Imports C1.C1Preview 

To write code in C# 

C# Copy Code  

 

using C1.C1Preview; 

4. Add the following Form_Load event, which adds an image to the page and scales that 

image to 50% of the available width with the height scaling automatically, replacing 

c1logo.png with your image name and location:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles MyBase.Load 

    ' Create a new Render Image, replacing c1logo.png with your image name 

and location. 

    Dim img As New C1.C1Preview.RenderImage 

    img.Image = Image.FromFile("C:\c1logo.png") 

    ' Scale the image to 50% of the available page width, the height of the 

image will scale automatically here. 

    img.Width = "50%" 

    ' Create the document. 

    C1PrintDocument1.StartDoc() 

    C1PrintDocument1.RenderBlock(img) 

    C1PrintDocument1.EndDoc() 

End Sub 
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To write code in C# 

C# Copy Code  

 

private void Form1_Load(object sender, EventArgs e) 

{ 

    // Create a new Render Image, replacing c1logo.png with your image name 

and location.  

    C1.C1Preview.RenderImage img = new C1.C1Preview.RenderImage();  

    img.Image = Image.FromFile("C:\\c1logo.png");  

    // Scale the image to 50% of the available page width, the height of the 

image will scale automatically here.  

    img.Width = "50%";  

    // Create the document.  

    c1PrintDocument1.StartDoc();  

    c1PrintDocument1.RenderBlock(img);  

    c1PrintDocument1.EndDoc(); 

} 

What You've Accomplished 

A image appears scaled on the page: 
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Adding a Watermark Image 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Adding a Watermark 

Image 

Show All  

Hide All  

To set the page size for the document, use the Watermark property. 

1. From the Toolbox, add the C1PrintPreviewControl and C1PrintDocument 

components to your project. 

2. Click C1PrintPreviewControl1 to select it, and in the Properties window set its 

Document property to C1PrintDocument1. 

3. Switch to Code view and add the following namespace declaration:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Imports C1.C1Preview 

To write code in C# 

C# Copy Code  

 

using C1.C1Preview; 

4. Add the following Form_Load event, which uses the Watermark property to add a 

watermark to the page, and replace c1logo.png with your image's name and location:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles MyBase.Load 

    ' Create watermark and layout. 

    Dim waterMark As New RenderImage 

    Dim pl As New C1.C1Preview.PageLayout() 

     

    ' Set the watermark image; replace c1logo.png with your image's name. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.C1Report.4~C1.C1Preview.PageLayout~Watermark.html
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    waterMark.Image = Image.FromFile("c:\c1logo.png") 

    waterMark.Y = New Unit(2, UnitTypeEnum.Inch) 

    pl.Watermark = waterMark 

    Me.C1PrintDocument1.PageLayout = pl 

  

    ' Generate the document.  

    Me.C1PrintDocument1.Generate() 

End Sub 

To write code in C# 

C# Copy Code  

 

private void Form1_Load(object sender, EventArgs e) 

{ 

    // Create watermark and layout.  

    RenderImage waterMark = new RenderImage(); 

    C1.C1Preview.PageLayout pl = new C1.C1Preview.PageLayout(); 

     

    // Set the watermark image; replace c1logo.png with your image's name.  

    waterMark.Image = Image.FromFile("c:\\c1logo.png"); 

    waterMark.Y = new Unit(2, UnitTypeEnum.Inch); 

    pl.Watermark = waterMark; 

    this.c1PrintDocument1.PageLayout = pl; 

     

    // Generate the document.  

    this.C1PrintDocument1.Generate(); 

} 

What You've Accomplished 

A watermark is added to the page: 
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Setting the Initial Zoom Mode 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Setting the Initial 

Zoom Mode 

Show All  

Hide All  

To set the initial zoom mode, set the ZoomMode property to ActualSize, PageWidth, 

TextWidth, WholePage (default), or Custom. This property can be set at either in the designer 

or in code. 

In the Smart Designer 

1. Click the Layout button in the PreviewPane floating toolbar to open Layout dialog 

box. 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewPane~ZoomMode.html
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2. Select PageWidth from the drop-down menu next to the Zoom Mode: 

 

In the Properties window 

1. Locate the PreviewPane property for C1PrintPreviewControl in the Properties window 

and expand the properties node. 

2. Set the ZoomMode property to PageWidth. 

 

In Code 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PrintPreviewControl.html
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Add the following code to the Form_Load event to set the ZoomMode to PageWidth: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintPreviewControl1.PreviewPane.ZoomMode = 

C1.Win.C1Preview.ZoomModeEnum.PageWidth 

To write code in C# 

C# Copy Code  

 

this.c1PrintPreviewControl1.PreviewPane.ZoomMode = 

C1.Win.C1Preview.ZoomModeEnum.PageWidth; 

What You've Accomplished 

When the document loads, the page zooms into the page width: 

 

 

Removing an Item from the Context Menu 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Removing an Item 
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from the Context Menu 

Show All  

Hide All  

By default a context menu appears when the C1PreviewPane is right-clicked at run time. This 

ContextMenuStrip includes settings for manipulating the preview including items from the 

File, Zoom, and Text toobars. You can create your own context menu by adding a 

ContextMenuStrip control and assigning it to the PreviewPane.ContextMenuStrip property. 

You can also customize the existing ContextMenuStrip by adding additional items or removing 

existing items. 

The following example removes the standard "Copy" item from the context menu. Complete the 

following steps: 

1. In the Form_Load event attach a handler to the Opening event of the 

ContextMenuStrip on the C1PreviewPane:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

AddHandler PreviewPane.ContextMenuStrip.Opening, AddressOf 

ContextMenuStrip_Opening 

To write code in C# 

C# Copy Code  

 

PreviewPane.ContextMenuStrip.Opening += new 

CancelEventHandler(ContextMenuStrip_Opening); 

2. Create the ContextMenuStrip_Opening event, and add the following code to remove 

the "Copy" item from the context menu:  

To write code in Visual Basic 

Visual Basic Copy Code  

 

Private Sub ContextMenuStrip_Opening(ByVal sender As Object, ByVal e As 

CancelEventArgs)  

    Dim cms As System.Windows.Forms.ContextMenuStrip = DirectCast(sender, 

file:///C:/Users/GPCTAdmin/AppData/Local/Temp/684100/C1.Win.C1Report.4~C1.Win.C1Preview.C1PreviewPane.html
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System.Windows.Forms.ContextMenuStrip)  

    For Each item As ToolStripItem In cms.Items  

        If item.Tag = ContextMenuTags.Copy Then  

            item.Visible = False  

        End If  

    Next  

End Sub 

To write code in C# 

C# Copy Code  

 

void ContextMenuStrip_Opening(object sender, CancelEventArgs e) 

{ 

  System.Windows.Forms.ContextMenuStrip cms = 

(System.Windows.Forms.ContextMenuStrip)sender; 

  foreach (ToolStripItem item in cms.Items) 

    if (item.Tag == ContextMenuTags.Copy) 

      item.Visible = false; 

} 

What You've Accomplished 

When you right-click the preview pane in the C1PrintPreviewControl control, observe that the 

standard "Copy" item is not included on the context menu. 

Disabling the Context Menu 
Reports for WinForms Task-Based Help > Printing and Previewing Task-Based Help > Disabling the 

Context Menu 

Show All  

Hide All  

A context menu appears by default when the C1PreviewPane is right-clicked at run time. This 

ContextMenuStrip includes settings for manipulating the preview. You can disable this context 

menu in code by setting the ContextMenuStrip property of the C1PreviewPane to null. Note 

that this cannot be done in the designer only in code but, you can override the default context 

menu strip with your own in the designer (by dropping a ContextMenuStrip component on 

the form, and setting the C1PreviewPane's ContextMenuStrip property to that component). 

When using the C1PrintPreviewControl control, the preview pane can be accessed via the 

PreviewPane property on the control.  
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Add the following code to the Form_Load event to disable this context menu in a 

C1PrintPreviewControl control: 

To write code in Visual Basic 

Visual Basic Copy Code  

 

Me.C1PrintPreviewControl1.PreviewPane.ContextMenuStrip = Nothing 

To write code in C# 

C# Copy Code  

 

this.c1PrintPreviewControl1.PreviewPane.ContextMenuStrip = null; 

What You've Accomplished 

The default context menu does not appear when you right-click the preview pane in the 

C1PrintPreviewControl control. 
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